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Software Copyright and Warranty
This legal document is an agreement between you, the
end user, and BIAS, Inc. BY UTILIZING THE SOFT-
WARE ON THESE DISKS, YOU ARE AGREEING TO
BECOME BOUND BY THE TERMS OF THIS AGREE-
MENT, WHICH INCLUDES THE SOFTWARE LICENSE
AND THE SOFTWARE DISCLAIMER OF WARRANTY
(collectively the “Agreement”). THIS AGREEMENT
CONSTITUTES THE COMPLETE AGREEMENT
BETWEEN YOU AND BIAS, INC. IF YOU DO NOT
AGREE TO THE TERMS OF THIS AGREEMENT, DO
NOT USE THE SOFTWARE ON THE DISKS INCLUDED
IN THIS PACKAGE AND PROMPTLY RETURN THE
UNOPENED PACKAGE AND THE OTHER MATERIALS
(INCLUDING WRITTEN MATERIALS, BINDERS OR
OTHER CONTAINERS) THAT ARE PART OF THIS
PRODUCT TO THE PLACE WHERE YOU OBTAINED
THEM FOR A FULL REFUND.
BIAS SOFTWARE LICENSE
1. GRANT OF LICENSE. In consideration of payment
of the LICENSE fee, which is part of the price you paid
for this product, BIAS, as Licensor, grants to you, the
LICENSEE, a non-exclusive right to use and display this
copy of a BIAS software program (hereinafter the
“SOFTWARE”) an a single COMPUTER (i.e., with a
single CPU) at a single location. BIAS reserves all rights
not expressly granted to LICENSEE.
2. OWNERSHIP OF SOFTWARE. As the LICENSEE, you
own the magnetic or other physical media on which
the SOFTWARE is originally or subsequently recorded
or fixed, but BIAS retains title and ownership of the
SOFTWARE recorded on the original disk copy (or
copies) and all subsequent copies of the SOFTWARE,
regardless of the form or media on which the original
and other copies may exist. This License is not a sale of
the original SOFTWARE or any copy.
3. COPY RESTRICTIONS. This SOFTWARE and the
accompanying written materials are copyrighted.
Unauthorized copying of the SOFTWARE, including
SOFTWARE that has been modified, merged, or
included with other software, or of the written
materials is expressly forbidden. You may be held
legally responsible for any copyright infringement that
is caused or encouraged by your failure to abide by the
terms of this License. Subject to these restrictions, and

if the SOFTWARE is not copy-protected, you may make
one (1) copy of the SOFTWARE solely for backup
purposes. You must reproduce and include the
copyright notice on the backup copy.
4. USE RESTRICTIONS. As the LICENSEE, you may
physically transfer the SOFTWARE from one computer
to another provided that the SOFTWARE is used on
only one computer at a time. You may not electroni-
cally transfer the SOFTWARE from one computer to
another over a network. You may not distribute copies
of the SOFTWARE or accompanying written materials
to others. You may not modify, adapt, translate,
reverse engineer, de-compile, disassemble, or create
derivative works based on the SOFTWARE. You may
not modify, adapt, translate, or create derivative works
based on the written materials without the prior
written consent of BIAS.
5. TRANSFER RESTRICTIONS. This SOFTWARE is
licensed only to you, the LICENSEE, and may not be
transferred to anyone without the prior written
consent of BIAS. Any authorized transferee of the
SOFTWARE shall be bound by the terms and condi-
tions of this Agreement. In no event may you transfer,
assign, rent, lease, sell, or otherwise dispose of the
SOFTWARE on a temporary or permanent basis except
as expressly provided herein.
6. TERMINATION. This License is effective until
terminated. This License will terminate automatically
without notice from BIAS if you fail to comply with any
provision of this License. Upon termination you shall
destroy the written materials and all copies of the
SOFTWARE, including modified copies, if any.
7. UPDATE POLICY. BIAS may create, from time to
time, updated versions of the SOFTWARE.  At its
option, BIAS will make such updates available to the
LICENSEE and transferees who have paid the update
fee and returned the registration card to BIAS.
8. MISCELLANEOUS. This Agreement is governed by
the law of the State of California.

DISCLAIMER OF WARRANTY AND LIMITED WAR-
RANTY
THE SOFTWARE AND ACCOMPANYING WRITTEN
MATERIALS (INCLUDING INSTRUCTIONS FOR USE)
ARE PROVIDED “AS IS” WITHOUT WARRANTIES OF
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LEGAL RIGHTS. YOU MAY HAVE OTHER RIGHTS
WHICH VARY FROM STATE TO STATE.
NEITHER BIAS NOR ANYONE ELSE WHO HAS BEEN
INVOLVED IN THE CREATION, PRODUCTION, OR
DELIVERY OF THIS PRODUCT SHALL BE LIABLE FOR
ANY DIRECT, INDIRECT, CONSEQUENTIAL, OR
INCIDENTAL DAMAGES (INCLUDING DAMAGES FOR
LOSS OF BUSINESS PROFITS, BUSINESS INTERRUP-
TION, LOSS OF BUSINESS INFORMATION, AND THE
LIKE) ARISING SUCH DAMAGES. BECAUSE SOME
STATES DO NOT ALLOW THE EXCLUSION OR
LIMITATION OF LIABILITY FOR CONSEQUENTIAL OR
INCIDENTAL DAMAGES, THE ABOVE LIMITATION
MAY NOT APPLY TO YOU.
This Disclaimer of Warranty and Limited Warranty is
governed by the laws of the State of California.
U.S. GOVERNMENT RESTRICTED RIGHTS

The SOFTWARE and documentation is provided with
RESTRICTED RIGHTS. Use, duplication, or disclosure
by the Government is subject to restrictions as set
forth in subdivision (b)(3)(ii) of The Rights in
Technical Data and Computer Software clause at
252.227-7013.
Contractor/manufacturer is BIAS (Berkley Integrated
Audio Software), Inc./ 1370 Industrial Ave., Suite A,
Petaluma, CA 94952
Should you have any questions concerning this
Agreement, or if you desire to contact BIAS for any
reason, please contact in writing:
BIAS Customer Sales and Service,
1370 Industrial Ave., Suita A, Petaluma CA 94952.
Copyright 1998 BIAS, Inc.
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3Introduction à Deck

Chapitre 1 :
Introduction à Deck

Bienvenue !

Deck 3.0 de BIAS est une application audionumérique
multipiste complète pour le Macintosh qui a recueilli
des félicitations pour ses fonctions professionnelles et
son interface utilisateur intuitive. Deck offre une
édition entièrement non-destructive permettant
d’éditer une piste autant que vous le voulez, sans
craindre de perdre ou d’altérer le matériau original.
Utilisez Deck pour enregistrer et éditer jusqu’à 64
pistes de lecture audio simultanées (selon la vitesse de
votre processeur et de vos disques durs). Deck offre
également jusqu'à 999 pistes de travail virtuelles.

Deck 3.0 est entièrement natif avec un Macintosh G4,
G3 ou PowerPC. Vous pouvez utiliser les connexions
audio intégrées de votre Mac sans recourir à du
matériel supplémentaire. Deck est également
compatible avec la norme ASIO, vous permettant un
grand choix de matériel audio.

Deck fournit un traitement du signal en temps réel
avec des égaliseurs, des délays, du chorus, et d’autres
effets intégrés sous forme graphique — sur chaque
piste (selon la vitesse et la puissance du processeur).
Un grand nombre de plug-ins VST et Adobe Premiere
sont compatibles.

Deck offre une abondance de fonctions de post-
production audio professionnelles, dont une synchro
SMPTE/EBU et des films QuickTime à la trame près.
Deck est le compagnon idéal des systèmes d’édition
de vidéonumérique comme Adobe, Avid, Finalcut Pro,
iMovie, Media 100, Radius ou autres.

Deck est conçu pour une grande variété d’utilisateurs.
Les musiciens l’utilisent comme environnement de

composition. Les ingénieurs l’utilisent pour
enregistrer, éditer et mixer en multipiste. Deck est
utilisé en post-production vidéo pour repérer des
effets sonores et des pistes son. Les designers sonores
l’utilisent pour élaguer et trier de l’audio. Les
producteurs multimédia l’utilisent comme
environnement de post-production audio et vidéo. Les
programmateurs radio l’utilisent pour le reportage et
pour monter des programmes entiers. Toute personne
intéressée par l’audio et possédant un système
Macintosh adéquat peut tirer profit de Deck.

Fonctions de Deck
• Solution professionnelle d’enregistrement,

édition & traitement multipiste

• Jusqu'à 64 pistes simultanées - aucun matériel
audio n’est nécessaire

• Tourne sur la plupart des Mac - même sur les
PowerBook

• Jusqu'à 999 pistes virtuelles

• Effets DSP en temps réel intégrés dont égaliseurs
graphiques & paramétriques, délays, chorus, gain
& autres

• Compatibilité avec les plug-ins audio VST et
Adobe Premiere

• Mixage automatisé 24 bits des niveaux avec
fadeurs mobiles haute résolution

• Mutes, pans & niveaux automatisés

• Copiez, collez, faites glisser & dessinez des
enveloppes d'automation

• Compatibilité vidéo intégrée - avec synchro
timecode MTC & SMPTE/EBU à la trame près
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• Synchro avec tous les séquenceurs MIDI
compatibles OMS

• Lancement de Peak ou Peak LE de BIAS
directement depuis Deck

• Inclut BIAS Peak LE

Quelles sont les nouveautés de
Deck 3.0 ?
La version 3.0 de Deck inclut les nouvelles fonctions
suivantes :

• Compatibilité avec les plug-ins VST

• Capacité de pistes de lecture améliorée, limitée
uniquement par votre système, avec jusqu'à 64
pistes de lecture simultanées

• Fenêtre Master Outputs : inclut le fadeur et les
Vu-mètres Master, et les inserts VST

• Graphismes améliorés

• Fenêtre CPU Meter : affiche le niveau d’utilisation
de la RAM, du processeur et du disque

• Bureau personnalisé

• La mémoire virtuelle est compatible avec les
pilotes ASIO tiers et les plug-ins VST adéquats

Ressources système minimum

Pour utiliser Deck vous il faut :

• Un PowerPC avec processeur G3 ou G4 (266 MHz
ou plus)

• Interface 16 bits Macintosh intégrée ou matériel
audio compatible ASIO avec le pilote ASIO 1.0 le
plus récent provenant du constructeur de la carte,
ou carte audio Korg 1212 I/O sur bus PCI.

• La synchro à la trame près de timecode SMPTE/
EBU nécessite du matériel compatible OMS.

• Un minimum de 32 Mo de RAM

• Un minimum de 5 Mo d’espace disque disponible
(pour le programme)

• Mac OS 8.5 ou supérieur

• QuickTime 3.0 ou supérieur

• Sound Manager 3.2.1 ou supérieur

• OMS 2.3.8 nécessaire pour synchroniser Deck à
des séquenceurs MIDI compatibles OMS et pour
la lecture de pistes MIDI

• Disque dur tournant au moins à 7200 rpm, UW-
SCSI recommandé

Deck fonctionne en natif sur les Macintosh PowerPC,
G3 et G4. Deck peut utiliser les cartes son compatibles
ASIO 1.0 en utilisant le plug-in ASIO de Deck. Deck est
également compatible avec la Korg 1212 I/O sur bus
PCI en utilisant le pilote DECK II 1212 I/O Driver.

Pour enregistrer et lire les pistes, vous aurez
également besoin du matériel suivant :

• Pour enregistrer, une source en niveau ligne
(table de mixage, instrument électronique, lecteur
de CD, platine-disque, platine cassette,
magnétophone DAT, microphone, etc.).

• Pour lire, un amplificateur stéréo et des enceintes
ou des enceintes amplifiées.

• Une table de mixage ou du matériel ASIO avec
table de mixage intégrée (par exemple, Tascam
US-428) est fortement recommandée.

Optimiser les performances de Deck

Pour obtenir les meilleures performances de Deck et
de votre Macintosh, suivez les indications suivantes.

Pour optimiser les performances de Deck :

• Utilisez un nombre minimal d’Extensions système.
Les extensions peuvent ralentir votre Macintosh
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en utilisant des cycles processeur précieux.
Désactivez en particulier les extensions tierces
dont vous n’avez pas besoin avec Deck. Pour
définir un jeu d’extensions dédié à Deck,
dupliquez votre jeu d’extensions Mac OS Base
dans le Gestionnaire d’extensions et renommez-le
(quelque chose comme jeu_audio), redémarrez
votre ordinateur avec ce jeu d'extensions et
installez Deck, activez les extensions
supplémentaires requises par Deck (par exemple,
OMS, les pilotes de votre matériel audio, etc.), et
redémarrez votre ordinateur avec ce jeu
d'extensions mis à jour.

• Désactivez le Partage de fichiers, à moins que
vous n’en ayez besoin.

• Démontez les volumes réseau lors de l’utilisation
de Deck car le Finder peut entraîner des
ralentissements quand il scrute les volumes
réseau en arrière-plan.

• Allouez plus de RAM à Deck si possible, en
utilisant la commande Lire les informations du
Finder. Sélectionnez l’application Deck dans le
Finder, choisissez Lire les informations dans le
menu Fichier du Finder, et entrez la quantité de
RAM souhaitée dans le champ Souhaitée. Vérifiez
que vous allouez plus de RAM que la quantité
indiquée dans le champ Minimum !

• Optimisez votre disque dur.

À propos de votre Manuel
utilisateur

Deck est conçu pour être simple et intuitif. Votre
Manuel utilisateur vous aide à régler et utiliser Deck
pour l’enregistrement numérique et l’édition aussi vite
et facilement que possible.

Ce Manuel utilisateur considère que vous connaissez
les opérations standards du Macintosh, dont :

• Régler, démarrer et utiliser votre Macintosh

• Choisir des commandes dans les menus

• Double-cliquer, sélectionner, Majuscules-
sélectionner, et déplacer avec la souris

• Ouvrir, copier, enregistrer et supprimer des
fichiers

• Ouvrir, fermer, faire défiler, déplacer, modifier la
taille et sélectionner des fenêtres Macintosh

Si vous ne savez pas effectuer ces tâches, reportez-
vous au Manuel utilisateur de votre Macintosh et
prenez un peu de temps pour faire connaissance avec
votre Macintosh avant de continuer. Ceci rendra votre
travail avec Deck plus facile et agréable.

Regardez les notes et les trucs importants dès
que vous voyez ce point d’exclamation.

Conventions

Le Manuel utilisateur de Deck utilise les conventions
suivantes pour indiquer les choix de menu et
commandes clavier :

Convention Action

File > Save Choisissez Save dans le menu
File.

Commande-S Enfoncez la touche Commande
et appuyez sur la touche S.

Option-cliquer Enfoncez la touche Option  et
cliquez avec la souris.

À propos de Deck LE

Si vous utilisez l’édition limitée de Deck, toutes les
fonctions ne seront pas disponibles, en particulier
celle listées ci-dessous :

• Pas plus de 8 pistes de lecture

• Pistes virtuelles

• Automation 24 bits
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• Enveloppes d'automation

• Effets DSP en temps réels

• Compatibilité plug-ins Adobe Premiere

• Plug-ins VST

• Compatibilité film QuickTime

• Compatibilité MIDI Time Code et SMPTE/EBU

LE Les fonctions non incluses dans Deck LE ont
cette icône dans le manuel. Les fonctions de LE
seront également grisées dans leurs menus.

Conclusion

Maintenant que vous connaissez un peu mieux Deck,
allez au chapitre suivant pour apprendre comment
installer votre logiciel et commencer à l’utiliser.



Chapitre 2
Installation et configuration de Deck
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Chapitre 2 :
Installation et
configuration de Deck

Deck offre des fonctions puissantes de synchronisa-
tion, d’édition, de mixage et de traitement audio
dernier cri. Cependant, avant que vous puissiez
commencer à utiliser Deck, vous devez installer et
configurer votre logiciel Deck et configurer votre
ordinateur et votre matériel audio. Le matériel est
constitué de l’interface stéréo 16 bits intégrée de votre
Macintosh ou d’une carte audio PCI ou PCMCIA ou
d’une interface audio USB ou Firewire. Vous utiliserez
également une table de mixage, un amplificateur et
des enceintes pour faire entrer et sortir l’audio de
votre Macintosh.

Installation de Deck

Le logiciel d’installation automatique de Deck rend
cette étape très facile.

Votre système Deck complet est constitué de :

• Le CD-ROM d’installation

• Le numéro de série et le Code d'Autorisation de
Produit (PAC) de Deck

Avant d’installer Deck, vérifiez les Ressources
système minimum à la page 4 de ce Manuel
utilisateur.

Installer Deck :

1. Si vous utilisez un logiciel anti-virus, désactivez-le
ou retirez-le temporairement et redémarrez votre
Macintosh.

2. Insérez le CD-ROM d'installation de Deck dans

votre lecteur, ouvrez le dossier Product Installers
et double-cliquez sur l’icône Install Deck.

3. Lorsque la boîte de dialogue Installer apparaît,
lisez le Read Me pour des informations de
dernière minute concernant l’installateur, puis
cliquez sur Continue.

4. Sélectionnez où vous voulez installer Deck, en
utilisant le pop-up menu Switch Disk.

5. Cliquez sur Install en bas à droite de ce dialogue.

6. Après avoir cliqué sur Install, suivez les instruc-
tions à l’écran. Deck sera installé dans un dossier
nommé Deck 3.0 sur votre disque dur sélec-
tionné.

7. À la fin de l’installation, l’installateur vous permet
d’enregistrer Deck électroniquement, ce qui peut
être plus pratique pour vous que d’envoyer votre
carte d'enregistrement.

8. Lorsque l’installation est achevée, un message
apparaît indiquant que l’installation a fonctionné.
Cliquez sur Quit pour quitter l’installateur ou
cliquez sur Continue pour installer d’autres copies
(n’oubliez pas de réactiver le logiciel anti-virus
pour la prochaine fois où vous redémarrerez
l'ordinateur).

Si vous n’enregistrez pas Deck, le logiciel
expire au bout de 14 jours, vous ne pouvez
profiter de l’assistance technique et vous n’êtes
pas tenu au courant des mises à jour, des
nouvelles versions et des nouvelles importantes
de BIAS !
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Autorisation

Deck doit être autorisé pour fonctionner sur votre
Macintosh. Pour autoriser Deck, vous aurez besoin de
votre Code d'Autorisation de Produit (PAC) en plus du
numéro de série qui apparaît sur votre Certificat de
propriété de Deck. BIAS vous fournit votre Code
d'Autorisation de Produit lorsque vous enregistrez
Deck.

Vous devez enregistrer Deck afin d’obtenir
votre Code d'Autorisation de Produit ; Deck ne
se lancera plus après la période d’enregistre-
ment de 14 jours à moins que vous n’autorisiez
Deck avec vos Nom, Organisation, Numéro de
série et Code d'Autorisation de Produit !

Lorsque vous lancez Deck la première fois, il vous
demande de l’autoriser en entrant vos Nom, Organisa-
tion, Numéro de série et Code d'Autorisation de
Produit.

Si vous n'avez pas encore reçu votre PAC, Deck reste
entièrement fonctionnel en Mode enregistrement
pendant 14 jours. Ceci vous laisse le temps d’enregis-
trer Deck et d’obtenir le Code d'Autorisation de
Produit de  BIAS. Pour lancer Deck en Mode enregis-
trement, cliquez sur le bouton “Still waiting for
Product Authorization Code”. Si vous avez enregistré
Deck chez BIAS et avez reçu votre PAC, entrez votre
Nom, Organisation, Numéro de série et Code
d'Autorisation de Produit et cliquez sur le bouton
“Authorize” ou enfoncez la touche Retour chariot.
Votre copie de Deck 3.0 est maintenant autorisée.

Allouer de la RAM à Deck

Vous devez maintenant allouer de la RAM à Deck.
Dans la plupart des cas, vous aurez besoin d’allouer
plus de RAM que le réglage par défaut.

Deck n’est pas compatible avec RAM Doubler

de Connectix.

Pour modifier l’allocation RAM de Deck :

1. Quittez toutes les applications ouvertes.

2. Deck est maintenant compatible avec la mémoire
virtuelle, et vous devriez donc laisser la mémoire
virtuelle activée à moins qu’elle ne fasse conflit
avec le pilote ASIO ou l’un des plug-ins VST que
vous utilisez avec Deck. Réglez la mémoire
virtuelle à exactement 1 Mo au-dessus de la
mémoire système totale ; ceci est le réglage
optimal, et si vous l’augmentez vous courrez le
risque de performances moins bonnes et/ou de
résultats non désirés.

3. Dans le Finder, déterminez combien de RAM est
disponible pour Deck en sélectionnant À propos
de ce Macintosh dans le menu Pomme.

4. Le Plus gros bloc inutilisé montre combien de
RAM est disponible. Vous pouvez également voir
combien de RAM est utilisée par votre système.

5. Sélectionnez l’icône de Deck dans le dossier Deck
situé sur votre Bureau.

6. Choisissez Fichier > Lire les informations
(Commande-I).

7. Réglez le champ Souhaitée à la quantité désirée
tout en laissant suffisamment de RAM pour que
votre système (et les autres applications que vous
voulez utiliser en même temps, par exemple Peak
de BIAS) fonctionnent.

Par exemple, si vous avez 128 Mo de RAM et que votre
Système utilise 24 Mo, vous pouvez parfaitement
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allouer 92 Mo de RAM à Deck. Vous devriez toujours
laisser un minimum de 5 Mo pour le Plus gros bloc
inutilisé de votre système.

Vous aurez peut-être besoin de faire quelques essais
avec la quantité de RAM que vous allouez à Deck. De
nombreux facteurs peuvent affecter la quantité de
RAM dont vous aurez besoin, comme la quantité de
RAM disponible dans votre système, la taille et la
complexité de votre séance Deck et la RAM nécessaire
pour utiliser les effets plug-in ou un éditeur audio
externe comme Peak de BIAS.

Brancher les connexions audio

Deck est compatible avec la plupart des matériel audio
utilisant le Sound Manager d’Apple ou l’ASIO, ainsi
qu’avec l’entrée son intégrée du Macintosh. Deck est
également directement compatible avec la carte audio
Korg 1212 I/O  (via SoundLink) et l’interface audio
Tascam US-428 USB (via ASIO). Suivez les instructions
d’installation des constructeurs pour votre carte
audio/interface spécifique.

Il est facile d’effectuer les connexions audio entre
votre Macintosh et une table de mixage ou un système
d’enceintes. Votre schéma exact sera légèrement
différent selon que vous utilisez les connecteurs
d’entrée/sortie intégrés de votre Macintosh ou ceux de
matériel audio tiers. Les instructions pour chaque cas
sont données ci-dessous.

Utilisation des entrées et sorties intégrées
du Macintosh

Si vous voulez utiliser vos entrées et sorties audio
intégrées du Macintosh pour l'enregistrement et la
lecture, suivez la procédure suivante :

1. Baissez le volume de votre système d'écoute.

Deck peut être utilisé avec plusieurs types de
systèmes d'écoute, dont :

• Un récepteur ou amplificateur stéréo et des

enceintes

• Une table de mixage, un amplificateur et une paire
d’enceintes

• Une table de mixage et une paire d’enceintes
amplifiées

• ou simplement une paire d’enceintes amplifiées,
versions plus petites de ce que l’on appelle
souvent des enceintes “multimédia”.

2. Connectez votre sortie de source audio au
connecteur d'entrée audio du Macintosh.

Votre source audio peut provenir de plusieurs
types de machines, comme :

• Une sortie cassette, CD, DAT ou mini-disc

• Une sortie, un envoi bus ou un envoi aux de table
de mixage

• Une sortie ligne de récepteur stéréo (comme une
sortie “enregistrement cassette”)

• Une sortie ligne d’instrument (comme la sortie
d’un synthétiseur).

Les jacks d’entrée audio de la plupart des Macs sont
des minijacks standards (1/8 de pouce). La plupart des
sorties source sont des jacks 1/4 de pouce ou RCA.
Pour brancher cette connexion, vous aurez peut-être
besoin d’utiliser un adaptateur jack 1/4 de pouce ou
RCA à minijack.

miniplug to 
female RCA cables

Macintosh

audio
input

audio
output

    RCA-to-1/4 inch
adapter cables.

Attach to mixer inputs

RCA-to-1/4 inch
adapter cables.

Attach to mixer outputs

power amp and speakers

mixer

right
output

left
output
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Pour les utilisateurs avertis : certaines consoles
de mixage, platines DAT ou autres sources
audio professionnelles peuvent avoir un
niveau de sortie nominal de +4 dBu, là où le
Macintosh s’attend à avoir un niveau nominal
de -10 dBu. Vous pouvez ajuster les niveaux de
sortie de vos consoles pour empêcher la
saturation de l’entrée du Macintosh ; ou bien
vous pouvez aussi utiliser un transformateur
ligne “+4 / -10”.

3. Connectez la sortie audio de votre Macintosh à
l’entrée de votre système d'écoute. Le connecteur
de la sortie audio du Macintosh est un minijack
stéréo standard (1/8 de pouce). La plupart des
entrées de table de mixage, récepteur et enceinte
amplifiée sont équipées de jacks 1/4 de pouce ou
RCA. Pour brancher cette connexion, vous aurez
peut-être besoin d’utiliser un adaptateur jack 1/4
de pouce ou RCA à minijack.

4. Montez le volume de votre table de mixage ou de
votre système d'écoute. Votre système doit
maintenant être proprement configuré et être
prêt pour l'enregistrement et la lecture.

Cartes audio PCI et PCMCIA et interfaces
audio USB et Firewire

Si vous avez une carte audio compatible Sound
Manager ou ASIO ou une interface audio USB ou
Firewire installée dans votre ordinateur et que vous
voulez utiliser ses entrées et sorties plutôt que celles
de votre Macintosh, suivez la procédure suivante :

1. Baissez le volume de votre table de mixage ou de
votre système d'écoute.

2. Vérifiez que vous avez installé la carte audio dans
l’un des bus d’expansion PCI disponibles de votre
Macintosh ou dans un bus de carte PCMCIA de
votre PowerBook ou connectez votre interface
audio USB ou Firewire dans un port USB ou
Firewire disponible de votre Macintosh. Si vous
n’êtes pas sûr de savoir le faire, reportez-vous aux
instructions du constructeur qui accompagnent
votre carte ou interface audio.

3. Installez les pilotes Sound Manager et/ou ASIO de
votre carte ou interface audio. Veuillez vous
reporter aux instructions d’installation du
constructeur de votre carte audio pour la
procédure à suivre.

Pour utiliser le pilote ASIO de la carte ou de
l’interface audio avec Deck, placez le pilote ASIO
dans le dossier ASIO Drivers de Deck dans le
dossier Deck.

4. Connectez la sortie de votre console aux
connecteurs d’entrée du matériel audio.

5. Connectez les sorties de votre matériel audio à
l’entrée de votre console (ou de votre système
d'écoute).

6. Montez le volume de votre table de mixage ou de
votre système d'écoute. Votre système doit
maintenant être proprement configuré et être
prêt pour l'enregistrement et la lecture.

analog input
connect to mixer outputs

analog output
connect to mixer inputs

digital input/output

RCA-to-1/4 inch
adapter cables

TO MIXER OUTPUT

RCA-to-1/4 inch
adapter cables

TO MIXER INPUT

power amp and speakers

mixer

right
output

left
output

Une configuration table de mixage/ordinateur
courante consiste à brancher les sorties de
l'ordinateur sur les entrées canaux de votre
table de mixage et les envois auxiliaires ou bus
de la table de mixage sur les entrées de
l'ordinateur.  Les instruments que vous voulez
enregistrer sont branchés dans d’autres entrées
canaux de la table de mixage et vous pouvez
ensuite les diriger v ers les envois auxiliaires ou
bus de la table de mixage pour être enregistrés
par l'ordinateur. Les sorties principales de la
console vont vers l’amplificateur et les
enceintes.
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Utiliser les entrées et les sorties d’une carte
audio ou d’une interface audio

Deck est compatible avec la plupart des cartes et
interfaces audio Sound Manager et ASIO. Afin
d’effectivement utiliser ces cartes avec Deck, vous
aurez besoin de vérifier que vous avez installé les
pilotes Sound Manager fournis par le constructeur (la
plupart des constructeurs de matériel audio fournis-
sent leurs propres pilotes). Si vous n’avez pas déjà
installé les pilotes Sound Manager de votre matériel
audio, faites-le maintenant. Dans la plupart des cas,
vous devrez placer le pilote Sound Manager de votre
matériel dans le dossier Extensions de votre Dossier
Système. Après avoir fait ceci, redémarrez votre
ordinateur.

Si votre matériel audio possède également un pilote
ASIO 1.0 ou un pilote ASIO 2.0 compatible avec la
version 1.0, vous voudrez bien le placer dans le dossier
ASIO Drivers de Deck.

Pour utiliser les sorties d’un matériel audio tiers pour
prévisualiser avec les Plug-ins Premiere :

1. Choisissez Sortie dans le pop-menu du Tableau de
bord Son.

2. Sélectionnez la carte audio (la VX Pocket de
Digigram est montrée dans cet exemple) comme
matériel de sortie son.

Le Tableau de bord Son d’Apple

3. Fermez le Tableau de bord Son lorsque vous avez
fini.

ASIO

Deck 3.0 est compatible avec les pilotes audio ASIO 1.x
pour l'enregistrement et la lecture de l’audio à travers
votre matériel audio ASIO. L’ASIO est une technologie
standard pour diriger l’audio entre une carte son et
une application développée par Steinberg Software
und Hardware, GmBH. ASIO, contrairement au Sound
Manager d'Apple, permet plus de 2 canaux d’audio
simultané. La plupart du matériel audio disponible
possèdes des pilotes ASIO. BIAS a testé la compatibi-
lité ASIO avec Deck 3.0 des cartes suivantes :

• Sound Manager d'Apple

• Digidesign Direct IO

• Digigram VX Pocket

• Echo Gina, Layla et Darla

• Ensoniq PARIS

• Gadget Labs WAVE/8-24

• Korg 1212 I/O

• Lucid PCI-24

• M-Audio Delta Series

• Midiman DMAN 2044

• MOTU PCI-324

• RME Digi96

• SeaSound

• Sonorous STUDI/O

• Tascam US-428

• Yamaha DSP Factory

La MOTU PCI-324 doit être configurée avec la
Console MOTU PCI-324 et la Console PCI-324
Cuemix avant de lancer Deck. La Yamaha DSP
Factory nécessite que vous lanciez MixTest
avant de lancer Deck et que vous sélectionniez
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le pilote ASIO DS2416. D’autres cartes peuvent
également nécessiter des utilitaires fournis par
le constructeur de la carte (comme la M-Audio
Delta series).

Configurer Deck pour l’ASIO

Afin que Deck utilise le pilote ASIO de votre matériel
audio, vous devez vérifier que le plug-in ASIO Deck se
trouve dans le dossier Deck Plug-Ins.

Deck 3.0 est également compatible avec le système
Korg 1212 SoundLink. Pour utiliser SoundLink avec
Deck, vérifiez que DECK II 1212 I/O Driver se trouve
dans le dossier Deck Plug-Ins. Si vous comptez utiliser
Deck avec l’ASIO, vous devez déplacer DECK II 1212 I/
O Driver dans le dossier Plug-Ins (Unused).

Installation du pilote ASIO

Pour installer un pilote ASIO à utiliser avec Deck,
glissez-déposez le pilote ASIO de votre carte audio
ASIO dans le dossier ASIO Drivers situé dans le dossier
de Deck.

Remarquez que Deck doit se trouver dans le même
dossier (le dossier Deck) que le dossier ASIO Drivers
pour qu’il puisse reconnaître le pilote ASIO.

Deck ne peut avoir qu’un seul pilote dans le dossier
ASIO Drivers mais plusieurs pilotes dans le dossier
ASIO Drivers (Unused). Vous devez les déposer
manuellement si vous voulez changer de pilote ASIO.

Dès que vous avez installé le pilote ASIO de votre carte
audio, lancez Deck. Celui-ci démarre et enregistre le
pilote ASIO.
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Korg SoundLink

Deck 3.0 est compatible avec la carte Korg 1212 I/O via
SoundLink™. Pour utiliser SoundLink avec Deck et la
carte Korg 1212, vérifiez que Deck Korg 1212 I/O
Driver se trouve dans le dossier Deck Plug-Ins et que
le pilote ASIO de Deck est déplacé vers le dossier Plug-
Ins (unused).

Configuration matérielle

Vous devez sélectionner et configurer votre interface
audio via la boîte de dialogue Hardware Configuration
pour spécifier si vous utilisez le Sound Manager
d'Apple, l’ASIO ou le Korg SoundLink.

Choisissez Hardware Configuration dans le menu
Options de Deck.

Audio card

Choisissez Sound Manager ou le pilote ASIO de votre
carte audio dans le pop-up menu Audio card.

Choisir le Sound Manager permet d’utiliser l’entrée et
la sortie audio sélectionnées comme Entrée et Sortie
dans votre Tableau de bord Son.

Si vous utilisez SoundLink avec la carte Korg 1212,
choisissez SoundLink dans le pop-up menu Audio
card.

Choisissez le pilote ASIO de votre carte audio dans le
pop-up menu Audio card pour permettre à Deck
d’accéder aux capacités d’entrées/sorties multicanaux
de votre carte audio via ASIO.

Si vous utilisez Deck avec le pilote ASIO de votre carte
audio, vérifiez de bien cocher les cases pour activer ou
désactiver Record monitoring et Play audio while in
background.

Clock Source

Il est important de remarquer que lorsque vous
enregistrez des signaux audionumériques (par
exemple SPDIF, ADAT optical, etc.), Clock Source doit
être réglé sur la source d’horloge numérique
appropriée. Enregistrer un signal numérique avec une
source d’horloge réglée sur une source incorrecte
entraîne une erreur appelée “jitter”, qui produit des
clics et des pops dans l’audio.

Play audio while in background

La case Play audio while in background permet au
pilote ASIO de fonctionner lorsque Deck est en
arrière-plan. Si vous lancez plusieurs applications
audio utilisant le même pilote ASIO (par exemple,
Peak de BIAS), vous devrez désactiver Play audio while
in background.
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Record monitoring

Si vous voulez contrôler l’entrée audio en numérique
lorsque vous enregistrez, activez Record monitoring
dans la boîte de dialogue Hardware Configuration.

Pour contrôler l'enregistrement en numérique :

1. Activez Record monitoring dans la boîte de
dialogue Hardware Configuration.

2. Choisissez les entrées de canal pour les pistes sur
lesquelles vous voulez enregistrer.

3. Activez ces pistes en enregistrement.

4. Commencez à enregistrer.

Il est fortement recommandé de contrôler votre
enregistrement en analogique lorsque vous enregistrez
en direct ou en overdub. Utilisez votre table de mixage
analogique pour contrôler le signal audioanalogique
lorsque vous enregistrez dans Deck. Lorsque vous
contrôlez l'enregistrement dans Deck, il existe un
temps de latence égal à deux fois la taille du buffer
ASIO (par exemple à 44 100 avec une taille de buffer
de 2 048 octets il y aura presque 93 ms de latence
entre le moment où vous aurez enregistré le signal
dans Deck et celui où vous l’entendez dans vos
enceintes). Contrôler l’enregistrement en analogique
évite ce problème.

Pour contrôler l'enregistrement en analogique :

1. Désactivez Record monitoring dans la boîte de
dialogue Hardware Configuration.

2. Vérifiez que les signaux analogiques que vous
voulez enregistrer sont correctement dirigés vers
les entrées de votre interface audio pour être
enregistrés dans Deck tout en étant contrôlés à
travers vos enceintes.

3. Choisissez les entrées de canal pour les pistes sur
lesquelles vous voulez enregistrer.

4. Activez ces pistes en enregistrement.

5. Commencez à enregistrer.

Options matérielles
Choisissez Hardware Options dans le menu Options
pour ouvrir le gestionnaire du pilote ASIO de certaines
cartes ASIO (la boîte de dialogue Digidesign Hardware
Setup et le Tableau de bord Digigram VX Pocket sont
montrés ci-dessous).

Boîte de dialogue Digidesign Hardware Setup

Tableau de bord Digigram VX Pocket

Veuillez remarquer que les pilotes de certaines
cartes peuvent ne pas avoir d’utilitaires de
réglage ou que ces derniers doivent parfois être
configurés avant de lancer Deck (comme la
MOTU PCI-324 ou la M-Audio Delta series) et
ne sont pas accessibles depuis Deck.
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Configurer Deck et régler le nombre
maximum de pistes de lecture

Vous devez vérifier que Deck est réglé sur le matériel
correct. Ceci est en général automatique. Vous pouvez
également avoir besoin de régler le nombre de pistes
de lecture, surtout si vous effectuez une mise à jour
d’une version plus ancienne de Deck ou que vous avez
accéléré votre ordinateur.

Pour configurer Deck et régler le nombre de pistes de
lecture :

1. Dans Deck, choisissez Options > Hardware
Configuration.

2. Sélectionnez votre matériel audio dans l'option
Audio card et cliquez sur OK.

3. Choisissez File > Preferences > Memory &
Storage.

4. Réglez Set Max. Play Tracks comme désiré. Dans
la plupart des cas, la valeur sera par défaut le
nombre de pistes nominal de votre système. Le
nombre maximum de pistes de lecture réel
dépend de votre système et de votre matériel.

Préférences Memory & Storage

Vous pouvez toujours régler le nombre de
pistes de lecture maximum en-dessous du
maximum disponible. Ceci est recommandé si
vous obtenez des messages “Disk is too slow” ou
peu de réponse de l’interface.

Le nombre de pistes optimal sur n’importe quelle

machine dépend de nombreux facteurs, comme la
vitesse de votre disque dur, la vitesse de votre
processeur et le modèle de Macintosh sur lequel
tourne Deck.

Utilisation de disques audio dédiés

Utiliser votre disque dur système pour enregistrer et
lire va diminuer la performance de votre système, en
raison de la conception du logiciel système. Utilisez un
disque dur SCSI différent du système pour l'enregistre-
ment et la lecture afin d’obtenir une performance
optimale. Utiliser des disques audio dédiés tournant à
7 200 rpm ou plus augmente encore le nombre de
pistes et la performance de Deck. UW-SCSI est la
norme actuelle des disques durs haute performance,
mais les disques durs UDMA-66 peuvent presque
obtenir la même performance. Les disques durs
Firewire sont une nouvelle norme très prometteuse
avec des transferts de données jusqu'à 30 Go/seconde
(1 canal audio 16 bits 44 100 = 88 Ko/seconde) !
Souvenez-vous, plus le disque dur est rapide, mieux
c’est.

Conclusion

Maintenant que vous avez installé et configuré Deck,
allez au chapitre suivant pour apprendre plusieurs
concepts et fonctions de base essentiels pour utiliser
Deck.
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Chapitre 3 :
Pour commencer

Deck a l’apparence et se comporte en général comme
une table de mixage et un enregistreur portable. Il
vous permet d’enregistrer des pistes, de les contrôler
lorsque vous enregistrez d’autres pistes, d’ajuster le
niveau et l’égalisation de ce que vous avez enregistré
et des effets, et de mixer votre enregistrement pour en
faire un master. Deck offre également de nombreuses
fonctions que vous ne trouveriez pas sur un enregis-
treur portable analogique, dont une édition visuelle de
la forme d'onde, un bounce de pistes sans perte de
qualité, un placement automatique multipoints, une
automation de table de mixage avec fadeur animé, des
effets destructifs et des effets non-destructifs en temps
réel, et un son 16 bits de qualité CD. Ce chapitre
aborde la création et l’enregistrement de séances,
l’importation de fichiers audio, l’enregistrement et les
fonctions de base de votre système Deck.

Séances Deck

Un fichier de séance Deck est un document Macintosh
qui contient une carte d’un projet d'enregistrement
spécifique. Il ne contient pas de fichiers audio, mais
des pointeurs vers les fichiers audio de votre disque
dur.

Lorsque vous créez une nouvelle séance, un document
fichier de séance et un dossier Audio Files sont créés
et placés dans leur propre dossier par Deck, qui est
nommé d’après la séance. Si vous créez plus tard des
crossfades dans la séance, un dossier Crossfades est
automatiquement créé. Le dossier Audio Files contient
tous les fichiers audio que vous enregistrez dans la
séance et tous ceux qui sont physiquement copiés
pendant l’importation (que ce soit par votre choix ou
parce qu’ils devaient être convertis).

Il est recommandé de conserver toutes les données
associées à chaque séance—le fichier de séance, le
dossier Audio Files et le dossier Crossfades—dans le
dossier de cette séance, spécialement au début. Pour
plus d'informations sur la structure des séances Deck,
voir le Chapitre 10 “Enregistrement numérique et
bases du mixage” et l'appendice “Optimisation &
dépannage de votre système”.

Créer, ouvrir, fermer et enregistrer des
séances
Créer une nouvelle séance :

1. Choisissez File > New (Commande-N).

2. Nommez votre séance et sélectionnez son
emplacement.

3. Choisissez un taux d'échantillonnage et cliquez
sur OK.

En général vous utiliserez le taux d'échantillonnage de
44 100 Hz (le taux standard du CD). Pour plus
d'informations sur les taux d'échantillonnage, voir
“Concepts de base de l'échantillonnage” à la page 147.

Ouvrir une séance existante :

1. Choisissez File > Open (Commande-O).

2. Localisez et sélectionnez le fichier de séance
désiré.

3. Cliquez sur Open.

La commande Open ne peut être utilisé pour ouvrir
des fichiers son. Ceux-ci doivent être ajoutés à une
séance.

Enregistrer une séance :

• Choisissez File > Save (Commande-S).

Si vous voulez enregistrer la séance en cours sous un
nouveau nom, choisissez File > Save A Copy As.
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Fermer une séance :

• Choisissez File > Close Session (Option-
Commande-W).

Ajouter des fichiers audio et des
régions à une séance

La tâche la plus simple et la plus courante que vous
aurez besoin d’effectuer consiste à placer des fichiers
audio existants et à les organiser pour la lecture. Vous
pouvez sélectionner des fichiers de votre disque dur
dans n’importe quel format compatible, les ajouter
dans le Presse-papiers puis les placer dans n'importe
quel ordre dans la fenêtre Tracks. Si votre Macintosh
possède un lecteur de CD-ROM, vous pouvez
également ajouter des fichiers audio ou des films
QuickTime de n’importe quel CD-ROM ou des fichiers
audio d’un CD audio normal. La fenêtre Library
conserve automatiquement trace de tout matériau
source ajouté à la séance de cette façon.

Deck utilise des fichiers son monophoniques au
format Sound Designer II. Si vous ajoutez un autre
type de fichier son, Deck copie automatiquement le
fichier son et convertit la copie au format correct.
Deck importe des fichiers audio Sound Designer I,
Sound Designer II, AIFF, Apple Resource (SND),
QuickTime et WAV. Les fichiers audio seront égale-
ment convertis par Deck s’ils ne sont pas à un taux
d'échantillonnage compatible.

Bien que Deck utilise beaucoup le Presse-papiers pour
ajouter des fichiers audio à une séance, il ne place pas
les données audio réelles dans le Presse-papiers, mais
il utilise celui-ci pour garder trace des fichiers que
vous ajoutez ou éditez. Vous n’avez donc pas besoin
de grandes quantités de RAM pour ajouter de gros
fichiers audio à une séance.

Ajouter des fichiers son et des régions à une séance :

1. Choisissez File > Add Audio to Clipboard
(Commande-D).

• Pour ajouter des pistes d’un CD audio, utilisez la
commande Add Audio CD Tracks to Clipboard.

• Pour ajouter une ressource SND, utilisez la
commande Add SND to Clipboard.

• Pour ajouter l’audio d’un film QuickTime,
choisissez QuickTime > Import Movie.

2. Localisez et sélectionnez le fichier audio désiré
dans la liste de fichiers sur la gauche.

L’information sur le fichier sélectionné apparaît
dans la zone Comments en bas à gauche de la
boîte de dialogue et une liste des régions de ce
fichier son apparaît en haut à droite. La région du
haut représente le fichier entier.

3. Sélectionnez la région désirée du fichier son dans
la liste de droite.

Une région marquée d’un •F• représente le
fichier son entier, celle marquée d’un •R• est
une simple région audio et celle marquée d’un
•L• est une boucle (fichiers AIFF uniquement).
Les fichiers stéréo sont séparés et possèdent les
suffixe .L (gauche) et .R (droite).

• Cliquez sur Play pour entendre le fichier, la région
ou la boucle sélectionné. Vous pouvez entendre
l’audio bouclé en activant l'option Loop Audition.

• Activez l’option Make a Copy pour copier tous les
fichiers importés dans le dossier Audio Files pour
la séance. Remarquez que Deck copie automati-
quement les fichiers ajoutés depuis un support en
lecture seule vers le dossier Audio Files.

4. Cliquez sur Add Region pour ajouter la région
sélectionnée à la piste courante.

5. La piste courante est affichée en bas à droite de la
boîte de dialogue. Pour retirer des régions de la
piste courante, sélectionnez-les et cliquez sur
Remove.

6. Suivez les étapes 2 à 5 jusqu’à avoir ajouté tous les
fichiers et les régions que vous désirez, puis
cliquez sur Done.
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Fenêtre Tracks

La fenêtre Transport

La fenêtre Transport est très proche des commandes
de n’importe quel enregistreur à bande, à la différence
qu’elle possède plus de fonctions.

Fenêtre Transport

La fenêtre Mixer

Utilisez la fenêtre Mixer pour le contrôle de l'enregis-
trement et de la lecture audio.

Fenêtre Mixer

Si nécessaire, Deck convertit les fichiers et les régions
sélectionnés pour faire correspondre le taux d'échan-
tillonnage et le nombre de bits à la séance courante.

Suivez l’une des possibilités suivantes :

• Pour placer l'audio sélectionné, cliquez dans la
zone de forme d'onde de la fenêtre Tracks au
temps désiré et choisissez Edit > Paste At. La
valeur temporelle du curseur est affichée en haut
de la fenêtre Tracks. Si vous ajoutez des fichiers et
des régions stéréo ou multicanaux, sélectionnez le
nombre de pistes correspondant. Ceci permet de
garder tous les canaux en phase.

• Pour placer l'audio sur de nouvelles pistes,
choisissez Edit > Deselect, puis choisissez Edit
> Paste At. La nouvelle piste (ou les nouvelles
pistes si l'audio sélectionné est multicanaux) est
placé en haut de la fenêtre Tracks et tout audio
existant est déplacé vers des pistes plus basses.

• Pour placer l'audio à différents points dans le
temps sur plusieurs pistes, faites-les glisser de la
fenêtre Library à la fenêtre Tracks.

Les fenêtres Tracks, Transport,
Mixer, Master Outputs et CPU Meter

Pour effectuer les fonctions de base dans Deck, vous
aurez fréquemment besoin d’utiliser les fenêtres
Tracks, Transport, Mixer, Master Outputs et CPU
Meter.

La fenêtre Tracks

La fenêtre Tracks est la fenêtre dans laquelle vous
voyez, arrangez et éditez les fichiers audio le long
d’une ligne temporelle. Bien que seul le nombre de
pistes de lecture allouées puisse être lu, vous pouvez
toujours bouncer ces pistes ou utiliser des pistes de
travail et du mixage virtuel pour créer des mixages
contenant des centaines de pistes. Pour plus d'infor-
mations sur le bounce de pistes et le mixage virtuel,
voir le chapitre 8, “Automation, Mixage et Mastering”.
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La fenêtre Master Outputs

Utilisez la fenêtre Master Outputs pour contrôler et
atténuer les niveaux des paires stéréo de sorties. Vous
pouvez également assigner des plug-ins VST à des
canaux de sortie mono et stéréo.

Fenêtre Master Outputs avec interface audio stéréo

Fenêtre Master Outputs avec interface audio multicanaux

La fenêtre CPU Meter

Utilisez la fenêtre CPU Meter pour contrôler l’utilisa-
tion du processeur, du disque et de la RAM par Deck.

Fenêtre CPU Meter

Vous pouvez changer la position par défaut de toutes
les fenêtres de Deck en utilisant la commande File >
Preferences > Save Settings As Template. À chaque
fois que vous commencez une nouvelle séance, les
fenêtres apparaissent dans ces positions par défaut.

Les fenêtres Transport et Mixer peuvent être utilisées
en arrière-plan. Ceci signifie que même si les contrôles
de Transport ou les fadeurs de Mixer sont partielle-
ment couverts par d’autres fenêtres de Deck, vous
pouvez encore accéder à leurs fonctions en temps réel
sans être obligé de les amener au premier-plan. Pour
plus d'informations sur toutes les fenêtres de Deck,
voir le chapitre 9, “Références de Deck”.

Enregistrer dans la fenêtre Tracks

La fenêtre Tracks vous permet d’enregistrer directe-
ment dans n’importe laquelle de ses pistes de lecture.
En contrôlant le signal avec les Vu-mètres de la fenêtre
Mixer, vous pouvez ajuster le signal pour éviter qu’il
soit trop faible (ce qui crée un enregistrement
bruiteux en raison d’un faible rapport signal/bruit) ou
trop fort (ce qui crée une distorsion numérique en
raison d’un clip).

Si vous avez l'intention d’intégrer du MIDI dans une
séance Deck, il est recommandé de préparer cela dès
le début. Si vous avez une séquence MIDI existante et
que vous voulez enregistrer de l’audio sur cette
séquence, vérifiez de bien charger le fichier MIDI dans
la fenêtre MIDI de Deck avant d’enregistrer de l’audio.
Si vous voulez enregistrer de l’audio avant d’attaquer
les pistes MIDI, vous pouvez enregistrer les pistes
audio en vous calant sur un métronome MIDI, qui
peut être fourni en temps réel par un séquenceur
compatible OMS tournant en arrière-plan. Vous
pouvez également enregistrer un simple fichier de
clics MIDI et l’importer dans votre séance. De cette
façon, vous êtes sûrs que vos pistes audio sont
enregistrées avec une base temporelle régulière et
prévisible, ce qui permettra d’assembler et de
synchroniser facilement les pistes MIDI. Pour plus
d'informations sur l'intégration du MIDI et de l’audio
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dans Deck, voir le chapitre 7 “MIDI et Synchronisa-
tion”.

Pour enregistrer dans la fenêtre Tracks :

1. Vérifiez qu’une séance Deck est ouverte et qu’une
source son est branchée sur les entrées audio.

2. Pour entendre ce que vous enregistrez, vous
devriez également brancher les sorties audio à un
amplificateur et des enceintes ou à un casque.
Pour plus d'informations, voir “Brancher les
connexions audio” à la page 11.

3. Sélectionnez l’entrée audio désirée dans le pop-
up menu à droite du nom de la piste.

4. Cliquez sur le bouton R pour activer la piste
désirée.

5. Choisissez Windows > Mixer. Les Vu-mètres de la
piste sont maintenant des Vu-mètres de niveau
d'entrée et affiche tout signal d'entrée.

6. Commencez à jouer de votre source et contrôlez
le signal d'entrée pour garder le Vu-mètre le plus
près possible du haut sans allumer la diode de
clip (le petit carré en haut du Vu-mètre). La diode
de clip indique que l’audio enregistré à ce niveau
sera distordu. Éteignez la diode de clip en
cliquant dessus et ajustez l'audio d'entrée et/ou le
niveau d'entrée de la façon suivante :

•  Si vous utilisez le matériel audio intégré 16 bits de
votre Power Macintosh, réglez Analog Input Level
(dans le menu Options) sur 0 et montez le niveau
de votre audio d'entrée (instrument ou table de
mixage) à la source jusqu’à ce qu’il s’affiche
correctement dans les Vu-mètres d'entrée. Un
réglage de Analog Input Level sur 0 ne désactive
pas l’entrée ; il désactive le préampli intégré de
basse qualité qui crée des anomalies dans
l’enregistrement.

•  Si vous avez un autre matériel audio, ajustez le
volume du signal d'entrée à la source pour obtenir
un bon niveau.

7. De multiples pistes peuvent être enregistrées

simultanément, mais deux pistes d'enregistrement
ne peuvent être réglées sur la même entrée. Si
vous voulez enregistrer en stéréo, activez
simplement deux pistes, en assignant l’une à
l’entrée 1 et l’autre à l’entrée 2. Pour obtenir une
vraie séparation stéréo, pannez une piste
complètement à gauche et l’autre complètement
à droite pour respecter l’image stéréo de votre
source audio.

8. Ajustez le niveau de contrôle de la piste que vous
enregistrez en déplaçant son fadeur de piste vers
le haut ou le bas dans la fenêtre Mixer.

Lorsqu’une piste est activée, son fadeur de
volume ajuste le niveau de volume pour contrôler
la piste, mais ne modifie pas le niveau d'enregis-
trement. Lorsque la piste n’est pas activée, son
fadeur de volume ajuste le niveau de sortie de
l’audio qui est déjà sur la piste. Ce volume peut
être réglé à un niveau différent du volume de
contrôle d'entrée, ce qui est pratique pendant un
enregistrement en punch-in. Vous devriez utiliser
les fadeurs de piste pour ajuster le volume de
lecture à votre convenance, mais vérifiez toujours
que le niveau d'entrée analogique ou que le
niveau de sortie de votre source est réglé pour
que le Vu-mètre du canal affiche un signal de haut
niveau, mais sans clip.

En raison des limites du Sound Manager d'Apple,
vous ne pouvez pas modifier le volume ou le pan
d’une piste qui est enregistrée avec un Power
Macintosh. De plus, les pistes enregistrées seront
toujours lues à travers le système à plein volume
lorsque vous enregistrez et seront contrôlées à
travers le canal que vous avez choisi comme canal
d’entrée. En d'autres termes, vous ne pouvez pas
enregistrer dans l’entrée 1 et contrôler à travers la
sortie 2. Il peut s’avérer pratique d’utiliser une
table de mixage externe branchée à la sortie audio
de votre ordinateur Macintosh pour mieux
contrôler le volume de lecture et le pan.

9. Lorsque vous êtes prêts à enregistrer sur les pistes
activées, cliquez sur le bouton Record de
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Transport puis cliquez sur le bouton Play (Barre
d'espace).

Dès que vous cliquez sur le bouton Play, Deck
commence à enregistrer.

10. Lorsque vous avez fini d’enregistrer, cliquez sur le
bouton Stop de Transport (Barre d'espace).

Si l'enregistrement s’arrête avant que vous ne l’ayez
souhaité, vous n’avez plus d’espace disque.

Pour entendre la piste que vous venez d’enregistrer :

• Cliquez sur le bouton Return-to-zero de la fenêtre
Transport (Retour chariot) et cliquez sur le
bouton Play (Barre d'espace).

Votre piste enregistrée est maintenant lue et vous
devriez voir le Vu-mètre de la piste afficher le niveau
audio. Pour ajuster le niveau de sortie de votre piste
enregistrée, déplacez son fadeur de volume vers le
haut (plus fort) ou le bas (moins fort). Pour panner la
piste à gauche ou droite dans l'image stéréo, ajustez le
fadeur de pan de la piste dans la fenêtre Mixer.

Pour voir la forme d'onde de la piste que vous venez
d’enregistrer :

• Dans la fenêtre Tracks, utilisez les boutons
Zoomer/Dézoomer pour ajuster votre résolution.
Option-Majuscules-cliquer sur ces boutons
permet de passer d’une résolution à l’autre plus
rapidement.

Lorsque vous lisez les pistes, le curseur de Deck se
déplace le long de l'axe temporel, indiquant votre
position courante. Activer Scroll During Playback dans
le menu Options fait défiler l’affichage des pistes
pendant la lecture, pour que votre position courante
reste à l’écran en permanence. Comme Scroll During
Playback est une fonction très gourmande en calcul,
elle peut être désactivée sur des ordinateurs Macin-
tosh plus anciens ou plus lents.

Si vous êtes satisfaits de la piste que vous venez
d'enregistrer, vous pouvez maintenant enregistrer la
piste suivante. Si vous voulez réenregistrer la piste,
répétez la procédure que vous venez d’utiliser. Pour
apprendre à ne réenregistrer que quelques zones

sélectionnées de la piste, voir “Enregistrement punch-
in et punch-out automatique” à la page 28.

Effets

Vous pouvez également écouter vos pistes avec les
effets intégrés de Deck—comme EQ, Delay, Chorus ou
Gain —ou avec les plug-ins VST. Dans la fenêtre Mixer,
cliquez sur l’un des quatre pop-up menus Thru de la
piste à laquelle vous voulez ajouter du traitement et
sélectionnez l'effet que vous voulez. Puis ouvrez la
fenêtre Effect (Commande-7) pour les effets intégrés
de Deck ou Option-cliquez sur le nom du plug-in VST
et ajustez les paramètres de cet effet. Pour plus
d'informations sur les effets intégrés de Deck et les
plug-ins VST, voir le chapitre 5, “Effets”.

Temps de position

Sur le côté droit de la fenêtre Transport agrandie vous
voyez deux groupes de six pop-up menus. Les six pop-
up menus de gauche sont les boutons de Temps de
position de Deck.

Fenêtre Transport avec Temps de position et États de Mixer visibles

Pour ceux qui connaissent les machines d’enregistre-
ment multipistes, il s’agit des mémoires de position
automatique de Deck. Chacun de ces six pop-up
menus vous donne accès à la liste complète des
Temps de position que vous avez stocké dans la
séance courante. Les boutons directement à gauche de
chaque menu sont les contrôles que vous utiliserez
pour enregistrer et lire les temps de position.

La fenêtre Transport peut être réduite ou agrandie en
cliquant sur la case située dans le coin supérieur droit.
Les outils Temps de position, État de Mixer et Punch-
In sont tous cachés lorsque la fenêtre Transport est
réduite.
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Pour régler un temps de position lorsque la lecture est
arrêtée :

• Faites défiler ou lisez la séance pour placer la tête
de lecture à la position temporelle désirée.

Suivez l'une des procédures suivantes :

• Commande-cliquez sur un bouton à gauche de
l’une des fenêtres Temps de position.

• Choisissez New dans le pop-up menu Temps de
position.

Les temps de position sont visibles sous la forme d’un
drapeau rouge ou marqueur, dans l’axe temporel de la
fenêtre Tracks (également appelé la ligne temporelle,
juste au-dessus des pistes et en-dessous des boutons
outil).

Pour régler des temps de position pendant la lecture :

• Appuyez sur Entrée du clavier numérique. Le
temps est ajouté à la liste de temps dans le pop-
up menu Temps de position.

Pour rappeler un temps de position avec les boutons
Temps de position :

• Dans la fenêtre Transport, cliquez sur le bouton
directement à gauche de la position stockée. Dès
que vous cliquez sur le bouton (ou que vous
sélectionnez une position dans le pop-up) vous
êtes immédiatement amené à ce temps de
position, que l’audio soit lu ou non.

Tous les temps de position stockent également les
temps de départ/fin courants de boucle/punch. Pour
rappeler un temps de position avec ses temps de
départ et de fin, appuyez simplement sur la touche
Contrôle lorsque vous cliquez sur un bouton Temps
de position.

Pour nommer un temps de position :

1. Commande-cliquez sur le pop-up Temps de
position.

2. Entrez un nom et cliquez sur OK.

Mode boucle

La fonction Mode boucle vous permet de définir un
segment de votre séance et de boucler automatique-
ment la lecture de ce segment. Ceci est particulière-
ment pratique pour s’entraîner sur un petit segment
de séance en préparation de l’enregistrement d’une
piste ou pour évaluer des boucles potentielles en vue
d’arrangements.

Pour régler les temps de départ et de fin de la boucle
et lancer sa lecture :

1. Faites défiler le petit compteur Begin de la fenêtre
Transport jusqu’au point de début de boucle
désiré.

• Vous pouvez faire défiler le compteur en gardant
cliquée la souris au-dessus du compteur. Lorsque
le curseur se change en flèches droite/gauche,
faites glisser à droite (en avant) ou gauche (en
arrière) pour régler le point exact dans l'enregis-
trement. Faire défiler de cette façon permet de lire
l’audio lorsque le compteur se déplace. Si vous
voulez faire défiler la valeur du compteur sans
entendre l’audio, appuyez sur la touche
Majuscules. Puis cliquez et faites glisser la souris
au-dessus du compteur Begin. Réglez le temps de
boucle avec le clavier, enfoncez la touche
Commande et cliquez sur le compteur Begin. Puis
utilisez la boîte de dialogue pour régler votre
temps.

• Vous pouvez également cliquer sur les boutons
Begin et End pour entrer le temps courant du
compteur principal lorsqu’une séance est lue.
Lorsque les temps sont entrés, vous pouvez
préciser le temps de départ et de fin en faisant
défiler. Commande-cliquez sur les boutons Begin
et End pour transférer leurs temps au compteur
principal de la fenêtre Transport.

2. Faites défiler le petit compteur End jusqu’au point
de fin de boucle désiré.

3. Cliquez sur le bouton Boucle.

4. Cliquez sur le bouton Play pour lire la boucle.
Cliquez sur le bouton Stop pour arrêter la lecture.



Manuel utilisateur de Deck28

Les boucles ne peuvent être inférieures à 0,5
secondes. Si vous essayez de régler une boucle
plus courte, Deck va automatiquement
désactiver la boucle.

Il existe un certain nombre d’outils qui améliorent la
facilité d’utilisation du Mode boucle. Vous pouvez
déplacer automatiquement la sélection (dans la
fenêtre Tracks) sur les compteurs Begin et End en
utilisant la commande Option > Selection Tools >
Set Punch Times From (ou faire l’inverse avec la
commande Set from Punch Time). Vous pouvez
également utiliser d’autres commandes de ce sous-
menu pour sélectionner automatiquement la forme
d'onde entre les temps de départ et de fin indiqués
dans la fenêtre Transport. Pour plus d'informations,
voir le chapitre 9 “Références de Deck”. Enfin, lorsque
la fenêtre Tracks est ouverte, vous pouvez appuyez sur
la touche C de votre clavier à n’importe quel moment.
Ceci équivaut à une commande Cue, qui règle
automatiquement les temps de départ et de fin de la
fenêtre Transport sur la sélection courante et active le
Mode boucle. Option-C désactive le Mode boucle.

Enregistrement punch-in et punch-out
automatique

Bien que parfois une piste enregistrée est parfaite dès
la première prise, dans la plupart des cas au moins un
segment de la piste devra être réenregistré. Imaginez,
par exemple, une piste de voix de cinq minutes qui ne
possède une erreur que sur une seule ligne. En tant
qu’ingénieur de cette séance, vous voulez enregistrer
une nouvelle fois et ne remplacer qu’un petit morceau
de la piste enregistrée. En enregistrement traditionnel,
ce processus de remplacement est appelé enregistre-
ment en punch-in. Deck permet un enregistrement en
punch-in/punch-out automatique.

Pour faire un punch-in et punch-out sur un segment de
piste automatiquement :

1. Faites défiler le petit compteur Begin de la fenêtre
Transport jusqu’au point de punch-in désiré. C’est
l’endroit où l’enregistrement de remplacement
commence automatiquement.

• Vous pouvez faire défiler le compteur en gardant
cliquée la souris au-dessus du compteur. Lorsque
le curseur se change en flèches droite/gauche,
faites glisser à droite (en avant) ou gauche (en
arrière) pour régler le point exact dans l'enregis-
trement. Faire défiler de cette façon permet de lire
l’audio lorsque le compteur se déplace. Si vous
voulez faire défiler la valeur du compteur sans
entendre l’audio, appuyez sur la touche
Majuscules. Puis cliquez et faites glisser la souris
au-dessus du compteur Begin. Réglez le temps de
punch avec le clavier, enfoncez la touche
Commande et cliquez sur le compteur Begin. Puis
utilisez la boîte de dialogue pour régler votre
temps.

• Vous pouvez également cliquer sur les boutons
Begin et End pour entrer le temps courant du
compteur principal lorsqu’une séance est lue.
Lorsque les temps sont entrés, vous pouvez
préciser le temps de départ et de fin en faisant
défiler.

2. Faites défiler le petit compteur End jusqu’au point
de punch-out désiré. C’est l’endroit où l’enregis-
trement de remplacement s’arrête automatique-
ment.

Vous avez maintenant réglé vos temps de punch-
in (début) et de punch-out (fin).

3. Cliquez sur le bouton Punch.

Le Mode punch est maintenant activé et le
segment de la séance entre les temps de départ et
de fin sera enregistrée automatiquement sur la
piste activée lors de votre prochain enregistre-
ment. Aucun autre segment de la piste ne sera
remplacé.

4. Cliquez sur le bouton Play de Transport.

Lorsque la piste existante est lue, contrôlez
(jouez) votre nouveau signal source (instrument,
microphone, etc.). Réglez le niveau d'entrée pour
que le niveau de remplacement corresponde à
peu près au niveau du signal sur la piste.
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Lorsque vous faites un punch-in, vous pouvez
régler le niveau de contrôle de la piste existante à
un niveau différent du niveau de contrôle du
signal d'entrée. Souvenez-vous, le niveau de
contrôle est ce que vous entendez, tandis que le
niveau d'entrée est ce qui est réellement
enregistré. Lorsqu’une piste n’est pas activée, le
fadeur de volume de la piste ajuste le niveau de
lecture (contrôle) de cette piste. Lorsqu’une piste
est activée, le fadeur de volume de la piste ajuste
le niveau du signal d'entrée. Activez ou désactivez
la piste pour utiliser l’un de ces deux niveaux.

5. Ajustez les niveaux de contrôle relatifs des autres
pistes en déplaçant leurs fadeurs de volume vers
le haut ou le bas.

6. Lorsque vous êtes prêts à puncher dans la piste,
cliquez sur le bouton Record puis sur le bouton
Play (Barre d'espace) de Transport. Les deux
doivent être allumés.

Deck commence la lecture et vous entendez la
piste existante ainsi que votre nouveau signal
d'entrée. Souvenez-vous, cependant, que seul le
segment de piste entre les temps de départ et de
fin du compteur sera enregistré. Lorsque la
lecture atteint le point de départ du punch,
l’enregistrement commence automatiquement et
vous n’entendez plus la piste audio originale.
L’enregistrement continue jusqu’au point de fin
de punch, après lequel vous entendrez de
nouveau la piste audio originale.

7. Lorsque vous avez fini, cliquez sur le bouton Stop
(Barre d'espace). Cliquez ensuite sur le bouton
Return-to-zero de Transport (Retour chariot) puis
sur le bouton Play (Barre d'espace) pour entendre
ce que vous avez enregistré.

Souvenez-vous, Deck est une enregistreur non-
destructif, donc lorsque vous punchez un nouveau
matériau, l’ancien matériau n’est pas supprimé. Ceci
signifie que vous pouvez ouvrir la fenêtre Tracks après
avoir punché et voir votre nouvel enregistrement. Si
vous n’aimez pas la nouvelle prise, vous pouvez la
supprimer et étirer la vieille région pour retrouver la

prise originale. Pour plus d'informations, voir le
chapitre 4 “Édition visuelle de la forme d'onde” et
l'appendice “Optimisation & dépannage de votre
système” pour des trucs sur la gestion de multiples
prises dans Deck.

Nommer des pistes

Vous pouvez commencer à renommer vos pistes
lorsque vous travaillez avec de multiples pistes. Les
pistes sont nommées par défaut Track 1, Track 2, etc.
En donnant à vos pistes des noms plus descriptifs,
comme “Basse, prise 3”, vous trouverez beaucoup plus
facile de travailler avec elles. Pour renommer une
piste, Commande-cliquez sur la boîte contenant le
nom sur la gauche de la piste. Ceci fait afficher une
boîte de dialogue qui vous permet d’entrer le nouveau
nom de votre piste. Vous pouvez également cliquer
sur la piste dans la fenêtre Tracks pour la sélectionner,
puis choisir Rename dans le menu File. Pour plus
d'informations sur la façon de renommer et éditer les
pistes et les régions, voir le chapitre 4 “Édition visuelle
de la forme d'onde”.

Compacter une séance

Après avoir arrêté vos choix concernant les prises,
vous pouvez supprimer automatiquement les prises
inutiles de votre séance en utilisant Compact Session
ou compacter des fichiers audio seuls en utilisant
Compact Audio File. Avant de compacter des fichiers,
vérifiez que vous comprenez comment le compactage
fonctionne et ce qu’il fait. Pour des informations sur le
compactage de fichiers audio de séance, voir le
chapitre 4 “Édition visuelle de la forme d'onde”.

Conclusion

Maintenant que vous savez comment importer des
fichiers audio et des régions existants, enregistrer
directement dans Deck, passez au chapitre suivant
pour apprendre comment éditer votre audio dans une
séance Deck.
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Chapitre 4 :
Édition visuelle de la
forme d'onde

Ce chapitre du manuel de Deck va vous aider à vous
servir le mieux possible de la fenêtre Tracks, l’environ-
nement d’édition visuel de la forme d'onde. Vous
utiliserez la fenêtre Tracks pour déplacer les pistes,
arranger l’audio, redéfinir des régions, placer de
l’audio existant, créer et éditer des enveloppes
visuelles d'automation, caler le son sur l’image,
bouncer des pistes, créer des pistes de travail et
beaucoup d’autre choses !

C’est dans la fenêtre Tracks que vous trouverez la vraie
puissance de la station de travail et bien que vous
n’ayez pas besoin d’utiliser la fenêtre Tracks pour
enregistrer et mixer des pistes, vous avez besoin de
comprendre la fenêtre Tracks afin d’utiliser la plupart
des fonctions d'édition.

Déplacer et renommer des pistes

La fenêtre Tracks utilise la position de la piste pour
déterminer quelles pistes sont lues. Les pistes de
lecture en temps réel actives sont numérotées dans
leurs zones de contrôle de piste, à gauche de chaque
piste. Toutes les autres pistes (jusqu'à 999) sont des
pistes de travail, comme cela est indiqué par la lettre
W qui apparaît dans leurs zones de contrôle de piste.
Les pistes de travail ne lisent pas. Pour lire des régions
audio qui se trouvent sur une piste de travail, vous
devez les déplacer sur une piste de lecture. Pour cette
raison, il est important que vous compreniez comment
changer la position des différentes pistes.

Pour déplacer une piste d’une piste à une autre, suivez
l'une des procédures suivantes :

1. Dans la zone de contrôle de piste à gauche de la
piste de destination, sélectionnez la nouvelle piste
dans le pop-up menu Piste.

2. Cliquez sur la zone de contrôle de piste, puis
faites glisser la zone de contrôle jusqu’à sa
nouvelle position. Lorsque vous faites glisser la
piste, vous voyez une ligne horizontale indiquant
le point de destination.

Si vous utilisez cette méthode pour déplacer des pistes
dans la fenêtre Tracks, vous pouvez vous faciliter la
tâche en diminuant la taille des pistes. Cliquez sur les
boutons Taille de piste dans la fenêtre Tracks pour
passer d’un affichage à l’autre.

Pour couper, copier et coller des pistes entières :

1. Cliquez sur la zone de contrôle de piste. La piste
sera en surimpression pour indiquer qu’elle est
sélectionnée. Lorsqu’une piste est sélectionnée de
cette manière, n’importe quelle commande dans
le menu Edit peut être exécutée sur la piste.

2. Choisissez Edit > Cut (Commande-X) ou Copy
(Commande-C).

3. Cliquez sur la zone de contrôle d’une piste pour
sélectionner cette piste comme destination.

4. Choisissez Edit > Paste (Commande-V).

Les pistes ne sont jamais remplacées lorsque vous
utilisez la commande Paste. La piste collée est toujours
placée sur la piste située en-dessous de la piste de
destination sélectionnée.
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Pour renommer une piste :

1. Cliquez sur la zone de contrôle de la piste.

2. Choisissez Edit > Rename.

3. Entrez un nouveau nom pour la piste, puis cliquez
sur OK.

La fenêtre Tracks fait immédiatement apparaître le
nouveau nom de la piste dans le pop-up menu de la
zone de contrôle.

Vous pouvez également renommer des pistes en
appuyant sur la touche Commande et en cliquant sur
le pop-up menu Piste. Cette méthode permet de
changer facilement le nom d’un élément dans la
plupart des pop-up menus. Le même raccourci
fonctionne avec les Temps de position et les États de
Mixer dans la fenêtre Transport.

Naviguer dans la fenêtre Tracks

Avant que vous ne puissiez vraiment éditer les régions
et les formes d'onde audio, vous aurez besoin de
comprendre les outils que vous utiliserez pour
naviguer dans la fenêtre Tracks et pour configurer la
zone d'affichage de la forme d'onde.

Pour changer le zoom d’affichage de la forme d'onde :

• Pour zoomer l’affichage courant de la forme
d'onde, cliquez sur le bouton Zoomer.

Bouton Zoomer

• Pour dézoomer l’affichage courant de la forme
d'onde, cliquez sur le bouton Dézoomer.

Bouton Dézoomer

• Commande-cliquez sur le bouton Zoomer ou
Dézoomer pour (dé)zoomer complètement.
Option-cliquez pour (dé)zoomer 2 fois ;
Majuscules-Option-cliquez pour (dé)zoomer 4
fois.

• Pour que le zoom n’affiche que la sélection
courante, sélectionnez d’abord un segment ou
une région puis cliquez sur le bouton Ajuster sur
la sélection. Ceci est particulièrement pratique
pour manipuler l’affichage lorsqu’une édition
précise de la forme d'onde est nécessaire.

Bouton Ajuster sur la sélection

• Option-cliquez sur le bouton Ajuster sur la
sélection pour centrer l'affichage au début du
segment ou de la région sélectionnée. Com-
mande-cliquez sur le bouton Ajuster sur la
sélection pour centrer l'affichage à la fin du
segment ou de la région sélectionnée.

Pour zoomer l'affichage vertical des formes d'onde :

• Cliquez sur la flèche haut (Waveform Expand)
pour zoomer l’affichage d’un signal de faible
niveau.

• Cliquez sur la flèche bas (Waveform Contract)
pour revenir à l'affichage normal.

Boutons Zoom Vertical

Ces boutons ne zooment que l'affichage de la forme
d'onde, pas les données audio réelles. Si vous voulez
modifier les données pour augmenter le niveau réel de
l’audio, utilisez la commande Normalize. Pour plus
d'informations, voir le chapitre 5 “Effets”.

Utilisez les touches crochet gauche et droite ([ et ])
pour allonger ou réduire rapidement l'affichage de la
forme d'onde.
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• Pour renommer un marqueur, Commande-cliquez
dessus pour afficher sa boîte de dialogue.

• Pour supprimer des marqueurs, Option-cliquez
dessus. Appuyez sur Tab fait automatiquement
défiler l’affichage des pistes pour caler sur le
marqueur suivant le long de l'axe temporel.

Les marqueurs peuvent améliorer la prise de décision
et la navigation dans la fenêtre Tracks. Par exemple,
entrez des marqueurs lorsque vous enregistrez ou lisez
pour marquer les erreurs ou les passages à garder,
pour pouvoir facilement localiser ces zones lorsque
vous commencez l’édition. Si vous avez tendance à
vous y perdre lors d’enregistrements longs et
répétitifs, utilisez des marqueurs pour avoir une
référence à l’écran des moments de transition ou de
changement. Vous pouvez également utiliser les
marqueurs avec la touche Tab pour localiser et revenir
à des parties de votre séance où de nombreuses
éditions ou traitements sont nécessaires.

Les marqueurs sont identiques aux Temps de position
de la fenêtre Transport. Dès que vous créez un
marqueur (en appuyant sur la touche Entrée) le temps
ou le nom du marqueur est ajouté aux pop-up menus
Temps de position et ces derniers peuvent être utilisés
pour aller automatiquement à un point.

Édition de base en Mode segment
et Mode objet

Segment vous permet de sélectionner n’importe quel
morceau de n’importe quelle forme d'onde sur une
piste et de le couper ou le copier pour créer ou
modifier une région. Objet vous permet de sélection-
ner des groupes de régions et de les déplacer pour
arranger un morceau, repérer des effets ou organiser
en général. Vous ne pouvez pas sélectionner un
élément plus petit qu’une région en Mode objet.

Boutons Mode objet et segment

Pour stocker des mémoires d’affichage :

1. Réglez l'affichage de la forme d'onde pour que le
degré de zoom soit à votre convenance.

2. Commande-cliquez sur n’importe lequel des
quatre boutons Mémoire d'affichage.

Boutons Mémoire d'affichage

Pour rappeler l’affichage stocké :

• Cliquez sur un bouton Mémoire d'affichage.

Les outils Zoomer et Ajuster sur la sélection vous
permettent de zoomer et dézoomer à des résolutions
autres que les résolutions d’affichage usuelles. Si vous
ne faites pas attention, votre affichage peut être ajusté
à une résolution bizarre. Pour revenir à la résolution
de votre choix, sélectionnez cette résolution dans le
pop-up menu Résolution de l'axe.

Pour modifier la taille de piste :

• Cliquez sur les boutons Taille de piste pour
sélectionner une taille de piste.

Boutons Taille de piste

Les boutons Taille de piste vous permettent de
sélectionner parmi quatre modes d’affichage de la
forme d'onde. Les modes les plus grands permettent
de localiser des points de passage par zéro dans une
forme d'onde, l’affichage moyen sert à éditer un
segment ou une région de forme d'onde et le plus
petit est assez pratique pour réarranger les pistes.

Pour placer des marqueurs dans l’axe temporel de la
fenêtre Tracks (ligne temporelle) :

• Appuyez sur Entrée du pavé numérique. Dès que
vous appuyez sur la touche Entrée, (pendant
l’enregistrement, la lecture ou à l’arrêt) un
drapeau rouge—ou Marqueur—est placé dans
l’axe temporel de la fenêtre Tracks (ou ligne
temporelle) à la position courante. Les nombres
qui apparaissent à côté du marqueur indique la
coordonnée temporelle du marqueur.
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Le Mode segment vous permet de sélectionner des
segments de forme d'onde en faisant glisser la souris
sur ces segments. La plupart des éditions que vous
effectuerez en Mode segment consistent à définir des
morceaux d’une piste audio comme régions, à couper
et coller de petites parties de régions audio plus
longues et à fader ou crossfader des parties de régions
audio. Le Mode objet est conçu pour l’arrangement
global des régions existantes, l’ajustement général et
les fonctions de placement.

Pour une liste complète des raccourcis clavier qui
rendent l’édition plus efficace, voir le chapitre 9
“Références de Deck”.

Pour sélectionner un segment de forme d'onde :

1. Cliquez sur le bouton Mode segment  (ou la
touche ~) pour vérifier que vous êtes en Mode
segment. Le bouton sera allumé.

Bouton Mode segment

2. Faites glisser la souris sur une zone de forme
d'onde.

Segment de forme d'onde sélectionné

Si vous faites glisser la souris dans la sélection, vous
pouvez détacher le segment sélectionné et le placer
sur une piste quand vous le voulez. Si vous voulez
définir le segment sélectionné comme nouvelle région
audio (pour un arrangement ultérieur en Mode objet),

vous pouvez choisir Edit > Slice (Commande-R) pour
créer de nouvelles régions à partir du segment
sélectionné en gardant la même place, pour qu’aucun
changement global du temps ou du placement audio
ne survienne. Vous pouvez également traiter les
segments audio avec des effets destructifs disponibles
dans le menu Process.

Il existe un certain nombre de commandes clavier qui
facilitent les fonctions de glisser-éditer du Mode
segment. Par exemple, les flèches haut et bas
déplacent la sélection entre les pistes, touche Option
et les flèches gauche ou droite déplacent la sélection
le long de la ligne temporelle, touche Majuscules et les
flèches étendent la sélection, et touche Commande et
les flèches vous permet de déplacer l'audio sélec-
tionné.

Si vous travaillez de la musique basée sur des boucles,
le Mode segment peut vous aider dans l’édition à
l’aide de “modèles”, pour que vous puissiez trouver et
éditer des boucles rapidement et sans raccord.
Supposont que vous ayez déjà enregistré ou importé
une boucle de batterie d’une mesure et copié celle-ci
bout à bout sur la piste un. En écoutant cette boucle
de batterie, vous enregistrez ensuite une ligne de
basse sur la piste deux. Vous pouvez maintenant
utiliser le segment de la boucle de batterie comme
modèle pour faciliter la sélection d’un passage de
basse à boucler. Cliquez simplement une fois sur une
région de la boucle de batterie de la piste un, puis
appuyez sur la touche tilde (~). Si vous étiez en Mode
objet, vous êtes maintenant en Mode segment. Si vous
étiez en Mode segment, appuyez de nouveau sur la
touche tilde (~), pour revenir en Mode objet. La
sélection est maintenant exactement égale à la durée
de la boucle de batterie. Ensuite, appuyez sur la flèche
bas pour déplacer la sélection sur votre nouvelle piste
de basse. Vous pouvez écouter la piste de basse
(Majuscules-Barre d'espace) et déplacer la sélection le
long de la piste en utilisant Option-flèche gauche/
droite pour trouver la répétition de basse désirée.
Découpez votre meilleure prise (Commande-R) puis
copiez et collez-la pour construire une nouvelle piste
de basse bouclée.
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Comme vous avez utilisé votre boucle de batterie
comme outil de découpage, vous n’avez pas à éditer
individuellement les points de début/fin des boucles
suivantes. Cette forme d’édition permet d’identifier,
éditer et placer une boucle beaucoup plus facilement
et rapidement.

Pour sélectionner une région en objet :

1. Cliquez sur le bouton Mode objet (ou la touche
~) pour vérifier que vous êtes en Mode objet. Le
bouton sera allumé.

Bouton Mode objet

2. Cliquez sur la région de forme d'onde désirée.

Une région de forme d'onde sélectionnée

Vous pouvez appuyer sur la touche Majuscules et
cliquer sur une autre région pour l’ajouter à la
sélection. Remarquez que Deck vous permet de
sélectionner des régions qui ne sont pas nécessaire-
ment l’une à côté de l’autre. Vous pouvez maintenant
éditer la région sélectionnée de plusieurs façons. Si
vous cliquez dans la région et faites glisser la souris,
vous pouvez la placer n’importe où dans la fenêtre
Tracks. Vous pouvez obtenir la même chose en
choisissant Cut (Commande-X) dans le menu Edit et
en plaçant un point d'insertion n'importe où dans la
fenêtre Tracks pour coller la sélection. Vous pouvez
également supprimer le segment sélectionné
simplement en appuyant sur la touche Suppression de

votre clavier Macintosh, mais celui-ci sera alors
définitivement supprimé—il n’ira pas dans le Presse-
papiers. Vous pouvez utiliser les commandes Copy et
Paste dans le menu Edit pour coller des copies de la
région bout à bout (ou dans n’importe quel arrange-
ment désiré). Vous pouvez également appliquer des
effets destructifs sur n’importe quelles régions
sélectionnées en sélectionnant le sous-menu
Destructive Effects dans le menu Process. Pour plus
d'informations sur les effets, voir le chapitre 5 “Effets”.

Remarquez que lorsque vous déplacez une région, les
boîtes Indicateur de données du coin supérieur
gauche de la fenêtre Tracks changent pour vous
montrer la durée de la région et les positions départ,
fin et courante (souris). Utilisez ces nombres pour
placer l’audio à l’échantillon, la trame, la pulsation ou
la seconde désiré.

Option-cliquez et faites glisser la souris pour séparer
une copie d’une région en laissant l’original à sa place,
Commande-cliquez et faites glisser la souris pour
coller la sélection courante à la fin de la région
précédente et les combinaisons Commande-Option-
flèche pour déplacer les régions audio sélectionnées
dans la fenêtre Tracks. Remarquez que dès que vous
déplacez une région dans une zone de la fenêtre
Tracks où d’autres régions existent déjà, la région
déplacée coupe (ou édite) les régions qu’elle recouvre
en partie ou en totalité.

Sélection des unités de l'axe et
gestion de la grille

Deck vous permet d’ajuster une séance pour qu’elle
vous montre tous les temps et les formes d'onde en
secondes, échantillons, trames SMPTE ou mesures et
pulsations. Vous pouvez régler ces unités selon le type
d’édition que vous comptez faire et vous pouvez
passer de l’un à l’autre à n’importe quel moment sans
vous soucier du timing de vos pistes. Les différentes
unités peuvent être très utiles et il est important de les
comprendre, car de nombreuses fonctions d’édition
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de la fenêtre Tracks sont basées sur les unités. L’une
des raisons majeures de cela est la grille de la fenêtre
Tracks, qui est extrêmement pratique pour travailler
sur des arrangements.

Grille intelligente

La grille intelligente est comme un modèle invisible
qui place automatiquement vos éditions sur l’unité
appropriée la plus proche. Elle est appelé grille
intelligente car elle s’ajuste automatiquement à l’unité
la plus raisonnable pour la résolution d’affichage
courante. Par exemple, si vous avez choisi secondes
comme unités de l'axe, la grille de la fenêtre Tracks
peut automatiquement passer de minutes, 10
secondes, 1 seconde, centièmes de seconde,
millisecondes et échantillons, selon votre zoom. La
grille de Deck est un outil particulièrement important
pour l’arrangement musical, car elle vous permet
d’effectuer de l’édition de régions audio dans le style
d’une boîte à rythme et d’éditer des régions audio
globales à des tempos spécifiques. Bien que vous
soyez libres de désactiver la grille à n'importe quel
moment, il vous sera très utile d’apprendre ses
fonctions de base.

Pour sélectionner les unités d’affichage de la séance :

• Sélectionnez les unités désirées dans le pop-up
menu Unités de l'axe en haut à gauche de la
fenêtre Tracks.

Pop-up menu Unités de l'axe

Ces unités sont enregistrées avec la séance et lorsque
celle-ci est ouverte la fois suivante, les temps sont
affichés dans ces unités. Vous pouvez changer vos
unités à n'importe quel moment sans modifier le
placement des régions audio.

Mode pulsation

Si vous travaillez en Mode pulsation, il existe un cas où
vous pouvez souhaiter que les régions audio garde le

placement de mesure et de pulsation lorsque le tempo
est changé. Si vous utilisez Deck comme une boîte à
rythme virtuelle (en lisant chaque son de batterie sous
forme de régions), vous voudrez être sûrs que les
changements de tempo ajustent le placement des
régions audio afin que celles-ci commencent à leur
emplacement de mesure et pulsation original. Dans
cette situation, changer le tempo modifie l’endroit où
les mesures et les pulsations surviennent en fonction
du temps réel et les temps de départ mesure/pulsation
sont des temps relatifs plutôt que des temps absolus.
Deck possède une préférence spéciale pour ce type
d’édition. Si vous voulez que les régions restent à leurs
emplacements de mesure et pulsation lorsque le
tempo est changé (en Mode pulsation), cochez la case
“Change region start times with BPM change” dans le
sous-menu General Preferences du menu File. Lorsque
cette option est activée, les changements de tempo en
Mode pulsation ajustent le placement des régions
audio pour que celles-ci restent à leurs emplacements
de mesure et pulsation. Pour plus d'informations, voir
le chapitre 7 “MIDI et Synchronisation”.

Pour activer et désactiver la grille :

1. Choisissez Snap to Grid dans le menu Options, ce
qui vous permet d’activer ou désactiver la grille.
Remarquez que vous pouvez également cliquer
sur le bouton Grille directement à gauche du pop-
up menu Unités de l'axe.

Bouton Grille

2. Cliquez de nouveau sur ce bouton pour réactiver
la grille.

Le bouton Grille sera allumé lorsque Snap to Grid est
activé.

Pour passer à une résolution d'affichage spécifique :

• Sélectionnez la résolution désirée dans le pop-up
menu Résolution de l'axe-juste à droite du pop-up
menu Unités de l'axe.
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Pop-up menu Résolution de l'axe

Ceci est le moyen le plus rapide et le plus précis pour
que la zone d'affichage de la forme d'onde affiche la
résolution que vous voulez. Vous pouvez maintenant
effectuer des éditions basées sur les unités courantes.
Vous pouvez aussi utiliser les quatre mémoires
d’affichage de la fenêtre Tracks pour stocker votre
affichage courant de la forme d'onde.

Lorsque la résolution est changée, la zone de forme
d'onde est (dé)zoomée sur son côté gauche.
L'affichage peut alors se placer sur une zone qui n’a
plus de rapport avec la sélection courante (ou qui
montre son centre, mais empêche de voir le début ou
la fin de la sélection). Quelle que soit la résolution,
vous pouvez immédiatement centrer l'affichage de la
forme d'onde au début ou à la fin de la sélection
courante : utilisez Position at Beginning (Commande-
[) ou Position at End (Commande-]) dans le sous-
menu Selection Tools dans le menu Option.

Pour localiser un point spécifique dans la séance,
cliquez simplement sur l'axe temporel. Le curseur en
forme de carré noir dans l'axe temporel indique votre
emplacement courant dans la séance.

Édition des régions

Les régions audio sont les blocs de construction d’une
séance Deck et les techniques pour créer et définir les

régions sont parmi les plus essentielles à connaître.
Une région peut être créée de plusieurs façons
simples, simplement en séparant un segment de forme
d'onde pour découper le segment en place. Dès que
vous avez créé une région audio, il existe une
méthode très simple pour éditer les points de début et
de fin de cette région. Elle ne nécessite pas de mode
spécial et peut être effectuée très rapidement.

Si c’est possible, placez vos points de début/fin
pendant un passage de silence, entre les événements
sonores. S’il n’est pas possible de trouver une bonne
pause entre des mots ou des notes, essayez de couper
au passage à zéro, à l’endroit où la forme d'onde
croise la ligne au milieu de la piste affichage. Ces
techniques simples vous évite des clics et des pops
audibles qui sont créés par des éditions trop abruptes.

Pour changer la taille d’une région audio :

1. Cliquez sur le bouton Mode objet (ou touche ~)
pour vérifier que vous êtes en Mode objet.

2. Sélectionnez la région de forme d'onde désirée.

3. Pour changer la taille de la région, cliquez et faites
glisser l’un des quatre onglets de définition de
région, situé dans chaque coin de l’objet
sélectionné.

Onglets de définition de région
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Lorsque vous faites cela, une marque apparaît qui
indique la nouvelle taille de la région. Vous pouvez
regarder l’affichage numérique du coin supérieur
gauche de la fenêtre Tracks pour connaître la taille
courante de la région. Si vous éditez la taille de la
région avec la grille activée, la taille est automatique-
ment calée sur la grille.

Une région audio est comme une petite fenêtre dans
le fichier son source. Vous pouvez ajuster cette fenêtre
pour afficher n’importe quelle partie du fichier son,
mais il n’est pas possible de révéler plus de données
de la région audio que celles qui sont contenues dans
le fichier son source. Lorsque vous faites glisser un
onglet de définition de région pour changer sa taille,
mais que la région refuse de s’agrandir davantage, c’est
que vous avez atteint la fin des données du fichier son
source.

Vous pouvez éditer les points de début et de fin d’au
moins deux régions simultanément en sélectionnant
des régions en Mode objet. Cliquez et faites glisser la
souris en commençant d’une partie vide de la fenêtre
Tracks pour créer une sélection avec une marque ou
appuyez sur la touche Majuscules en cliquant sur les
régions que vous voulez sélectionner. Cliquez ensuite
sur l’un des onglets de définition de région des
régions sélectionnées et gardez appuyé le bouton de la
souris pour changer la taille. Toutes les régions
sélectionnées changent leur taille au point de début
ou de fin que vous choisissez.

Utilisation des pistes de lecture et
des pistes de travail

Bien que Deck ait l’air d’un simple enregistreur et
éditeur multipistes, le concept de pistes virtuelles vous
permet de créer des mixages qui possèdent plusieurs
couches sans bouncer des pistes. Vous pouvez
imaginer cela de la façon suivante : Deck vous permet
d’enregistrer et d’arranger un nombre virtuellement
illimité de pistes, avec la possibilité de pouvoir choisir
à n'importe quel moment lesquelles de ces pistes

seront lues. Toutes les pistes autres que les pistes de
lecture du haut de la fenêtre Tracks sont appelées
pistes de travail. Les pistes de travail ne sont pas lues,
mais elles peuvent être mélangées avec les pistes de
lecture si vous avez activé la commande Virtual Mix.
Les pistes de travail stockent toutes les informations
d’une piste, dont l’automation. Si la commande Virtual
Mix n’est pas activée, vous pouvez utiliser les pistes de
travail comme base de données visuelle de pistes de
lecture, d’arrangements et de sources pré-mixées
potentiels.

Pour déplacer les pistes des pistes de lecture en pistes
de travail et inversement :

• Dans la zone de contrôle de la fenêtre Tracks,
cliquez et gardez enfoncé le bouton de la souris
sur le nom de la piste de destination. Vous allez
voir une liste en pop-up de toutes les pistes de
votre séance. Sélectionnez la nouvelle piste.
Lorsque vous relâchez la souris, la nouvelle piste
et toutes les informations associées apparaissent
sur cette piste.

Repérage rapide et écoute

La fenêtre Tracks offre un certain nombre de fonctions
que vous pouvez utiliser pour entendre des sélections
spécifiques et repérer automatiquement un segment
pour évaluer une boucle.

Pour écouter un segment de forme d'onde ou de région
:

1. Sélectionnez le segment de forme d'onde (Mode
segment) ou de région (Mode objet) que vous
voulez entendre. Vous pouvez sélectionner un
segment ou des régions de plusieurs pistes, si
vous voulez.

2. Sélectionnez Audition Selection dans le sous-
menu Audition dans le menu Process (Com-
mande-T ou Majuscules-Barre d'espace).

Votre segment ou votre région sélectionné est lu. Lors
de la lecture, tout l’audio est panné au centre et
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l’automation est ignorée. Remarquez que la com-
mande Audition lit la piste de travail audio, si vous
avez sélectionné cet audio.

Pour repérer automatiquement un segment de séance
pour évaluer une boucle :

1. Sélectionnez le segment de forme d'onde ou de
régions qui constitue la partie de la séance que
vous voulez entendre en lecture bouclée. Toutes
les pistes sont lues lorsque vous commencez la
boucle de repérage, quelles que soient les pistes
de la sélection.

2. Appuyez sur C. Le segment de sélection courant
est automatiquement transféré aux temps de
début et de fin de la fenêtre Transport et le Mode
boucle est activé. Vous êtes maintenant prêts à
entendre la boucle.

3. Appuyez sur le bouton Play de la fenêtre
Transport (ou sur la Barre d'espace du clavier de
votre Macintosh) pour entendre la boucle.

La boucle est lue de façon répétée jusqu’à ce que vous
cliquiez sur le bouton Stop de la fenêtre Transport ou
appuyiez sur la Barre d'espace du clavier de votre
Macintosh. Pour désactiver la boucle, cliquez sur le
bouton Boucle de la fenêtre Transport (ou appuyez
sur Option-C).

Bouton Boucle

Fades et crossfades constructifs

La fenêtre Tracks offre toutes les fonctions standards
de fade et de crossfade constructif que vous pouvez
attendre d’une station de travail audio. Contrairement
aux enveloppes d'automation (qui contrôlent
physiquement les fadeurs de volume ou de pan), les
fades et les crossfades créent de nouvelles données
audio et placent ces données audio au-dessus du
segment sélectionné, sans supprimer les données
audio originales. Les crossfades en particulier sont des
outils de design sonore extrêmement importants, car

ils vous permettent de superposer deux régions audio
sur la même piste et d’éditer la transition entre les
deux régions pour que la première disparaisse au
moment où la seconde apparaît. Normalement, ceci
devrait nécessiter deux pistes, mais Deck permet
d’accomplir cela sur une seule piste. Voici le genre de
sélection de segment que vous pouvez faire pour
générer un crossfade entre deux régions :

Si vous avez exécuté un crossfade sur cette sélection,
vous allez obtenir le résultat suivant. La région 1 va
commencer à disparaître au début du segment
sélectionné et aura entièrement disparu à la fin de
celui-ci. La région 2 commence à apparaître au début
du segment sélectionné et sera au maximum de
volume à la fin de celui-ci. Le résultat de ce crossfade a
cette apparence :

Les fades et les crossfades sont en général basés sur la
sélection courante, mais Deck offre un certain nombre
de formes différentes de fade in et de fade out, qui ont
également un grand effet sur le résultat du fade ou du
crossfade.
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Les crossfades sont basés sur les données audio
situées après la fin de la région 1 et les autres données
situées avant le début de région 2 dans les fichiers son
source. Si vous tentez de créer un crossfade en
utilisant des régions qui référencent des fichiers son
ne contenant aucune données après la fin de la région
1 ou avant le début de la région 2, Deck vous avertit
qu’il n’y a pas de données. Vous pouvez quand même
créer le crossfade, mais Deck utilisera du silence
comme données de substitution.

Formes de fade out

Cette courbe conserve la région 1 au volume
maximum à travers le crossfade puis la fait disparaître
d’un seul coup à la fin de la sélection.

Cette courbe fait disparaître la région 1 relativement
lentement, en gardant l’amplitude assez élevée. Vers la
fin du crossfade, l’amplitude chute rapidement.

Cette courbe fait disparaître la région 1 légèrement
plus rapidement, avec l’amplitude légèrement plus bas
que l’enveloppe précédente.

Cette enveloppe fait disparaître la région 1 avec une
courbe de fade linéaire. Elle crée un fade out lisse et
régulier. C’est la courbe par défaut.

Cette courbe fait disparaître l’amplitude de la région 1
relativement rapidement au début du crossfade.

Cette courbe baisse l’amplitude de la région 1 encore
plus rapidement au début du crossfade.

Cette enveloppe coupe la région 1 au début du
crossfade.

Formes de fade in

Cette courbe amène immédiatement la région 2 au
maximum de volume au tout début du crossfade et la
conserve telle quelle à travers le crossfade.

Cette courbe fait apparaître la région 2 rapidement au
début, en atteignant l’amplitude maximum assez
rapidement dans le crossfade.

Cette courbe fait apparaître la région 2 un peu moins
rapidement avec une amplitude globale légèrement
plus basse.
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Cette courbe fait apparaître la région 2 avec une
courbe de fade linéaire. Elle est légèrement plus lente,
avec une amplitude régulière à travers le crossfade.
C’est l’enveloppe par défaut.

Cette courbe fait apparaître la région 2 lentement au
début du crossfade.

Cette courbe fait apparaître la région 2 encore plus
lentement que la courbe précédente.

Cette courbe coupe la région 2 jusqu’à la fin du
crossfade.

Combinaisons possibles d’enveloppes

Voici des combinaisons d’enveloppes de fade out et de
fade in que vous pouvez essayer.

Border of region 1 and 2

Selection range crosses both regions

Region 2Region 1

Crossfade linéaire—Un crossfade qui convient bien
à des tâches générales avec une transition lisse et

régulière entre la région 1 et la région 2. Si le
volume baisse au centre du crossfade, essayez le
crossfade à puissance constante.

Crossfade à puissance constante—Un crossfade
qui convient bien à des tâches générales, pratique
dans les cas où un crossfade linéaire semble créer
une baisse globale de volume au point de
jonction.

Fade superposé—Cette combinaison de courbes
conserve les deux régions à amplitude maximum
à travers le crossfade : la région 2 arrive au début
et la région 1 quitte à la fin.

Silence—Ces deux courbes créent du silence
pendant la durée du crossfade. Cette combinaison
n’est dans la plupart des cas pas particulièrement
pratique.

Pour appliquer un fade ou un crossfade sur la
sélection courante :

1. Ouvrez la fenêtre Tracks (Commande-3), et
vérifiez que vous êtes en Mode segment (touche
~), puis cliquez et faites glisser la souris pour
sélectionner le segment de forme d'onde sur
lequel vous voulez appliquer le fade ou le
crossfade.

Ce segment doit croiser au moins une limite de
région. S’il ne croise que le début d’une région,
un fade in est généré. S’il ne croise que le fin
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d’une région, un fade out est généré. S’il croise le
bord de deux régions contiguës, un crossfade est
généré.

2. Sélectionnez Fade Selection dans le menu
Process.

Un fade in commence toujours au début de la région
sélectionnée et un fade out finit toujours à la fin de la
région. Ceci est vrai quelle que soit la distance à
laquelle vous sélectionnez du début ou de la fin.

Fade in

Fade out

Cross fade

Pour régler le fade/crossfade par défaut :

1. Sélectionnez Set Default Fade dans le menu
Process.

Le fade par défaut est les formes de fade in et fade out
de base (avec les durées par défaut) qui sont utilisées
lorsque vous choisissez la commande Fade Selection
ou la commande Default Fade. La commande Fade
Selection utilise toujours les courbes de fade par
défaut, mais crée le fade ou le crossfade selon la
sélection courante de forme d'onde. La commande
Default Fade exécute toujours le fade ou le crossfade
en utilisant les formes de fade et les durées de fade par
défaut. C’est une commande très pratique lorsque
vous voulez créer de petits fades ou crossfades de
lissage, mais que vous ne voulez pas zoomer complète-
ment pour sélectionner un petit segment. La
commande Default Fade vous permet d’effectuer de
grandes sélections de forme d'onde qui peuvent créer
des fades très subtiles. Dès que vous voulez créer un
fade ou un crossfade qui n’utilise pas les formes de
fade par défaut, utilisez la commande Custom Fade.
Cette commande fonctionne comme la commande
Fade Selection, sauf qu’elle vous demande toujours de
choisir vos formes de fade avant de créer celui-ci.

2. Réglez vos formes de fade in et de fade out et
entrez les durées qui seront utilisées par la
commande Default Fade.

3. Cliquez sur le bouton OK.

Vous avez maintenant réglé votre information de fade
par défaut.

Deck vous permet exécuter des fades et des
crossfades sur un nombre quelconque de
régions en une seule fois. Lorsque vous
sélectionnez des régions et que vous choisissez
la commande Default Fade, toutes les régions
sélectionnées sont fadées ou crossfadées en
utilisant les formes de fade et les durées par
défaut. Lorsque vous sélectionnez des régions
et choisissez la commande Fade Selection,
toutes les régions sélectionnées sont fadées ou
crossfadées en utilisant les formes de fade par
défaut et leurs durées entières comme durée de
fade.
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Exécuter le fade/crossfade par défaut :

1. Vérifiez que vous avez réglé votre information de
fade par défaut comme ci-dessus.

2. Ouvrez la fenêtre Tracks et sélectionnez le
segment de forme d'onde (Mode segment) ou la
région (Mode objet) sur lequel vous voulez
appliquer le fade ou le crossfade.

3. Sélectionnez Default Fade (Commande-H) dans le
menu Process.

Si vous avez un grand nombre de régions sélection-
nées, ce traitement peut prendre du temps. Après un
moment, la fenêtre Tracks réapparaît et tous vos fades
et crossfades sont en place.

Si vous éditez de la musique, du dialogue ou des
effets, vous pouvez utiliser la commande Default Fade
comme filtre automatique pour corriger les clics et les
pops que vous pourriez avoir sur les limites de région :
réglez les formes de fade par défaut sur puissance
constante et durées de fade par défaut sur une petite
durée (60 ms, par exemple). Sélectionnez ensuite
toutes les régions et choisissez la commande Default
Fade. Toutes les régions sont fadées in, fadées out et/
ou crossfadées, ce qui vous garantit qu’aucune
transition de région ne sera abrupte. Pour plus
d'informations sur les combinaisons de fade, voir
“Combinaisons possibles d’enveloppes” à la page 43.

Créer un fade ou crossfade personnalisé :

1. Ouvrez la fenêtre Tracks et sélectionnez le
segment de forme d'onde sur lequel vous voulez
appliquer un fade ou un crossfade. Ce segment
doit croiser au moins une limite de région. S’il ne
croise que le début d’une région, un fade in est
généré. S’il ne croise que le fin d’une région, un
fade out est généré. S’il croise le bord de deux
régions contiguës, un crossfade est généré.

2. Sélectionnez Custom Fade (Commande-G) dans
le menu Process.

3. Choisissez votre forme de fade out et de fade in

4. Cliquez sur le bouton OK.

Après un moment, votre crossfade sera achevé et vous
le verrez dans la fenêtre Tracks. S’il n’y a pas de
données audio dans le fichier source après la fin de la
région 1 ou avant le début de la région 2, Deck vous
avertit qu’il n’y a pas de données. Vous pouvez quand
même créer le crossfade, mais Deck utilisera du
silence comme données de substitut.

Si vous avez sélectionné un segment de forme d'onde
qui ne recouvre que le début ou la fin d’une région,
vous ne verrez qu’un seul jeu de formes de fade, au
lieu de deux, car vous exécutez un fade, et non pas un
crossfade.

Pour supprimer des crossfades :

1. Ouvrez la fenêtre Tracks et sélectionnez un
segment de forme d'onde qui touche un
crossfade ou des régions qui contiennent des
crossfades.

2. Choisissez Delete Fade dans le menu Process.

Tous les fades in des régions touchées par la sélection
courante seront supprimées. Remarquez que les fades
et les crossfades sont des petits fichiers audio qui sont
générés automatiquement par Deck et placés dans le
dossier Crossfades de la séance courante. Lorsque
vous supprimer des fades, ils sont supprimés de votre
disque dur. Cependant, les crossfades ne sont pas
physiquement supprimés avant que vous n’enregis-
triez la séance courante. Ce n’est qu’à ce moment que
l’espace disque occupé par les fades supprimés
redevient disponible.
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Lorsque vous déplacez des régions connectées par un
crossfade, ce crossfade est automatiquement
supprimé. Tout crossfade est lié spécifiquement aux
deux régions sur lesquelles il est à cheval. Le crossfade
n’a plus lieu d’être lorsque les régions sont séparées.

Les fades et les crossfades sont générés par Deck à
partir des fichiers son source originaux. Deck conserve
toujours trace des fichiers son source et peut récréer
automatiquement les crossfades si vous en supprimer
de votre disque dur. Si vous voulez libérer de l’espace
disque utilisé par le dossier Crossfades d’une séance,
vous pouvez simplement jeter ce dossier à la corbeille.
Les crossfades seront automatiquement reconstruits la
prochaine fois que vous ouvrirez la séance.

Compacter de l’audio qui contient des
crossfades

Lorsque vous utilisez des crossfades, vous devez faire
attention si vous comptez utiliser Compact Session ou
Compact Audio File plus tard. Ces deux traitements
permettent un ajustement appelé taille de marge, qui
vous permet de choisir la quantité de source audio
conservée avant chaque début de région et après
chaque fin de région lorsque les fichiers son source
sont compactés (lorsque des parties de fichiers son
sont supprimées). Il est possible de compacter une
séance ou un fichier son avec des marges plus petites
que celles qui seraient nécessaires pour recréer les
crossfades de la séance. Les crossfades sont construits
à partir des données sonores avant le début et après la
fin des régions. Si vous supprimer des crossfades ou
effectuez des éditions qui suppriment des crossfades
après avoir compacté avec une petit taille de marge, il
se peut que les données nécessaires pour recréer les
crossfades supprimés ne soient pas suffisantes.

Utiliser Compact Session et
Compact Audio File

Le compactage est un processus destructif, et vous
devez donc comprendre ce que vous faites avant de
l’utiliser. Il est particulièrement important que vous

compreniez les préférences Always save regions when
Session is saved et Rewrite region list dans la boîte de
dialogue General Preferences de Deck. Ces préféren-
ces ont une forte influence sur le processus de
compactage. Lisez bien le passage sur ces préférences
avant de compacter des fichiers audio ou des séances.

Compact Session

La fonction Compact Session peut être très pratique.
Comme Deck est un enregistreur non-destructif, les
données audio ne sont pas supprimées lorsque de
l’audio est de nouveau enregistré. Ceci signifie
qu’aucun processus d’enregistrement ou d’édition ne
change, n’endommage ou ne supprime réellement les
fichiers source originaux, et vous pouvez donc
toujours revenir aux versions précédentes. Le seul
effet secondaire négatif de cette caractéristique est
que les prises non-utilisées et les régions mises de
côté restent sur votre disque dur, même après que
vous avez arrêté de les utiliser. Si, par exemple, vous
enregistrez trois prises de voix et décidez de conserver
la seconde prise, les prises 1 et 3 restent sur votre
disque dur même après que vous les avez retiré de la
séance. Pour supprimer de façon permanente tout
l’audio non-utilisé de la séance courante, utilisez le
processus Compact Session. Pour supprimer de façon
permanente tout l’audio non-utilisé d’un seul fichier
audio, utilisez Compact Audio File.

Compact Session compacte automatiquement tous les
fichiers audio du dossier Audio Files qui sont utilisés
dans la séance courante. Utilisez toujours cette
commande pour vous débarrasser de données audio
non-utilisées (prises ratées, mots supprimés ou solos
non-utilisés, par exemple) dans tous les fichiers son de
la séance.

Les fichiers sont compactés de la façon suivante : Deck
examine la liste des régions audio et des boucles de
chaque fichier audio. Puis il regarde dans les données
audio de chaque fichier et trouve toutes les données
audio qui ne sont utilisées dans aucune région. Après
que l’audio non-utilisé a été trouvé, il est supprimé de
façon permanente du disque dur et toutes les
définitions de région sont mises à jour.
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Compact Session ne compacte que les fichiers audio
situés dans le dossier Audio Files de la séance
courante. Il ne compacte pas les fichiers audio situés
ailleurs sur le disque dur ou sur d’autres disques durs.
Cette fonction de protection a été intégrée dans Deck
pour empêcher le compactage accidentel de fichiers
son d’une bibliothèque centrale d’effets sonores ou de
fichiers son utilisés dans plusieurs séances. Vérifiez
que vous gardez toujours les fichiers de bibliothèque
sonore et les fichiers son partagés dans un dossier
situé à l’extérieur du dossier Audio Files de la séance
courante.

Pour compacter une séance :

1. Vérifiez que vous avez supprimé toutes les régions
audio non voulues des pistes de lecture et de
travail de la fenêtre Tracks.

2. Choisissez File > Preferences > General et
activez les options “Always save regions when
Session is saved” et “Rewrite region list”.

3. Ouvrez la fenêtre Library (Commande-6).

4. Choisissez Session > Library Operations >
Update from Session.

5. Enregistrez votre séance (Commande-S).

6. Choisissez Session > Compact Session, réglez
Handle Length (taille de marge).

7. Cliquez sur OK.

Le réglage Handle Length vous permet de conserver
un peu de données audio supplémentaire avant et
après chaque début et fin de région, ce qui est très
pratique si vous comptez appliquer un crossfade aux
régions. Vous devriez dans ce cas régler votre taille de
marge sur au moins deux secondes.

Lorsque votre séance contient des crossfades, vous
devez faire attention aux réglages de taille de marge. Il
est possible de compacter une séance ou un fichier
son avec des marges plus petites que celles qui
seraient nécessaires pour recréer les crossfades de la
séance. Les crossfades sont construits à partir des
données sonores avant le début et après la fin des

régions. Compacter avec une taille de marge trop
petite ne modifie pas vos crossfades courants.
Cependant, si vous supprimer des crossfades ou
effectuez des éditions qui suppriment des crossfades
après avoir compacté avec une petit taille de marge, il
se peut que les données nécessaires pour recréer les
crossfades supprimés ne soient pas suffisantes.

Compact Audio File

Lorsque vous sélectionnez Compact Audio File, Deck
regarde dans les données audio du fichier et trouve
toutes les données audio de ce fichier qui ne sont
utilisées dans aucune région de la séance courante.
Après que l’audio non-utilisé a été trouvé, il est
supprimé de façon permanente du disque dur et
toutes les définitions de région sont mises à jour. Le
réglage de taille de marge vous permet de conserver
un peu de données audio supplémentaire avant et
après chaque début et fin de région, ce qui est très
pratique si vous comptez appliquer un crossfade aux
régions. Vous devriez dans ce cas régler votre taille de
marge sur au moins deux secondes.

Pour compacter des fichiers audio :

1. Choisissez File > Preferences > General.

2. Activez “Always save regions when Session is
saved” et “Rewrite region list.”

3. Ouvrez la fenêtre Library (Commande-6) et
choisissez Session > Library Operations >
Update from Session.

4. Sélectionnez File > Compact Audio File.

5. Pour compacter un fichier audio, sélectionnez-le,
entrez une taille de marge et cliquez sur le bouton
Compact.

Ce processus est permanent, et vous devez donc être
sûrs de vouloir modifier le fichier audio sélectionné
avant de continuer. Vous pouvez faire une copie du
fichier si vous pensez vouloir l’utiliser plus tard dans sa
forme originale.

Compact Audio File ne modifie que le fichier audio
que vous sélectionnez, contrairement à Compact
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Session, qui modifie tout l’audio du dossier Audio
Files de votre séance.

Placer des régions audio sur un
timecode

L’une des tâches courantes du processus de post-
production audio est le placement de son sur une
trame SMPTE particulière. Deck vous permet de faire
cela de façon très simple en utilisant les outils
d’édition normaux.

Pour placer une région audio sur trame SMPTE
spécifique :

1. Ouvrez la fenêtre Tracks et réglez les unités de la
fenêtre sur SMPTE en utilisant le pop-up menu
Unités de l'axe.

2. Cliquez sur le bouton Mode objet (ou touche ~)
pour passer en Mode objet.

3. Ajoutez la région audio que vous voulez placer en
utilisant le processus décrit dans “Ajouter des
fichiers audio et des régions à une séance” à la
page 22.

4. Restez cliqué sur la région audio que vous voulez
placer.

5. Faites glisser la région sur la trame désirée.

Lorsque vous faites glisser la région, les boîtes
Indicateur de données du coin supérieur gauche de la
fenêtre Tracks sont mis à jour pour vous montrer le
temps de départ, le temps de fin, le temps courant et
la durée du segment sélectionné. Le temps courant est
le temps situé directement sous le curseur.

L’indicateur de temps courant est particulièrement
pratique lorsque vous voulez placer un son sur un
point de synchro interne (un point autre que le début
ou la fin de la région). Si, par exemple, vous avez le
son d’un moteur d’une voiture qui passe, avec un son
de dérapage au milieu, vous pouvez placer la souris au
moment du son de dérapage et placer ce son sur la
trame désirée.

Vous n’avez pas besoin de faire glisser la région pour
la placer. Vous pouvez également copier ou couper la
région, cliquer pour placer le point d'insertion sur la
trame correcte puis choisir la commande Paste At ou
Paste After.

Si vous connaissez le temps exact où vous voulez
placer une région, double-cliquez sur la région, ce qui
affiche la boîte de dialogue Region Information. Vous
pouvez changer le temps de départ de la région et le
nom de la région.

Pour plus d'informations sur la synchronisation et le
placement avec Deck, voir “Synchronisation” à la page
98.

Utiliser les réglages de tempo et
d’indication de mesure

La fenêtre Tracks offre des outils simples qui
permettent d’éditer l’audio selon des réglages de
mesure et pulsation traditionnels. Ceci est une
nécessité absolue lorsque vous enregistrez ou arrangez
de la musique qui doit suivre un tempo MIDI, un clic
sur piste ou une piste de séquenceur MIDI. Lorsque
vous utilisez Deck avec le séquenceur Metro, les
réglages de tempo prennent une importance
particulière, car ils vous permettent de faire corres-
pondre les éditions de mesure et pulsation entre les
deux programmes. Pour plus d'informations sur
l’utilisation de Deck avec Metro, voir “Utiliser Deck
avec le séquenceur Metro” à la page 94.

Pour régler et utiliser l’information de tempo et
d’indication de mesure :

1. Ouvrez la fenêtre Tracks et réglez les unités de la
fenêtre sur Beat en utilisant le pop-up menu
Unités de l'axe.

2. Faites défiler le sélecteur de tempo pour régler un
nouveau tempo.
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Sélecteur de tempo

3. Vous pouvez également appuyer sur la touche
Commande et cliquer sur le sélecteur pour entrer
le nouveau tempo ou la nouvelle indication de
mesure en texte. Appuyez ensuite sur la touche
Retour chariot du clavier de votre Macintosh pour
appliquer le changement.

4. Faites défiler le numérateur de l’indication de
mesure pour régler le nombre de pulsations par
mesure.

5. Faites défiler le dénominateur de l’indication de
mesure pour régler la valeur de la note qui
correspond à une pulsation.

Par exemple, réglez ceci sur 4 signifie qu’une noire est
considérée comme une pulsation.

Ces valeurs sont très pratiques pour un arrangement
de morceau. Lorsque vous réglez ces valeurs, vous
déterminez les unités qui vont être utilisées par les
marqueurs de l’axe en Mode pulsation et les réglages
de grille associés. Remarquez que les valeurs de tempo
et d’indication de mesure ne modifient que l’axe
temporel de la fenêtre Tracks, la grille et les indica-
teurs numériques (et, bien sûr, le compteur de la
fenêtre Transport). Les valeurs de tempo et d’indica-
tion de mesure ne modifient pas le placement des
régions audio à moins que vous n’ayez configuré Deck
comme dans le paragraphe ci-dessous.

Si vous utilisez le séquenceur Metro, vous
verrez que les changements de tempo et
d’indication de mesure que vous faites dans
Metro sont automatiquement intégrés dans
Deck. De même, un segment de sélection
courant du Note Editor de Metro ou de la
fenêtre Tracks sera automatiquement
sélectionné lorsque vous passez dans Deck.

Cependant, les changements de tempo et
d’indication de mesure effectués dans Deck ne
sont pas transmis à Metro (Metro est considéré
comme “tempo master”), et vous devriez donc
changer votre information de tempo et
d’indication de mesure dans Metro si vous
faites tourner les deux programmes. Deck est
compatible avec les cartes de tempo de Metro
pour que celles-ci trouvent toujours un
équivalent dans les marqueurs de l’axe de la
fenêtre Tracks (lorsque vous êtes en Mode
pulsation).

Si vous travaillez en Mode pulsation, il existe un cas où
vous pouvez souhaiter que les régions audio gardent
le placement de mesure et de pulsation lorsque le
tempo est changé. Si vous utilisez Deck comme une
boîte à rythme virtuelle (en lisant chaque son de
batterie sous forme de régions), vous voudrez être
sûrs que les changements de tempo ajustent le
placement des régions audio afin que celles-ci
commencent à leurs emplacement de mesure et
pulsation original. Dans cette situation, changer le
tempo modifie l’endroit où les mesures et les
pulsations surviennent en fonction du temps réel et
les temps de départ mesure/pulsation sont des temps
relatifs plutôt que des temps absolus. Deck possède
une préférence spéciale pour ce type d’édition. Si vous
voulez que les régions restent à leurs emplacements
de mesure et pulsation lorsque le tempo est changé
(en Mode pulsation), cochez la case “Change region
start times with BPM change” dans le sous-menu
General Preferences dans le menu File. Lorsque cette
option est activée, les changements de tempo en
Mode pulsation ajustent le placement des régions
audio pour que celles-ci restent à leurs emplacements
de mesure et pulsation. Pour plus d'informations, voir
le chapitre 7 “MIDI et Synchronisation”.
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Utiliser un éditeur externe

Deck vous permet d’assigner un programme externe
d’édition audio, comme Peak de BIAS, qui peut être
lancé depuis Deck et utilisé pour traiter des fichiers
audio.

Deck est conçu pour vous permettre de lancer un
éditeur externe et Deck en même temps, et la
commande Launch Editor vous fait automatiquement
passer dans l’autre programme.

Éditer de l’audio dans des programmes qui reconnais-
sent les régions audio est différent de l’édition dans
des programmes qui ne les reconnaissent pas. Les
deux méthodes sont présentées dans la partie
suivante.

Pour utiliser un éditeur externe avec Deck, vous
devrez avoir suffisamment de RAM pour faire tourner
les deux programmes. Utilisez la commande Lire les
informations du Finder pour trouver combien de RAM
nécessite votre programme d’édition audio.

Pour régler un éditeur de son externe :

1. Choisissez File > Preferences > General.

2. Cliquez sur Set à droite de Sound Editor
signature.

3. Localisez et sélectionnez votre programme
d’édition.

4. Cliquez sur Open.

Set Sound Editor signature de la boîte de dialogue General

Pour éditer des fichiers audio de Deck en utilisant un
éditeur externe :

1. Vérifiez que vous avez sélectionné votre éditeur
son en utilisant le processus décrit ci-dessus.

2. Vérifiez que la fenêtre Tracks est en Mode objet et
sélectionnez la région ou le fichier que vous
voulez éditer.

3. Choisissez Process > Launch Editor (Commande-
E).

Vous lancez immédiatement votre éditeur externe et le
fichier audio entier qui contient la région sélectionnée
est ouvert dans ce programme. Vous pouvez mainte-
nant effectuer les éditions que vous désirez, enregis-
trer les changements et revenir à Deck : le fichier son
modifié sera lu.

Éditez votre audio avec soin si vous comptez le lire de
nouveau dans Deck. Si vous supprimez un segment de
forme d'onde ou changez la longueur du fichier, vous
changerez le timing global des pistes de Deck et votre
arrangement de la fenêtre Tracks pourra être modifié
de façon permanente. Il est recommandé de travailler
avec une copie du fichier son si vous le pouvez.

Utiliser Peak de BIAS comme éditeur
externe

L’édition de régions audio en utilisant Peak comme
éditeur externe est un peu différente de celle avec un
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autre éditeur, car Peak reconnaît le concept de régions
audio.

Éditer une région audio de Deck dans Peak :

1. Vérifiez que vous avez sélectionné Peak comme
votre éditeur son en utilisant le processus décrit
dans la partie précédente.

2. Dans la fenêtre Tracks, passez en Mode objet.

3. Sélectionnez la région audio que vous voulez
éditer.

4. Choisissez Process > Launch Editor (Commande-
E).

Vous lancez immédiatement Peak et la région
sélectionnée est ouverte dans ce programme. La
région sera en surimpression. Vous pouvez maintenant
effectuer les éditions que vous désirez, enregistrer les
changements et revenir à Deck : le fichier son modifié
sera lu.

Seuls les changements effectués sur la forme d'onde et
enregistrés seront reflétés dans Deck.

Conclusion

Maintenant que vous avez appris comment éditer et
gérer les régions audio dans Deck, continuez avec le
chapitre suivant pour apprendre les effets intégrés
destructifs et en temps réel ainsi que la façon d’utiliser
les plug-ins VST et Premiere avec Deck.
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Chapitre 5
Effets



Manuel utilisateur de Deck54



5

55Effets

Chapitre 5 :
E f f e t s

Les effets disponibles dans Deck sont classés en trois
catégories : les effets destructifs qui réécrivent
réellement les fichiers audio ; les effets non-destructifs
en temps réel qui agissent de la même façon que des
boîtes d’effets externes ou des contrôles EQ d’une
table de mixage externe, en modifiant le signal en
temps réel pendant la lecture ou le mixage, en laissant
le fichier audio source intact ; et les plug-ins.

Les effets en plug-in de Deck utilisent l’architecture
plug-in Adobe Premiere et les plug-ins VST de
Steinberg et sont conçus par des développeurs tiers
comme Arboretum Systems et Waves. Il s’agit de
produits logiciels séparés qui peuvent être comman-
dés chez ces développeurs.

Vous pouvez également choisir d’utiliser d’autres
programmes d’édition sonore indépendants— comme
Peak—pour éditer de façon destructive les fichiers
audio de Deck. Normalement, n’importe quel
programme d’édition audionumérique qui fonctionne
avec les formats audio compatibles avec Deck peut
être assigné comme éditeur externe dans Deck et peut
être lancé depuis celui-ci avec une seule commande.

Effets destructifs

Dans un certain nombre de cas, vous voudrez changer
les données audio réelles de façon destructive ou
permanente. Supposez que vous avez enregistré un
solo parfait, mais que le niveau global est légèrement
bas (ou que la forme d'onde semble petite). Vous
voudrez sûrement augmenter le niveau de cette piste
au maximum. Tous les effets destructifs se trouvent
dans le menu Process > Destructive Effects.

Normalize—examine une région audio (ou un
groupe de régions) et ajuste automatiquement
l’amplitude au niveau maximum permis. Ceci vous
permet de monter des signaux faibles à un niveau
raisonnable, qui utilise toute la résolution
d’amplitude disponible de votre système.

Group Normalize—fonctionne de la même façon
que Normalize, sauf qu’il trouve la crête sur un
groupe de régions et ajuste chaque région de la
même quantité.

Forme d'onde avant normalisation

Forme d'onde après normalisation

Reverse—prend l’audio de la région sélectionnée
(ou du groupe de régions) et le met à l’envers
dans le temps. Ceci est assez pratique pour des
effets spécialisés et des effets de prétraitement
comme le pré-écho.

Invert—place la région audio (ou le groupe de
régions) à l’envers selon l’axe d’amplitude nulle.
Ceci ne modifie pas le son de la région, mais peut
être très pratique pour caler des formes d'onde
dans des boucles et pour du design sonore en
général.
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Duplicate—duplique physiquement les segments ou
les régions que vous avez sélectionné et copie les
nouveaux fichiers audio dans le dossier Audio
Files de cette séance. Ceci est pratique si vous
avez copié une région audio plusieurs fois dans
votre séance Deck, mais voulez n’avoir qu’un seul
exemplaire de ce fichier audio modifié par une
édition, par exemple. Deck fait une copie
physique séparée de cette région dans le dossier
Audio Files et les changements que vous y faites
ne modifieront pas les autres copies de cette
région.

Pour appliquer Normalize, Reverse, Invert ou Duplicate
sur une région ou un groupe de régions :

1. Dans la fenêtre Tracks, sélectionnez les segments
ou les régions que vous voulez traiter.

2. Choisissez l’effet désiré dans le sous-menu
Process > Destructive Effects.

3. Dès que vous effectuez un effet destructif, Deck
vous demande si le processus doit être exécuté
sur une copie. Le traitement du signal change de
façon permanente les données audio et ne peut
être annulé, donc c’est toujours une bonne idée
de sélectionner Make a copy lorsque vous utilisez
des effets destructifs.

4. Cliquez sur OK ou sur Make a copy pour
continuer.

Si vous choisissez Make a copy, la copie est placée à la
position de la région audio originale, mais la région
originale n’est pas modifiée.

Effets en temps réel

Deck offre des effets non-destructifs intégrés en temps
réel qui sont disponibles pendant la lecture. Les effets
en temps réel de Deck sont : Parametric EQ (simple et
4 bandes), Delay, Chorus, Hi Shelf EQ, Lo Shelf EQ,
Gain et Graphic EQ.

Ces effets sont disponibles dans chaque module Mixer
des pistes de lecture et peuvent être configurés dans la

fenêtre Effect. Vous pouvez assigner jusqu’à quatre
effets en temps réel à chaque piste de lecture. La
quantité de chaque type d’effet disponible dans la
fenêtre Mixer et la configuration de la fenêtre Effect
peuvent être modifiés dans le sous-menu Effects du
menu Preferences.

Ces effets sont simples à utiliser et possèdent une
interface graphique intuitive similaire à celle de
n’importe quelle boîte multi-effets. En fait, ces effets
sont plus faciles à utiliser que de nombreux multipro-
cesseurs matériels, car tous les contrôles de tous les
effets que vous avez choisi sont disponibles dans une
seule fenêtre.

Assigner des effets aux pistes de lecture

Dans Deck, créez une nouvelle séance ou ouvrez une
séance existante. Ouvrez la fenêtre Mixer dans le menu
Windows (Commande-2). Vous remarquerez quatre
boîtes appelées Thru en haut de chaque module de
table de mixage.

Pop-up menus Sélecteur d'effet en haut de chaque module de table
de mixage

Il s’agit des pop-up menus Sélecteur d'effet. Lorsque
vous restez cliqué sur Thru dans l’une des boîtes
Sélecteur d'effet, un pop-up menu apparaît avec les
noms de tous les effets intégrés et VST disponibles.
Gardez appuyé le bouton de la souris et faites défiler la
liste pour sélectionner un effet à ajouter à cette piste.
Remarquez que vous pouvez ajouter jusqu’à quatre
effets sur chaque piste de lecture en utilisant chaque
boîte de Sélecteur d’effet de la piste. Choisissez l’un
des effets intégrés de Deck dans le pop-up menu
Sélecteur d'effet > sous-menu Built-in FX.
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Sous-menu Built-in FX dans le pop-up menu Sélecteur d'effet

Dès que vous avez ajouté des effets à vos pistes de
lecture, vous voyez les noms des effets que vous avez
sélectionné dans les boîtes Sélecteur d'effet.

Effets sélectionnés, l’effet Delay 1 est bypassé

Vous allez maintenant entendre les effets lorsque vous
lisez votre séance. Pour désactiver temporairement un
effet, cliquez sur le bouton Bypass à gauche de la boîte
Sélecteur de cet effet et cliquez de nouveau pour
réactiver l'effet—le bouton Bypass sera allumé lorsque
l'effet est activé. Ceci vous permet d’activer l'effet sur
une partie de la piste uniquement ou d’entendre la
piste avec et sans l'effet tout en conservant les
changements que vous avez fait aux réglages de cet
effet.

Pour retirer un effet et tous ses réglages d’une piste,
cliquez sur la boîte Sélecteur de cet effet et cliquez sur
Thru. Ceci retire l'effet et tous ses réglages de cette
piste, mais vous pouvez toujours remettre cet effet-ou
un autre, à n'importe quel moment et le reconfigurer
dans la fenêtre Effect. Ouvrez maintenant la fenêtre
Effect dans le menu Windows (Commande-7). Vous
allez voir les curseurs de contrôle correspondant à
chacun des effets que vous avez sélectionné dans votre
séance. L’exemple suivant montre la fenêtre Effect
avec plusieurs effets.

Fenêtre Effect

Chaque effet possède un différent ensemble de
paramètres que vous pouvez changer pour régler
chaque effet à votre convenance. Même si vous avez
choisi un genre d’effets pour plusieurs pistes de
lecture, les réglages de l’effet de chaque piste peut
être modifié indépendamment des autres pistes. Vous
pouvez avoir jusqu’à quatre effets indépendants par
piste de lecture. Remarquez cependant que le nombre
d’effets possibles simultanés est déterminé par la
vitesse d’horloge de votre ordinateur. Vous pouvez
contrôler votre système dans la fenêtre CPU Meter et
éviter de dépasser les capacités de votre système.

Vous saurez que vous avez appliqué trop d’effets en
temps réel dans une séance lorsque Deck commence à
se comporter de façon erratique. Lorsque ceci
survient, il est recommandé de réduire le nombre
d’effets en temps réel. L’effet Graphic EQ est l’effet en
temps réel le plus gourmand en calcul.

Ajuster les paramètres d’un effet

Chaque effet possède un ensemble de paramètres
différents qui peuvent être modifiés en utilisant les
curseurs de la fenêtre Effect. Par exemple, les curseurs
de Graphic EQ fonctionnent comme un vrai égaliseur
graphique. Vous pouvez augmenter ou diminuer
chaque fréquence en déplaçant les curseurs.
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Curseurs de l’effet Graphic EQ

De nombreux effets fonctionnent avec la fenêtre
Transport. Par exemple, lorsque vous déplacez le
curseur Frequency de la fenêtre EQ, la valeur
représentée par ce curseur est montrée dans la boîte
Indicateur de valeur de contrôle (en haut à gauche) de
la fenêtre Transport et suit les changements de valeurs
lorsque vous déplacez le curseur. Ceci peut être très
pratique pour isoler une fréquence particulière avec
l’EQ ou pour trouver une vitesse de retard spécifique
pour les effets Delay ou Chorus.

Le diagramme suivant montre la fenêtre Transport
suivant un curseur EQ Frequency.

Remarquez que le curseur de la souris se trouve sur le
curseur de fréquence et que la valeur de ce curseur est
montrée en Hz dans la boîte Indicateur de valeur de
contrôle de la fenêtre Transport. Utiliser la fenêtre

Transport pour suivre chaque curseur peut vous aider
à régler les différents paramètres de chaque effet. Vous
pouvez tester chaque effet individuellement sur la
même piste pour vous habituer à eux.

Ces effets sont non-destructifs et ne vont pas modifier
les fichiers audio, les segments ou les régions. Ils sont
disponibles en lecture et pendant les opérations de
mixage sur disque et vous pouvez les activer/
désactiver et changer les réglages à n'importe quel
moment, même pendant la lecture.

À propos des effets intégrés

Voici une brève description de tous les effets en temps
réel et des différents paramètres que vous pouvez
ajuster sur chacun d’entre eux dans la fenêtre Effect.

EQ (simple et 4 bandes), Hi EQ, Lo EQ, Graphic
EQ (7 bandes)—Peut être imaginé comme une
version très flexible des contrôles d’aigu et de
basse sur votre chaîne hi-fi. EQ vous permet
d’isoler et d’augmenter ou diminuer certaines
fréquences (en déplaçant les curseurs vers le haut
ou le bas). Vous pouvez utiliser cet effet pour
ajouter du punch à une piste de basse ou pour
retirer la sibilance d’une voix.

Les deux EQ (simple et 4 bandes) vous permet-
tent de sélectionner la fréquence modifiée, le gain
(la quantité de diminution ou d’augmentation) et
le Q ou résonance, pour chaque EQ sélectionné.
Les Hi et Lo-shelf EQ vous permettent de
sélectionner la fréquence et le gain du seuil. Le
Graphic EQ fonctionne comme un égaliseur
graphique 7 bandes, avec un curseur pour
augmenter ou diminuer chacune des 7 bandes de
fréquence. Le Graphic EQ et le EQ 4 bandes sont
gourmands en calcul.

Delay—Ajoute une copie retardée de l’audio à des
intervalles spécifiés, pour créer un effet d’écho.
Un retard court sonne bien sur une voix rock et
une guitare rockabilly et sonne presque comme
une réverbération. Un long retard crée un écho
long et “spatial”.
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Vous pouvez contrôler le temps de retard, la
quantité de feedback, la fréquence de coupure et
le pourcentage d’effet (wet).

Gain—Un effet avec un seul curseur, qui vous donne
une tranche de gain +18/-18 dB. Essayez-le avant
ou après l’EQ. Il s’agit en fait d’un préampli ou
d’un atténuateur, qui augmente ou diminue
l’amplitude (volume) de votre piste de lecture.

Chorus—Il s’agit en fait d’un retard court avec de la
modulation. Le son retardé est mélangé avec
l’audio original pour ajouter du corps et de la
richesse aux voix et à la guitare et, à des réglages
extrêmes, crée un excellent effet spécial.

Les effets de Chorus vous permettent de choisir la
quantité de retard, la vitesse, la profondeur de
modulation et le pourcentage d’effet (wet).

Multitap—Conçu pour utiliser plusieurs retards pour
simuler des effets de réverbération. Multitap est
gourmand en calcul.

Réglage des préférences des effets

Vous pouvez changer la configuration de la fenêtre
Effect ou la quantité de chaque type d’effet disponible.
Vous pouvez changer ces réglages en utilisant Effects
dans le menu Preferences.

Boîte de dialogue Effects Preferences

Vous pouvez utiliser ce dialogue pour spécifier
comment les curseurs de la fenêtre Effects doivent
être arrangés et pour sélectionner le nombre de
chaque type d’effet qui doivent être disponibles dans
les boîtes Sélecteur d'effet de la fenêtre Mixer. Vous
pouvez également sélectionner la longueur maximum
de retard dans les effets de retard en entrant la valeur,
en millisecondes, dans le champ Delay Line Length.

Plug-ins Premiere

Les effets audio au format plug-in Premiere pour Deck
sont disponibles chez des développeurs tiers dont
Arboretum Systems et Waves. Vous n’avez pas besoin
de matériel supplémentaire pour utiliser les plug-ins
Premiere—tout Macintosh compatible avec Deck
devrait également pouvoir utiliser les plug-ins. Bien
que les fonctions et les interfaces varient selon les
plug-ins que vous ajoutez, vous pouvez réellement
améliorer vos capacités de traitement audio en
utilisant des plug-ins Premiere.

Vous n’avez pas besoin d’Adobe Premiere pour utiliser
des plug-ins Premiere avec Deck. Nous avons
simplement adopté l’architecture qu’Adobe a défini
pour les plug-ins audio Premiere, car elle représente
une alternative simple et ouverte aux normes très
contrôlées comme les architectures de plug-in Sound
Designer ou TDM.

Les plug-ins fournis avec Adobe Premiere lui-
même ne peuvent être utilisés dans d’autres
programmes que Premiere.

Les plug-ins Premiere sont des logiciels séparés qui
peuvent être achetés, copiés sur votre disque dur et
placés dans le dossier Deck Plug-Ins. Vos plug-ins
seront listés dans le sous-menu External Effects.

Bien que les plug-ins Premiere soit destructifs, ce qui
signifie qu’ils réécrivent physiquement les fichiers
audio pour que ceux-ci contiennent les données audio
traités, ils créent une copie de votre fichier audio et
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travaillent à partir de cette copie. Les plug-ins retirent
également l’information de crossfade de la région et
peuvent également retirer les données d’automation
de la partie de piste que vous avez traité. Il est
recommandé d’ajouter les crossfades et l’automation
après avoir traité l’audio avec les plug-ins.

Remarquez que vous devrez laisser un peu de RAM
libre dans votre système afin d’utiliser ces effets. Plus
vous pouvez laisser de RAM libre pour vos plug-ins
Premiere, plus le temps de prévisualisation de l'effet
sera long.

La prévisualisation (ou écoute) des plug-ins se passe à
travers le Sound Manager d'Apple. Si vous utilisez une
carte son compatible Sound Manager, vérifiez que
vous avez installé ses pilotes Sound Manager et qu’elle
est sélectionnée comme Sortie dans le tableau de bord
Son.

Pour appliquer un plug-in Premiere :

1. Sélectionnez l’audio dans la fenêtre Tracks, en
Mode segment ou en Mode objet, que vous
voulez traiter.

2. Choisissez le plug-in avec lequel vous voulez
traiter votre audio dans le sous-menu Process >
External Effects.

3. Ajustez les réglages du plug-in et prévisualisez le
plug-in avant de traiter l'audio sélectionné.

4. Cliquez sur le bouton Process dans le plug-in pour
traiter l'audio sélectionné.

Deck va alors traiter l'audio sélectionné avec le plug-in
et redessiner la forme d'onde.

Plug-ins VST

Deck est compatible avec le format de plug-ins VST
1.0. VST est une technologie de plug-in audio standard
développée par Steinberg Software und Hardware,
GmBH. Les plug-ins VST offrent une grande variété
d’effets en temps réel par des sociétés comme
Steinberg, Cycling ’74, Arboretum, Waves et d’autres.

Vous pouvez enchaîner jusqu’à 4 plug-ins VST par
canal en temps réel dans Deck, tant que vous avez un
processeur suffisamment rapide dans votre Macin-
tosh—les plug-ins VST sont en temps réel et dépen-
dent du processeur hôte (celui de votre Mac). Utilisez
la fenêtre CPU Meter pour contrôler l’utilisation du
système pour ne pas surcharger celui-ci avec l’utilisa-
tion de plug-ins VST.

Installation de plug-ins VST

Les plug-ins VST sont installés dans le dossier
VstPlugIns du dossier Deck, et non dans le dossier
Deck Plug-Ins. Pour installer un plug-in VST, consultez
la documentation qui était fournie avec celui-ci.

Organiser les plug-ins VST

Deck vous permet d’organiser vos plug-ins VST en
sous-dossiers. Créez des dossiers dans le dossier
VstPlugIns et déplacez les plug-ins VST dans ces
dossiers. Ceci organise vos plug-ins VST en sous-
menus dans le pop-up menu Sélecteur d’effets de la
fenêtre Mixer et de la fenêtre Master Outputs.
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réapparaître l’éditeur d’un plug-ins VST actif,
choisissez simplement Open editor dans le pop-
up menu Sélecteur d'effets ou Option-cliquez sur
le nom du plug-in VST dans la boîte Sélecteur
effets.

Inserts de canal VST dans les boîtes Sélecteur d'effets sur un canal de
la fenêtre Mixer

La fenêtre Mixer est compatible avec les plug-
ins VST mono-to-mono et stereo-to-stereo. Vous
pouvez utiliser des plug-ins VST mono-to-stereo
dans la fenêtre Mixer, mais ils sont traités en
stereo-to-stereo, et vous devriez donc panner
votre signal complètement à gauche—panner à
droite atténue le signal vers -∞ .

Pour insérer un plug-in VST dans la fenêtre Master
Outputs :

1. Dans la fenêtre Master Outputs, sélectionnez un
plug-in VST dans le pop-up menu Sélecteur
d'effets pour le canal gauche ou droite ou pour la
paire stéréo auquel vous voulez appliquer l'effet.

2. Choisissez Open editor dans le pop-up menu
Sélecteur d'effets ou Option-cliquez sur le nom du
plug-in VST pour ouvrir son éditeur.

3. Appuyez sur la Barre d'espace ou le bouton Play
de la fenêtre Transport pour entendre l’audio
traité par le plug-in VST.

4. Ajustez les réglages du plug-in VST.

5. Vous pouvez masquer l’éditeur du plug-in VST en
cliquant dans la boîte de fermeture de l’éditeur du
plug-in ou en choisissant File > Close (Com-
mande-W).  Le plug-in reste actif jusqu’à ce que
vous le retiriez, en sélectionnant Thru dans le
pop-up menu Sélecteur d'effets. Pour faire
réapparaître l’éditeur d’un plug-in VST actif,

Pop-up menu Sélecteur d’effets avec plug-ins VST et sous-menus

Insérer des plug-ins VST
Pour insérer un plug-in VST dans la fenêtre Mixer :

1. Dans la fenêtre Mixer, sélectionnez un plug-in VST
dans le pop-up menu Sélecteur d'effets du canal
sur lequel vous voulez appliquer l'effet.

2. Choisissez Open editor dans le pop-up menu
Sélecteur d'effets ou Option-cliquez sur le nom du
plug-in VST pour ouvrir son éditeur.

3. Appuyez sur la Barre d'espace ou le bouton Play
de la fenêtre Transport pour entendre l’audio
traité par le plug-in VST.

4. Ajustez les réglages du plug-in VST.

5. Vous pouvez masquer l’éditeur du plug-in VST en
cliquant dans la boîte de fermeture de l’éditeur du
plug-in ou en choisissant File > Close (Com-
mande-W).  Le plug-in reste actif jusqu’à ce que
vous le retiriez, en sélectionnant Thru dans le
pop-up menu Sélecteur d'effets. Pour faire
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choisissez simplement Open editor dans le pop-
up menu Sélecteur d'effets ou Option-cliquez sur
le nom du plug-in VST dans la boîte Sélecteur
effets.

Inserts VST dans les boîtes Sélecteur d'effets des canaux stéréo de la
fenêtre Master Outputs

La fenêtre Master Outputs est compatible avec
les plug-ins VST mono-to-mono et stereo-to-
stereo.

Inserts VST Mono, Mono-to-stereo et Stereo

Les plug-ins VST mono-to-stereo ne sont en général
pas compatibles avec Deck. Cependant, vous pouvez
les utiliser en stéréo en sachant néanmoins que le
plug-in ne passe que dans le canal de droite.

Si vous voulez utiliser un insert stéréo sur une paire de
pistes mono, mettez vos pistes mono sur des pistes
adjacentes, pannez l’une complètement à gauche,
l’autre complètement à droite, puis placez l’effet
stéréo sur les Master Outputs de cette paire.

Si vous sélectionnez le mauvais type d’insert, Deck
vous avertit et vous offre la possibilité d’annuler votre
sélection en cliquant sur le bouton Oops ou de la
garder en cliquant sur le bouton Ignore.

Plug-in Mono-to-mono dans un insert stéréo
coupe le canal de droite (vous entendez l'effet si
le pan est à gauche, du silence s’il est à droite).

Plug-in Mono-to-stereo dans un insert stéréo
coupe le canal de droite (vous entendez l'effet si
le pan est à gauche, du silence s’il est à droite).

Plug-in Mono-to-stereo dans un insert mono
envoie le canal de droite sortant du plug-in.

Plug-in Stereo-to-stereo dans un insert mono
n’est en général pas permis. Cependant, dans le
cas rare où il peut l’être, envoie le canal de droite
sortant du plug-in.

Pour retirer un plug-in VST :

• Choisissez Thru dans le pop-up menu Sélecteur
d'effets. Le plug-in VST de cet insert n’est plus
actif.

Trajet du signal par canal

Dans la fenêtre Mixer, les effets intégrés et VST mono-
to-mono sont utilisés en mono-to-mono en haut de la
chaîne (pré-fadeur, pré-pan), et les effets VST stereo-
to-stereo sont utilisés après les effets intégrés, le
fadeur et le pan.
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Si vous tentez d’assigner trop de plug-ins VST
par rapport à la puissance de votre processeur,
l’audio peut commencer à être lu de façon
erratique. Utilisez la fenêtre CPU Meter pour
contrôler l’utilisation du processeur lorsque
vous assignez des plug-ins VST.

Bouncer vos réglages de plug-in VST

Dès que les réglages de vos plug-ins VST vous
conviennent, vous pouvez appliquer les effets aux
pistes de façon permanente. Mettez simplement les
pistes que vous voulez traiter en solo, sélectionnez
Bounce to Mono Clipboard ou Bounce to Stereo
Clipboard, puis copiez le Presse-papiers sur n’importe
quelle piste disponible. Les plug-ins VST actifs seront
également appliqués en utilisant la fonction Mix to
Disk.

Pour bouncer des plug-ins VST :

1. Mettez les pistes avec les plug-ins VST actifs que
vous voulez bouncer en Solo.

2. Choisissez Process > Bounce to Mono Clipboard
ou Process > Bounce to Stereo Clipboard.

3. Placez le curseur sur les pistes de la fenêtre Tracks
à l’endroit où vous voulez placer l’audio traité.

4. Choisissez Edit > Paste (Commande-V).

5. Placez les plug-ins VST sur Thru dans le pop-up
menu Sélecteur d'effet pour les pistes originales.

6. Désactivez les boutons Solo de la fenêtre Mixer
pour les pistes originales.

7. Vous pouvez couper les pistes originales ou les
mélanger avec les pistes traitées.
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8. Appuyez sur la Barre d'espace ou cliquez sur le
bouton Play de la fenêtre Transport pour
entendre le mélange.

LE Deck LE n’est pas compatible avec les plug-ins
VST.

Conclusion

Vous avez appris à utiliser les effets intégrés destruc-
tifs, les effets en temps réel, et les plug-ins Premiere et
VST. Au chapitre suivant, vous apprendrez l’automa-
tion de volume et de pan, le mixage et le mastering.



Chapitre 6
Automation, mixage et mastering
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Chapitre 6 :
Automation, mixage et
m a s t e r i n g

Le mixage et le mastering sont en général les étapes
finales de n’importe quel processus de post-produc-
tion audio. Ils génèrent le produit final que vous aller
publier ou délivrer aux clients. Ce chapitre couvre
l’automation de la table, le mixage et le mastering.

Lorsque vous aurez fini ce chapitre, vous aurez toute la
connaissance nécessaire pour gérer un projet audio
dans Deck du début à la fin et pour produire un
master audionumérique achevé.

Automation de la table

Le fait de mixer un enregistrement multipiste en
master stéréo est toujours compliqué par les
changements de niveau et de pan stéréo qui survien-
nent pendant le processus de mixage. Les fades in et
out lisses et les changements de pan instantanés
modulés à un rythme spécifique nécessitent en
général pas mal de coordination physique et sont
difficiles à répéter. Voici pourquoi les consoles de
mixage dernier cri offrent des capacités de mixage
automatisé.

Deck vous permet de créer et d’enregistrer de
l’automation de table pour que vous puissiez
entièrement automatiser votre processus de mixage.
La façon la plus simple d’automatiser un mixage est de
créer et d’éditer des enveloppes visuelles de volume et
de pan dans la fenêtre Tracks.

Deck offre également une automation de table plus
traditionnelle en temps réel basée sur l’idée d’effec-
tuer un mixage et d’enregistrer le déplacement des

fadeurs en même temps. Cette automation de la table
crée également des enveloppes d'automation qui
peuvent être éditées visuellement dans la fenêtre
Tracks. Pour gérer l’automation de la table, Deck
utilise les concepts d’enregistrement en temps réel du
déplacement de fadeur, d’états de Mixer et de temps
de transition. L’enregistrement en temps réel du
déplacement de fadeur enregistre le mouvement réel
des fadeurs de la table et constitue une façon simple et
intuitive de créer de l’automation.

L’automation d'état de Mixer est orientée scène par
scène. Un état de Mixer est comme un cliché de la
position courante de chaque fadeur de la table.
Chaque état est stocké dans le pop-up menu État de
Mixer de la fenêtre Transport et chacun peut être
rappelé à n'importe quel moment. Un temps de
transition fixe peut être défini et ce temps est toujours
utilisé pour passer de façon lisse d’un état de Mixer à
l’autre.

Bien que l’enregistrement en temps réel du déplace-
ment de fadeur et les états de Mixer puissent sembler
un peu incommodes au début, vous verrez qu’ils
permettent souvent un enregistrement simple et en
une seule étape de l’automation de mixage.

Pour enregistrer en temps réel un déplacement de
fadeur :

1. Ouvrez la séance que vous voulez automatiser et
ouvrez la fenêtre Mixer en sélectionnant Windows
> Mixer (Commande-2).

2. Décidez quels fadeurs de volume de piste et de
pan vous voulez automatiser.

3. Utilisez le pop-up menu Automation de ces pistes
pour sélectionner quelle automation vous voulez
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enregistrer. Vous pouvez choisir Record Volume,
Record Pan ou Record All. Vous pouvez également
choisir vos contrôles par piste (par exemple
volume sur la piste 1 et pan sur la piste 2) ou vous
pouvez utiliser le sous-menu Automation du
Menu Options pour enregistrer tous les volumes
et les pans en choisissant Record All.

Pop-up menu Automation

Bien qu’il soit possible d’enregistrer l’automa-
tion en utilisant la souris comme contrôleur,
vous pourrez trouver cela assez incommode,
car la souris ne peut déplacer qu’un seul
contrôle à la fois. Pour obtenir les meilleurs
résultats, utiliser un contrôleur MIDI externe
(par exemple, un Peavey PC-1600 ou un
Tascam US-428) pour contrôler les fadeurs de
la table qui seront enregistrés. Voir “Configura-
tion MIDI” à la page 91 et “MIDI Maps” à la
page 92.

4. Cliquez sur le bouton Record de Transport, puis
cliquez sur le bouton Play (ou appuyez sur la
Barre d'espace) pour commencer l’enregistre-
ment de l’automation.

5. Effectuez votre mixage comme vous le voulez.
Tous les déplacements de fadeurs avec l’enregis-
trement activé seront enregistrés.

6. Cliquez sur le bouton Return-to-zero de Transport
(Retour chariot) et cliquez sur le bouton Play
(Barre d'espace) pour voir et entendre votre
nouvelle automation.

Les fonctions d’enregistrement fonctionnent de la
même façon avec l’automation qu’avec l’audio. Par
exemple, vous pouvez utiliser le Mode Punch-in pour
remplacer un segment d’automation comme vous
remplaceriez un segment d’audio.

Vous pouvez effacer l’automation d’une piste en
utilisant les commandes Erase du pop-up menu
Automation de la piste. Vous pouvez également
utiliser ce pop-up menu pour muter l’automation
d’une piste en réglant le pop-up menu sur Off.

Bien que le mouvement des fadeurs puisse sembler
saccadé, ne vous en inquiétez pas. L’automation de
Deck est toujours reproduite avec une précision de 24
bits (plus de 16 millions de valeurs entre volume
maximum et silence). La mise à jour de l’écran n’est
pas prioritaire sur le contrôle de volume et le niveau
de pan. Votre automation sera toujours lue de façon
lisse même lorsque les fadeurs semblent saccadés.

Pour voir les enveloppes visuelles du déplacement que
vous venez d’enregistrer :

1. Choisissez Windows > Tracks (Commande-3).

2. Régler le pop-up menu Affichage de la piste qui
contient l’automation que vous voulez éditer sur
Volume ou Pan.

Pop-up menu Affichage

Vous pouvez maintenant voir et éditer l'enveloppe
d'automation que vous avez créé lorsque vous avez
enregistré en temps réel le déplacement de fadeur
(dans l’illustration, la piste 2 est réglée pour afficher
l'enveloppe de volume). Si vous voulez éditer ces
enveloppes, il est plus facile de choisir tout d’abord
Automation Thin dans le menu Process. Automation
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Le volume de cette illustration est contrôlé (et
indiqué) par la ligne épaisse. Plus la ligne est basse,
plus le volume est bas ; le haut de la piste est le
volume maximum et le bas le silence. Si vous regardez
attentivement, vous allez voir un certain nombre de
points de rupture dans la ligne où l’angle de la ligne
change. Créer ces points, qui sont automatiquement
connectés par des lignes, est la méthode la plus simple
que vous pouvez utiliser pour automatiser un mixage.
Ajouter et éditer ces points vous permet de modifier le
mixage de façon très exacte. Ces enveloppes d'automa-
tion peuvent être éditées en utilisant les même
fonctions de base de la fenêtre Tracks que vous
utilisez pour éditer les formes d'onde.

Créer une enveloppe d'automation :

1. Utilisez le pop-up menu Affichage de l'automation
de la piste pour choisir le type d’enveloppe
d'automation que vous comptez créer ou éditer.
Pour régler toutes les pistes sur le même type
d’automation, Option-sélectionnez le type
d'automation.

Pop-up menu Affichage de l'automation de la piste

2. Les données audio de la piste se mettent en grisé
pour indiquer que vous ne pouvez pas éditer les
données en même temps que l’automation.
Lorsque le pop-up menu Affichage de l'automa-
tion de la piste est réglé sur None, vous ne voyez
et n’éditez que les données normales de la forme
d'onde. Lorsqu’il est réglé sur Volume, les
données de la forme d'onde sont toujours
montrées, mais seules les enveloppes de volume
peuvent être créées et éditées sur la piste. Dans
ce cas, le haut de la piste est le volume maximum
et le bas le silence. Lorsqu’il est réglé sur Pan, les
données de la forme d'onde sont toujours
montrées, mais seules les enveloppes de pan
stéréo peuvent être créées et éditées sur la piste.
Dans ce cas, le haut de la piste est le canal de
gauche et le bas est le canal de droite.

Thin va chercher des lignes droites dans vos données
d’automation et éliminer des points de rupture
étrangers.

Enveloppes d’automation visuelles

Contrôler le volume et le placement stéréo du son est
l’essence même d’un mixage. Deck vous permet de
contrôler le volume ou le pan de n’importe quelle
piste de lecture en temps réel et vous permet
également d’enregistrer le déplacement de fadeur de
volume et de pan lorsque vous l’effectuez. Le concept
d’effectuer un mixage est traditionnel, mais ne
constitue qu’une façon parmi d’autres d’automatiser
un mixage.

Avec l’avènement de la station de travail audionuméri-
que, de nombreuses autres méthodes pour créer des
mixages automatisés ont fait surface. La simple édition
visuelle d’une ligne graphique (enveloppe) pour
contrôler le volume et le pan est l’une des plus
puissantes et des plus flexibles de ces nouvelles
méthodes. Deck vous permet de créer et d’éditer
toutes les données d'automation de cette manière si
vous le voulez.

Imaginons que vous avez une région audio et que vous
voulez qu’elle arrive au maximum de volume, baisse
pendant la moitié de sa durée puis augmente
lentement jusqu’au volume maximum. Dans le monde
analogique, il vous faudrait lire votre bande en utilisant
votre table de mixage automatisée pour enregistrer
vous-même le déplacement physique du fadeur. Dans
Deck, vous pouvez simplement ouvrir la fenêtre
Tracks, trouver la région audio et créer cette enve-
loppe de volume.

Enveloppe d'automation de volume avec point de rupture sélectionné
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3. Vous pouvez voir le réglage exact d'un point de
rupture d’enveloppe de volume ou de pan en
regardant l’indicateur de niveau ou de pan sur
cette piste lorsque vous déplacez le point. La
valeur courante exacte est montrée dès que vous
ajustez un point.

4. Pour créer un point d'automation, enfoncez la
touche Commande et cliquez avec la souris
n'importe où dans la piste.

5. Lorsque vous faites cela, un point d'automation
de rupture apparaît avec la ligne d'automation
plate qui lui est associée. Vous avez maintenant
défini un seul réglage de niveau.

6. Continuez à Commande-cliquer n'importe où sur
la forme d'onde pour créer plus de points
d'automation et pour développer la forme
d’enveloppe globale que vous voulez. Pour
insérer un point de rupture ayant la même valeur
verticale que le précédent, appuyez sur les
touches Contrôle et Commande et cliquez sur la
nouvelle position.

À n'importe quel moment vous pouvez lire l’audio en
utilisant les contrôles de la fenêtre Transport (ou la
Barre d'espace) pour entendre la nouvelle automation.
Si vous ouvrez la fenêtre Mixer, vous pouvez égale-
ment voir les nouveaux déplacements du fadeur
reproduire l’enveloppe que vous venez de créer.

Pour ajuster un point de rupture :

• Cliquez sur le point et faites-le glisser vers une
nouvelle position. Pour contraindre le temps sur
l’unité la plus proche, appuyez sur la touche
Majuscules en même temps.

Pour supprimer un point de rupture :

• Enfoncez la touche Option et cliquez sur ce point.

Lorsque vous avez fini, vous pouvez régler le pop-up
menu Affichage de l'automation de la piste sur None
pour masquer l'enveloppe d'automation.

Vous pouvez maintenant continuer l’édition des
segments et des régions audio, si vous le voulez. Tant

que le pop-up menu État de l'automation est réglé sur
la position Play, toute automation sur la piste sera lue.

Éditer les enveloppes d'automation :

1. Utilisez le pop-up menu Affichage de l'automation
de la piste pour choisir le type d’enveloppe
d'automation que vous comptez éditer.

2. Suivez l'une des procédures suivantes :

• Pour ajuster un point de rupture, cliquez sur le
point et faites-le glisser sur une nouvelle position.

• Pour supprimer un point de rupture, Option-
cliquez sur ce point.

• Pour éditer des segments d’enveloppe d'automa-
tion, passez en Mode objet, faites glisser la souris
pour sélectionner des points de rupture puis
utilisez Commande-flèches pour les déplacer.

Vous pouvez également cliquer sur le bouton Mode
segment (touche ~) pour faire passer la fenêtre
Tracks en Mode segment. Sélectionnez un segment
d’enveloppe d'automation et éditez-le comme s’il
s’agissait d’une forme d'onde, en séparant des copies
et en les déplaçant. Pour supprimer des segments
d’automation, sélectionnez un segment de points (en
Mode segment ou objet) et appuyez sur la touche
Suppression.

Automation et défilement de film
QuickTime

Si vous travaillez avec un film QuickTime et que Chase
Positioning est activé dans le menu QuickTime, les
éditions d’automation font défiler les trames Quick-
Time. Lorsque vous déplacez un groupe de points de
rupture plus tôt ou plus tard dans une piste avec les
flèches, la fenêtre QuickTime se met à jour, en suivant
le début de votre édition d’automation. Ceci fournit
une référence visuelle aisée pour positionner
précisément les événements d’automation en synchro
avec les trames vidéo.
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Voir le chapitre 7, “QuickTime” pour plus d'informa-
tions sur les fonctions QuickTime.

Copier et coller des enveloppes
d'automation

Vous pouvez copier et coller des enveloppes
d'automation. Vous pouvez également utiliser les
fonctions de déplacement de segment et de région de
la fenêtre Tracks et les flèches pour faire glisser,
pousser sur le côté et copier des segments d’automa-
tion sur une piste ou entre des pistes. Une liste de
toutes les commandes clavier de la fenêtre Tracks,
dont les raccourcis d’automation, se trouve au
chapitre 9, “Références de Deck”.

Muter et effacer des enveloppes d'automation

Pour muter ou effacer des enveloppes d'automation :

1. Choisissez la piste sur laquelle vous voulez muter
ou effacer l’automation.

2. Restez cliqués sur le pop-up menu État de
l'automation de la piste.

3. Pour muter toute l’automation de cette piste,
placez-vous sur Off.

Ceci mute toute l’automation de la piste courante.
Cette automation n’est pas supprimée ; elle est
simplement désactivée. Pour la réactiver, réglez de
nouveau le pop-up menu État de l'automation de la
piste sur Play.

Pour effacer toute l’automation de cette piste,
sélectionnez Erase Volume, Erase Pan ou Erase All
dans le pop-up menu État de l'automation de la piste.
Le type d'automation que vous choisissez sera
supprimé de façon permanente de la piste.

Afficher/Masquer l’enveloppe d'automation

À n'importe quel moment vous pouvez utiliser le pop-
menu Affichage de l'automation de la piste pour
afficher ou masquer les enveloppes d'automation de
cette piste. Même lorsque vous avez caché les
enveloppes d'automation, les fonctions du pop-up
menu État de l'automation (Play, Off, Erase, etc.)

fonctionnent toujours. Vous n’avez pas besoin de voir
une enveloppe d'automation pour qu’elle soit lue.

Associer aux éditions audio

L’automation suit la piste, donc si vous déplacez une
piste sur une autre, son automation se déplace avec
elle. Cependant, vous pouvez parfois vouloir ne
déplacer ou copier qu’une région d’audio d’un endroit
à un autre en déplaçant l’automation en même temps.
Deck vous permet d’effectuer cela avec la commande
Conform to Audio Edits. Pour résumer, Conform to
Audio Edits associe l’automation à la région audio
pour qu’elle soit déplacée ou copiée avec cette région.

Pour activer/désactiver Conform To Audio Edits :

1. Sélectionnez Options > Automation > Conform
to Audio Edits

2. Une encoche apparaît à côté de Conform to Audio
Edits pour indiquer qu’elle est activée.

3. Sélectionnez de nouveau Options > Automation
> Conform to Audio Edits pour la désactiver.

Vérifiez que vos points de rupture d'automa-
tion se trouve dans les limites de la région
lorsque vous utilisez Conform to Audio Edits,
faute de quoi une automation irrégulière peut
survenir.

Utiliser les états de Mixer

Bien qu’il soit possible d’automatiser un mixage entier
sans utiliser les états de Mixer, ces états “instantanés”
peuvent être très pratiques (spécialement pour créer
des déplacements d’automation complexes qui
doivent survenir à des endroits spécifiques). Les états
de Mixer vous permettent de déplacer n'importe
lequel des fadeurs de volume et de pan de la fenêtre
Mixer avec un simple clic de souris. Pour utiliser un
état de Mixer pour l’automation en temps réel, vous
aurez besoin de le stocker. Dès qu’un état de Mixer a
été stocké, il peut être enregistré de la même façon
qu’une automation en temps réel. En fait, vous pouvez
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mélanger l’automation de déplacement de fadeur en
temps réel et l’automation d'état de Mixer. Les deux
types d’automation créent des enveloppes d'automa-
tion qui peuvent être éditées dans la fenêtre Tracks.

Pour stocker un état de Mixer :

1. Ouvrez la séance que vous voulez automatiser.

2. Tout en lisant l’audio, réglez les fadeurs de
volume et de pan à votre convenance. Vous
pouvez également régler ces états lorsque Deck
n’est pas en lecture.

3. Lorsque la table de mixage entière est réglée de la
façon que vous désirez, Commande-cliquez sur le
bouton situé à côté du pop-up menu dans lequel
l’état de Mixer doit être stocké.

États de Mixer stockés dans la fenêtre Transport

Vous avez maintenant stocké un état de Mixer et le
bouton situé à côté de cet état peut être utilisé à
n'importe quel moment pour rappeler ou lire cet état
dans Mixer. Remarquez que les nouveaux états sont
créés avec le nom “snap” suivi d’un nombre. Vous
pouvez renommer un état de Mixer en Commande-
cliquant sur son nom.

Deck vous permet de stocker un nombre illimité
d’états de Mixer. À chaque fois que vous en stockez
un, il est ajouté au pop-up menu État de Mixer, qui
contient tous les états de Mixer que vous avez créé
pour cette séance. Chacun des six boutons États de
Mixer peuvent être réglés pour vous permettre l’accès
instantané à un état de Mixer.

Utilisez simplement le pop-up menu État de Mixer de
la fenêtre Transport pour sélectionner l’état que vous
voulez. Cet état sera placé à côté du bouton courant
pour un accès instantané.

Pop-up menu État de Mixer

Pour rappeler un état de Mixer :

• Cliquez sur le bouton situé à gauche de l’état de
Mixer désiré. Cet état est instantanément rappelé
par la table de mixage.

Pour supprimer un état de Mixer :

• Option-cliquez sur le bouton État de Mixer pour
supprimer l’état de Mixer chargé auparavant.

Pour renommer un état de Mixer :

• Commande-cliquez sur le pop-up menu État de
Mixer pour renommer l’état de Mixer chargé
auparavant.

Tous les états de Mixer stockés sont enregistrés avec la
séance courante et seront présents à l’identique la
prochaine fois que vous ouvrirez la séance.

Pour enregistrer l’automation d'état de Mixer :

1. Ouvrez la séance que vous voulez automatiser et
ouvrez la fenêtre Mixer.

2. Réglez le temps de transition de l'état sur zéro
(choisissez Options > State Transition Time).

3. Décidez quels fadeurs de volume et de pan vous
voulez automatiser.

4. Utilisez le pop-up menu Automation sur les pistes
que vous voulez automatiser pour choisir quels
contrôles vous voulez enregistrer.
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Vous pouvez choisir Record Volume, Record Pan
ou Record All. Vous pouvez choisir vos contrôles
par piste (par exemple, volume sur la piste 1 et
pan sur la piste 2) ou vous pouvez utiliser le sous-
menu Automation du menu Options pour
enregistrer tous les volumes et les pans en
choisissant Record All. Bien que vous enregistriez
des états de Mixer, seuls les fadeurs réglés à cet
effet seront enregistrés depuis les états. Ceci vous
permet d’isoler des parties de vos états de Mixer
pour l’enregistrement de l'automation.

5. Cliquez sur le bouton Record de Transport, puis
sur le bouton Play (Barre d'espace) pour
commencer l’enregistrement de l’automation.

6. Pendant la lecture, cliquez sur les boutons d’état
de Mixer dès que vous voulez enregistrer un état
de Mixer.

L’état de Mixer sera enregistré au moment où vous
cliquez sur le bouton. Ne vous inquiétez pas de la
précision exacte du temps pour cet état. Toute
l’automation peut être éditée visuellement dans la
fenêtre Tracks après avoir été enregistrée.

Les fonctions d’enregistrement fonctionnent de la
même façon avec l’automation qu’avec l’audio. Par
exemple, vous pouvez utiliser le Mode Punch-in pour
remplacer un segment de l’état d’automation comme
si vous remplaciez un segment d’audio.

Cliquez sur le bouton Return-to-zero (ou Retour
chariot) de la fenêtre Transport, puis cliquez sur le
bouton Play (Barre d'espace) pour voir et entendre
votre nouvelle automation.

Vous pouvez effacer l’automation d'une piste en
utilisant les commandes Erase situées dans le pop-up
menu Automation de la piste. Vous pouvez également
utiliser ce pop-up menu pour muter l’automation
d'une piste en réglant le pop-up menu sur Off.

Pour enregistrer l’automation d'état de Mixer avec des
temps de fade de transition préprogrammés :

1. Choisissez Options > State Transition Time.

2. Entrez la durée du fade de transition lisse que
vous voulez, puis cliquez sur OK.

Cette durée est la période de temps qu’il faut pour
fader vers le nouvel état de Mixer. Supposons que
vous avez un état de Mixer dans lequel tous les fadeurs
de volume sont au maximum, mais que ces derniers
sont pour l’instant au minimum. Vous réglez le temps
de transition de l'état sur 2 secondes et commencez la
lecture. Après quelques instants, vous cliquez sur votre
état de Mixer “Volume au maximum”. Vous verrez
immédiatement les fadeurs commencer à se déplacer,
et, après 2 secondes, être tous en position volume
maximum. Ceci vous a permis de générer un
déplacement lisse de tous les fadeurs d’un seul coup
avec un simple clic de souris.

Pour enregistrer ce déplacement en temps réel, suivez
les mêmes étapes que celles expliquées dans
“Automation de la table” à la page 67.

Pour enregistrer des états de Mixer dans la fenêtre
Tracks :

1. Sélectionnez si vous voulez éditer le Pan ou le
Volume.

2. En Mode segment (forme d'onde), créez un point
d'insertion à l’endroit où doit se trouver
l’automation.

3. Cliquez sur l’état de Mixer correct dans la fenêtre
Tracks. Les nouvelles enveloppes d'automation
associées avec l’état de Mixer se trouvent à
l’endroit désiré.

Lorsque vous enregistrez de l’automation d'état de
Mixer avec des transitions automatisées, celle-ci peut
être éditée visuellement dans la fenêtre Tracks.

Souvenez-vous, l’automation suit la piste. Si
vous déplacez une piste vers une piste de
travail et que vous en enregistrez une
nouvelle, vous aurez besoin de créer une
automation pour la nouvelle piste.
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Bouncer des pistes dans Deck

Bouncer est le processus constituant à sous-mixer
plusieurs pistes ensemble pour créer une ou deux
nouvelles pistes. La nouvelle piste est ensuite utilisée à
la place des pistes sources originales, libérant du coup
des pistes occupées. Sur la plupart des systèmes
quatre ou huit pistes, bouncer représente une solution
aux problèmes causés par un nombre limité de pistes.
Bien que Deck n’impose aucune restriction quant au
nombre de pistes pouvant être mixées ensemble, il
permet également de bouncer. Pour plus d'informa-
tions, voir “Mixage virtuel” à la page 75. Deck apporte
de grosses améliorations par rapport au bounce
analogique : il bounce les pistes numériquement, ce
qui ne dégrade par la qualité sonore des pistes
sources. De même, Deck vous permet de conserver
toutes vos pistes sources, pour que vous puissiez
toujours revenir aux pistes originales et rebouncer un
nouveau sous-mixage (le bounce analogique nécessite
en général que les pistes sources soient effacées pour
que les nouvelles pistes puissent être enregistrées).

Deck vous permet de bouncer les pistes de façon
purement visuelle. Pour bouncer des pistes dans Deck,
sélectionnez simplement un segment de temps dans la
fenêtre Tracks et choisissez l’une des commandes
Bounce to Clipboard. Votre bounce commence
immédiatement et la piste ou la région résultante peut
être placée où vous le désirez.

Pour bouncer des pistes :

1. Passez en Mode segment en cliquant sur le
bouton Mode segment (touche ~) :

2. Faites glisser la souris pour sélectionner le
segment de destination de vos pistes bouncées.

Lorsque vous bouncez dans Deck, toutes vos pistes de
lecture sont inclues dans le bounce, à l’exception des
pistes mutées. Pour cette raison, peu importe en fait
sur quelle piste vous choisissez de sélectionner le
segment. Vous pouvez même sélectionner directe-

ment le segment de destination plutôt que le segment
source. Ceci vous ramène à la fenêtre Tracks après que
le bounce soit achevé et ne vous demande que
d’utiliser la commande Paste At pour finir le bounce et
coller le nouvel audio au point approprié dans le
temps. Souvenez-vous de sélectionner deux pistes de
destination si vous choisissez Bounce to Stereo
Clipboard.

3. Si vous voulez vérifier que certaines pistes ne sont
pas utilisées comme source dans un bounce,
mutez ces pistes. Mute et Solo sont pris en
compte lorsque vous choisissez Bounce to the
Clipboard. Réglez également le pop-up menu
Automation sur Play pour inclure l’automation.

4. Choisissez Process > Bounce All to Mono
Clipboard (Commande-Majuscules-B) ou Bounce
All to Stereo Clipboard (Commande-Option-B).

5. Lorsque le bounce est achevé, vous revenez à la
fenêtre Tracks et votre segment sélectionné à
l’origine est toujours sélectionné.

6. Choisissez Edit > Paste At (Commande-Option-V)
pour coller la région nouvellement bouncée à
l’endroit approprié dans le temps.

Vous êtes maintenant libres de supprimer les régions
qui étaient utilisées pour créer le bounce. Utilisez les
flèches haut et bas pour déplacer le segment
sélectionné vers le haut ou le bas des pistes que vous
voulez supprimer pour un montage ultra-précis. Vous
pouvez aussi simplement déplacer les pistes utilisées
comme source pour le bounce dans la zone Pistes de
travail, où elles ne seront pas lues. Ceci est la meilleure
option, car elle vous permet de revenir à vos pistes
sources originales si vous le désirez.
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Mixage virtuel

Un des gros avantages de l’utilisation d’une station de
travail audionumérique comme Deck est que vous
n’êtes pas gênés par les limites du monde analogique.
Les enregistreurs et les tables analogiques sont
physiquement limités au nombre de pistes qui
peuvent être lues. Deck n’effectuant pas son mixage
en temps réel, il n’y a pas de limites à la quantité
d’audio qu’il peut mixer (autre que l’espace du disque
dur). Bien que vous ne puissiez lire que la quantité de
pistes de lecture en temps réel simultanées que votre
système peut gérer, vous pouvez créer jusqu’à 999
pistes de travail.

La fonction mixage virtuel contrôle quelles pistes Deck
va mixer lorsque vous choisissez d’utiliser les fonctions
Bounce to Disk ou Mix to Disk. Lorsque Virtual Mix est
activé dans le menu Process, Deck va mixer l’audio de
vos pistes de lecture et l’audio des pistes de travail
avec l’automation de volume et de pan que vous avez
créé.

Pour utiliser le mixage virtuel :

1. Choisissez Process > Virtual Mix pour activer le
mixage virtuel. Une encoche apparaît à côté de
l’élément de menu Virtual Mix. Maintenant, dès
que vous choisissez une commande Bounce ou
Mix, Deck va mixer les pistes de travail et les
pistes de lecture dans le nouveau fichier.

2. Enregistrez vos pistes comme d’habitude. Ajoutez
l’automation que vous désirez aux nouvelles
pistes.

3. Lorsque vous avez rempli les pistes de lecture,
créez des pistes de travail en sélectionnant New
Track dans le menu Process. Entrez le nombre de
pistes de lecture que vous avez enregistré dans la
boîte de dialogue. Vous avez maintenant de
nouvelles pistes de travail qui vont servir de pistes
de destination aux pistes que vous venez
d’enregistrer.

4. Déplacez les pistes sur les pistes de travail.
Utilisez le pop-up menu Nom de piste pour
sélectionner Piste 1 sur la première piste de
travail, Piste 2 sur la seconde, etc.

5. Sélectionnez New dans le pop-up menu Nom de
piste pour chacune des pistes de lecture.

6. Répétez les étapes ci-dessus jusqu’à avoir
enregistré tout votre matériau. Lorsque vous avez
fini l’enregistrement et l’édition, créez un master
comme décrit dans “Mastering final vers un fichier
disque mono ou stéréo” à la page 76.

Comme vous aviez sélectionné Virtual Mix, le nouveau
fichier audio qui est créé par le mixage ou le bounce
contient le son de toutes vos pistes de lecture, plus
vos pistes de travail et toutes les automations et effets
associés.

Si vous choisissez Bounce to Clipboard, votre nouveau
mixage se trouve dans la mémoire du Presse-papiers et
vous pouvez le coller dans la séance.

Si vous avez choisi Mix to Disk, votre nouveau fichier
de mixage est sur votre disque dur dans le dossier que
vous avez sélectionné et peut être importé dans votre
séance en utilisant la boîte de dialogue Add Audio to
Clipboard.

Utiliser le mixage virtuel va rapidement utiliser de
l’espace du disque dur. Si votre espace de disque dur
est limité, vous feriez mieux de bouncer des pistes et
de compacter votre séance. Dans les deux cas, soyez
sûrs de laisser assez d’espace de disque dur pour le
processus Mix to Disk final. Par exemple, à un taux de
44,1 kHz, vous devriez laisser environ 5 Mo par minute
pour un mixage mono et 10 Mo par minute pour un
mixage stéréo.

Pour plus d'informations sur le déplacement des pistes
et l’utilisation des pistes de travail, voir le chapitre 4
“Édition visuelle de la forme d'onde”.
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Renommer les pistes

Si vous comptez enregistrer beaucoup de pistes, il est
recommandé de les renommer. En utilisant le système
de noms par défaut (Piste 1, Piste 2, Piste 3, etc.) vous
ne vous y retrouverez plus avec beaucoup de pistes.

Pour renommer une piste :

1. Commande-cliquez sur le nom de la piste.

2. Entrez un nouveau nom dans la boîte de dialogue.

Pour plus d'informations sur l’organisation des pistes
dans Deck, voir “Astuces pour la gestion des fichiers” à
la page 164.

Mastering final vers un fichier
disque mono ou stéréo

La dernière étape d’un projet d'enregistrement est en
général le processus de mastering. Pendant le
mastering, un mixage final stéréo de l'enregistrement
est créé. Cette version stéréo est le master à partir
duquel toutes les copies distribuées seront fabriquées.
Pour cette raison, le master doit être la meilleure copie
possible du mixage final.

Dès que votre mixage final est automatisé comme vous
le voulez, vous êtes prêts pour le processus de
mastering numérique. Dans ce processus, vous
utiliserez Deck pour créer un fichier son mono ou
stéréo au format Sound Designer II, Audio
Interchange (AIFF), Sound Resource, QuickTime ou
.WAV sur votre disque dur. Ce fichier son sera une
copie numérique exacte du mixage à partir duquel il
est créé, y compris tous les effets de traitement, les
réglages de niveau et de pan et l’automation.

Souvenez-vous que vous aurez besoin de suivre
certaines étapes de travail avant de créer un
master numérique. Si votre séance lit un
fichier MIDI synchronisé dans le séquenceur
Metro, la fenêtre MIDI ou un autre séquenceur
MIDI, les pistes MIDI ne seront évidemment pas

incluses dans un master numérique avant
d’avoir été enregistrées numériquement. La
façon la plus simple pour faire cela est
d’observer la procédure suivante :

1. Lorsque toutes vos pistes audio sont automatisées
et prêtes pour le mastering, sélectionnez Virtual
Mix dans le menu Process. Utilisez la procédure
décrite dans la partie Mixage virtuel pour libérer
deux pistes de lecture. Si vous êtes limités par
l’espace disque, sélectionnez Bounce All to Stereo
Clipboard dans le menu Process pour bouncer
toutes vos pistes de lecture vers une image stéréo
finale, puis collez ces régions bouncées sur les
pistes 1 et 2, par exemple.

2. Mixez la lecture de votre machine MIDI dans une
image stéréo sur votre table de mixage et
enregistrez-la en stéréo sur deux pistes restan-
tes—les pistes 3 et 4, par exemple. Vous avez
maintenant votre audio original plus vos pistes
d’instrument MIDI sous forme d’audio stéréo.

3. Ajoutez une automation supplémentaire de table
ou les effets dont vous pourriez avoir besoin et
vous êtes prêts pour le mastering.

Créer un master numérique sur disque dur d’une
séance :

1. Ouvrez la séance que vous voulez masteriser
(Commande-O). Vérifiez qu’elle est lue exacte-
ment comme vous voulez que sonne le fichier de
mixage final, car le master sera une copie exacte
de la séance telle que vous l’entendez maintenant.

2. Si vous utilisez Virtual Mix, vérifiez de bien
entendre chaque piste de travail dans une piste de
lecture avant le mixage. Le mixage virtuel ne
sonnera pas exactement comme la séance, car il
ajoute les données des pistes de travail au mixage,
qui ne peuvent être entendues pendant la lecture
en temps réel.

3. Choisissez Windows > Tracks (Commande-3).

4. Si vous voulez ne mixer qu’une partie de la séance
sur disque, sélectionnez le segment que vous
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voulez mixer avant de choisir la commande Mix to
Disk.

Souvenez-vous, toutes vos pistes de lecture (et
pistes de travail, si Virtual Mix est activé) sont
mixées sur disque, même si vous ne sélectionnez
qu’un segment (ou que des régions) d’une seule
piste. Pour retirer des pistes du mixage, mutez
celles-ci et/ou desélectionnez Virtual Mix dans le
menu Process. Vérifiez de bien sélectionner Play
dans le pop-up menu Automation pour inclure
l’automation dans le mixage.

Si vous voulez mixer la séance entière sur disque,
vérifiez qu’aucun segment ou région audio n’est
sélectionné. Vous pouvez choisir Deselect dans le
menu Edit pour vérifier qu’aucun audio n’est
sélectionné. Remarquez que vous pouvez
également choisir Select All avant de mixer sur
disque pour vérifier que le fichier de séance entier
est mixé.

7. Choisissez Mix to Disk dans le menu Process.

Boîte de dialogue Mix to Disk

8. Entrez le nom que vous voulez utiliser pour votre
fichier son master. Par défaut, il s’agit toujours du
nom de la séance suivi de “mix”. C’est sans doute
une bonne idée d’utiliser ce système de nom, car
il associe le master et la séance source et

empêche de remplacer accidentellement un
fichier existant important.

9. Sélectionnez le dossier de destination pour le
master.

10. Choisissez parmi les options suivantes :

Format—règle le type de fichier que vous voulez
créer. Choisissez parmi les formats suivants :

Sound Designer II (SDII)—Le format le plus
courant. Il s’agit du format natif utilisé par Deck,
compatible avec un grand nombre de program-
mes audio. Si vous créez des masters stéréo 16
bits pour le mastering de CD, c’est en général le
format de choix.

Audio Interchange File Format (AIFF)—
Format audio haute  résolution populaire. Il n’y a
pas de différence de qualité ou de portabilité
entre les fichiers Sound Designer II et AIFF. Les
fichiers AIFF sont mieux appropriés à un échange
de fichier entre plate-formes et furent conçus
dans cette intention. Cependant, les fichiers AIFF
ne vous permettent pas d’enregistrer des
définitions de région dans le fichier son et ne
peuvent être utilisés pour un enregistrement
direct de l’audio dans Deck ou Sound Designer
II. Pour cette raison, les fichiers Sound Designer
II sont en général suggérés.

Sound Resource (.SND)—Format standard de
fichiers audio d’Apple qui possède le plus haut
niveau d’intégration. Les fichiers Sound Resource
huit bits sont utilisés sur les systèmes Macintosh
plus anciens et peuvent être lus par le haut-
parleur interne du Macintosh directement depuis
le Bureau, simplement en double-cliquant sur
leurs icônes. Ces Sound Resource 8 bits sont
facilement intégrées dans des programmes
comme Macromedia Director ou Adobe
Premiere, bien que l’audio 16 bits soit de plus en
plus compatible avec de nombreux programmes.

Wave (.WAV)—Format de fichier son Windows
pratique pour transférer des sons ou des mixages
de séance vers la plate-forme Windows.
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QuickTime—Les fichiers son peuvent être
utilisés pour des films QuickTime ou comme
lecteurs autonomes de fichier son audio
Macintosh. Ce format est spécialement pratique
pour transférer de courts fichiers son démos sur
Internet ou pour toute personne ayant un
ordinateur Macintosh ou IBM compatible
QuickTime.

Sample rate—Règle le taux d'échantillonnage que
vous voulez pour votre fichier de mixage final. Le
pop-up menu vous permet de choisir parmi
plusieurs taux d'échantillonnage standards,
comme 44100 Hz et 22050 Hz, mais vous pouvez
aussi entrer un taux dans la boîte du pop-up.
Vous utiliserez des taux différents pour différents
besoins. 44 100 Hz est le taux standard du CD. En
général, des taux d'échantillonnage plus élevés
sont meilleurs car ils offrent une fidélité plus
élevée. Cependant, ils nécessitent également plus
d’espace disque. Des taux comme 22050 Hz
conviennent pour un travail multimédia, car ils
occupent moins d’espace—mais plus le taux est
bas, plus l’audio contient du bruit, donc
choisissez le taux le plus bas avec soin.

Si vous mixez vers un fichier Sound Resource 8
bits pour une lecture à partir du Bureau, le
réglage 22050 Hz produira de très bons résultats.

Bit Depth—Spécifie le nombre de bits que vous
voulez pour votre fichier master lorsque l’audio
est mixé. Vous pouvez choisir entre 8 bits et 16
bits (souvenez-vous de sélectionner une
méthode Bit-Depth Conversion appropriée pour
votre séance si vous convertissez en 8 bits). Si
vous voulez créer un vrai master haute-fidélité,
choisissez toujours 16 bits.

Number of Channels—Détermine si votre mixage
sera un fichier mono, un fichier stéréo (entrelacé)
ou des fichiers stéréo séparés (qui auront
automatiquement les suffixes .L et .R attachés à
leurs noms de fichier). Si vous faites un mastering
pour graver un CD-ROM, essayez d’utiliser
l’option Stereo (entrelacé), qui combine les
canaux gauche et droite dans un seul fichier. Si

vous comptez utiliser votre mixage plus tard dans
Deck, sélectionnez l’option Split Stereo, qui
donne pour résultat des fichiers séparés gauche
(.L) et droite (.R).

Bit Depth Conversion—Règle la méthode de
conversion 16 à 8 bits. Si vous convertissez votre
fichier 16 bits en fichier 8 bits, Bit Depth
Conversion vous permet d’améliorer la sonorité
des fichiers 8 bits.

Truncation—Prend l’octet le plus haut de votre
fichier son comme valeur d’échantillon et jette
l’octet le plus bas. Truncation peut souvent
générer des artefacts ou du bruit déplaisant—
spécialement sur des signaux bas niveau et la voix
parlée.

Rounding—Traite l’échantillon 16 bits original
comme un nombre à virgule, avec la partie
décimale entre les octets. Si l’octet le plus bas est
supérieur ou égal à 0,5, alors 1 est ajouté à l’octet
le plus haut et celui-ci est pris comme valeur
d’échantillon.

Convergent Rounding—Diffère de Rounding
dans la façon dont il traite la valeur de 0,5 dans
l’octet le plus bas de votre fichier son—1 n’est
ajouté à l’octet le plus haut que dans le cas où la
valeur de l’octet le plus bas est supérieure ou
égale à 0,5 et que l’octet le plus haut est pair.
Sinon, l’octet le plus haut est pris comme valeur
d’échantillon.

Dithering—Est similaire à la fonction Dithering
des programmes de création visuelle. Le
Dithering applique un signal de bruit bas niveau
sur le fichier son pour couvrir les artefacts
désagréables causés par Truncation. Cette
méthode est également appelée Error Diffusion
Dithering.

En général, Rounding et Dithering produisent de
meilleurs résultats que Truncation, mais les
résultats de ces méthodes de conversion
dépendent de votre matériau source. Expérimen-
tez avec différents genres de conversion pour voir
ce qui fonctionne le mieux pour vous.
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11. Cliquez sur Save pour créer le fichier de mixage
numérique.

Deck utilise exactement le même ensemble de
routines pour créer un fichier de mixage que pour lire
les pistes source. Pour cette raison, vous pouvez être
absolument sûrs que le fichier de mixage sera une
vraie copie du mixage de la séance. Dès que vous avez
créé un master numérique de votre séance, vous êtes
libres de le transférer sur un support transportable
pour le faire dupliquer. Encore mieux, utilisez Peak de
BIAS pour masteriser votre mixage stéréo et le graver
vous-même sur CD.

Conclusion

Vous avez appris comment mixer et masteriser dans
Deck. Dans le chapitre suivant, vous apprendre à
utiliser Deck pour illustrer des films QuickTime.
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Chapitre 7 :
Qu ickT ime

Deck est le complément parfait d'un programme de
création de film QuickTime, comme Adobe Premiere,
Final Cut Pro ou iMovie. Vous pouvez importer un film
QuickTime existant dans Deck et ajouter de l’audio
synchronisé à ce film, en exploitant toutes les
fonctions d’édition audio, de traitement et de mixage.

Deck est capable de lire plusieurs pistes audio 16 bits
et un film QuickTime—en plus de la bande son
originale de ce film, si désiré—simultanément depuis
un seul disque dur. Vous pouvez ajouter de la
musique, de la narration et des effets sonores à votre
film QuickTime et l’exporter sous forme d’un nouveau
film avec sa bande son mixée en plusieurs taux
d’échantillonnage et nombre de bits pour la distribu-
tion, le multimédia, la production de CD-ROM ou juste
pour vous amuser.

L’extension QuickTime d'Apple, version 3.0 ou
supérieure, doit être installée dans votre Macintosh
(QuickTime est en général inclus dans le logiciel
Système d’Apple, mais si vous ne l’avez pas, vous
pouvez le télécharger depuis le site Web d'Apple ou en
contactant Apple directement). Il est également utile
d’avoir un programme de lecture de film, comme
Lecture QuickTime, si vous voulez être capable de lire
vos films QuickTime indépendants finis sans ouvrir
Deck.

Importer un film QuickTime

Lorsque vous importez un film QuickTime qui a déjà
une bande son, vous pouvez supprimer ou importer
l'audio du film avec celui-ci. Si vous importez l'audio
du film, Deck convertit l'audio du film en 16 bits au
taux d'échantillonnage de votre session.

Pour importer un film QuickTime dans Deck :

1. Créez une nouvelle séance ou ouvrez la séance
que vous voulez synchroniser à un film Quick-
Time.

2. Sélectionnez QuickTime > Import Movie.

3. Localisez et sélectionnez le film désiré.

4. Sélectionnez l'une des options suivantes :

• Put on Clipboard—Retire la bande son existante du
film QuickTime et la convertit en fichier Sound
Designer II 16 bits monophonique au taux
d'échantillonnage sélectionné dans votre séance.
Ces fichiers sont créés dans le dossier Audio Files
de la séance puis placés dans le Presse-papiers
pour être collés dans n'importe quelle piste de la
fenêtre Tracks. Pour être sûr que le fichier du
Presse-papiers soit en synchro avec le film
importé, vous devrez le faire glisser ou le coller
pour qu’il commence au début de la séance.

Si l'audio source était stéréo, vous devrez
sélectionner deux pistes dans la fenêtre Tracks
lorsque vous collez l'audio.

• Put in new work track(s)—Retire l'audio source du
film QuickTime et le convertit en fichier Sound
Designer II 16 bits monophonique. Ces fichiers
sont créés dans le dossier Audio Files de la séance
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puis placés sur de nouvelles pistes de travail en
bas de la fenêtre Tracks. Pour lire ces pistes,
cliquez sur les zones de contrôle de la piste pour
sélectionner la piste, puis faites glisser la piste vers
une des pistes de lecture (vous pouvez également
utiliser le pop-up menu situé en bas d'une piste
de la fenêtre Mixer pour déplacer ces nouvelles
pistes vers des pistes de lecture). Choisissez cette
option pour vérifier que l’audio QuickTime
original sera inclus dans tous les mixages stéréo 16
bits et les films QuickTime exportés.

• Discard—Importe le film QuickTime sans son
audio original.

Vous pouvez changer la taille de la fenêtre QuickTime
en utilisant le sous-menu Size du menu QuickTime. Si
vous avez ajouté l'audio du film dans le Presse-papiers,
vous devrez le coller sur une piste en choisissant Edit
> Paste At ou en faisant glisser l'audio sur la fenêtre
Tracks depuis la fenêtre Library. Vérifiez de bien placer
l'audio du film au tout début de la séance. Le film
QuickTime sera toujours lu en synchro avec la séance
Deck et ouvert en même temps que celle-ci.

Les séances sont réglées pour avoir une durée par
défaut de 10 secondes si elles ne contiennent pas
d’audio. Si vous voulez lire un film QuickTime sans sa
bande son originale, utilisez Session End Time dans le
menu Session pour régler la durée de la séance afin
qu’elle soit au moins aussi longue que la durée du
film.

Fenêtre QuickTime

Pour ouvrir la fenêtre QuickTime ou pour l’amener au
premier plan de l'écran dans le cas où elle est
recouverte par d’autres fenêtres, sélectionnez
QuickTime dans le menu Windows (Commande-4). La
fenêtre QuickTime ne contient pas de contrôles. La
lecture du film est contrôlée par les contrôles de
Transport. Cependant, remarquez que vous pouvez
faire défiler le film QuickTime en restant cliqué dans la
fenêtre QuickTime—déplacez le curseur sur la gauche
pour faire défiler en arrière et sur la droite pour faire
défiler en avant.

Outils QuickTime

Maintenant que vous avez  importé un film QuickTime
dans Deck, familiarisez-vous avec les outils QuickTime.

Voici certains des outils QuickTime que vous
trouverez dans le menu QuickTime :

Dispose Movie—Ferme le film courant pour que
vous puissiez en importer un autre ; un seul film
QuickTime peut être ouvert à la fois.

Get Movie Info—Ouvre une boîte de dialogue qui
vous montre l’information sur le film courant, dont
son emplacement sur votre disque dur, la date à
laquelle le film a été créé, le nombre de trames, les
trames par seconde et la durée.

Copy Frame—Copie la trame du film qui est affichée
dans le Presse-papiers. Vous pouvez ensuite coller
cette trame dans l’Album ou dans un programme
de traitement de texte ou d’image comme
Microsoft Word ou Adobe Photoshop. La trame est
toujours copiée à la taille à laquelle vous la voyez.
Vous pouvez également utiliser Copy Frame pour
copier une trame de vidéo en direct depuis la
fenêtre Live Video.

Set Poster—Règle et enregistre la trame poster
courante du film QuickTime—ou prévisualisation.
La trame poster est la trame utilisée comme icône
du film et comme la trame de prévisualisation qui
apparaît lorsque des programmes comme Deck
montre les films QuickTime à importer ou à
ouvrir.

Chase Positioning—Active le mode de suivi
QuickTime, qui fait automatiquement défiler le
film QuickTime avec l'audio et l’automation dans
la fenêtre Tracks. La fenêtre QuickTime se place
sur la trame courante lorsque les régions audio
sont déplacées (la trame située au temps de départ
de la région est toujours montrée). Vous pouvez
également sélectionner une région audio dans la
fenêtre Tracks, puis faire défiler dans la fenêtre
QuickTime (restez cliqués et faites glisser à gauche
ou à droite) pour repositionner l’audio sélectionné
au début de la trame courante. Ceci est une
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Center—Place la fenêtre QuickTime au centre de
votre moniteur sans la barre de titre.

Défilement de la vidéo QuickTime

QuickTime possède deux autres fonctions : l’une sert à
faire défiler la vidéo pour vous déplacer sans à-coups
dans la vidéo située sur votre disque dur ; l’autre sert à
faire défiler jusqu’à un point, ce qui vous permet de
sélectionner une région audio dans la fenêtre Tracks,
et de vous déplacer dans les trames vidéo pour placer
l’audio sur une trame QuickTime spécifique.

Pour faire défiler la vidéo en direct depuis le disque
dur :

1. Placez le curseur de la souris sur la fenêtre
QuickTime et restez cliqués sur le bouton. Le
curseur en forme de flèche se transforme en
triangle droite-gauche.

2. Faites glisser vers la gauche (plus tôt) ou la droite
(plus tard) pour faire défiler la vidéo directement
depuis le disque dur.

Pour faire défiler jusqu’à un point :

1. Choisissez QuickTime > Chase Positioning.

2. Sélectionnez une région audio ou un groupe de
régions dans la fenêtre Tracks.

3. Placez le curseur de la souris sur la fenêtre
QuickTime et restez cliqués sur le bouton. Le
curseur en forme de flèche se transforme en
triangle droite-gauche.

4. Faites glisser vers la gauche (plus tôt) ou la droite
(plus tard) pour trouver la trame vidéo sur laquelle
l'audio sélectionné doit commencer. Puis relâchez
le bouton de la souris pour pointer automatique-
ment les régions sélectionnées sur cette trame.

Lorsque vous relâchez, toute la sélection de la fenêtre
Tracks est déplacée pour commencer sur la trame que
vous avez choisi. Utilisez cette fonction pour repérer
rapidement des effets sonores ou des indications de
musique.

fonction rapide et indispensable pour repérer de
la musique, des dialogues et des effets sur des
trames de film QuickTime spécifiques.

Si Chase Positioning est activé, déplacer des points de
rupture d’automation de volume ou de pan le long la
ligne temporelle de la piste fait également défiler les
trames QuickTime, vous permettant de positionner
rapidement des événements d’automation avec une
précision inférieure à la trame.

Set Offset—Vous permet de démarrer le film à un
autre moment que le début de la séance.
Normalement, lorsque vous importez un film
QuickTime dans Deck, celui-ci commence au
début de la séance.

Live Video—Est pratique si vous utilisez Deck pour
ajouter de la musique ou des effets à une vidéo
analogique en direct provenant du port vidéo de
votre Macintosh AV ou des entrées d’une carte
vidéo.

Configure Live Video—Configure le signal vidéo
entrant, comme la sélection d’une compression,
d’une profondeur de couleur et d’un taux de
trame. Les options disponibles dépendent de votre
matériel vidéo.

Les fonctions QuickTime en temps différé comme faire
défiler ou suivre la position vous permettent de voir et
d’examiner toutes les trames QuickTime d’un film
donné, jusqu’à 30 trames par seconde, quelle que soit
la vitesse de votre ordinateur ou le débit de votre
disque, et ne nécessitent pas de matériel vidéo
supplémentaire. Même si votre installation ne lit pas la
vidéo plein écran en temps réel, vous pouvez toujours
l’examiner et l’éditer précisément à 30 trames par
seconde avec QuickTime.

Size—Règle la taille de votre fenêtre de film
QuickTime. Remarquez que l’option Size ne
modifie pas la taille réelle du film QuickTime et
que celui-ci revient à sa taille originale lorsque
vous l’exporter. L’option Size ne modifie que la
taille de la fenêtre QuickTime et sert à faciliter le
travail avec QuickTime dans Deck.
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Lorsqu’un film QuickTime est importé dans Deck et
que vous connaissez bien les fonctions QuickTime,
vous pouvez ajouter de l’audio multipiste à votre vidéo
numérique. Toutes les fonctions d’importation,
d’enregistrement, d’édition, d’agencement, de
traitement et de mixage audio peuvent être utilisées
pour ajouter une bande son à votre film.

Dès que vous avez fini votre bande son, vous pouvez
exporter votre film sous forme d’un nouveau film
QuickTime mis à plat avec le nouvel audio attaché.

Exporter le film QuickTime final

Si vous utilisez Deck comme outil de post-production
audio QuickTime, la dernière étape de votre processus
est assez similaire au processus de mastering audio
final décrit au chapitre 6 “Automation, mixage et
mastering”. La principale différence est que vous créez
un fichier fini constitué d’un film lisible depuis le
Bureau ainsi que de son. Le processus de mixage d’un
film QuickTime final (avec de l’audio) depuis la séance
courante est très simple.

Créer un film QuickTime final avec l’audio de la séance
:

1. Ouvrez la séance qui contient l'audio et le film que
vous voulez mixer.

2. Vérifiez que la séance et son film sont lus
exactement comme l’apparence que doit avoir le
produit final. Le film exporté sera une copie exact
de la séance telle que vous la voyez et l’entendez.

3. Choisissez QuickTime > Export Movie.

Boîte de dialogue Export Movie

La boîte de dialogue Export Movie permet de créer de
nouveaux films QuickTime contenant (ou faisant
référence à) des pistes audio AIFF 8 ou 16 bits, mono
ou stéréo, à plusieurs taux d'échantillonnage
possibles. Le film exporté contient l’audio édité,
l’automation et les effets audio. Imaginez la com-
mande Export Movie comme une commande  de
mixage sur disque pour l’image et le son. C’est en
général la dernière étape dans le processus de post-
production audio QuickTime et le résultat peut être
relu sur un ordinateur compatible QuickTime.

4. Choisissez un dossier de destination et entrez un
nom pour le film.

5. Sélectionnez l'une des options suivantes :

Make movie self-contained—Crée un film
indépendant entièrement nouveau. Ce film est
constitué d’un seul document QuickTime qui
contient toutes les images et le son. Selon les
spécifications de QuickTime, le son et les images
sont entrelacés pour créer un film compatible et lu
efficacement. Remarquez qu’il faut un certain délai
à Deck pour créer un tel film, car cela nécessite
une étape supplémentaire (mis à plat). Souvenez-
vous, un film indépendant est en général un
document assez gros.
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Faites un film indépendant lorsque vous voulez
créer un seul document pour le faire parvenir à
quelqu’un. Si vous êtes simplement en train de
tester des éditions et des mixages, ne faites pas de
film indépendant. Lorsque le film n’est pas
indépendant, un nouveau document film
extrêmement petit (en général autour de 30 Ko)
est créé. Tout comme une séance Deck, ce
document fait simplement référence au son source
et aux fichiers d’images. La commande Informa-
tions de Lecture QuickTime peut toujours être
utilisée pour déterminer quels fichiers audio et
images sont utilisés par un film qui n’est pas
indépendant.

Make playable on Non-Apple Computers—Crée
un film indépendant lisible sur d’autres plate-
formes compatibles QuickTime, comme Windows.
Ceci va aplatir votre film et en retirer toutes les
données spécifiques au Macintosh. Vous devez
cocher “Make movie self-contained” afin d’utiliser
cette option.

Add audio to movie—Détermine si l'audio de la
séance courante sera mixé, converti et ajouté au
film fini. Vous laisserez en général cette option
activée. Lorsqu’elle est désactivée, un document
film silencieux est créé et les données audio
restent dans Deck.

Audio Format—Spécifie le nombre de bits que doit
avoir votre fichier de mixage audio lorsque l'audio
est mixé et que le film est exporté. Un fichier son
AIFF est toujours créé à moins que vous ne
choisissiez “Make movie self-contained”, auquel
cas l'audio est placé directement dans les données
d’images du film. Vous pouvez choisir entre 8 bits
mono, 8 bits stéréo, 16 bits mono ou 16 bits
stéréo. Le format 8 bits mono nécessite moins
d’espace disque, prend moins de temps à charger
sur Internet et sera lu plus efficacement sur des
ordinateurs Macintosh plus anciens. Si vous voulez
créer un master haute-fidélité, choisissez 16 bits
stéréo.

Sample rate—Règle le taux d'échantillonnage que
doit avoir l’audio de votre film QuickTime final.

Vous pouvez sélectionner l’un des taux standards,
en sélectionner d’autres et entrer un taux dans le
pop-up menu. En général, des taux d'échantillon-
nage plus élevés sont meilleurs car ils offrent une
fidélité plus grande. Ils nécessitent cependant plus
d’espace disque. Pour obtenir la plus haute fidélité
possible, réglez ce pop-up menu sur le taux
compatible le plus élevé, comme 48000 ou 44100
Hz. Ceci va mixer votre audio sous forme d’une
bande son de qualité CD, mais va également créer
un grand document film. Si vous n’avez pas besoin
d’audio en qualité CD ou si vous devez obtenir un
film plus petit, un taux de 22050 Hz fournit un bon
équilibre entre la qualité audio et la taille du
fichier.

Bit Depth Conversion—Spécifie la méthode
d’échantillonnage vers le bas. Si vous convertissez
votre fichier Deck 16 bits en fichier 8 bits, Bit
Depth Conversion rend possible la création de
fichiers 8 bits sonnant mieux.

Truncation—Prend l’octet le plus haut de votre
fichier son comme valeur d’échantillon et jette
l’octet le plus bas. Truncation peut souvent
générer des artefacts ou du bruit déplaisant—
spécialement sur des signaux bas niveau et la voix
parlée.

Rounding—Traite l’échantillon 16 bits original
comme un nombre à virgule, avec la partie
décimale entre les octets. Si l’octet le plus bas est
supérieur ou égal à 0,5, alors 1 est ajouté à l’octet
le plus haut et celui-ci est pris comme valeur
d’échantillon.

Convergent Rounding—Diffère de Rounding dans
la façon dont il traite la valeur de 0,5 dans l’octet le
plus bas de votre fichier son—1 n’est ajouté à
l’octet le plus haut que dans le cas où la valeur de
l’octet le plus bas est supérieure ou égale à 0,5 et
que l’octet le plus haut est pair. Sinon, l’octet le
plus haut est pris comme valeur d’échantillon.

Dithering—Est similaire à la fonction Dithering des
programmes de création visuelle. Le Dithering
applique un signal de bruit bas niveau sur le
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fichier son pour couvrir les artefacts désagréables
causés par Truncation. Cette méthode est
également appelée Error Diffusion Dithering.

Si vous mixez un film QuickTime avec un son 8
bits pour la lecture à partir du Bureau, un taux
d'échantillonnage de 22050 Hz avec les réglages
Dithering ou Convergent Rounding produisent de
très bons résultats.

6. Cliquez sur Save.

Conclusion

Maintenant que vous connaissez les fonctions de
QuickTime, allez au chapitre suivant pour apprendre à
vous servir des capacités de synchro MIDI et SMPTE.



Chapitre 8
MIDI et Synchronisation
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Chapitre 8 :
MIDI et
Synchron i sa t ion

Utiliser les fonctions MIDI vous permet de synchroni-
ser votre séance à du timecode SMPTE, d’utiliser Deck
comme source master de timecode, d’importer un
fichier MIDI pour une lecture synchrone avec votre
séance et de contrôler Deck avec des machines MIDI
externes. Vous pouvez également synchroniser Deck
avec un séquenceur MIDI, comme Metro.

La partie suivante de ce chapitre traite des méthodes
que vous emploierez pour synchroniser Deck à une
machine analogique vidéo ou audio. Vous devrez
comprendre la synchronisation pour ajouter de l’audio
à une vidéo ou un film, ou pour ajouter des pistes
audio synchrones du disque dur aux pistes de votre
magnétophone analogique. Vous pouvez également
synchroniser Deck aux films QuickTime. Pour plus
d'informations, voir le chapitre 7 “QuickTime”.

Configuration MIDI

Avant d’utiliser les fonctions MIDI, vous devrez
installer et configurer OMS (Open Music System,
auparavant Opcode MIDI System). L’installateur OMS
peut être téléchargé gratuitement chez
www.opcode.com. Reportez-vous à la documentation
technique d’Opcode pour plus d'informations sur la
configuration d’OMS.

OMS doit être installé et configuré pour utiliser
Deck avec le MIDI.

Open Music System (OMS)

OMS est constitué d’un ensemble de documents
système qui, avec l’application OMS Setup, vous

permettent de décrire une configuration de votre
studio MIDI qui est reconnue par tous les programmes
compatibles OMS. Dès que vous avez réglé votre
environnement OMS, les applications compatibles
OMS peuvent faire la liste de tous vos instruments
MIDI (dont les synthétiseurs, les interfaces et les
contrôleurs) par leurs noms. Ceci vous évite de devoir
régler et définir votre configuration de système MIDI
pour chaque application.

Lorsque vous avez installé OMS, configurez Deck
comme suit :

1. Ouvrez une séance Deck.

2. Choisissez Options > MIDI Setup.

Si vous faites tourner Deck avec des programmes
esclave compatibles OMS (par exemple, Metro) réglez
la boîte de dialogue sur Run MIDI in background. Ceci
vous permet de passer de Deck aux programmes
esclaves pendant la lecture sans forcer l’arrêt de la
lecture MIDI ou audio. Si vous faites tourner Deck
avec des programmes à l’arrière-plan qui ne sont PAS
compatibles OMS, sélectionnez l’option Run MIDI in
background. Ceci permet de partager les ports, mais
peut arrêter la lecture MIDI et/ou audio lorsque vous
passez d’une application à l’autre (pour plus d'infor-
mations sur la configuration et l’utilisation de OMS,
voir la documentation OMS disponible chez Opcode).

Préférences MIDI

La prochaine étape dans la configuration de votre
système pour le MIDI consiste à régler vos préférences
MIDI. Choisissez File > Preferences > MIDI pour
ouvrir la boîte de dialogue MIDI Preferences.

http://www.opcode.com
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Boîte de dialogue MIDI Preferences

Split channels on incoming MIDI files—Sépare
les canaux lorsque vous importez un fichier MIDI.
Ceci est pratique lorsque vous importez des
fichiers MIDI Type 0, qui stockent toutes les
données de la piste dans un canal.

Default Output Port—Spécifie le port de sortie
MIDI par défaut.

Timecode Output Port—Contrôle à travers quel
port le MIDI timecode sortant est envoyé. Pour
changer le port, sélectionnez simplement un port
différent en utilisant le pop-up menu.

Si vous comptez importer de grands fichiers MIDI,
vous devriez d’abord augmenter la taille de buffer
MIDI dans les préférences Memory & Storage.
Souvenez-vous, dès que vous augmentez la taille de
buffer, vous devriez également augmenter la quantité
de RAM allouée à Deck.

Vous avez maintenant fini de configurer votre système
MIDI et vous pouvez utiliser n'importe lesquelles des
fonctions MIDI.

Envoyer du MIDI timecode

Vous pouvez utiliser Deck comme master timecode
très facilement. Choisissez simplement Output MIDI
Time Code dans le menu Options. Deck va automati-
quement générer du timecode et l’envoyer dans le
port de sortie timecode (Timecode output port) que
vous choisissez dans MIDI Preferences. Pour arrêter
l’envoi de timecode, choisissez de nouveau Output

MIDI Time Code. Vous pouvez vérifier si Deck envoie
du timecode en regardant si une encoche se trouve à
côté de Output MIDI Time Code dans le menu
Options. Si l’encoche est présente, Deck envoie du
timecode.

MIDI Maps
Deck vous permet de créer, enregistrer et charger des
MIDI Maps. Vous pouvez relier des contrôleurs MIDI
aux contrôles de Transport (Rewind, Fast Forward,
Stop, Play et Record), aux fadeurs de volume et de pan
et aux boutons Solo, Mute et Record enable de la
fenêtre Mixer. Les boutons État de Mixer et Temps de
position de la fenêtre Transport répondent également
aux messages de contrôleurs MIDI en plus des
messages d’enfoncement et de relâchement de touche
MIDI. Les MIDI Maps vous permettent de rapidement
et facilement régler le contrôle de Deck par une
surface de contrôle MIDI.

MIDI Map Faders
Pour relier des contrôleurs MIDI à Deck

1. Activez MIDI Map Faders dans le menu Options.
Tous les fadeurs et les boutons MIDI compatibles
deviennent verts.

2. Cliquez sur les fadeurs ou les boutons auxquels
vous voulez relier un contrôleur MIDI. Les fadeurs
ou les boutons deviennent jaunes.

3. Déclenchez le contrôleur MIDI que vous voulez
relier aux fadeurs ou aux boutons. Les fadeurs ou
les boutons deviennent rouges.

4. Répétez les étapes 2 et 3 pour chaque contrôleur
MIDI que vous voulez relier.

5. Lorsque vous avez fini d’assigner des contrôleurs
MIDI aux fadeurs et aux boutons, décochez MIDI
Map Faders dans le menu Options.

Pour relier plus d’un bouton ou d’un fadeur à un seul
contrôleur MIDI, cliquez simplement sur les fadeurs
ou les boutons que vous voulez relier puis déclenchez
le contrôleur MIDI.
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3. Choisissez MIDI Map Faders dans le menu
Options. Tous les fadeurs reliés sur l'écran
s’allument automatiquement en rouge (les autres
fadeurs seront allumés en vert).

4. Cliquez une fois sur un fadeur relié (rouge) pour
le délier. Le fadeur reste allumé en vert pour
indiquer qu’il n’est plus relié.

5. Choisissez de nouveau MIDI Map Faders pour
désactiver le mode Map.

Vous avez maintenant délié le fadeur. Souvenez-vous
d’enregistrer la séance si vous voulez délier le fadeur
de façon permanente.

Enregistrer et charger une MIDI Map

Dès que vous avez relié des contrôleurs MIDI à des
fadeurs et des boutons, vous pouvez enregistrer vos
MIDI Maps et les charger plus tard. Ceci est particuliè-
rement pratique si vous travaillez régulièrement avec
différentes interfaces de contrôle ou si vous utilisez
fréquemment les mêmes MIDI Maps dans chaque
séance. Pour enregistrer votre MIDI Map, sélectionnez
simplement Save MIDI Map dans le menu File pour lui
donner un nom et indiquer où enregistrer la MIDI
Map courante sur votre disque dur. Pour charger une
MIDI Map enregistrée, sélectionnez Load MIDI Map
dans le menu File, localisez la MIDI Map désirée sur
votre disque dur, et cliquez sur Open.

Le Tascam US-428 communique avec Deck via
MIDI, et cependant la plupart de ses fadeurs et
de ses boutons sont déjà reliés aux fonctions de
Deck. Si vous tentez de créer une MIDI Map
pour l’un des contrôles du US-428 que Deck

Édition de la MIDI Map

Deck permet une édition manuelle de la MIDI Map.

Pour éditer manuellement la MIDI Map :

1. Choisissez Edit MIDI Map dans le menu Options
pour ouvrir la boîte de dialogue Remote Control.

2. Cliquez sur la fonction que vous voulez éditer
puis sur le bouton Edit pour ouvrir la boîte de
dialogue Edit Map Element.

3. Entrez le canal MIDI et le numéro de contrôleur
MIDI que vous voulez relier à cette fonction et
cliquez sur OK.

4. Répétez les étapes 2 et 3 pour chaque fonction
que vous voulez éditer et cliquez sur OK dans
Remote Control lorsque vous avez fini.

Pour délier un fadeur :

1. Ouvrez la séance qui contient les fadeurs que
vous voulez délier.

2. Déplacez vos contrôleurs MIDI externes pour voir
à l’écran comment les fadeurs reliés se déplacent
avec eux.
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comprend déjà, le comportement intégré est
prioritaire sur la MIDI Map que vous sélection-
nez. Les boutons Aux 1 ... Aux 4 et F2 et F3 du
US-428 ne sont pas utilisés par Deck et peuvent
être utilisés pour relier aux boutons Temps de
position ou État de Mixer de la fenêtre
Transport.

Utiliser Deck avec le séquenceur
Metro

Deck offre la possibilité de se synchroniser au
séquenceur Metro sur un seul Macintosh. Faire
tourner Deck et Metro ensemble ne nécessite ni
logiciel spécial ni processus de réglage compliqué. Si
les deux programmes tournent simultanément, ils se
connectent automatiquement l’un à l’autre et restent
synchronisés. Vous pouvez éditer, lire et enregistrer
dans un des programmes pendant que l’autre tourne
en synchro. Vous pouvez même passer d’un pro-
gramme à l’autre pendant la lecture et l’édition sans
rien arrêter. Chaque programme peut enregistrer et
ouvrir automatiquement les documents dans l’autre,
peut passer les tempos et les sélections, et peut lancer
et quitter l'autre. Le niveau de contrôle entre les
programmes ne dépend que de vous.

Il existe un certain nombre d’avantages à utiliser Metro
comme solution MIDI avec Deck, contrairement aux
séquenceurs tiers compatibles OMS. L’un d’eux est le
niveau élevé d’intégration et d’interaction, comme
décrit ci-dessus. Un autre avantage est que Deck et
Metro utilisent une architecture de synchronisation
propriétaire qui permet aux deux programmes de
partager des données de synchronisation de façon
continue, afin qu’ils puissent rester très solidement en
synchro. En comparaison, OMS et MIDI Manager ne
permettent que la synchro de déclenchement, ce qui
signifie que les deux programmes peuvent commencer
en même temps, mais qu’ils n’ont aucun moyen de se
resynchroniser en aval si leur synchronisation se
décale. Ainsi, la resynchronisation MIDI/Audio

continue de Deck et Metro vous donne des punch-in
et punch-out plus précis, sans parler d’une plus
grande stabilité lors de longues séances.

Régler les connections de Deck dans le
menu Setups de Metro

Metro offre une boîte de dialogue de réglages qui vous
permet de configurer le niveau d’interaction entre
Deck et Metro. Dans Metro, choisissez Setups >
Digital Audio.

Boîte de dialogue Digital Audio Setup de Metro

Si vous comptez faire tourner Deck avec Metro en
arrière plan, vous pouvez régler les préférences
comme montré dans l’illustration ci-dessus. Ce réglage
considère que vous lancerez Deck et que vous voudrez
toujours que Metro soit lancé et connecté en arrière
plan. Pour achever le processus de configuration,
réglez également Slave Settings, comme expliqué ci-
dessous.

Régler la préférence Slave Settings du
menu File de Deck

Deck offre une boîte de dialogue de réglages qui vous
permet de configurer le niveau d’interaction entre
Deck et un programme esclave compatible (Metro ou
d’autres séquenceurs MIDI). Choisissez File >
Preferences > Slave Settings pour ouvrir la boîte de
dialogue Slave Settings.
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Boîte de dialogue Slave Settings

Lorsque vous faites tourner Deck avec Metro en
arrière plan, vous pouvez configurer les réglages
esclave comme montré dans l'illustration ci-dessus. Ce
réglage considère que vous lancerez Deck et que vous
voudrez toujours que Metro soit lancé et connecté en
arrière plan. Lorsque vous ouvrez une séance avec
Deck configuré de cette manière, Deck va automati-
quement ouvrir le fichier MIDI associé dans Metro.
Bien que vous ne voyiez pas Metro (à moins que vous
ne passiez dans celui-ci), la lecture dans Deck va
automatiquement contrôler la lecture de Metro (et
vice versa).

Open Slave Documents—Vous permet de choisir si
Deck doit toujours lancer l’application esclave
(Metro) et ouvrir le document Metro associé à la
séance Deck que vous ouvrez.

Ceci conserve les séances Deck liées avec leurs
documents Metro associés (il en est de même
pour un programme MIDI esclave).

Quit Slave when Quitting—Deck ferme le
document Metro associé lorsque la séance Deck
est fermée.

Save Slave’s Document When Saving—La séance
Metro est enregistrée dès que vous enregistrez
dans Deck.

Always Pass Selection—Passe la sélection courante
de Deck à Metro—donc si vous êtes arrêtés à la
mesure 37 dans Deck, vous vous retrouvez
automatiquement à la mesure 37 lorsque vous
passez dans Metro.

Lorsque vous faites tourner Deck et Metro sur un seul
Macintosh, choisissez l’un des deux programmes
(celui que vous faites en général tourner au premier-
plan) et n’autorisez que ce programme à ouvrir des
documents dans l'autre. Si en général vous ouvrez
Metro et travaillez d’abord sur du MIDI, autorisez
Metro à ouvrir des documents. Si en général vous
attaquez l’audio avant d’ajouter du MIDI, autorisez
Deck à ouvrir des documents (voir la préférence Slave
Settings dans le sous-menu Deck Preferences).

Régler la vitesse de mise à jour de l'écran
pour Metro dans Deck

Deck offre une préférence dans la boîte de dialogue
General Preferences qui vous permet de régler la
fréquence à laquelle les écrans de Metro sont mis à
jour lorsqu’ils sont en arrière plan (elle contrôle
également la fréquence à laquelle les écrans de Deck
sont mis à jour lorsqu’ils tournent en arrière plan
derrière Metro).

Pour mettre à jour l'écran de Metro (ou d'un autre
programme en arrière-plan) aussi souvent que
possible, réglez “Update speed during playback” sur 1.
Ceci permet au programme en arrière plan de se
mettre à jour aussi souvent que possible, Ce réglage
est suggéré si vous utilisez Metro. Si vous voulez
diminuez les mises à jour d'écran des programmes en
arrière plan pendant la lecture, réglez “Update speed
during playback” sur 10.

Régler Deck avec un métronome MIDI ou
audio

Deck est avant tout un programme audio, et il ne
possède donc pas de métronome MIDI interne. Si
vous voulez utiliser un clic ou un métronome, vous
devrez utiliser le séquenceur Metro (ou un autre
séquenceur esclave compatible) tournant en arrière
plan sur votre Macintosh. Vous pouvez également
créer une piste de clic dans un séquenceur différent et
importer le fichier pour le lire avec votre séance. Pour
plus d'informations, voir “Importer des fichiers MIDI”
à la page 96.
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Pour régler et faire tourner Deck avec un métronome
MIDI ou audio :

1. Vérifiez que Deck et Metro sont configurés pour
tourner ensemble.

Les programmes sont réglés à l’usine pour
tourner correctement ensemble, mais vous
pouvez revoir ces réglages en lisant “Régler les
connections de Deck dans le menu Setups de
Metro” à la page 94.

2. Créez une nouvelle séance dans Deck, puis passez
dans Metro et créez un nouveau document Metro.
Vous pouvez accomplir cela en sélectionnant New
dans le menu File des deux programmes.

3. Faites défiler le réglage Bars d'une piste dans la
fenêtre Tracks de Metro pour régler le nombre de
mesures de clic que vous voulez.

Vous pouvez régler ceci sur n'importe quel
nombre. Vous pouvez utiliser un réglage court
comme comptage de base. Réglez le nombre de
mesures sur une valeur élevée (600, par exemple)
si vous voulez une longue période de clic.

4. Cliquez sur l’ouverture de boîte de dialogue
située dans le coin inférieur droit de la zone de
réglage de tempo dans la fenêtre Transport de
Metro.

5. Utilisez la boîte de dialogue Metro Tempo pour
entrer le tempo que vous désirez, puis cliquez sur
le bouton OK.

6. Vous avez maintenant réglé le tempo du clic (et le
tempo de départ du fichier MIDI Metro du même
coup). Il ne vous reste plus qu’à activer le
métronome.

7. Cliquez sur l’icône Metro Metronome pour activer
le clic MIDI.

Le clic est maintenant activé. Il peut être réglé pour
déclencher une machine MIDI ou pour lire un certain
nombre de sons en utilisant le haut-parleur ou le jack
de sortie audio de votre Macintosh. Dès que le clic est
activé, il lit automatiquement lorsque vous appuyez
sur le bouton Play de Deck. Pour plus d'informations

sur l’édition et la configuration du métronome Metro,
consultez le manuel utilisateur de Metro.

Deck et Metro partagent un réglage de tempo
commun et échangent leurs cartes de tempo. Pour
changer le tempo partagé, réglez le tempo dans Metro
comme décrit ci-dessus. Changer le tempo dans Deck
ne change pas automatiquement le tempo dans Metro,
mais Metro change le tempo de Deck. Remarquez que
Deck est compatible avec la lecture de fichier MIDI en
dixièmes de BPM, mais ne permet pas encore l’entrée
en dixièmes.

Souvenez-vous, la fenêtre Transport de Metro peut
être réglée sur deux tailles différentes. Si vous ne
trouvez pas les zones de réglage Tempo et
Metronome, cliquez sur la boîte d’agrandissement de
la fenêtre Transport pour révéler tous les contrôles.

Importer des fichiers MIDI

Si vous ne possédez pas Metro mais que vous voudriez
qu’un fichier MIDI créé dans un séquenceur soit lu
avec votre séance, vous pouvez utiliser Deck pour
importer le fichier MIDI.

Pour importer un fichier MIDI standard dans Deck :

1. Ouvrez la fenêtre MIDI en choisissant Windows >
MIDI.

Fenêtre MIDI

2. Cliquez sur le bouton Import.

3. Ceci amène une boîte de dialogue standard vous
demandant de choisir un fichier à importer.
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Choisissez le fichier MIDI standard que vous
voulez importer.

4. Lorsque vous avez ouvert le fichier, Deck prend
un peu de temps pour traduire le fichier.

5. Cliquez sur les pop-up menus Port pour assigner
les pistes MIDI aux instruments MIDI spécifiques
de votre installation.

6. Commande-cliquez sur le nom de la piste pour
renommer les pistes MIDI individuelles.

Fenêtre MIDI avec fichier MIDI importé

Vous pouvez changer le fichier MIDI qui est lu avec la
séance en cliquant de nouveau sur le bouton Import et
en choisissant un nouveau fichier. Deck va effacer les
données MIDI précédentes pour faire de la place au
nouveau fichier.

Les fichiers MIDI sont importés avec leurs cartes de
tempo : Deck lit celles-ci et affiche les données audio
mesure/pulsation selon l’événement de tempo initial.
Pour que les formes d'onde audio soient visuellement
ajustées à l’affichage mesure/pulsation pris sur le
tempo, choisissez Beat dans le sous-menu Time Mode
du menu Options.

L’indicateur de tempo ne vous montre que le premier
tempo d'un fichier MIDI. Bien que Deck suive les
changements de tempo de votre fichier MIDI,
l’affichage n’est pas mis à jour à chaque nouveau

tempo. Entrer un nouveau tempo efface la carte de
tempo existante et règle la séance sur ce seul nouveau
tempo.

MIDI Thru

Une autre des fonctions MIDI est MIDI Thru. Pour
utiliser MIDI Thru, ouvrez la fenêtre MIDI et appuyez
sur le bouton de la piste Thru.

Vous pouvez changer le port de cette piste en cliquant
dessus et en sélectionnant un nouveau port grâce au
pop-up menu. Maintenant, tous les événements MIDI
entrant dans le port “entrée” seront dirigés à travers le
port que vous choisissez.

Synchronisation

Cette partie traite des méthodes que vous emploierez
pour synchroniser Deck à une machine analogique
vidéo ou audio. Vous aurez besoin de comprendre la
synchronisation afin d’ajouter de l’audio à une vidéo
ou à un film, ou pour ajouter des pistes audio
synchronisées du disque dur aux pistes de votre
magnétophone multipiste analogique. Vous pouvez
également synchroniser Deck aux films QuickTime.
Pour plus d'informations, voir le chapitre 7 “Quick-
Time”.

L’une des fonctions les plus importantes de Deck est
qu’il fournit un véritable environnement de synchroni-
sation multipiste non-linéaire. Deck rend possible
l’utilisation de l’audio du disque dur sans raccord et en
synchro avec un film, une vidéo et d’autres sources.
Synchroniser l’image et le son est la tâche de Deck,
qui agit comme esclave de votre source SMPTE. Tout
ce dont vous avez besoin est de diriger le signal
SMPTE depuis votre source vidéo ou audio vers une
interface MIDI Macintosh compatible (Opcode Studio
5 ou MOTU MIDI TimePiece, par exemple). Puis,
lorsque vous sélectionnez le taux de trame SMPTE
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approprié dans Deck et mettez Deck online, la séance
courante est automatiquement synchronisée à la
source de timecode externe.

Si vous comptez utiliser Deck dans un environnement
de synchro, vous devriez commencer par acquérir une
compréhension basique du timecode SMPTE. Si vous
êtes déjà familier avec le timecode, vous êtes prêts à
utiliser le système. Si vous n’avez jamais utilisé du
timecode SMPTE, il est recommandé de lire l’un des
ouvrages mentionné dans “Lectures recommandées”
au chapitre 10 “Enregistrement numérique et bases du
mixage”.

Une note importante à propos de la synchro de
déclenchement

Dans le monde de la synchronisation audio par
ordinateur, la plupart des systèmes font la différence
entre la resynchronisation continue et la synchro de
déclenchement.

La resynchronisation continue fait référence aux
systèmes qui mesurent la stabilité de vitesse de lecture
de la source de synchronisation (SMPTE) master et
ajustent constamment la vitesse de lecture esclave
pour qu’elle suive la fluctuation de la machine master.
La synchro de déclenchement attend simplement une
trame de départ et déclenche la lecture. Dans ce cas, la
vitesse de lecture esclave n’est pas modifiée, quelle
que soit la fluctuation de vitesse master.

Deck offre la resynchro continue (le mode natif) et la
synchro de déclenchement. Il est important de noter,
cependant, que Deck n’offre une resynchro continue
qu’en lecture. Ceci rend Deck très pratique pour les
tâches de post-production audio, mais rend difficile
l’utilisation de Deck comme esclave d’enregistrement
avec des machines multipistes analogiques anciennes
et des magnétoscopes bas de gamme. Dès que vous
enregistrez, Deck doit utiliser la synchro de déclenche-
ment, car il est impossible d’effectuer les multiples
conversions de taux d'échantillonnage nécessaires
pour la resynchro continue d’enregistrement en
n’utilisant que le logiciel. Il existe un certain nombre
de façons élégantes pour gérer cette situation.

Vérifiez que toutes les machines sont réglées sur
“house sync”

Pour les meilleurs résultats possibles, vous devriez
vérifier que toutes vos machines sont branchées dans
un signal de synchro de référence central et lancer
Deck avec Trigger Sync activé. En plaçant le poids de
la servo-précision sur les épaules des différentes
machines analogiques plutôt que de demander à votre
Macintosh de changer constamment le taux d'échan-
tillonnage, vous maintenez toujours la plus haute
fidélité audio possible. Dans la plupart des environne-
ments, un signal “vidéo noir”, appelé “black burst” est
utilisé comme référence centrale. Lorsque le même
signal est fourni dans toutes les pièces à toutes les
machines, il est souvent appelé “house sync”. De
nombreuses machines audio multipistes et toutes les
machines vidéo peuvent utiliser un tel signal. Dès que
possible, branchez toutes vos machines analogiques
sur le “black burst”.

Si vous utilisez une machine vidéo bon marché, vous
pouvez en général améliorer votre précision de
synchro d’enregistrement en utilisant le “black burst
du pauvre”. Vous pouvez accomplir cela en allumant
une caméra vidéo (une Handycam suffira) et en
branchant la sortie vidéo de la caméra dans l’entrée
vidéo du magnétoscope. Ceci force le magnétoscope à
se caler sur la caméra, ce qui fournit en général un
signal de synchro beaucoup plus sain que celui du
magnétoscope seul et force ce dernier à lire avec
moins de fluctuations temporelles.

Ne mettez Deck en esclave que de sources
numériques

Lorsque vous mettez Deck en esclave d’une source
numérique, comme un lecteur DAT ou des enregis-
treurs multipistes numériques avec timecode, vous
pouvez en général éviter tout problème de synchroni-
sation. Ces machines dépendent énormément de la
précision temporelle de leur lecture et en général ne
fluctuent pas leur vitesse de lecture. Si vous mettez
Deck en esclave d’une telle machine, vous devriez
mettre Deck en mode Trigger Sync, puis continuer
comme d’habitude. Il s’agit de l’une des meilleures
configurations possibles pour utiliser Deck.
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Utilisez un SMPTE Slave Driver

Si vous avez un SMPTE Slave Driver—une machine qui
convertit un signal SMPTE analogique en digital slave
clock et en word clock—vous pouvez l’utiliser pour y
synchroniser Deck. Le SMPTE Slave Driver mesure les
fluctuations de vitesse dans le signal source SMPTE et
change le taux d'échantillonnage d’enregistrement ET
de lecture de façon continue. Cette solution offre les
meilleurs résultats en matière de performance du
système et de fidélité audio, car toutes les vitesses
d’enregistrement et de lecture de l’audio sur disque
dur sont ajustées directement au niveau du matériel,
ce qui évite la dégradation du signal audio souvent
causée par la conversion du taux d'échantillonnage en
temps réel par le logiciel.

Pour synchroniser l’enregistrement ou la lecture de
Deck au timecode :

1. Vérifiez que votre source SMPTE est branchée sur
une interface MIDI capable de gérer la conversion
de timecode SMPTE-MIDI (par exemple, Opcode
Studio 5 ou MOTU MIDI TimePiece).

2. Ouvrez la séance que vous voulez synchroniser au
timecode.

3. Choisissez Options > MIDI Setup. Vérifiez que le
bon port MIDI est activé et qu’il est réglé sur la
vitesse correct. Pour la plupart des applications,
vous pouvez activer à la fois les ports Imprimante
et Modem et les régler sur 1.0 MHz, réglages
génériques.

Si vous synchroniser sur du SMPTE et faites
tourner Metro en arrière plan (ou au premier-
plan), configurez Deck pour recevoir la
synchro et utilisez-le pour contrôler la lecture
synchronisée. Ne réglez pas Metro pour être en
synchro avec le SMPTE, mais simplement pour
une lecture normale. Deck va gérer toutes les
tâches de synchronisation et va directement
contrôler la lecture de Metro.

4. Choisissez Options > SMPTE Start Frame.

5. Entrez l’heure, minute, seconde et numéro de
trame de la trame SMPTE qui va être utilisée

comme début de séance (le début de matériau
sur votre bande timecode ou la scène avec
laquelle vous travaillez). Cliquez sur OK.

6. Le temps que vous avez entré dans la boîte de
dialogue précédente sera votre temps de départ
SMPTE et le bouton Return-to-zero reviendra
toujours à ce point.

Vous pouvez cliquer sur le bouton Capture pour
capturer la trame de timecode courante depuis
votre source timecode. Remarquez cependant
que le bouton Capture n’obtiendra pas un temps
précis à moins que vous ne soyez en synchro sur
une bande vidéo utilisant le Vertical Interval
Timecode (VITC). Si vous utilisez le Longitudinal
Timecode (LTC) standard, le bouton Capture
incorpore la dernière trame reçue, mais celle-ci
peut se trouver en fait à plus d’une seconde de la
position réelle. Cette situation est due au fait que
seul le VITC peut être lu à de faibles vitesses de
molette et en mode still-frame/pause. Les
adresses de trame LTC sont illisibles à faibles
vitesses et en mode still-frame/pause.

7. Choisissez Options > Online.

8. Pour lire l’audio en synchro avec le timecode
entrant, appuyez sur le bouton Play de la fenêtre
Transport pour mettre la séance courante en
stand-by.

L’indicateur d’état de la fenêtre Transport dit
maintenant “Standby” pour indiquer que Deck attend
le timecode entrant. Dès qu’un timecode est présent
sur le port MIDI sélectionné, Deck se synchronise et
commence la lecture.

Pour enregistrer de l’audio en synchro avec le
timecode entrant :

1. Vérifiez que vous avez activé une piste en
enregistrement dans la fenêtre Mixer de Deck.

2. Appuyez sur le bouton Record de Transport puis
sur le bouton Play, pour mettre la séance
courante en stand-by.

3. L’indicateur d’état de la fenêtre Transport dit
maintenant “Standby” pour indiquer que Deck
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attend le timecode entrant. Dès qu’un timecode
est présent sur le port MIDI sélectionné, Deck se
synchronise et commence à enregistrer.
Remarquez qu’il faut quelques secondes pour que
l’enregistrement et la lecture de l’audio se cale et
commence.

Le temps de pre-roll de synchronisation SMPTE est
ajustable par l’utilisateur dans General du sous-menu
Preferences. Ce réglage est ajusté en secondes et le
temps que vous entrez sera la quantité de temps que
prend Deck entre la première trame SMPTE reçue et le
début de la lecture. Si vous avez un Macintosh et un
disque dur rapide, vous pouvez régler cette préférence
sur deux secondes ou moins. Si vous avez des
problèmes pour obtenir la synchro de Deck (messages
“missed in-point”), réglez cette valeur sur au moins six
secondes.

Conclusion

Vous avez appris à utiliser le MIDI pour contrôler les
fadeurs et les boutons et pour synchroniser à des
séquenceurs MIDI (par exemple, Metro). Vous
également appris comment utiliser le timecode MIDI
et le SMPTE pour synchroniser Deck à de la vidéo. Le
chapitre suivant est une présentation complète des
menus et des fenêtres de Deck.



9

101Références de Deck

Chapitre 9
Références de Deck
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Chapitre 9 :
Références de Deck

Ce chapitre explique toutes les fenêtres, les contrôles
et indicateurs d’écran et chacune des commandes des
menus. Si vous vous posez une question spécifique sur
une fenêtre, une commande, un contrôle ou une
fonction de Deck, ce chapitre est conçu pour vous. Si
vous désirez en savoir plus sur une procédure
spécifique ou sur Deck en général, vous devriez lire les
chapitres précédents de ce manuel. Pour plus
d'informations sur l’enregistrement numérique, voir le
chapitre 10 “Enregistrement numérique et bases du
mixage”.

Fenêtre Tracks
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Zone de contrôle global des pistes

La Zone de contrôle global des pistes se trouve en
haut de la fenêtre Tracks. Elle inclut, de droite à
gauche, l'Indicateur de position, les boutons Taille de
piste, les boutons Objet/Segment, les boutons
Mémoire d'affichage, les boutons Zoom, les contrôles
Tempo, Aligner sur la Grille, Axe temporel, etc.

Indicateur de position—Affiche le temps courant
(position du curseur), les temps de départ et de fin, et
la durée de l’objet ou du segment sélectionné. Tous
les temps sont indiqués dans les Unités de l'axe
sélectionnées. Pour plus d'informations, voir
“Sélection des unités de l'axe et gestion de la grille” à
la page 37.

Vous pouvez placer un point spécifique dans une
région sur la trame ou la pulsation exacte en saisissant
la région désirée au point de départ de la forme
d'onde et en faisant glisser la région jusqu’à ce que le
temps courant indique la trame ou la pulsation que
vous voulez. Cette méthode de placement permet de
placer du son autrement qu’avec les points de départ
et de fin de la région.

Boutons Taille de piste—Règlent la taille d’affichage
de la piste. Les deux plus grands modes d’affichage
sont pratiques pour une édition détaillée de la forme
d'onde, la taille moyenne convient bien aux tâches
courantes et la plus petite peut afficher jusqu’à 24
pistes à la fois, ce qui est particulièrement pratique
pour gérer des séances complexes.

Boutons Mode objet et segment—Activent le Mode
objet ou segment. Le Mode objet vous permet de
sélectionner et de manipuler des régions audio
entières sous forme d’unités. Il est très pratique pour
l’arrangement. Le Mode segment vous permet de
sélectionner des segments de forme d'onde dans ou à
travers une région audio. Il est très pratique pour
l’édition de composants avant de commencer
l’arrangement (création de boucles, etc.).

Utilisez la touche tilde (~) pour passer entre les
Modes objet et segment.

Boutons Mémoire d'affichage—Stockent et
rappellent l'état courant de la zone de forme d'onde
de la fenêtre Tracks. Pour plus d'informations sur le
stockage et le rappel des mémoires d'affichage, voir
“Naviguer dans la fenêtre Tracks” à la page 34.

Boutons Zoom In et Zoom Out—Ajustent
l'affichage du temps. Commande-cliquez pour zoomer
ou dézoomer complètement. Option-cliquez pour
(dé)zoomer 2 fois, Majuscules-Option-cliquez pour
(dé)zoomer 4 fois.

Bouton Ajuster sur la sélection—Étend ou
raccourcit l'affichage pour que la sélection courante
remplisse l'écran. En Mode segment, appuyez sur la
touche Z de votre clavier avec le bouton de la souris
enfoncé après avoir fait une sélection dans la fenêtre
Tracks pour que la sélection remplisse l'écran.
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Boutons Zoom Vertical—Manipulent l'affichage
vertical. La flèche haut étend l'affichage de la forme
d'onde pour voir l’audio enregistré à bas niveaux ou
pour trouver les points nuls d’une forme d'onde. La
flèche bas remet l'affichage en résolution normale.
Commande-cliquer sur l’un des boutons étend
immédiatement au maximum ou revient à la normale.
Les crochets [ et ] peuvent aussi être utilisés.

Contrôles de tempo—Règlent le tempo de base et
l’indication de mesure utilisés pour afficher et éditer
en Mode pulsation. Ces réglages permettent d’aligner
les éditions et les sélections sur des longueurs en
mesures et en pulsations. Si vous utilisez Metro, le
tempo est réglé par Metro et tout changement du
tempo sera reflété dans Metro. Faites défiler les zones
de valeur tempo et indication de mesure pour entrer
de nouveaux réglages ou Commande-cliquez sur les
contrôles pour entrer les réglages en texte.

Aligner sur la Grille—Active et désactive la grille. Les
unités de la grille s’auto-ajustent pour suivre la
résolution de l’axe : si la résolution de l'axe est sur
mesures, la grille est une mesure, si elle est sur noires,
la grille est une noire. La grille est donc très pratique
pour composer de la musique ou arranger des sons
selon un tempo spécifique.

Pop-up menu Unités de l'axe—Règle les unités de
temps avec lesquelles vous allez éditer et qui
apparaissent sur l'axe horizontal situé juste au-dessus
de la fenêtre Tracks. Vous pouvez choisir entre
Sample, Second, SMPTE et Beat. Sample affiche le
numéro d'échantillon à partir du début de la séance.
Second affiche les temps comme une horloge
classique. SMPTE les affiche en trame de timecode
SMPTE, pour synchroniser à l’image ou à des machines
externes (choisissez Options > SMPTE Format pour
sélectionner votre format de trame SMPTE). Beat est
en général utilisé pour la composition musicale et
trouve particulièrement son utilité lorsque vous
utilisez Deck en synchro avec un séquenceur MIDI.

Pop-up menu Résolution de l'axe—Change
l'affichage de la forme d'onde en sous-unités naturelles
des Unités de l'axe master. Par exemple, Mode
pulsation offre Bar, Half Note, Quarter Note, Eighth
Note, Sixteenth Note, 32nd Note, 64th Note, 128th
Note et 1 Tick comme résolutions.

Vous pouvez utiliser le sous-menu Selection Tools du
menu Options pour régler l'affichage sur des zones
spécifiques (le début ou la fin de la sélection courante,
par exemple) avec une seule commande, sans tenir
compte de la résolution d'affichage. Ou essayez les
raccourcis Commande-[ et Commande-] pour aller au
début ou à la fin de votre sélection.
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Axe temporel—Indique la trame temporelle de la
zone forme d'onde. L'axe temporel (ou ligne
temporelle) est toujours montré dans les unités du
pop-up menu Unités de l'axe et l'axe est constamment
ajusté lorsque le niveau de magnification (la résolution
d'affichage) est changé.

Marqueurs—Fournissent un corollaire graphique
dans la fenêtre Tracks aux points de position
automatique stockés dans les pop-up menus Temps
de position de la fenêtre Transport. Pour plus
d'informations sur l'utilisation des marqueurs, voir
“Naviguer dans la fenêtre Tracks” à la page 34.

Indicateur de l'état du disque dur—Montre la
quantité d’espace non-utilisé sur le disque dur qui
contient la séance courante. Vous pouvez en général
libérer plus d’espace de disque dur en sélectionnant
File > Compact Session. Si vous vous retrouvez à
court d’espace disque lorsque vous enregistrez une
nouvelle piste, l’enregistrement s’arrête,  en détruisant
donc votre prise. Pour plus d'informations sur le
compactage de séance, voir “Compacter une séance” à
la page 29.

Zone de contrôle de piste

Il y a une zone de contrôle de piste pour chaque piste
de la fenêtre Tracks située à la gauche de celle-ci. Elle
contient le pop-up menu Piste, la boîte sélecteur
d'entrée, les boutons solo/mute/record, les indicateurs
de niveau de piste et de pan, ainsi que l’affichage
d’automation de la piste.

Zone Numéro/Déplacement de la piste—Le coin
supérieur gauche de la zone de contrôle de piste
contient le numéro de la piste courante et vous
permet de faire glisser celle-ci pour réarranger l’ordre
des pistes. Pour plus d'informations, voir “Déplacer et
renommer des pistes” à la page 33.

Pop-up menu Piste—Spécifie la piste couramment
chargée dans la position de la piste indiquée. Vous
pouvez changer l'emplacement de la piste en cliquant
et en faisant défiler le pop-up menu pour sélectionner
une nouvelle piste. Vous pouvez également changer le
nom de la piste courante en Commande-cliquant dans
cette zone.
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Pop-up menu Sélecteur d'entrée—Spécifie quels
canaux d’entrée audio de votre matériel fournira le
signal à la piste courante pour l’enregistrement.

Boutons Solo et Mute—Solo vous permet d’enten-
dre la piste seule. Mute désactive la lecture de la piste.
Remarquez que plusieurs pistes peuvent être mises en
solo ou mutées simultanément et que Solo est
toujours prioritaire sur Mute.

Bouton Record—Active l’enregistrement de cette
piste. Lorsque vous cliquez sur ce bouton, vous
pouvez immédiatement entendre l'audio qui passe à
travers le canal d’entrée sélectionné dans le Sélecteur
d'entrée de la piste. Pour plus d'informations sur
l’enregistrement, voir “Enregistrer dans la fenêtre
Tracks” à la page 24.

Indicateurs de Niveau et de Pan de la piste—Vous
permet de contrôler les valeurs de niveau et de pan
lors de l’édition de l’automation. Faire défiler ces
indicateurs vous permet de régler les niveaux de
volume de piste et de pan de la fenêtre Tracks (sans
aller dans Mixer).

Pop-up menu Affichage de l'automation de la
piste—Permet de voir, créer et éditer les enveloppes
d'automation dans la fenêtre Tracks. Lorsque ce pop-
up menu est sur None, la piste ne montre et n’édite
que l’information de forme d'onde. Pour plus
d'informations sur les enveloppes d'automation, voir
“Enveloppes visuelles d'automation” à la page 69.

Pop-up menu État de l'automation de la piste—
Fonctionne comme le pop-up menu Automation
expliqué à la page 68. Pour des informations sur
l’enregistrement du fadeur, voir le chapitre 6
“Automation, mixage et mastering”. Lorsque vous
éditez des enveloppes dans la fenêtre Tracks, ce pop-
up menu permet d’activer ou désactiver l’automation
et d’effacer celle-ci. Ce pop-up menu doit être sur Play
pendant l’écoute et pendant le mixage pour que vos
données soient calculées dans le nouveau fichier.

Enfoncez la touche Option en sélectionnant l’état pour
régler toutes les pistes sur le même état.

Pistes de travail—Deck ne permet d’avoir que le
nombre de pistes audio autorisées par votre système,
mais la fenêtre Tracks vous permet de créer un
nombre illimité de pistes de travail. Une piste de
travail fonctionne comme une piste de lecture sauf
que vous ne pouvez pas entendre l’audio en temps
réel, à moins de sélectionner Audition Selection.
Utilisez les pistes de travail pour créer un mixage
virtuel. Pour plus d'informations sur le mixage virtuel,
voir “Mixage virtuel” à la page 75.
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Commandes clavier de la fenêtre Tracks

Un grand nombre des fonctions d'édition de la fenêtre Tracks ne sont accessibles qu’à partir de commandes
clavier. En utilisant les commandes clavier, Deck permet d’exécuter et de modifier n’importe quel type d’édition
sans passer entre les différents modes. Voici une liste des commandes clavier de la fenêtre Tracks et ce qu’elles
font :

Raccourci clavier Résultat

Commande-, Ajuste sur la sélection

[ Zoome l’amplitude de l’onde

] Dézoome l’amplitude de l’onde

C Active la boucle de repérage et la cale sur la sélection courante

Tab Déplace jusqu’au temps de position ou marqueur suivant

Majuscules-Tab Déplace jusqu’au temps de position ou marqueur précédent

+ Pousse la sélection en avant

- Pousse la sélection en arrière

Retour chariot Retourne à zéro

Tilde (~) Passe entre le Mode segment et le Mode objet

Barre d'espace Lecture/Arrêt/Continuer

Contrôle-Barre d'espace Lit depuis la position de lecture précédente

Majuscules-Barre d'espace ou Commande-T Écoute de la sélection

Option-C Désactive la boucle de repérage

Option-[ Zoome au  maximum de l'amplitude de l'onde

Option-] Dézoome au maximum de l'amplitude de l'onde

Commande-] Va à gauche de la sélection

Commande-[ Va à droite de la sélection

Entrée Crée un marqueur dans l’axe temporel à la position courante

Option-cliquer sur le marqueur Supprime le marqueur

Commande-cliquer sur le marqueur Renomme le marqueur

Majuscules après faire glisser verticalement Se cale sur le temps de départ original

Commande-faire glisser “Colle” la région sur la fin de la région précédente
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Raccourci clavier Résultat

Contrôle après faire glisser Déplace toutes les régions plus tard de la durée de la sélection

Option-faire glisser Copie la région, en laissant l’original derrière

Flèches Déplace la sélection vers haut/bas/gauche/droite

Commande flèche gauche/droite Déplace la sélection de l’unité courante de la grille

Option-cliquer sur Zoom (Dé)Zoome 2 fois

Majuscules-Option-cliquer sur Zoom (Dé)Zoome 4 fois

Commande-cliquer sur Zoom gauche (-) Dézoome au maximum

Commande-cliquer sur Zoom droite (+) Zoome au maximum

Commande-cliquer sur Ajuster sur la sélection Positionne la sélection à gauche

Option-cliquer Ajuster sur la sélection Positionne la sélection à droite

Option-cliquer sur l’affichage de la piste Change l’affichage de toutes les pistes

Option-cliquer sur l’affichage de l’automation Change l’affichage de l’automation de toutes les pistes

Commande-cliquer sur le nom de la piste Renomme la piste

Commande-cliquer sur l’indicateur de niveau Ouvre la boîte de dialogue d’entrée de volume

Commande-cliquer sur l’indicateur de pan Ouvre la boîte de dialogue d’entrée de pan

Option-cliquer sur l’indicateur de pan Règle la position du pan sur le centre

Option-cliquer sur l’indicateur de niveau Règle le curseur de volume sur 0 dB

Commande-cliquer sur la barre horizontale Déplace la fenêtre Tracks par incréments de moitié

Commande-Majuscules-Option-U Recalcule l’affichage de toutes les régions

X-faire glisser Ajuste l’écran sur la zone tracée sans changer la sélection

S-faire glisser Fait défiler en solo la piste courante

Option-S-faire glisser Fait défiler toutes les pistes

Option-Commande-V Colle à

Option-cliquer sur le compteur de Transport Déplace la fenêtre Tracks à la position courante

Commande-V Colle après

Majuscules-Commande-V Colle avant

Commande-C Copie

Commande-X Coupe
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Raccourci clavier Résultat

Commande-B Efface

Commande-Y Retire

Commande-A Sélectionne tout

Commande-U Désélectionne

Majuscules-cliquer sur un point d'automation Contraint le temps

Commande-cliquer sur un point d'automation Entre un nouveau point de rupture d’automation

Ctrl-Comm.-cliquer sur un point d’automation Entre un nouveau point d’automation au même niveau que le
point précédent

Commandes clavier de la fenêtre Tracks (Mode segment uniquement)

Raccourci clavier Résultat

A-cliquer Sélectionne une région ou l’espace vide entre deux régions

Majuscules-A-cliquer Étend la sélection/point d'insertion à la limite de la région

Option-Majuscules-A-cliquer Étend la sélection/point d'insertion au début/fin de la séance

Majuscules-A-flèche gauche/droite Étend la sélection/point d'insertion à la limite de la région

Option-Majuscules-A-flèche gauche/droite Étend la sélection/point d'insertion au début/fin de la séance

Z-faire glisser Ajuste l’écran à la nouvelle sélection

Option-flèche gauche/droite Déplace le segment de la quantité de la sélection

Contrôle-flèche gauche/droite Réduit la sélection à gauche ou droite

Majuscules-flèche gauche/droite Étend la sélection à gauche ou droite

Flèche gauche/droite Déplace la sélection de l’unité courante de la grille

Flèche haut/bas Déplace la sélection sur la piste voisine

Majuscules-flèche haut/bas Étend la sélection sur la piste voisine

Commande-R Découpe (crée une nouvelle région)

Contrôle-cliquer sur un point d'automation Contraint l’amplitude

Commande-flèche haut Déplace vers le haut les points d'automation pixel par pixel

Commande-flèche bas Déplace vers le bas les points d'automation pixel par pixel

Commande-Option-flèche gauche/droite Copie la sélection à gauche ou droite

Commande-Option-flèche haut/bas Copie la sélection au-dessus ou en-dessous
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Commandes clavier de la fenêtre Tracks (Mode objet uniquement)

Raccourci clavier Résultat

Contrôle-cliquer sur un point d'automation Ouvre la boîte de dialogue entrée de point

Commande-flèche haut sur point d'automation Déplace vers le haut le point d'automation pixel par pixel

Commande-flèche bas sur point d'automation Déplace vers le bas le point d'automation pixel par pixel

Commande-flèche gauche sur point d'automation Déplace à gauche le point d'automation pixel par pixel

Commande-flèche droite sur point d'automation Déplace à droite le point d'automation pixel par pixel

Fenêtre Mixer

Choisissez Windows > Mixer (Commande-2) pour
ouvrir la fenêtre Mixer. La fenêtre Mixer est l’endroit
où vous contrôlez les tâches audio de base, comme
l’enregistrement, l’overdub, la synchronisation, le
mixage, l’automation et, sur un Power Macintosh,
l’assignation des effets en temps réel sur les pistes de
lecture.
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Boîtes Sélecteur d'effet—Vous permettent
d’assigner jusqu'à quatre effets en ligne en temps réel
(intégrés ou VST) sur chaque piste de lecture. Pour
désactiver temporairement un effet, cliquez sur le
bouton On/Off de l'effet à gauche de sa boîte
Sélecteur. Pour retirer un effet et tous ses réglages de
façon permanente, réglez le sélecteur sur Thru. Pour
ouvrir la fenêtre d’édition d’un effet VST, Option-
cliquez sur le nom de l’effet VST ou choisissez Open
editor dans le pop-up menu.

Sélecteur d'entrée—Spécifie quel canal d’entrée
audio de votre matériel fournit le signal à la piste
courante pour l’enregistrement.

Chaque piste activée en enregistrement doit être
réglée sur une entrée différente car plusieurs
pistes ne peuvent pas enregistrer à partir de la
même entrée.

Pop-up menu Automation—Est utilisé pour enregis-
trer, lire et effacer en temps réel l’automation de
volume et de pan de cette piste. Pour plus d'informa-
tions sur l’enregistrement et l’édition de l’automation,
voir “Enveloppes visuelles d'automation” à la page 69 et
“Automation de la table” à la page 67.

Sélecteurs de Pan de Sortie—Spécifient la paire de
sortie (canal de sortie gauche et droite) à travers lequel
l’audio de la piste sera lu.
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Fadeur de pan—Ajuste le placement de la piste audio
dans le champ stéréo (gauche et droite). Ceci ne
fonctionne correctement que dans le cas où vous avez
dirigé vos sorties audio sur les canaux gauche et droite
d’un système d’amplification stéréo ou d’enceintes
amplifiées.

Fadeur de volume—Lorsque vous lisez une piste
audio, le fadeur de volume de la piste contrôle le
niveau de volume global de la piste. Lorsque la piste
est activée en enregistrement (le bouton Rec de la
piste est allumé), le fadeur de volume contrôle le
niveau de contrôle du signal d'entrée, et non le niveau
réel d’enregistrement de la piste. Les valeurs de fadeur
sont affichées dans la boîte Indicateur de valeur de
contrôle de la fenêtre Transport. Pour entrer un
niveau spécifique à un fadeur, Commande-cliquez
dessus. Pour plus d'informations sur le réglage des
niveaux d’entrée de plusieurs éléments audio, voir
“Ajouter des fichiers audio et des régions à une
séance” et “Enregistrer dans la fenêtre Tracks” au
chapitre 3.

Bouton Solo—Vous permet de n’entendre que cette
piste. Plusieurs pistes peuvent être mises en solo
simultanément. Si une piste est à la fois mutée et en
solo, elle est lue.

Bouton Mute—Désactive la lecture de la piste.
Plusieurs pistes peuvent être mutées simultanément.

Bouton Enregistrement activé—Active l’enregistre-
ment de cette piste. Lorsque vous cliquez sur ce
bouton, vous pouvez immédiatement entendre l'audio
qui passe à travers l’entrée sélectionnée dans le
Sélecteur d'entrée de la piste. Pour plus d'informations
sur l’enregistrement, voir “Enregistrer dans la fenêtre
Tracks” à la page 24.

Vu-mètres et Diode de clip—Lorsque la piste n’est
pas activée en enregistrement, les Vu-mètres vous
montrent le niveau d’amplitude (volume) du signal
audio de cette piste, sans tenir compte du réglage du
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fadeur de la piste, ce qui permet de voir où se trouve
le signal, même si celui-ci est muté ou entièrement
atténué. Lorsque la piste est activée en enregistre-
ment, les Vu-mètres montrent le niveau d’amplitude
du signal présent à l’entrée sélectionnée. Utilisez-les
pour ajuster le signal au plus haut niveau possible sans
clipper. Si le signal est trop haut, la diode de clip (tout
en haut des Vu-mètres) s’allume. Cliquez sur la diode
de clip pour l’éteindre, puis ajustez votre signal.

Pop-up menu Sélection de la piste—Spécifie la
piste qui doit être lue à cet emplacement. Commande-
cliquez sur cette zone pour renommer la piste.

Flux du signal de canal

Le flux du signal dans Deck, depuis la lecture du
fichier audio jusqu’à la sortie, est important à
comprendre lorsque vous appliquez du pan, ainsi que
des plug-ins VST ou des effets intégrés. Le trajet du
signal lors de la lecture du fichier audio provient
d’abord du disque (ou du canal d’entrée spécifié
pendant l’enregistrement), passe en mono à travers les
effets intégrés (si il y en a d’activés sur ce canal), le
fadeur de volume du canal (contrôle du gain mono),
tout effet VST mono-to-mono puis le fadeur de volume
; il est ensuite panné à gauche/droite aux sorties
assignées via le fadeur de pan et passe finalement à

travers tout plug-in VST stereo-to-stereo actif sur le
canal en question avant de passer à travers les sorties
master assignées.

Fenêtre Transport

Choisissez Windows > Transport (Commande-1) pour
ouvrir la fenêtre Transport. La fenêtre Transport
contrôle la lecture et l’enregistrement de l’audio et le
déplacement linéaire dans votre séance, tout comme
les contrôles de transport d’une machine à bandes
analogique. La fenêtre Transport n’a pas besoin d’être
la fenêtre active pour que les boutons de Transport
fonctionnent.

Fenêtre Transport, taille maximum

Fenêtre Transport, taille moyenne

Fenêtre Transport, taille minimum
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La fenêtre Transport possède trois tailles possibles.
Cliquez sur la boîte de zoom de la fenêtre pour ajuster
sa taille.

Compteur master—Affiche votre position courante
dans la séance et vous permet de le faire défiler pour
déplacer la lecture dans l’une ou l’autre des directions
pour se positionner avec précision. Lorsque vous
lancez Deck, les unités de temps par défaut sont réglés
sur trame SMPTE (29.97 trames par seconde non-
drop). Pour choisir une unité de temps différente
(comme secondes ou pulsations) utilisez le pop-up
menu Unités de l'axe dans la fenêtre Tracks. Si vous
voulez régler le temps de départ de la séance sur une
valeur non nulle, choisissez Options > SMPTE Start
Time.

Option-cliquez sur le Compteur master pour faire
automatiquement déplacer la fenêtre Tracks d’après le
temps du Compteur master. La fenêtre Tracks se
déplace automatiquement après que la lecture est
arrêtée si la préférence Scroll after play est activée.
Pour plus d'informations, voir General Preferences
dans la partie sur le menu File à la page 121. La fenêtre
Tracks se déplace pendant la lecture si Scroll During
Playback est activé dans le menu Options.

Boutons de Transport—Fonctionnent tout à fait
comme ceux d’une machine à bandes analogique. Les
boutons sont, de droite à gauche, Return-to-zero,
Rewind, Stop, Play, Fast Forward et Record.

La fonction normale du bouton Record est d’activer
l’enregistrement non-destructif. Ceci signifie que le
punch-in du nouvel audio sur l’ancien n’efface pas
l’audio original. C’est une méthode plus sûre qui vous
permet de revenir à une version précédente si vous
n’aimez pas un des punch-ins.

La Barre d'espace est la commande clavier par défaut
pour la lecture et l’arrêt. Contrôle-Barre d'espace
commence la lecture à partir de la dernière position
du compteur, et non de la position courante. La
touche Retour chariot est le raccourci pour Return-to-
zero. Les raccourcis clavier des contrôles de transport
peuvent être changés avec la commande General
Preferences.

Pour plus d'informations sur le contrôle externe des
boutons de Transport, voir “MIDI Maps” à la page 92.

Curseur de repérage—Vous aide à localiser
rapidement une partie de la séance courante. Faites
défiler le curseur horizontal pour vous déplacer dans
l'enregistrement. Lorsque vous faites glisser le curseur,
le Compteur master est mis à jour pour vous montrer
le temps courant. Lorsque vous relâchez, vous pouvez
commencer la lecture ou l’enregistrement à partir de
ce point.

Le Curseur de repérage est pratique pour un
déplacement global dans la séance courante, mais les
boutons de position automatique, expliqués dans la
partie “Temps de position” à la page 26, fournissent
une méthode plus rapide et précise pour localiser
exactement un temps.

Mode punch—Fait passer les fonctions d’enregistre-
ment de Deck en Mode punch. Lorsque Deck est en
Mode punch, les compteurs Begin et End règlent les
points de punch-in et de punch-out. Lorsque Mode
punch est activé, l’enregistrement ne se fait qu’entre
les points de punch-in et de punch-out. Pour plus
d'informations sur les punch-in et punch-out
automatisés, voir “Enregistrement punch-in et punch-
out automatique” à la page 28.
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Mode boucle—Fait passer les fonctions de lecture de
Deck en Mode boucle. Lorsque Deck est en Mode
boucle, les compteurs Begin et End règlent les points
de punch-in et de punch-out. Lorsque Mode boucle
est activé, seul le segment bouclé (entre Begin et End)
sera lu de façon répétée. Pour plus d'informations sur
le Mode boucle, voir “Mode boucle” à la page 27.

Compteurs Begin et End—Indiquent les temps
utilisés par les fonctions boucle et punch. Ces
compteurs peuvent être réglés de cinq façons :

1. Faites une sélection dans la fenêtre Tracks, puis
appuyez sur C. Cette méthode active automatique-
ment le bouclage.

2. Cliquez sur les boutons Begin et End pendant la
lecture pour indiquer les temps courants au
compteur.

3. Faites glisser les compteurs à gauche ou à droite
pour faire défiler leurs valeurs avec l’audio.

4. Commande-cliquez sur les compteurs pour entrer
les temps précis directement.

5. Choisissez Options > Selection Tools > Set
Punch Time From pour régler les temps Begin et
End à partir de la sélection courante.

Commande-cliquez sur le bouton Begin ou End pour
passer ce temps dans le compteur master.

Indicateur d'état—Vous alerte sur certaines
situations : si, par exemple, Deck est esclave d’un
timecode, il contient le mot “Standby”. Si vous ne
savez pas quoi faire lors d’une étape de production ou
si Deck semble être en attente, vérifiez cet indicateur.

Indicateur de valeur de contrôle—Affiche la valeur
de l’effet ou du contrôle de pan ou de volume que
vous déplacez, ainsi que de la plupart des contrôles de
la fenêtre Effect, pour que vous puissiez suivre chaque
contrôle d’effet lorsque vous l’ajustez.

Temps de position—Mémoires de compteur
stockant jusqu'à 200 temps avec rappel et positionne-
ment immédiat. Les temps de position sont stockés
dans le fichier de séance et y restent sauf à être
remplacés ou réinitialisés, et sont affichés sous forme
de marqueurs rouges dans la fenêtre Tracks. Pour plus
d'informations, voir “Temps de position” à la page 26.

États de Mixer—Prennent un cliché de la table en vue
d’un rappel ultérieur. Les états de Mixer sont stockés
dans le fichier de séance et y restent sauf à être
remplacés ou réinitialisés. Pour plus d'informations,
voir “Utiliser les états de Mixer” à la page 71.
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Fadeur de contrôle de hauteur—Vous permet
d’ajuster la vitesse de lecture de l'audio par petites
quantités pour compenser des conflits de hauteur et
de temps (comme sur une machine à bande multi-
piste). Il agit comme un contrôle de vitesse de bande
qui vous permet de modifier la vitesse de lecture
depuis la vitesse normale jusqu’à un arrêt presque
complet (–98 %). Certaines distorsions audio peuvent
résulter de réglages extrêmes.

Le contrôle numérique de la hauteur sur disque dur
est accompli en utilisant une conversion du taux
d'échantillonnage en temps réel, ce qui pousse votre
processeur dans ses limites. Régler à nouveau le
contrôle de hauteur sur zéro remet les pistes en route.

Vous pouvez également régler le taux de lecture de la
séance en utilisant la commande Pull-down du menu
Options. Le contrôle de hauteur ne fonctionne qu’en
lecture. Deck enregistre toujours à la vitesse normale.

Fenêtre Library
Choisissez Windows > Library (Commande-6) pour
ouvrir la fenêtre Library.

Fenêtre Library

La fenêtre Library vous permet de voir facilement tout
le matériau source audio que contient votre séance.
Vous pouvez également glisser-déposer ou couper et
coller les régions audio de la fenêtre Library vers la
fenêtre Tracks.

La première colonne montre les noms des régions que
vous avez placé dans votre séance. La seconde colonne
montre la durée de la région et la troisième colonne
montre l’emplacement du fichier audio associé sur
votre disque dur.

Si vous importez de grandes quantités de matériau,
utilisez le boîte de dialogue Add Audio pour tous les
importer. Puis utilisez la fenêtre Library pour placer
précisément les régions, plutôt que de les coller
directement dans la fenêtre Tracks.

La fenêtre Library montre initialement les régions que
vous avez importé dans Deck, avec la commande Add
Audio, par exemple. Si vous voulez voir toutes les
régions de votre séance dans cette fenêtre, sélection-
nez Update from Session dans le sous-menu Library
Operations du menu Session. Pour plus d'informations
sur Library Operations, voir “Menu Session” à la page
142.
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Fenêtre MIDI

Choisissez Windows > MIDI (Commande-5) pour
ouvrir la fenêtre MIDI.

Fenêtre MIDI

La fenêtre MIDI peut être utilisée pour importer un
fichier MIDI standard à lire dans votre séance en
synchro avec vos pistes audio. Pour plus d'informa-
tions sur l'utilisation du MIDI, voir le chapitre 8 “MIDI
et Synchronisation”.

Indicateur File—Vous montre le nom du fichier MIDI
courant.

Bouton Import—Importe un fichier MIDI dans la
séance. Si vous sélectionnez un nouveau fichier MIDI,
toutes les données MIDI courantes seront effacées.

Deck est uniquement compatible avec l’importation
de fichiers MIDI standards tels que définis par la
version 1.0 de spécification de l’International MIDI
Association (c’est-à-dire, Type 0 et Type 1).

Bouton Subscribe—Souscrit à votre fichier MIDI
standard. Lorsque la fonction Subscribe est activée, et
que Deck est ramené au premier plan, il examine le
fichier MIDI pour voir s’il a été modifié. Si tel est le
cas, Deck le réimporte automatiquement. Cette
fonction vous permet d’éditer votre fichier MIDI en
ayant tous les changements dans votre séance.

Pour que la fonction Subscribe fonctionne correcte-
ment, vous devez réexporter votre fichier au format
MIDI standard en utilisant le même nom.

Bouton Mute All—Mute toutes les pistes MIDI. Cette
commande est prioritaire sur les boutons Solo et Mute
des pistes MIDI individuelles.

Piste MIDI Thru—La première piste de la fenêtre
MIDI est la piste MIDI Thru.

Port MIDI Thru—Utilise le port par défaut de la boîte
de dialogue MIDI Preferences comme port à travers
lequel les données MIDI sortantes sont envoyées.

Bouton MIDI Thru—Active et désactive la piste MIDI
Thru. Lorsque le bouton est allumé, Deck renvoie
toutes les données MIDI entrant dans le système vers
le port MIDI Thru.

Nom de la piste—Renommez une piste en Com-
mande-cliquant dessus.
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Indicateur de port de piste —Si vous utilisez OMS,
le pop-up menu affiche une liste de vos instruments .
Si vous utilisez MIDI Setup interne, cette zone affiche
les ports choisis dans MIDI Setup du menu Options.

Indicateur de canal de piste—Indique le canal à
travers lequel les données MIDI sont lues. Changez-le
en cliquant et en faisant glisser vers le haut ou le bas
jusqu’au numéro de canal désiré. Un (-) indique que
les canaux du fichier original seront utilisés.

Boutons Solo et Mute—Solo vous permet de
n’entendre que cette piste, Mute en désactive la
lecture, plusieurs pistes peuvent être sur Solo
simultanément et ce dernier est prioritaire sur Mute.

Fenêtre Effect

Fenêtre QuickTime

Choisissez Windows > QuickTime (Commande-4)
pour ouvrir la fenêtre QuickTime. La fenêtre Quick-
Time vous permet de charger et de lire un film
QuickTime en synchro avec votre audionumérique.
Pour plus d'informations sur l'utilisation de films
QuickTime et la description des commandes du menu
QuickTime, voir le chapitre 7 “QuickTime”. Voir
également “Menu QuickTime” à la page 144, pour plus
d'informations sur les fonctions QuickTime.

Fenêtre Effect

Choisissez Windows > Effect (Commande-7) pour
ouvrir la fenêtre Effect. La fenêtre Effect contient les
contrôles pour tous les effets intégrés en temps réel.
Pour plus d'informations sur l'utilisation des effets,
voir le chapitre 5 “Effets”.
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Vous pouvez utiliser les boîtes Sélecteur d'effet de la
fenêtre Mixer pour ajouter jusqu'à quatre effets par
piste de lecture. Ouvrez ensuite la fenêtre Effect
(Commande-7) pour voir des contrôles pour chaque
effet. Vous pouvez configurer la fenêtre Effect en
utilisant le sous-menu Preferences du menu File.

En utilisant l’indicateur de valeur de contrôle de la
fenêtre Transport, suivez la valeur des curseurs que
vous déplacez. Ceci peut aider à supprimer une bande
de fréquence particulière avec un EQ ou à ajuster le
temps de retard d’un effet Delay, par exemple

Fenêtre Master Outputs, stéréo

Fenêtre Master Outputs

Choisissez Windows > Master Outputs (Commande-
9) pour ouvrir la fenêtre Master Outputs. Utilisez la
fenêtre Master Outputs pour contrôler et atténuer les
niveaux des paires de sortie stéréo. Vous pouvez
également assigner des plug-ins VST aux sorties mono
et stéréo.

Boîtes d’indication de sortie—Affichent l’assigna-
tion du canal master de sortie de votre interface audio.
Elles sont toujours groupées en paires stéréo.

Pop-up menus Sélecteur d'effet (Mono/Stereo)—
Vous permettent d’assigner jusqu'à quatre effets en
temps réel (uniquement VST) sur un canal de sortie
master mono (mono-to-mono) ou sur une paire de
sortie master stéréo (stereo-to-stereo). Pour désactiver
temporairement un effet, cliquez sur le bouton On/Off
de l'effet à gauche de sa boîte Sélecteur. Pour retirer
un effet et tous ses réglages de façon permanente,
réglez le sélecteur sur Thru. Pour ouvrir la fenêtre
d’édition d’un effet VST, Option-cliquez sur le nom de
l’effet VST ou choisissez Open editor dans le pop-up
menu. Pour plus d'informations sur l'utilisation des
effets VST dans la fenêtre Master Outputs, voir le
chapitre 5 “Effets”.
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CPU—contrôle le pourcentage de cycles de processeur
maximum en temps réel que Deck utilise.

Disk—contrôle le pourcentage de transfert maximum
sur votre disque dur.

RAM—contrôle la quantité de RAM disponible dans la
quantité de RAM allouée à Deck. Voir “Allouer de la
RAM à Deck” à la page 10.

Menu File

Le menu File contient la plupart des commandes que
vous utiliserez pour créer, ouvrir, importer, charger et
gérer les fichiers différents utilisés par Deck.

New (Commande-N)—Crée une nouvelle séance.

Open (Commande-O)—Ouvre une séance.

Close Session (Option-Commande-W)—Ferme la
séance courante.

Save (Commande-S)—Enregistre tous les change-
ments apportés à la séance depuis la dernière
sauvegarde. Si “Always save regions when Session is
saved” est coché (File > Preferences > General),
enregistrer la séance inclut toutes les définitions de
région et leurs fichiers son associés.

Save A Copy As—Vous permet de créer et d’enregis-
trer une copie de la séance sous un nouveau nom.
Cette procédure ne copie que le document de séance
et non les dossiers audio files et cross-fades associés.

Lorsque deux fichiers de séance partagent les mêmes
fichiers audio, toutes les éditions destructives
(Normalize, Invert, etc.) apparaissent dans les deux.
Pour cette raison, il est souvent conseillé d’exécuter
des éditions destructives sur une copie en utilisant le
bouton Make a copy de la boîte de dialogue Destruc-
tive Effects.

Fadeur Master—Le fadeur de volume Master contrôle
le niveau des sorties stéréo master. Les valeurs de
fadeur sont affichées dans la boîte Indicateur de valeur
de contrôle de la fenêtre Transport. Les Vu-mètres et
la Diode de clip sont post-fadeur sur les sorties master.

Vu-mètres et Diode de clip—Montrent le niveau
d’amplitude du signal sur les sorties stéréo master.
Utilisez-les pour ajuster le signal de sortie master le
plus haut possible sans clipper. S’il est trop haut, la
diode de clip (en haut des Vu-mètres) s’allume.
Cliquez dessus pour l’éteindre, puis ajustez votre
signal avec le fadeur Master.

Fenêtre CPU Meter

Choisissez Windows > CPU Meter (Commande-0)
pour ouvrir la fenêtre CPU Meter. Utilisez la fenêtre
CPU Meter pour contrôler l’utilisation du processeur,
du disque et de la RAM.

Fenêtre CPU Meter
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Revert—Annule tous les changements apportés à la
séance courante et ouvre la version la plus récemment
enregistrée de cette séance.

Add Audio to Clipboard (Commande-D)—Vous
permet de sélectionner un fichier son ou un ensemble
de fichiers son dans un disque dur monté et d’ajouter
ces fichiers son dans le Presse-papiers et dans la
fenêtre Library pour les coller dans une piste de la
fenêtre Tracks. Remarquez qu’une séance doit déjà
être ouverte pour pouvoir utiliser cette commande.
Pour plus d'informations sur l’ajout d’audio dans une
séance, voir “Ajouter des fichiers audio et des régions
à une séance” à la page 22.

Add SND to Clipboard—Vous permet de sélection-
ner une ressource son dans un disque dur monté et
d’ajouter cette ressource son dans le Presse-papiers
pour la coller dans une piste de la fenêtre Tracks.

Add SDII Playlist to Clipboard—Permet à ceux
possédant du matériel Digidesign d’éditer les playlists
en utilisant le logiciel Sound Designer II puis
d’importer facilement leur travail dans une séance
Deck.

Load Audio File (Commande-l)—Cette commande
est un reste de la version originale de Deck et n’a été
conservée que pour satisfaire les utilisateurs de cette
ancienne version. En général, vous feriez mieux
d’ajouter de l’audio directement dans la fenêtre Tracks
en utilisant la commande Add Audio to Clipboard.

Utiliser la commande Load Audio File comme
raccourci vous permet de charger directement un
fichier son existant sur une piste de lecture active.

Seuls des fichiers son Sound Designer II monophoni-
ques ou stéréo séparés peuvent être chargés avec la
commande Load Audio File. Pour d’autres formats de
fichier, voir “Ajouter des fichiers audio et des régions à
une séance” à la page 22.

Add Audio CD Track To Clipboard (Option-
Commande-D)—Si vous possédez un lecteur CD-
ROM intégré Apple en 2x ou plus ou un autre lecteur
compatible, vous pouvez utiliser la commande Add
Audio CD Track To Clipboard pour ajouter des pistes à
partir d'un CD audio dans le Presse-papiers de Deck.
Remarquez qu’il s’agit d’un processus de transfert
numérique et qu’il n’y a donc pas de perte de signal
ou de qualité sonore. Remarquez également que nous
utilisons QuickTime pour accomplir les transferts de
CD audio : ne vous étonnez donc pas de l’affichage
d’importation de film que vous verrez lors du transfert.

Afin d’utiliser cette fonction, vous devez
posséder le pilote Apple CD-ROM ou un pilote
100 % compatible, l’extension Système Foreign
File Access avec son fichier Audio CD access, en
version 5.0.1 ou supérieur, et un lecteur CD-
ROM compatible.

Compact Audio File—Vous permet de vous
débarrasser des données audio non-utilisées dans un
fichier son. Compacter l’audio est un processus
destructif. Pour plus d'informations, voir “Utiliser
Compact Session et Compact Audio File” à la page 46.

Si vous utilisez le fichier son entier dans une séance,
vous verrez qu’il n’y a pas de données à supprimer.
Dans un tel cas, Compact Audio File peut ne pas
augmenter l’espace disponible de votre disque dur.

Defragment Audio File—Défragmente un fichier
audio désigné. Vous pouvez préférer optimiser vos
disques durs audio avec une application externe,
comme Norton Speed Disk.
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Launch Metro (Option-Commande-l)—Si le
séquenceur Metro est installé dans votre ordinateur, la
commande Launch Metro lance automatiquement
Metro ou l’amène au premier-plan s’il est déjà ouvert.
Pour plus d'informations sur l’utilisation de Deck avec
Metro, voir “Utiliser Deck avec le séquenceur Metro” à
la page 90.

Import MIDI File—Vous permet d’importer des
fichiers MIDI dans votre séance sans ouvrir la fenêtre
MIDI. Pour plus d'informations sur les fonctions
d’importation MIDI, voir “Importer des fichiers MIDI”
à la page 96.

Les MIDI Preferences sont réglées pour séparer les
canaux lors de l’importation. Si vous ne souhaitez pas
que les canaux soient séparés, désactivez cette
préférence.

Dispose MIDI File—Retire le fichier MIDI courant de
votre séance.

Load MIDI Map—Charge les MIDI Maps précédem-
ment configurés et enregistrées. Ceci est particulière-
ment pratique si vous travaillez régulièrement avec
différentes interfaces de contrôle ou si vous utilisez
fréquemment les mêmes MIDI Maps dans chaque
séance. Pour charger une MIDI Map précédemment
enregistrée, sélectionnez Load MIDI Map dans le menu
File, localisez la MIDI Map désirée sur votre disque dur
et cliquez sur Open. Pour plus d'informations sur la
liaison de contrôleurs MIDI aux fadeurs de Deck, voir
“MIDI Maps” à la page 92.

Save MIDI Map—Enregistre vos MIDI Maps person-
nalisées. Ceci est particulièrement pratique si vous
travaillez régulièrement avec différentes interfaces de
contrôle ou si vous utilisez fréquemment les mêmes
MIDI Maps dans chaque séance. Pour enregistrer votre
MIDI Map, sélectionnez simplement Save MIDI Map
dans le menu File et utilisez la boîte de dialogue qui
vous permet d’enregistrer la MIDI Map courante sur
votre disque dur. Pour plus d'informations sur la
liaison de contrôleurs MIDI aux fadeurs de Deck, voir
“MIDI Maps” à la page 92.

Preferences

General Preferences

Boîte de dialogue General Preferences

Autostop at end of Session—Vous permet de
sélectionner si Deck doit automatiquement arrêter la
lecture lorsque la fin de la piste la plus longue de la
séance courante est atteinte.

Always save regions when Session is saved—
Vérifie que toutes les régions audio que vous avez créé
ou édité sont enregistrées en même temps que la
séance. Si vous désactivez cette préférence, les régions
audio que vous créez n’existeront que pour la séance
et ne seront pas accessibles par d’autres programmes
(par exemple, Peak) avant que vous ne sélectionniez la
commande Export Session Regions du menu Session.
Cette préférence devrait en général être activée, en
particulier pour que le compactage fonctionne.

Rewrite region list—Vous permet de sélectionner
exactement ce qui arrive lorsque les régions sont
enregistrés en dehors de leurs fichiers son source. Si
elle est activée, les régions existantes sont supprimées
du fichier son source et remplacées par les régions
courantes lorsque la séance est enregistrée. Si elle est
désactivée, les régions courantes sont ajoutées au
fichier son source. Les régions ayant le même nom
remplace les versions plus anciennes, mais aucune
région de fichier son existante n’est supprimée.
Utilisez cette option avec soin. Si tous les fichiers son
de la séance courante ne sont utilisés que par cette
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séance, cette commande conservent ces fichiers son
en parfaite synchro avec la séance. Ceci permet
d’obtenir les meilleurs résultats avec la commande
Compact Session en vérifiant qu’aucune région
étrangère ne reste dans les fichiers son source. Cette
préférence doit être activée pour que le compactage
fonctionne.

Stop audio playback if the drive is too slow—
Vous permet de régler avec quelle précision Deck
vérifie que votre disque dur est trop lent. Si vous
tentez de lire plusieurs pistes sur un disque dur très
lent, Deck ne pourra peut être pas les lire sans un petit
saut dans la lecture. Ce saut sera souvent si subtil que
vous ne pourrez pas l’entendre. Lorsque cette
préférence est activée, Deck affiche une boîte de
dialogue et arrête immédiatement la lecture dès que le
disque risque de créer un saut dans la lecture. Lorsque
cette préférence est désactivée, Deck continue à lire,
même si un léger saut est possible.

Si vous mixez en direct directement vers un
DAT ou un support de mastering, activez cette
préférence. Elle garantit que la lecture audio
sera supervisée et arrêtée avant qu’un saut ne
survienne. Si vous éditez simplement du son et
que vous comptez mixer sur disque, laissez
cette préférence désactivée. La plupart des
sauts ne seront pas audibles et même si vous
deviez en entendre un, il n’apparaîtrait pas
dans le fichier master qui provient du mixage
sur disque.

Change region start times with BPM change—
Cette préférence ne s’applique qu’aux éditions faites
dans la fenêtre Tracks lorsque vous êtes en Mode
pulsation. Lorsque cette préférence est activée, tout
changement de tempo dans la fenêtre Tracks déplace
toutes les régions audio pour ajuster leurs temps de
départ sur les nouvelles limites mesure/pulsation. Ceci
est pratique si vous utilisez Deck comme boîte à
rythme virtuelle, avec des sons individuels qui
devaient être déplacés avec un changement de tempo.
Lorsque cette préférence est désactivée, un change-
ment de tempo dans la fenêtre Tracks ne déplace

aucune région audio. Ceci est pratique si vous utilisez
Deck pour arranger des segments d’audio possédant
leurs propres rythmes internes ou si vous faites de la
synchronisation et voulez être sûrs que les temps
audio restent toujours inchangés.

Loop audition—Lorsque cette préférence est activée,
la commande Audition Selection du menu Process
boucle automatiquement le segment sélectionné
pendant la lecture. Lorsque la préférence est
désactivée, Audition Selection ne lit la sélection
qu’une seule fois.

Scroll after play—Lorsque cette préférence est
activée, Deck fait automatiquement défiler la fenêtre
Tracks jusqu’au point où la lecture s’est arrêtée. Vous
pouvez utiliser cette fonction pour trouver facilement
les formes d'onde que vous venez de lire.

Enable multi-processing support—Permet la
compatibilité multi-traitement pour les effets intégrés.
Ceci signifie que les effets intégrés tourneront sur le
second processeur, s’il existe, tandis que toutes les
autres fonctions tourneront sur le processeur
primaire.

Update speed during playback—Cette préférence
vous permet de régler la vitesse à laquelle les
programmes en arrière plan se mettent à jour lors de
la lecture audio dans Deck. Un réglage de 1 permet au
programme en arrière plan de se mettre à jour aussi
souvent que possible. Ce réglage permet de voir
facilement l’activité sur l’écran dans les programmes
en arrière plan (si vous faites tourner Metro en arrière
plan, vous pouvez utiliser un réglage de 1 pour voir
facilement ce qui se passe dans les fenêtres Metro lors
de la lecture dans Deck). Un réglage de 10 empêche
les programmes en arrière plan de se mettre à jour
pendant la lecture, ce qui permet à Deck de monopoli-
ser votre affichage. Ce réglage ne modifie pas du tout
la vitesse du programme en arrière plan., mais
uniquement l’affichage de l’écran. Un réglage de 5 est
suggéré.
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SMPTE Preroll Time—Ce réglage ne s’applique que
si vous enregistrez ou lisez de l’audio en étant online
et synchronisé sur du timecode SMPTE. Dans de tels
cas, le temps de Pre-roll est le temps que vous allouez
à Deck pour se caler et commencer la lecture. Le
nombre de secondes que vous choisissez est le temps
situé entre la première valeur de trame SMPTE reçue
et le début de la lecture de Deck. Si vous possédez un
Macintosh et un disque dur rapides, vous pouvez
régler sur le nombre le plus bas (2 secondes, par
exemple) pour des temps de calage plus rapides. Si
vous possédez un Macintosh et un disque dur lents,
ou que vous avez des problèmes pour vous caler sur le
SMPTE, essayez de régler cette valeur sur 6 ou 8
secondes (dans la plupart des configurations, le
réglage par défaut suffit).

Sound Manager Record Offset—Vous permet de
spécifier un temps de décalage en millisecondes
lorsque vous enregistrez via le Sound Manager
d'Apple. Ceci vous permet des faire des ajustements
pour la latence.

Sound Editor signature—Cette préférence ne
s’applique qu’à la commande Launch Editor du menu
Process. Elle est conçue pour les utilisateurs qui
souhaitent utiliser un éditeur deux pistes dédié pour
éditer plus en détail leurs régions audio de Deck (par
exemple, Peak de BIAS). Il s’agit de la signature
Macintosh du programme que vous voulez lancer
comme éditeur de forme d'onde. Pour choisir le
programme que vous voulez utiliser comme éditeur
externe, cliquez sur le bouton Set et utilisez la boîte de
dialogue Open pour sélectionner le programme.
Lorsque vous cliquez sur le bouton Open, la signature
de l’éditeur apparaît. Vous pouvez alors sélectionner
une région de forme d'onde dans la fenêtre Tracks (en
Mode objet) et sélectionner Launch Editor (Com-
mande-E) dans le menu Process. L’éditeur audio est
lancé et le fichier son apparaît avec le segment
approprié sélectionné. Pour plus d'informations sur
l'utilisation d’un éditeur externe avec Deck, voir
“Utiliser un éditeur externe” à la page 50.

Équivalents touche de Transport—Ces boîtes
indiquent les touches clavier Macintosh qui opèrent
sur vos contrôles de Transport. N'importe quelle
touche tapant un caractère visible peut être utilisée
comme touche de Transport (par exemple, les touches
comme Retour clavier et Effacement ne peuvent pas
être utilisées). Dès que vous réglez ces équivalents, les
boutons de Transport de Deck peuvent être contrôlés
directement à partir du clavier. Pour régler un
équivalent de touche, cliquez sur le bouton Set
approprié et appuyez sur la touche que vous désirez
pour cette fonction.

Seule une fonction peut être utilisé par touche.
Pendant le processus de réglage, si vous tentez
de taper une touche qui est déjà assignée à une
autre fonction (ou si vous cliquez sur une
touche qui n’est pas valide), vous entendez un
signal d’alerte. Vous devez cliquer sur une
touche valide avant de pouvoir continuer.

Color scheme—Vous permet de régler les préféren-
ces de couleur d’affichage pour la forme d'onde, sa
surimpression, son fond, et pour les régions vides.
Vous pouvez également utiliser le fond d’écran et ses
couleurs et choisir ou non d’activer la fonction de
surimpression de la forme d'onde.

Memory & Storage Preferences

Boîte de dialogue Memory & Storage Preferences

Disk buffer size—Deck accomplit ses tâches
d’enregistrement et de lecture en dirigeant les
données audio du disque dur vers la RAM puis vers vos
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sorties audio. Les paquets de données audio placés en
RAM résident dans les buffers de disque. Lorsque vous
avez un petit buffer de disque (128K ou moins), Deck
peut charger et manipuler ces buffers très rapidement,
et donc la réponse du programme peut sembler plus
réactive, mais vous mettez plus de pression sur la
performance du disque dur. Lorsque vous avez un
grand buffer de disque (512K ou plus), il faut plus de
temps à Deck pour charger les buffers du disque, mais
ces chargements peuvent survenir moins souvent, et
donc moins de performance est demandée à votre
disque dur. Si vous avez un Macintosh et un disque
dur rapides, laissez ce réglage sur 192K. Ceci permet
en général une utilisation souple. Si vous avez un
Macintosh plus lent ou un disque dur particulièrement
plus lent (un disque dur optique effaçable, par
exemple) augmentez ces buffers jusqu'à ce que votre
performance de lecture augmente. Il est courant, avec
des disques durs extrêmement lents, d’utiliser un
réglage de buffer de disque de 1024K.

Votre buffer de disque est stocké en RAM. Si vous
augmentez la taille de votre buffer de disque, vous
devriez également augmenter la quantité de RAM que
vous allouez à Deck. Pour faire cela, sélectionnez
l’icône de Deck dans le Finder et choisissez Lire les
informations dans le menu Fichier. Utilisez la fenêtre
pour augmenter l’allocation Souhaitée. Multipliez le
nombre de pistes par l’augmentation de la taille du
buffer de disque et entrez cette quantité (souvenez-
vous, il y a un buffer de disque par piste de lecture).

Max. play tracks—Utilisez ce réglage pour sélection-
ner le nombre de pistes de lecture des séances Deck.
Vous pouvez diminuer ce nombre si vous voulez
utiliser moins de pistes de lecture (pour économiser
de la RAM en diminuant le nombre de buffers alloués,
par exemple) mais vous ne pouvez pas augmenter le
nombre de pistes au-dessus des limites de votre
système. Il est très possible de dépasser les capacités
de votre système en créant plus de pistes de lecture
que ne peuvent en gérer votre processeur ou votre
disque dur. Si vous ajustez cette valeur, il est
recommandé de conserver activé “Stop audio playback
if the drive is too slow” dans General Preferences.

Automation buffer—Ce réglage est le nombre de
points d'automation alloués à votre séance. Si vous
utilisez des enveloppes d'automation de base pour des
changements de niveau et de pan simples, ce réglage
devrait suffire. Si vous créez des enveloppes comple-
xes ou utilisez de grandes quantités d’enregistrement
de fadeur, vous devriez augmenter la taille de buffer.
Souvenez-vous, si vous augmentez d’une grande
quantité, vous devriez également augmenter la
quantité de RAM allouée à Deck.

MIDI buffer—Ce réglage est le nombre d’événements
MIDI alloués à votre séance. Le réglage par défaut
devrait suffire pour de petits fichiers. Si vous avez de
longs fichiers MIDI ou beaucoup de pistes, vous
pouvez augmenter cette quantité. Souvenez-vous, si
vous augmentez d’une grande quantité, vous devriez
également augmenter la quantité de RAM allouée à
Deck. Si vous n’utilisez jamais de MIDI, vous pouvez
régler ceci sur 0 pour garder de la RAM.

Levels Preferences

Audition Volume—Détermine le niveau de volume
d’écoute. Vous pouvez choisir une valeur en dB ou un
nombre entre 0 et 1023.

Audition Outputs—Règle les sorties d’écoute sur une
paire de sorties stéréo de votre interface audio
compatible ASIO.
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Clip Light Threshold—La diode de clip s’allume si le
signal entrant est au-dessus du seuil de la diode de
clip. Le réglage par défaut est 0.00 dB—utilisez ce
réglage pour le baisser. Souvenez-vous, l’audio clippé
peut être distordu.

Only compact files that will free disk space—
Cette préférence et celles qui lui sont associées
contrôlent la quantité d’espace disque que les
commandes Compact File et Compact Session vont
libérer. Les commandes Compact écrivent chaque
région dans un nouveau fichier et éliminent toutes les
données non-utilisées dans le fichier original.
Cependant, si vous avez beaucoup de régions
superposées dans un fichier, le processus de
compactage ne vous fait pas gagner d’espace disque ;
il pourrait même en prendre plus. Il est recommandé
de laisser ce réglage activé.

Only compact files that will free x percent—
Comme la préférence ci-dessus, cette préférence
contraint encore plus les commandes Compact.
Choisissez simplement un pourcentage pour que les
commandes Compact n’agissent pas en-dessous de
cette quantité.

Only compact files that will free x MB—Comme la
préférence ci-dessus, cette préférence contraint
encore plus les commandes Compact. Choisissez
simplement un nombre pour que les commandes
Compact n’agissent pas à moins de libérer au moins
cet espace disque.

Bit Depth Conversion—Règle la méthode de
conversion du nombre de bits par défaut dans les
boîtes de dialogue Mix-To-Disk, Mix Regions as Files et
Export Movie. La conversion du nombre de bits ne
modifie que le mixage et n’est activé qu’au moment où
vous convertissez de l’audio 16 bits en 8 bits. Le
réglage ne modifie que le choix par défaut qui apparaît
dans les pop-up menus Bit Depth Conversion de
Deck—vous pouvez toujours utiliser les pop-up menus
pour sélectionner une autre des quatre méthodes
lorsque vous mixez ou exportez de l’audio.

Use Soft Saturation—Permet la saturation douce. La
saturation douce imite la distorsion analogique et
compresse le segment dynamique pour vous donner
plus de marge supplémentaire avant de clipper.
Néanmoins, il vaut mieux ajuster vos niveaux d’entrée
lorsque vous enregistrez pour éviter de clipper et ne
pas utiliser la saturation douce.

Slave Settings Preferences

Boîte de dialogue Slave Settings Preferences

Current slave—Cet indicateur montre le nom du
programme esclave de Deck. Il s’agit en général d’un
séquenceur (par exemple, Metro), mais peut être
n'importe quel programme en arrière plan et
comprenant l’architecture de synchronisation. Si vous
avez un programme incompatible avec cette architec-
ture, contactez BIAS et le fabriquant du programme.

Vous n’êtes pas obligé de choisir un programme
Current Slave. Le logiciel esclave se fait automatique-
ment connaître de Deck grâce aux AppleEvents. Tout
ce qui vous reste à faire est de lancer le programme
esclave avec Deck en arrière plan. Si le programme est
compatible, son nom apparaît dans cet indicateur.

Open Slave Documents—Cette case permet de
choisir si Deck doit démarrer l’application esclave et
ouvrir le document associé dès qu’une séance est
ouverte. Lorsque vous utilisez Metro avec Deck, par
exemple, Deck garde trace du fichier MIDI ouvert dans
Metro et associe ce fichier MIDI avec le fichier de
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séance courant. Lorsque Open Slave Documents est
coché, ouvrir une séance Deck ouvre automatique-
ment le fichier MIDI associé dans Metro.

Deck et Metro peuvent ouvrir l'autre application et
son document associé. Activez cette fonction dans l’un
des programmes, mais pas dans les deux. Choisissez
quel est le programme que vous utilisez en général en
premier pour composer ou arranger, et configurez-le
pour ouvrir les documents dans l'autre application.

Quit Slave when Quitting—Cette case permet de
forcer l’application esclave à quitter lorsque vous
quittez Deck. Cette fonction sert simplement à faire
gagner du temps, si vous utilisez l’esclave de façon
transparente et que vous ne voulez pas vous soucier
de savoir si l’esclave est même en train de tourner.

Save Slave’s Document When Saving—Cette case
permet de choisir si Deck doit automatiquement
enregistrer le document du programme esclave dès
que la séance courante est enregistrée. Cette
préférence permet de vérifier que les versions de la
séance Deck restent en synchro avec les documents de
l’application esclave (les fichiers MIDI de Metro).

Always Pass Selection—Cette case active la fonction
Pass Selection dans Deck. Dès lors, si vous arrêtez
Deck et passez dans Metro, la fenêtre Transport et
d’autres fenêtres de Metro seront placées au même
temps. Par exemple, si vous arrêtez Deck à la mesure
37 et que vous passez dans Metro pour éditer la même
partie, toutes les fenêtres de Metro montrent les
événements MIDI correspondants à la mesure 37.

MIDI Preferences

Boîte de dialogue MIDI Preferences

Split channels on incoming MIDI files—Lorsque
cette préférence est activée, Deck sépare les canaux
lorsque vous importez un fichier MIDI. Ceci est
pratique lorsque vous importez des fichiers MIDI Type
0, qui stockent toutes les données de piste dans un
seul canal.

Default Output Port—Ce pop-up menu liste vos
ports MIDI et utilise le premier comme port de sortie
par défaut. Pour changer le port, sélectionnez
simplement un port différent avec ce pop-up menu.

Timecode Output Port—Ce pop-up menu contrôle à
travers quel port le timecode MIDI sortant est envoyé.
Pour changer le port, sélectionnez simplement un port
différent en utilisant ce pop-up menu.

Effects Preferences

Boîte de dialogue Effects Preferences

Make rows as wide as the window and sliders
per row—Ces options contrôlent la disposition à
l’écran des curseurs de la fenêtre Effect. “Make rows as
wide as the window” vous permet de reconfigurer la
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taille de la fenêtre en utilisant l’outil taille de fenêtre
Macintosh (la zone située dans le coin inférieur droit
de la fenêtre Effect). Le champ sliders per row vous
permet de spécifier une largeur pour la fenêtre Effect.

Effects Allocation—Vous permet de spécifier le
nombre maximum d’effets intégrés en temps réel,
pour chaque effet. Pour régler cette préférence,
cliquez sur le nom de l'effet que vous voulez allouer,
puis entrez un nombre dans la boîte Number to
Allocate en-dessous.

Delay line length—Règle la durée maximum de la
ligne à retard (ou temps de boucle) pour un effet de
retard en temps réel. Ce réglage est en millisecondes
(ms) ou millièmes de seconde.

Save Settings As Template

Choisissez File > Preferences > Save Settings As
Template pour que Deck prenne un cliché de la
position courante de toutes les fenêtres ouvertes de la
séance et l’utilise comme modèle. Dès que vous créez
une nouvelle séance, Deck va automatiquement ouvrir
uniquement ces fenêtres en les plaçant au même
endroit que lorsque vous avez sélectionné Save
Settings As Template.

Quit (Commande-Q)—Ferme la séance courante et
quitte Deck.

Menu Edit

La plupart des éditions de Deck consistent à placer des
composants (régions de fichier son), à les copier et/ou
à les coller. Le menu Edit contient toutes les comman-
des que vous utiliserez pour appliquer vos fonctions
d’édition Macintosh.

Undo (Commande-Z)—Annule l'effet de la dernière
opération d’édition effectuée. Undo n’annule que
l’action la plus récente. Deck vous avertit toujours si
vous exécutez un processus qui ne peut être annulé
(certains effets destructifs, par exemple).

Clipboard Memories—Vous pouvez copier, couper
et coller, dans et à partir de quatre Presse-papiers,
nommés  A, B, C et D. Seul un des quatre est actif à la
fois. Utilisez le sous-menu Clipboard Memories pour
sélectionner un nouveau Presse-papiers ou utilisez les
raccourcis : Majuscules-Commande-Option-A/B/C/D.
Remarquez que les mémoires de Presse-papiers
inactives retiennent leur contenu. Lorsque vous
utilisez fréquemment des régions, gardez-les dans les
mémoire de Presse-papiers, pour qu’elle soient
toujours prêtes à être collées dans votre séance.

Cut (Commande-X)—Retire les données sélection-
nées de la position originale et les place dans le
Presse-papiers du Macintosh pour les coller (ou les
supprimer).

Cut retire les données et ne modifie pas le temps.
Lorsque vous coupez des données de forme d'onde,
un espace est laissé à l’emplacement des données. Si
vous voulez couper les données de forme d'onde et
refermer l’espace en déplaçant les données de forme
d'onde situées après, utilisez la commande Remove.

Copy (Commande-C)—Duplique les données
sélectionnées et les place dans le Presse-papiers.

Clear (Commande-B ou Effacement)—Retire les
données sélectionné sans les placer dans le Presse-
papiers Macintosh. Cette commande permet de copier
une région de forme d'onde, d’effacer une région
différente puis de coller la région copiée à l’origine.

Si vous copiez des régions depuis plusieurs pistes,
vous devrez sélectionner plusieurs pistes de destina-
tion pour utiliser l’une des commandes Paste. Ne
sélectionner qu’une seule piste de destination ne colle
que sur la première piste copiée.

Paste Before (Majuscules-Commande-V)—Colle le
contenu du Presse-papiers avant le point d'insertion
ou le segment sélectionné, avec la fin de la région
collée placée sur le début du segment sélectionné
précédent.
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Paste At (Option-Commande-V)—Colle le contenu
du Presse-papiers au point d'insertion ou au segment
sélectionné, en remplaçant la sélection si besoin. Si le
contenu du Presse-papiers est plus long que la
destination sélectionnée, le Presse-papiers recouvre
les régions audio situées après le point de collage. Si
vous voulez empêcher que le collage ne dépasse la
taille de la sélection, utilisez Edit > Replace.

Paste After (Commande-V)—Colle le contenu du
Presse-papiers après le point d'insertion ou le segment
sélectionné, avec le début de la région collée placée
sur la fin de la sélection.

Multiple Paste After—Colle le contenu du Presse-
papiers plusieurs fois, comme indiqué, après le point
d'insertion ou le segment sélectionné.

Replace—Remplace la région ou le segment sélec-
tionné avec le contenu du Presse-papiers. Si le
contenu du Presse-papiers est plus long que la
destination sélectionnée, seule la partie du Presse-
papiers qui rentre sera collée. Si le contenu du Presse-
papiers est plus court que la destination sélectionnée,
le contenu du Presse-papiers remplace la sélection, en
créant une zone de silence à la fin de celle-ci.

Slice (Commande-R)—Effectue une séparation du
segment sélectionné, en créant une nouvelle région.
Slice n’est disponible qu’en Mode segment. Pour
découper un segment, sélectionnez-le et choisissez la
commande Slice. Ceci crée une région autonome que
vous pouvez utiliser pour des arrangements. Souve-
nez-vous, Deck offre une façon encore plus rapide
pour découper une région : sélectionnez le segment
que vous désirez, puis gardez la souris enfoncée en
faisant glisser ce segment (ou Option-faites glisser une
copie) vers la nouvelle destination. Cette solution est
souvent plus rapide que la commande Slice lorsque
vous faites des arrangements de base. Cependant, la
commande Slice est très pratique si vous voulez définir
une nouvelle région sans la déplacer.

Vous pouvez également utiliser la commande Slice
lorsqu’un seul point d'insertion est présent. Ceci vous

permet de créer une limite, en générant deux régions
(la région avant la limite et la région après).

Insert At—Effectue les mêmes fonctions de base que
la commande Paste At, sauf qu’elle pousse dans le
temps toutes les données situées après le point
d'insertion, de la durée du Presse-papiers. Insert At ne
remplace jamais les données de forme d'onde. Si un
segment ou une région est sélectionné, la commande
Insert At va simplement insérer le début du Presse-
papiers à son point de départ et poussera toutes les
régions suivantes plus tard dans le temps. La région ou
le segment ne sera pas supprimé.

Si vous copiez des régions depuis plusieurs pistes,
sélectionnez de même plusieurs pistes de destination
avec l’une des commandes Insert. Sélectionner une
seule piste n’insère que sur la première piste copiée.

Insert After—Effectue les mêmes fonctions de base
que la commande Paste After, sauf qu’elle pousse dans
le temps toutes les données situées après le point
d'insertion, de la durée du contenu du Presse-papiers.
Comme Insert At, la commande Insert After ne
remplace jamais les données de forme d'onde. Si un
segment ou une région est sélectionné, la commande
Insert After va simplement insérer le début du Presse-
papiers à son point de départ et poussera toutes les
régions suivantes plus tard dans le temps. La région ou
le segment ne sera pas supprimé.

Vous pouvez effectuer de nombreuses éditions en
faisant glisser ou en utilisant les flèches avec Com-
mande, Option et Contrôle (la touche Contrôle
effectue des fonctions d’insertion). Expérimenter avec
ces combinaisons de touche vous aide à développer
des méthodes d’édition efficaces. Pour plus d'informa-
tions, voir “Fenêtre Tracks” à la page 103.

Insert Time—Insère du temps vide sur des pistes.
Pour insérer du temps, sélectionnez la région ou le
segment après lequel vous voulez créer un espace
vide, puis choisissez Insert Time. Lorsque la boîte de
dialogue apparaît, le temps de départ est par défaut le
temps de départ du segment ou de la région sélec-
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tionné et le temps de fin est par défaut le temps de fin
du segment ou de la région sélectionné. Si vous voulez
changer ces valeurs, entrez les nouveaux temps de
départ et de fin désirés dans les boîtes. Ceci détermine
les temps de départ et de fin du silence que vous
voulez ajouter. Cliquez ensuite sur OK : l’espace vide
est inséré sur les pistes sélectionnées lorsque vous
choisissez Insert Time. Aucune donnée n’est
supprimée—un temps vide est simplement inséré et la
forme d'onde à droite de la sélection est déplacée de
la durée du temps vide. Si vous entrez un temps de
départ situé au milieu de régions existantes, ces
régions sont séparées dans de nouvelles régions pour
laisser de la place au temps vide. Remarquez que les
unités de temps de la boîte de dialogue Insert Time
sont par défaut les unités de l'axe de votre séance.

Remove (Commande-Y)—Supprime le temps réel
associé à la région sélectionnée ou au segment, ce qui
ramène en avant dans le temps les régions des pistes
sélectionnées de la quantité des données supprimées.
Utilisez la commande Remove pour empêcher la
création de temps vide sur des pistes et pour refermer
automatiquement le trou créé par une suppression.

Select All (Commande-A)—Desélectionne toutes les
données de forme d'onde des pistes courantes. Pour
sélectionner tout sur une seule piste, placez un point
d'insertion sur cette piste ou sélectionnez un segment
ou une région de la piste, puis choisissez la commande
Select All. Pour sélectionner tout sur plusieurs pistes,
placez un point d'insertion sur ces pistes ou sélection-
nez des segments ou des régions sur ces pistes, puis
choisissez la commande Select All.

Deselect (Commande -U)—Desélectionne tous les
segments ou les régions, en vous laissant sans
sélection ou sans point d'insertion dans la fenêtre
Tracks.

Rename—Renomme la région ou la piste de fichier
son sélectionnée. Pour renommer une piste, sélection-
nez cette piste de lecture ou de travail en cliquant
dans la zone nom de piste à gauche de la fenêtre
Tracks, puis choisissez la commande Rename. Vous

pouvez renommer des pistes, des états de Mixer et des
temps de position dans la fenêtre Mixer et la fenêtre
Transport en Commande-cliquant sur le pop-up menu
playlist, état de Mixer ou temps de position spécifique.

Make Contiguous—Colle ensemble des formes
d'onde sélectionnées. Ce collage se fait toujours sur la
gauche. Si vous avez beaucoup de régions séparées sur
la même piste, toutes les régions se collent ensemble,
avec la première qui se place au début de la séance. Si
vous avez une seule région, Make Contiguous colle
cette région au début de la séance.

Menu Process

Le menu Process contient tous les commandes que
vous utiliserez pour créer de nouvelles pistes et pour
traiter l’audio de façon constructive ou destructive. Il
vous donne accès aux fades et aux crossfades, à la
normalisation et aux autres effets, et vous permet de
contrôler les fonctions de bounce et de mixage de la
piste.

New Track (Commande-K)—Crée un nombre
spécifié de pistes vides. Si vous avez déjà atteint la
quantité maximum de pistes audio de votre système
dans la fenêtre Tracks, cette commande crée de
nouvelles pistes de travail vides.

Si vous avez ajouté des régions audio dans le Presse-
papiers en utilisant Add Audio to Clipboard du menu
File, vous pouvez créer automatiquement de nouvelles
pistes dans la fenêtre Tracks en choisissant simple-
ment la commande Paste At ou Paste After sans avoir
de point d'insertion ou de segment sélectionné.

Bounce All to Mono Clipboard (Majuscules-
Commande-B)—La commande Bounce to Mono
Clipboard est très importante car elle vous permet de
remixer une ou plusieurs pistes sur disque, pour les
combiner en lecture sur une seule piste. La commande
bounce automatiquement le segment sélectionné dans
le Presse-papiers, avec les points d'automation, les
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crossfades et les effets en temps réel. Bounce to Mono
Clipboard mixe toujours toutes les pistes de lecture,
donc si vous voulez retirer certaines pistes du mixage,
utilisez le bouton Mute pour muter ces pistes. Lorsque
vous choisissez Bounce to Mono Clipboard, toute
l’information de pan des pistes de lecture est ignorée
et un fichier son mono est obtenu. Pour placer le
nouveau fichier mixé sur une piste, sélectionnez la
destination (avec un point d'insertion ou un segment)
et choisissez la commande Paste ou Insert.

Si vous ne bouncez qu’une partie de la séance
courante dans le Presse-papiers, sélectionnez la piste
vide de destination pour spécifier le segment à
bouncer. Deck bounce toujours toutes les pistes de
lecture, et donc en utilisant cette méthode, vous
revenez à la fenêtre Tracks après le bounce, avec le
segment correct sélectionné. Choisissez ensuite Paste
At pour coller le fichier de bounce en phase avec ses
pistes sources. Remarquez que ceci fonctionne
également si vous sélectionnez un segment de
destination sur une piste de travail.

Dès que vous avez bouncé plusieurs pistes en mono
ou stéréo et collé le fichier résultant, déplacez les
pistes source originales sur des pistes de travail et
créez de nouvelles pistes vides. Utilisez ces nouvelles
pistes vides pour enregistrer ou arranger plus d’audio.
En suivant ce processus, vous pouvez créer des
mixages qui contiennent des centaines de pistes sans
aucune dégradation du signal analogique. Souvenez-
vous, vous pouvez également mixer les pistes de
travail lorsque la commande Virtual Mix est activée.

Bounce All to Stereo Clipboard (Option-
Commande-B)—Fonctionne de la même façon que la
commande Bounce to Mono Clipboard, sauf qu’elle
crée un fichier mixé stéréo et le place dans le Presse-
papiers. Ce fichier mixé reflète le segment sélectionné,
avec tous les points d'automation, les crossfades et les
effets en temps réel. Bounce to Stereo Clipboard mixe
toujours toutes les pistes de lecture, donc si vous
voulez retirer certaines pistes du mixage, utilisez le
bouton Mute pour muter ces pistes. Lorsque vous
choisissez Bounce to Stereo Clipboard, toute

l’automation de pan et de volume et les effets en
temps réel sont utilisés, et deux fichiers son mono
sont produits. Pour placer ces nouveaux fichiers son
mixés sur des pistes, sélectionnez les pistes de
destination (vous devez placer un point d'insertion ou
un segment entre deux pistes) et choisissez la
commande Paste ou Insert. Pour avoir quelques trucs,
voir Bounce All to Mono Clipboard ci-dessus.

Bouncer dans le Presse-papiers est très pratique pour
créer des sous-mixages internes dans votre séance
Deck. Bouncez des pistes lorsque vous tentez de
supprimer plusieurs pistes pour faire de la place aux
nouvelles pistes (pour des besoins d’overdub). Si vous
avez fini votre séance Deck et que vous voulez créer
un fichier master mixé sur votre disque dur, voir la
commande Mix to Disk ci-dessous.

Mix to Disk (Option-Commande-M)—Crée un
fichier son mono ou stéréo Sound Designer II, AIFF,
Sound Resource (.SND), Wave (.WAV) ou QuickTime
qui reflète exactement la façon dont la séance sonne
lorsqu’elle est lue (il y a une exception à cette règle—
voir l’explication de Virtual Mix qui suit). Tous les
réglages de niveau et de pan, l’automation et les effets
en temps réel sont inclus dans le mixage. Pour plus
d'informations sur la création d’un master final, voir
“Mastering final vers un fichier disque mono ou
stéréo” à la page 76.

Il est en général préférable d’utiliser la commande Mix
to Disk pour créer votre fichier audio master plutôt
que de faire le mastering directement sur DAT. Le
mixage sur un support à accès aléatoire (disque dur),
garantit que votre fichier de mixage final sera une
copie exacte des données de votre séance. Vous
pouvez ensuite transférer cette copie sur une bande
streaming, un disque optique ou un DAT de sauve-
garde de données pour des résultats optimum. Les
enregistreurs audio DAT sont des enregistreurs
séquentiels et utilisent des schémas de correction
d’erreur pour compenser les problèmes d’intégrité
des données. Contrairement à un disque dur, un
enregistreur DAT ne vérifie pas que vos données sont
intègres et il ne peut pas revenir en arrière pour
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retrouver des données s’il rencontre un problème de
transmission de données.

Virtual Mix—Contrôle quelles pistes Deck mixe
lorsque vous choisissez les commandes Bounce ou
Mix to Disk. Lorsque cette commande est désactivée,
Deck ne mixe que les pistes de lecture actives. Ceci
crée un mixage qui sonne exactement de la même
façon que lorsque vous lisez la séance. Cependant,
lorsque la commande Virtual Mix est activée, Deck
mixe également ce qui se trouve sur les pistes de
travail, audio et données d'automation.

Mix Regions As Files (Majuscules-Commande-
M)—Mixe les régions sélectionnées en un fichier son
séparé. Utilisez cette commande pour exporter des
régions d’une séance comme fichier son séparé.
Lorsque vous sélectionnez Mix Regions As Files, la
boîte de dialogue suivante apparaît :

Utilisez cette boîte de dialogue pour sélectionner le
format, le taux d'échantillonnage, le nombre de
canaux, la conversion de nombre de bits (si vous
mixez en 8 bits) et la destination de vos nouveaux
fichiers son.

Fade Selection (Commande-F)—Génère un fade in,
un fade out ou un crossfade sur le segment sélec-

tionné en utilisant les courbes de fade par défaut, mais
pas les temps de fade (réglés avec la commande
Process > Set Default Fade). Si le segment sélec-
tionné ne se trouve que sur le début ou la fin d’une
région, un fade in ou un fade out est généré. Si le
segment sélectionné se trouve entre deux régions, un
crossfade est généré. Pour plus d'informations sur la
création de fades, voir “Fades et crossfades construc-
tifs” à la page 41.

Les crossfades nécessitent qu’il y ait des données de
forme d'onde sur votre disque dur après la fin de la
région 1 (la zone de fade out) et avant le début de la
région 2 (la zone de fade in). Si vous n’avez pas de
données dans ces zones du fichier son source, Deck
vous avertit, mais vous permet de tenter de construire
le crossfade en utilisant les données disponibles.

Set Default Fade—Règle les courbes et le temps de
fade par défaut. Le temps de fade par défaut ne
s’applique que lorsque vous fadez et/ou crossfadez
plusieurs régions. Ces temps de fade par défaut vous
permettent de sélectionner des centaines de régions
et de limites de région, et d’exécuter des fades sur
toutes les régions en une seule fois. Utilisez la
commande Custom Fade si vous voulez entrer
manuellement les temps de fade précis.

Boîte de dialogue Set Fade

Default Fade (Commande-H)—Exécute les fades in,
fades out et crossfades sur toutes les régions de forme
d'onde et limites de région sélectionnées. Les fades et
crossfades sont tous créés en utilisant les courbes et
les temps de fade réglés dans la boîte de dialogue Set
Default Fade. Les temps de fade par défaut sont
utilisés, sans tenir compte du segment sélectionné.
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Si vous sélectionnez une seule région en Mode objet
et que vous choisissez la commande Default Fade, le
fade in et le fade out par défaut seront exécutés sur la
région.

Custom Fade (Commande-G)—Génère un fade in,
un fade out ou un crossfade sur le segment sélec-
tionné, en vous permettant de spécifier les formes et
les temps de fade. Si le segment sélectionné ne se
trouve que sur le début ou la fin d’une région, un fade
in ou un fade out est généré. Si le segment sélectionné
se trouve entre deux régions, un crossfade est généré.
Pour plus d'informations sur la création de fades, voir
“Fades et crossfades constructifs” à la page 41.

Vous devriez utiliser la boîte de dialogue Custom Fade
dès que vous créez un fade ou un crossfade spécialisé
et que vous ne voulez pas utiliser vos formes par
défaut.

Boîte de dialogue Fade In

Si vous utilisez la commande Custom Fade pour créer
un fade in ou un fade out, vous ne verrez qu’un
ensemble d’icônes de forme de fade.

Les crossfades sont créés en mémoire, et si donc Deck
vous avertit qu’il n’y a pas assez de mémoire pour
générer un fade, vous pouvez augmenter la taille de
partition de mémoire (en utilisant la commande Lire
les informations du Finder) et essayer le fade de
nouveau. Si vous avez des problèmes à générer des
fades ou des crossfades extrêmement longs en raison
de limites de mémoire, essayez d’utiliser des
enveloppes d'automation de volume. Celles-ci ne
nécessitent pas de RAM supplémentaire et peuvent
générer des fades 24 bits de n'importe quelle durée.

Delete Fade—Supprime un fade ou crossfade existant
dans le segment sélectionné.

Rebuild Fades—Reconstruit tous les crossfades de
votre séance courante.

Destructive Effects

Le sous-menu Destructive Effects contient tous les
effets audio destructifs. Pour utiliser ces fonctions,
vous devrez sélectionner une ou plusieurs régions en
Mode objet ou sélectionner un segment en Mode
segment. Pour plus d'informations sur les effets
disponibles, voir le chapitre 5 “Effets”.

External Effects

Le sous-menu External Effects liste les plug-ins
Premiere installés dans le dossier Deck Plug-Ins. Pour
utiliser un traitement externe, une région doit être
sélectionnée en Mode objet.

Region Info (Commande-M)—Vous montre
l’information sur une région sélectionnée. Vous devez
sélectionnez la région en Mode objet. Lorsque vous
choisissez la commande Region Info, la boîte de
dialogue suivante apparaît :

Boîte de dialogue Region Information

La boîte de dialogue vous montre le nom de la région,
suivie de l’emplacement sur votre disque dur du
fichier audio associé. Vous pouvez renommer les
régions dans cette boîte de dialogue. Les temps de
départ et de fin ainsi que la durée de la région
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apparaissent en-dessous de l’emplacement du fichier.
Vous pouvez changer le temps de départ de la région
sélectionnée en tapant le nouveau temps dans les
champs Start. Si vous cliquez sur le bouton Capture
Start, le nouveau temps de départ est le temps SMPTE
courant.

Cliquer sur le bouton Show File fait passer Deck en
arrière plan et surimpressionne le fichier audio associé
à la région sur le Bureau. Le bouton Launch Editor fait
passer Deck en arrière plan et ouvre le fichier audio
associé à la région sélectionnée dans votre programme
d'édition sonore. La région sélectionnée sera en
surimpression dans le programme d'édition sonore. Le
bouton Audition lit la région sélectionnée (si la boîte
Loop Audition est cochée, cliquer sur le bouton
Audition boucle la région sélectionnée).

Double-cliquer sur une région de la fenêtre Tracks en
Mode objet ouvre la fenêtre Region Info de cette
région.

Sous-menu Audition

Audition Selection (Commande-T ou Majuscu-
les-Barre d'espace)—La commande Audition
Selection ne lit que la région ou le segment
sélectionné (en mono), en mutant automatique-
ment tout l’audio non-sélectionné. Vous pouvez
utiliser cette commande pour écouter des parties
spécifiques de votre séance pour des besoins
d’édition ou d’arrangement. Souvenez-vous,
Audition peut être utilisé sur une ou plusieurs
pistes en même temps et fonctionne également
sur les pistes virtuelles.

Audition End of Selection—Cette commande vous
permet d'entendre les dernières deux secondes
d'une région ou d’un segment sélectionné. Ceci
peut être pratique for écouter la fin d'une longue
région.

Audition Pre-Post Selection—Cette commande
vous permet d'entendre des parties de l'audio
avant et après la région ou le segment sélectionné.

N’oubliez pas le réglage Loop Audition des
General Preferences (dans le sous-menu
Preferences du menu File). Lorsque cette
option est activée, la région ou le segment
sélectionné sont toujours bouclés automatique-
ment lorsqu’ils sont écoutés en utilisant l’une
des trois méthodes Audition. Ceci est une façon
excellente de tester vos boucles pour des
besoins de composition ou de construction
d’ambiance.

Launch Editor (Commande-E)—Ouvre le pro-
gramme d'édition sonore que vous avez sélectionné
en utilisant le bouton Set dans la boîte de dialogue
General Preferences. Si une région est sélectionnée, le
fichier son qui la contient est ouvert et la région est
automatiquement sélectionnée dans le programme
d'édition sonore. Cette fonction est conçue avant tout
pour les utilisateurs de Sound Designer II qui
souhaitent avoir accès à certains des traitements du
signal destructifs en deux pistes de ce programme. Elle
fonctionne avec d’autres programmes, bien que
certains programmes d’édition audio ne soient pas
compatibles avec les régions. Pour plus d'informations,
voir “Utiliser un éditeur externe” à la page 50.

Automation Thin—Utilisez cette commande pour
supprimer des données d'automation étrangères. Si
vous utilisez la fenêtre Mixer ou une machine externe
pour enregistrer des points d'automation, beaucoup
plus de points de rupture apparaissent que si vous
cliquiez dans la fenêtre Tracks pour ajouter des points
d'automation. Il est plus facile d’éditer des données
d'automation que vous avez enregistré après avoir
utilisé cette commande. Sélectionnez d’abord volume
ou pan dans le pop-menu Affichage de l'automation de
la piste que vous voulez éditer (vous devez être dans la
fenêtre Tracks). Sélectionnez les données que vous
voulez éditer, puis choisissez la commande Automa-
tion Thin. Deck trouve des lignes droites dans les
données et supprime les enveloppes intermédiaires.
Ceci est un processus non-destructif que vous pouvez
annuler.
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Strip Silence—Cette commande fonctionne comme
un noise-gate non-destructif. Lorsque de l’audio est
sélectionné dans la fenêtre Tracks, la commande Strip
Silence crée automatiquement des régions à partir
d’un segment sélectionné en supprimant de façon
non-destructive les zones de silence en se basant sur
les paramètres que vous choisissez dans la boîte de
dialogue suivante :

Boîte de dialogue Strip Silence

L’audio qui est à un niveau supérieur au Noise
Threshold spécifié apparaît dans de nouvelle régions.
Les zones d’audio situées en-dessous du Noise
Threshold pendant une durée égale à la Frame Size
sont supprimées de façon non-destructive. Le Noise
Threshold peut être un nombre entre 0 (silence) et
1023 (volume maximum). Frame Size indique le
nombre d’échantillons de chaque “trame” que Deck
utilise pour calculer si l’audio est du signal ou du bruit.
Si vous choisissez une taille de trame trop petite, vous
pouvez finir avec plus de régions que ce que vous
désirez. Release Size indique à Deck combien
d’échantillons inclure au début et à la fin de l’audio
qu’il considère être du signal. Release Size permet
d’être sûr que le début et la fin du signal sont inclus
dans chaque nouvelle région. Frame Size et Release
Size sont en échantillons, pour permettre une édition
extrêmement précise.

Menu Options

Le menu Options contient toutes les commandes pour
configurer l’entrée et la sortie MIDI et le SMPTE,
activer l’enregistrement et la lecture de base de
l'automation, et manipuler les fonctions générales de
l’affichage de la fenêtre Tracks.

MIDI Setup—Deck nécessite que vous installiez Open
Music System (OMS)—disponible gratuitement sur
www.opcode.com—pour utiliser le MIDI avec Deck. En
général, vous devriez configurer la compatibilité OMS
de Deck pour accepter Only OMS Applications et vous
devriez éviter le MIDI Manager d'Apple. Si vous faites
tourner le séquenceur Metro sur votre Macintosh en
synchro avec Deck, vérifiez de régler OMS sur Run
MIDI in background. Ceci améliore la vitesse et la
souplesse lorsque vous passez entre les deux
programmes pendant la lecture.

Le sous-menu SMPTE Format—Utilisez ce sous-
menu pour sélectionner le format SMPTE que vous
voulez recevoir et envoyer lorsque Deck est synchro-
nisé au SMPTE (Deck tente de déterminer automati-
quement le format de timecode entrant, mais vous
devriez toujours le régler pour empêcher des
problèmes de base temporelle). Vous pouvez choisir
entre les formats suivants : 24 Frame (film), 25 Frame
(vidéo PAL/SECAM), 29.97 Frame (vidéo couleur
NTSC), 29.97 Drop-frame (vidéo couleur NTSC avec
horloge de référence), 30 Frame et 30 Drop-frame.

24 frame est utilisé pour la plupart des applications de
film ; 25 frame est pour la vidéo PAL/SECAM ; 29.97 est
pour la vidéo couleur NTSC ; 29.97 drop est pour la
transmission précise de vidéo couleur NTSC avec
horloge de référence ; et 30 frame/30-drop frame sont
des formats mal nommés qui étaient à l’origine utilisé
pour la vidéo noir et blanc, mais ne sont maintenant
plus utilisés en général que pour la synchronisation
temporelle dans des applications audio (et, de façon
très intelligente, sur des conversions film-bande du
type pulldown/pullup).

Si vous travaillez en vidéo NTSC et que quelqu’un vous
envoie une bande vidéo codée en 30 frame sur la piste
d’adresse, vous pouvez considérer que le timecode est
réellement une base temporelle de 29.97 frame. Cette
confusion est un reste des premiers jours du
timecode.

SMPTE Start Time—Décale le Compteur master d’un
nombre de trames SMPTE spécifique. Vous pouvez

http://www.opcode.com
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concevoir ce temps comme le début de la séance
courante. Si vous réglez ensuite Deck pour se
synchroniser en lecture, la séance commence à être
lue lorsque la trame SMPTE Start Time est reçue. Pour
plus d'informations, voir le chapitre 8 “MIDI et
Synchronisation”.

Vous pouvez également utiliser le bouton Capture de
la boîte de dialogue SMPTE Start Time pour placer la
trame courante SMPTE de la bande directement dans
la boîte de dialogue. Souvenez-vous, cependant, que
les fonctions de capture ne sont pas souvent précises
si vous utilisez du timecode longitudinal (LTC), car
son timecode ne peut pas être lu à faibles vitesses.

Si vous utilisez du timecode à intervalle vertical
(VITC), le bouton Capture place toujours l’adresse
correcte de trame SMPTE, même lorsque votre
machine vidéo est à faible vitesse ou en image arrêtée.

SMPTE Online (Commande-J)—Cette commande
met la séance courante online, ce qui signifie qu’elle
est prête à se synchroniser au timecode SMPTE
entrant. Pour caler la lecture sur le code entrant,
sélectionnez cette commande et cliquez sur le bouton
Play de la fenêtre Transport. Ceci met Deck en mode
standby. Dès que le timecode est détecté, Deck
commence à lire à la trame correcte.

Vous aurez besoin d’une source sur bande avec du
timecode SMPTE sur une piste et d’un convertisseur
de timecode SMPTE-MIDI ou d’une interface MIDI
Macintosh pour synchroniser à du SMPTE (MIDI
TimePiece de Mark of the Unicorn ou Studio 5
d’Opcode permettent la conversion SMPTE-MTC).
Pour plus d'informations, voir le chapitre 8 “MIDI et
Synchronisation”.

Pour enregistrer de l’audio en étant online, activez
l’enregistrement d’une piste, sélectionnez la com-
mande SMPTE Online et appuyez sur les boutons
Record et Play de la fenêtre Transport. Ceci met Deck
en mode standby. Dès que le timecode est détecté,
Deck commence l’enregistrement et place automati-
quement l’audio enregistré au temps correct.

Timecode Source—Règle la source de timecode. Si
vous avez une carte Korg 1212 I/O, utilisez DECK II
1212 I/O Driver et sélectionnez Soundlink DRS.

Trigger Sync—Deck offre deux types de synchronisa-
tion. Le mode natif est appelé “resynchro continue” et
est en général le plus préférable des deux modes.
Lorsque Trigger Sync est désactivé, Deck est en mode
resynchro continue. Dans ce mode, Deck examine
toutes les trames SMPTE entrantes pour déterminer si
la vitesse de votre unité de lecture source est correcte.
Lorsque Deck détermine que la lecture source SMPTE
ralentit ou accélère, il modifie le taux d'échantillon-
nage de lecture en temps réel pour compenser les
changements de vitesse. Lorsque cela arrive, vous
pouvez entendre la lecture audio de Deck ralentir ou
accélérer. Le mode resynchro continue garantit que
l’audionumérique de votre session reste étroitement
en synchro avec la source SMPTE.

Lorsque Trigger Sync est activé, le taux d'échantillon-
nage de lecture de la séance n’est pas modifié pendant
la lecture. Deck reste en synchro avec la trame SMPTE
entrante et suit/se cale correctement, mais aucun
ajustement de la vitesse de lecture n’est fait. Trigger
Sync est conçu spécifiquement pour les utilisateurs qui
savent que leur source SMPTE est absolument calée
sur le temps. Pour les professionnels de la vidéo,
utilisez Trigger Sync si vous faites tourner votre
machine vidéo SMPTE source avec une house sync
(“black burst” branché sur une entrée vidéo). Pour les
professionnels de l’audio, utilisez Trigger Sync si vous
faites tourner un multipiste numérique ou un DAT
avec timecode comme source SMPTE ou si vous avez
un enregistreur multipiste audio qui est branché sur
de la house sync.

La conversion en temps réel du taux d'échantillonnage
peut dégrader la qualité générale de l'audio qui est lu.
Pour cette raison, les meilleurs résultats sont atteints
lorsque vous faites tourner Deck avec Trigger Sync
activé et que votre source SMPTE est calée sur de la
house sync.
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Pulldown—Change le taux d'échantillonnage de
lecture master de la séance courante. Lorsque vous
choisissez cette commande, la boîte de dialogue
suivante apparaît :

Boîte de dialogue Session Playback Rate Settings

Session Nominal Rate est le taux de lecture que vous
choisissez lorsque vous créez votre séance. Vous
pouvez changer le taux de lecture en tapant une
nouvelle valeur dans ce champ. Augmenter le taux
d'échantillonnage fait monter la hauteur et diminue la
durée de la séance. Diminuer le taux d'échantillonnage
fait baisser la hauteur et augmente la durée de la
séance.

Le bouton Pull-down baisse automatiquement le taux
de lecture sur un taux pratique lorsque vous éditez de
l’audio sur des transferts vidéo à partir de film, lorsque
vous avez l'intention de revenir au film (magnétique
ou autre) pour le résultat final. Le bouton Reset
change le taux de lecture sur le Session Nominal Rate.
Le bouton Pull-up augmente automatiquement le taux
de lecture sur un taux pratique pour placer votre
audio édité sur du film magnétique (ou sur une DAT
pour le transférer sur film magnétique). Ceci est une
commande très spécialisée qui est pratique dans les
pays NTSC et nous vous présentons une explication
très simplifiée des cas dans lesquels vous pourriez
l’utiliser.

Si vous reconstruisez des pistes audio sur des
transferts vidéo téléciné de films en revenant aux
bande originales Nagra 1/4 de pouce, numérisez tout
l’audio des bandes aux taux 44,1 ou 48 kHz. Réglez
ensuite le taux d'échantillonnage sur Pull-down et

éditez le son à l’image. Lorsque vous envoyez l’audio
finalisé vers un DAT pour le transférer sur film
magnétique (ou directement sur film magnétique),
réinitialisez le taux de Pull-down. Ceci conduit à des
résultats qui sont corrects dans le temps pour le film
et reste la méthode la plus sûre pour préserver la
qualité audio.

Si vous avez construit des pistes audio sur des
transferts vidéo téléciné de films en utilisant des
fichiers audio et des effets de vos bibliothèques de son
ou de votre disque dur (de l’audio qui n’est pas l’audio
original), vous pouvez éditer toutes les bandes audio
aux taux 44,1 kHz ou 48 kHz. Lorsque vous envoyez
l’audio finalisé vers un DAT pour le transférer sur film
magnétique (ou directement sur film magnétique),
choisissez l’option Pull-up de la boîte de dialogue Pull-
down. Ceci conduit à des résultats qui sont corrects
dans le temps pour le film.

Vous pouvez également utiliser la commande
Pulldown pour allonger ou rétrécir l’audio. Par
exemple, si vous avez besoin de remplir 30 secondes,
mais que vous n’avez que 24 secondes d'audio et que
votre Session Nominal Rate est de 44100 Hz, vous
pouvez utiliser l’équation suivante pour allonger les 24
secondes en 30 : (24÷ 30) = (X÷ 44100). Ainsi, si
vous entrez 35280 (X) dans le taux de lecture, Deck
allonge votre audio à la durée désirée. Attention,
cependant, aux ajustements de taux d'échantillonnage
radicaux qui ne sonneront pas très bien.

Output MIDI Time Code—Cette commande vous
permet d’utiliser Deck comme master de MIDI
Timecode. Lorsque vous sélectionnez Output MIDI
Time Code, une encoche apparaît à son côté et Deck
génère automatiquement du timecode et l’envoie à
travers le Timecode Output Port que vous choisissez
dans MIDI Preferences. Pour arrêter d’envoyer du
timecode, choisissez la commande de nouveau pour la
décocher. Si la commande est cochée, Deck envoie du
timecode.
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Sous-menu Automation

Conform To Audio Edits—Active une fonction qui
ajuste les enveloppes d'automation lorsque des
éditions sont faites aux régions qui les contien-
nent. Si vous avez une piste automatisée et que
vous en éditez une partie, l’automation de cette
piste s’ajuste d’elle-même.

Mute All—Mute la lecture de l’automation de
volume et de pan sur toutes les pistes.

Play All—Indique que l’automation de volume et de
pan de toutes les pistes doit être lue.

Record All—Active l’enregistrement de l'automation
de volume et de pan de toutes les pistes.

Erase All—Efface toute l’automation de volume et de
pan enregistrée et dessinée.

Pour plus d'informations sur l’enregistrement et
l’édition de l’automation, voir le chapitre 4 “Édition
visuelle de la forme d'onde” et le chapitre 6 “Automa-
tion, mixage et mastering”.

MIDI Map Faders—Cette commande vous permet de
relier un contrôleur MIDI (un clavier MIDI ou un JL
Cooper FaderMaster, par exemple) directement aux
fadeurs de volume et de pan de la fenêtre Mixer et aux
contrôles de la fenêtre Transport. Ce processus de
liaison est très simple et ne nécessite aucune entrée
de texte.

Pour relier un fadeur de la fenêtre Mixer ou de la
fenêtre Effect à un contrôleur, choisissez MIDI Map
Faders. Tous vos fadeurs s’allument en vert, pour vous
montrer qu’ils sont prêts à être reliés. Ensuite, cliquez
sur les fadeurs que vous voulez contrôler, ce qui les
fait passer en jaune pour indiquer qu’ils sont prêts
pour l’entrée MIDI. Déplacez maintenant le contrôleur
de la machine qui doit contrôler les fadeurs jaunes
sélectionnés (votre fadeur MIDI ou la molette de
modulation de clavier, par exemple). Ces fadeurs
deviennent rouges pour indiquer qu’ils sont reliés.
Pour commencer à déplacer les fadeurs avec un
contrôleur externe, choisissez la commande MIDI Map
Faders pour sortir du mode MIDI Map.

Pour relier les contrôles de la fenêtre Transport sur
des événements de note-on MIDI, choisissez la
commande MIDI Map Faders. Les boutons de la
fenêtre Transport s’allument en vert, pour vous
montrer qu’ils sont prêts à être reliés. Ensuite, cliquez
sur les boutons que vous voulez contrôler, ce qui les
fait passer en jaune pour indiquer qu’ils sont prêts
pour l’entrée MIDI. Générez maintenant un événe-
ment de note-on MIDI sur votre contrôleur matériel
(par exemple, appuyez sur une touche de votre clavier
MIDI). Les boutons sélectionnés deviennent rouges
pour indiquer qu’ils sont reliés. Pour commencer à
utiliser les contrôles de la fenêtre Transport avec votre
contrôleur MIDI externe, choisissez la commande
MIDI Map Faders de nouveau pour sortir du mode
MIDI Map.

Vous ne pouvez pas utiliser cette fonction à moins que
vous n’ayez une interface MIDI compatible OMS et un
contrôleur MIDI. Remarquez que Deck n’est pas
directement compatible avec le JL Cooper CS-10, mais
l’est avec le Tascam US-428.

Mute MIDI Map—Cette commande arrête temporai-
rement le déplacement des fadeurs de la fenêtre Mixer
par vos contrôleurs externes. Elle ne fonctionne que si
vous avez déjà relié des contrôleurs externes aux
fadeurs en utilisant la commande MIDI Map Faders.
Pour réactiver un contrôle externe, choisissez de
nouveau la commande Mute MIDI Map.

Edit MIDI Map—Utilisez cette boîte pour assigner des
numéros de fadeur MIDI, des numéros de canal et des
numéros de note-on à des fonctions spécifiques,
comme le contrôle du pan, du volume et du transport.
Lorsque vous sélectionnez Edit MIDI Map, une boîte
de dialogue apparaît. Sélectionnez maintenant la
fonction que vous voulez assigner au fadeur MIDI et
cliquez sur OK. La boîte de dialogue Edit Map Element
apparaît. Utilisez cette boîte de dialogue pour éditer le
canal MIDI et le numéro MIDI d'une fonction MIDI
assignable.

State Transition Time—La commande State
Transition Time vous permet de sélectionner un
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temps de fade d’automation fixe qui est automatique-
ment utilisé dès que vous enregistrez ou lisez de
l’automation de table en utilisant les états de Mixer
(accessibles dans la fenêtre Transport). Lorsque vous
choisissez la commande State Transition Time, cette
boîte de dialogue apparaît :

L'apparence de cette boîte de dialogue peut varier,
selon votre sélection courante des Unités de l'axe.

Utilisez cette boîte de dialogue pour entrer la durée
du fade qui doit survenir entre le temps où vous
cliquez sur la flèche d’un état de Mixer et le moment
où le nouvel état de Mixer arrive à l'écran. Deck passe
graduellement au nouvel état de Mixer sur cette durée.
Souvenez-vous, ces fades sont enregistrés si vous
enregistrez de l’automation.

Sous-menu Selection Tools

Position at Beginning (Commande-[ )—Fait
défiler la fenêtre Tracks pour vous montrer le
début de la région ou du segment sélectionné.
Ceci est une commande très pratique lorsque vous
zoomez très près et que vous voulez ajuster le
temps de départ de la région sans avoir à
dézoomer pour le trouver.

Position at End (Commande-])—Fait défiler la
fenêtre Tracks pour vous montrer la fin de la
région ou du segment sélectionné. Ceci est une
commande très pratique lorsque vous zoomez très
près et que vous voulez ajuster le temps de fin de
la région sans avoir à dézoomer pour le trouver.

Position to Fit (Commande-, )—Effectue la même
fonction que l’icône Ajuster sur la sélection. Elle
étend ou raccourcit automatiquement l'affichage
pour que la sélection courante remplisse l'écran.
Ceci est vrai que la sélection soit une région ou un
segment de forme d'onde. Cette commande
permet de voir rapidement un segment audio, une

région, une transition ou un événement spécifi-
que.

Set Punch Time From (Commande-\)—Fait passer
les temps de départ et de fin de la sélection
courante de la fenêtre Tracks dans les compteurs
Begin et End de la fenêtre Transport. Utilisez cette
commande lorsque vous voulez sélectionner un
segment de forme d'onde ou une région pour un
enregistrement punch-in ou une lecture en boucle
à l’échantillon près.

    Dès que vous avez un segment de forme d'onde
ou une région sélectionnée, vous pouvez appuyez
sur la touche C du clavier de votre Macintosh pour
régler automatiquement une boucle de repérage.
Ceci transfère automatiquement les temps de
début et de fin du segment ou de la région à la
fenêtre Transport et active le Mode boucle.
Option-C désactive le Mode boucle.

Set from Punch Time (Commande-/)—Effectue
une fonction qui est l’inverse de la commande Set
Punch Time From. Elle lit automatiquement les
temps de départ et de fin de la fenêtre Transport
et sélectionne ce segment dans la fenêtre Tracks.
Le segment est sélectionné sur toute piste ayant
un segment sélectionné ou un point d'insertion.
Souvenez-vous, vous pouvez déplacer et allonger
la sélection en utilisant respectivement les touches
flèches et Majuscules-flèches du clavier du
Macintosh.

Set Selection—Vous permet de sélectionner un
segment en spécifiant les temps de départ et de
fin. Le segment est sélectionné sur toute piste
ayant un segment sélectionné ou un point
d'insertion. Souvenez-vous, vous pouvez déplacer
et allonger la sélection en utilisant respectivement
les touches flèches et Majuscules-flèches du clavier
du Macintosh.

Make Markers From—Crée des marqueurs pour la
sélection courante. Par exemple, si une région est
sélectionnée dans la fenêtre Tracks, Make Markers
From crée automatiquement des marqueurs au
début et à la fin de cette région. Les marqueurs
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apparaissent également dans les pop-up menus
Temps de position de la fenêtre Transport.

Send to Slave (Commande-=)—Envoie la
sélection courante au programme esclave. Par
exemple, si la mesure 37 est sélectionnée dans
Deck, que vous sélectionnez cette commande et
passez dans le programme esclave, celui-ci sera
également placé à la mesure 37.

Snap to Grid—Lorsque cette commande est cochée,
elle active et désactive la grille de la fenêtre Tracks.
Lorsque la grille est activée, toutes les sélections de
segment et les déplacements de segment et de région
seront contraint (collés) à la grille de la fenêtre Tracks.
La grille de la fenêtre Tracks est une grille intelligente,
en ce qu’elle s’ajuste toujours pour correspondre aux
unités courantes. Si vous voyez les formes d'onde à la
trame SMPTE, la grille aligne les éditions sur la trame.
Si vous voyez les formes d'onde à la noire, la grille
aligne les éditions sur la noire. Pour désactiver la grille,
sélectionnez de nouveau cette commande. Souvenez-
vous, les éditions avec la touche flèche (ainsi que
Majuscules-flèche, Commande-flèche, etc.) se placent
toutes sur la grille lorsque celle-ci est activée.

Vous pouvez également activer et désactiver la grille
en utilisant le bouton Grille, situé à gauche du pop-up
menu Unités de l'axe de la fenêtre Tracks.

Set Grid Interval—Il est possible de manipuler la
résolution d’affichage sur un grand nombre de niveaux
différents. Si le pop-up menu Résolution de l'axe à
droite du pop-up menu Unités de l'axe de la fenêtre
Tracks ne vous offre pas les unités de grille que vous
désirez, vous pouvez choisir votre propre résolution
d'affichage en utilisant la commande Set Grid Interval.

L'apparence de cette boîte de dialogue peut varier,
selon votre sélection courante des Unités de l'axe.

Entrez l’intervalle de grille que vous désirez. Vous
pouvez utilisez le temps SMPTE courant en appuyant
sur le bouton Capture.

Set Nudge Time—Lorsque vous utilisez Commande-
flèches sur un objet ou un segment sélectionné dans la
fenêtre Tracks, Deck déplace physiquement l’objet ou
le segment sélectionné à gauche ou à droite d'une
unité, ou d’une piste vers le haut ou le bas.

L'apparence de cette boîte de dialogue peut varier,
selon votre sélection courante des Unités de l'axe.

Entrez le temps de décalage que vous désirez. Vous
pouvez utilisez le temps SMPTE courant en appuyant
sur le bouton Capture.

Time Mode—Le sous-menu Time Mode duplique la
fonction du pop-up menu Unités de l'axe de la fenêtre
Tracks. Utilisez-le pour régler les Unités de l'axe
(Seconds, SMPTE, Samples ou Beat) qui vont être
utilisées par la grille, l’axe temporel et les fonctions
d'édition de la fenêtre Tracks.

Scroll During Playback—Cette fonction vous
permet de (dés)activer le défilement en temps réel de
la fenêtre Tracks. Lorsque cette fonction est activée (il
y a une encoche à côté de son nom dans le menu
Options), la fenêtre Tracks est mise à jour de façon
continue—ou défile—pendant la lecture, pour que les
régions lues soient toujours vues à l’écran.

Boîte de dialogue Hardware Configuration

Hardware Configuration—Vous permet de choisir
et de configurer votre carte audio ou de sélectionner
le matériel audio intégré de votre Macintosh.

Ne changez pas votre configuration matérielle
lorsqu’une ou plusieurs pistes sont activées en
enregistrement dans la fenêtre Mixer ou Tracks.

Ces options ne sont disponibles que si vous avez une
carte audio installée.
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Sync Mode—Réglez ce menu sur Digital si vous
enregistrez numériquement via les entrées
numériques S/PDIF ou AES/EBU de votre carte
audio. Dans les autres cas, laissez sur Internal.

Input Type—Réglez ce menu sur Digital si vous
voulez enregistrer avec les entrées numériques S/
PDIF ou AES/EBU de votre carte audio. Souvenez-
vous, lorsque vous faites cela, les entrées 1 et 2
sont prises sur vos entrées numériques. Lorsque
vous enregistrez en analogique, réglez sur Analog.

Digital Format—Utilisez ce menu pour choisir votre
format numérique d’entrée/sortie.

Mic Input On—Cette case n’est disponible que
lorsque vous avez une carte Audiomedia de
première génération. Cette carte possède un
préampli microphone intégré au lieu d’une entrée
et d’une sortie numérique. Lorsque vous cochez
cette case, votre carte Audiomedia de première
génération mixe automatiquement son entrée
microphone dans les entrées 1 et 2.

Play audio while in background—Permet au
pilote ASIO sélectionné d'opérer lorsque Deck est
en arrière plan. Si vous faites tourner plusieurs
applications audio en utilisant le même pilote
ASIO (par exemple, Peak de BIAS), il vaut mieux
désactiver Play audio while in background.

Record monitoring—Vous permet de contrôler
l’entrée audio dans le domaine numérique lorsque
vous enregistrez.

Sous-menu Analog Input Level (Commande-
Option-0/7)—Si vous possédez un système Pro Tools
1/442 ou Sound Tools II, ce sous-menu n’est pas
disponible. Tous les autres systèmes matériels vous
permettent de régler le niveau du signal entrant.
Utilisez ce sous-menu pour ajuster le niveau d'entrée
de l’enregistrement. Vérifiez que vous regardez les Vu-
mètres d'entrée sur la piste d’enregistrement de la
fenêtre Mixer lorsque vous ajustez ce niveau et essayez
de régler le niveau d’enregistrement aussi haut que
possible (sans clipper). Si le niveau est trop haut, la
diode de clip s’allume. Réglez en général la valeur sur
0 et ajustez le niveau du signal entrant dans votre
Macintosh. Remarquez qu’il existe un raccourci clavier
: appuyez sur les touches Option et Commande et sur
un nombre entre 0 et 7, pour régler rapidement le
niveau d'entrée. Pour plus d'informations sur le
réglage du niveau d’entrée analogique de différentes
plate-formes, voir le chapitre 3 “Pour commencer”.

Menu Session

Ce menu contient les commandes qui modifient la
séance entière.

Session Info (Commande-I)—Vous indique
combien de RAM libre vous avez, combien d’espace
disque libre reste sur le disque dur qui contient la
séance et fait la liste du taux d'échantillonnage et du
nombre total de points d'automation libres de la
séance. En-dessous de cette information de base, vous
trouvez une liste de tous les fichiers son utilisés dans
la séance courante. Vous pouvez utiliser cette liste
pour retrouver un fichier en le sélectionnant et en
cliquant sur le bouton Show ou simplement en
double-cliquant sur le nom du fichier, sous l’affichage
“Files in session”. Ceci vous fait automatiquement
passer dans le Finder, ouvre le dossier qui contient le
fichier et sélectionne ce fichier. Pour entendre un
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fichier son, cliquez sur le bouton Play. Pour donner un
nouveau nom à votre fichier son, cliquez sur le bouton
Rename et entrez le nouveau nom dans la boîte de
dialogue Rename. Si vous voulez supprimer un fichier
son, cliquez sur le bouton Delete.

Lorsque vous voulez renommer des fichiers audio,
vérifiez de bien utiliser le bouton Rename de la boîte
de dialogue Session Info. Renommer simplement le
fichier dans le Finder vous oblige à retrouver le fichier
la prochaine fois que vous rouvrez la séance. Ne sortez
pas d’une séance pour renommer un fichier lorsque la
séance est encore ouverte. Ceci peut créer des
résultats imprévisibles et parfois désastreux.

Session End Time (Majuscules-Commande-E)—
Change le temps de fin de votre séance. Cette
commande est pratique lorsque la préférence
“Autostop at end of Session” est activée. Au lieu de
s’arrêter lorsque le dernier échantillon de votre séance
est détecté, Deck s’arrête au nouveau temps de fin
que vous entrez ici.

Compact Session—Compacte tous les fichiers audio
situés dans le dossier Audio Files de la séance qui sont
utilisés dans la séance courante. Utilisez cette
commande pour vous débarrasser de données audio
non-utilisées dans tous les fichiers son associés à la
séance. Pour plus d'informations sur le compactage de
séance, voir “Utiliser Compact Session et Compact
Audio File” à la page 45.

Export Session Regions—Enregistre toutes les
régions définies dans la séance courante dans leurs
fichiers son source. Lorsque vous installez Deck, le
programme est réglé pour enregistrer toutes les
régions dans leurs fichiers son source dès que vous
enregistrez la séance courante. Ceci est une bonne
configuration de base, car elle vous assure que vos
régions sont toujours enregistrées. Vous pouvez
également choisir à n'importe quel moment d’enregis-
trer les régions en dehors de leurs fichiers son, même
si la séance n’a pas été enregistrée. Ceci est le but de
la commande Export Session Regions. Vous pouvez
faire cela, par exemple, si vous avez défini une région

d'audio intéressante, mais que vous ne souhaitez pas
la conserver dans la séance courante. Dans un tel cas,
vous utilisez la commande Export Session Regions
pour enregistrer la région puis supprimez-la  de la
séance. Même si la région n’est pas présente dans la
séance, vous vous rendrez compte qu’elle a été
enregistrée dans son fichier son source.

Read DECK 1.0 Session—Lit une séance créée dans
Deck 1.0 ou supérieur et la traduit dans une séance
Deck.

Import Session—Importe une séance existante dans
la séance courante. La séance importée est placée dans
de nouvelles pistes de travail.

Sous-menu Library Operations

Sort By Name et Sort By Size—Trie toutes les
régions de la fenêtre Library par leur nom ou par
leur taille, respectivement.

Update from Session—La fenêtre Library n’affiche
que les régions qui sont dans la fenêtre Tracks. Si
vous voulez que de nouvelle régions que vous avez
créé apparaissent dans la fenêtre Library,
choisissez la commande Update from Session.

Find File—Cette commande est disponible lorsque
vous avez une région sélectionnée dans la fenêtre
Library. Elle vous fait automatiquement passer
dans le Finder et surimpressionne le fichier audio
qui contient la région sélectionnée.

Select Regions—Lorsque vous sélectionnez une
région dans la fenêtre Library et que vous
choisissez Select Regions, toutes les copies de
cette région sont sélectionnées ou en surimpres-
sion.
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Menu Windows

Ce menu contient une liste des fenêtres disponibles
dans Deck. Choisissez le nom d'une fenêtre pour
ouvrir celle-ci ou pour l’amener au premier-plan.

Fenêtre Raccourci

Transport Commande-1
Mixer Commande-2
Tracks Commande-3
QuickTime Commande-4
MIDI Commande-5
Library Commande-6
Effect Commande-7
Master Outputs Commande-9
CPU Meter Commande-0

Close Window (Commande-W)—Ferme la fenêtre
active.

Menu Links

Le menu Links fournit des liens pratiques et informa-
tifs vers le site Web de BIAS, dont Product
Registration, BIAS Home Page, Deck Updates, Deck
Tech Support et Online Documentation.

Menu QuickTime

Ce menu contient toutes les commandes dont vous
aurez besoin pour ouvrir, fermer, éditer et exporter
(mixer) des films QuickTime dans Deck, ainsi que
pour configurer la vidéo en direct. Pour plus d'infor-
mations sur l'utilisation de films QuickTime, dont des
descriptions des commandes du menu QuickTime,
voir le chapitre 7 “QuickTime”.

Raccourcis QuickTime :

Flèche gauche/droite Déplace le film QT en
arrière/en avant d’une
seule trame

Flèche haut/bas Déplace au début/fin
de la région QT

Clic-faire glisser Fait défiler le film QT

Menu Help

Le menu Help vous permet d’activer les bulles d’aide
standard Macintosh.

Conclusion

Vous connaissez maintenant tous les détails des
fenêtres et éléments de menu de Deck. Le chapitre
final présente une introduction aux bases de l’enregis-
trement audionumérique.
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Chapitre 10
Enregistrement numérique et bases du mixage
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Chapitre 10 :
En reg i s t rement
numérique et bases
du mixage

Bien que Deck utilise des technologies complexes
pour enregistrer, éditer et mixer, le programme est
basé sur deux machines familières : le magnétophone
à bande et la table de mixage multicanaux. Deck utilise
votre disque dur comme magnétophone à bande
multicanaux et l’écran du Macintosh comme table de
mixage et d’édition. Quiconque a déjà utilisé un
magnétophone à bande multipiste se rendra compte
que l’apparence de Deck est très familière. Comme
Deck est construit sur la métaphore du magnétophone
à bande, une compréhension de base des concepts de
l’enregistrement multipiste est essentiel pour que
vous tiriez parti au maximum de ce programme.
Comme les représentations numériques de formes
d'onde sont utilisées pour représenter le son, la
familiarité avec l’échantillonnage audio est très utile. À
la fin de ce chapitre se trouve une liste de livres
excellents sur l’audio, la musique informatique, le
MIDI et les métiers de la musique.

Concepts de base de
l'échantillonnage

Deck accomplit ses tâches d’enregistrement sur
disque en utilisant une méthode appelée échantillon-
nage. Contrairement à l’enregistrement sur bande
magnétique normale, qui enregistre un signal audio
sous forme de charge continue sur la bande magnéti-
que, un échantillonneur convertit un signal audio en
nombres discrets qui sont ensuite stockés sur un
support de stockage numérique (un disque dur, par
exemple).

L’échantillonnage numérique de pistes audio est en
général supérieur aux méthodes d’enregistrement
analogiques standards—non seulement parce qu’il
offre une fidélité extrêmement haute, mais parce qu’il
évite les problèmes de génération de bande et de
dégradation de lecture. Comme l’audio échantillonné
est stocké sous forme d’un ensemble de nombres, il
n’y a pas de perte de fidélité lorsque vous copiez ces
nombres, quel que soit le nombre de “copies de
copies” que vous faites. Comme le support disque
n’est pas physiquement mis à mal par la lecture (ce qui
est le cas d’une bobine de bande analogique lors-
qu’elle amenée sur les têtes de lecture), la lecture
répétée d'une piste numérique ne modifie ou ne
dégrade la piste en aucune façon.

Le processus d’enregistrement numérique (ou
échantillonnage) est vraiment très simple : un signal
audio est envoyé dans un ordinateur (ou une machine
d’échantillonnage dédiée). Ce signal est envoyé à
travers un convertisseur analogique-numérique (ADC),
qui mesure l’amplitude (volume) du signal à interval-
les réguliers et passe ces mesures—ou échantillons—
sur un support de stockage. Lorsque les pistes
enregistrées doivent être lues, les échantillons sont
récupérées du support de stockage et passées à
travers un convertisseur numérique-analogique (DAC),
qui convertit ces échantillons sous forme d’onde
continue. Le signal qui sort du DAC (signal de sortie)
est l’image presque exacte du signal qui est entré dans
l’ADC.
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Comme vous pouvez le voir, l'onde audio d'entrée est
approximée par une série de points discrets qui
décrivent cette onde. La représentation physique de
cette onde est appelée une forme d'onde. La nature de
ce processus illustre l’une des questions centrales de
l’enregistrement numérique : quelle est la précision de
la représentation numérique par rapport au signal
analogique original ? Pour répondre à cette question,
vous aurez besoin de comprendre le concept de taux
d'échantillonnage.

Le taux d'échantillonnage est le nombre d’échantillons
d'une forme d'onde que vous prenez en une seule
seconde, et il a une très forte influence sur la qualité
de l’enregistrement que vous faites. Dans l’idéal, une
collection d’échantillons est une approximation
extrêmement bonne du signal d’entrée original. En
prenant de nombreux échantillons d’un signal audio,
vous finissez avec une description plus précise de
l’onde ; moins d’échantillons conduisent à une
description moins précise et plus bruiteuse.

Remarquez comme un taux d'échantillonnage élevé
produit un enregistrement plus précis et donc de plus
haute fidélité. Malheureusement, chaque échantillon
nécessite de l’espace de stockage. Comme un taux
d'échantillonnage plus élevé prend plus d’échantillons
par seconde, il nécessite plus d’espace de stockage sur
disque pour chaque seconde d'audio qu’un taux plus
bas. Deck utilise des taux d'échantillonnage de 22 050
Hz, 24 000 Hz, 44 100 Hz ou 48 000 Hz (remarquez
que du matériel supplémentaire est nécessaire pour
utiliser un taux de 48 kHz sur un Macintosh). Un taux
d'échantillonnage de 44 100 Hz signifie que Deck
prend 44 100 échantillons chaque seconde et les place
sur votre disque dur. Il s’agit du taux utilisé par les
disques compacts et il vous permet d’enregistrer des
fréquences jusqu'à précisément 22 050 Hz. Comme
l’étendue de l’audition humaine normale se situe
entre 20 Hz et 20 000 Hz, le taux d'échantillonnage de
44,1 kHz offre en général une fidélité acceptable. Deck
offre également un taux d'échantillonnage de 48 000
Hz, qui est le taux de base utilisé par de nombreux
enregistreurs DAT. Ce taux d'échantillonnage plus
élevé vous permet réellement d’enregistrer des
fréquences jusqu'à 24 000 Hz, mais comme ces
fréquences se trouvent en théorie en dehors de
l’étendue de l’audition de la plupart des humains, il
n’est en général pas nécessaire d’utiliser ce taux plus
élevé pour des besoins de fidélité.
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piste en chargeant un son différent sur le clavier. Le
séquenceur ne fait que jouer les notes et ne vérifie pas
quel son il joue. Vous pouvez également changer le
tempo d'une séquence MIDI enregistrée sans changer
la hauteur des notes (contrairement à la bande, qui
change la hauteur lorsque la vitesse de lecture est
modifiée).

Mais le concept de MIDI possède des faiblesses
inhérentes. Par exemple, comment enregistrer une
piste de guitare, de voix ou de sax ? Ces instruments
sont purement des signaux audio ; ils n’ont pas place
dans le monde MIDI. Voici où Deck intervient. Bien
que Deck soit un enregistreur multipiste numérique
complet, il est compatible avec le MIDI et démultiplie
celui-ci. En faisant tourner le séquenceur Metro (ou un
autre séquenceur compatible) sur votre Macintosh
avec Deck, vous pouvez ajouter les fonctionnalités
entièrement synchronisées du MIDI à une séance
audio. Si vous avez une séquence MIDI existante, vous
pouvez l’importer directement dans la fenêtre MIDI et
enregistrer plusieurs pistes d’audio au-dessus de celle-
ci sans faire tourner de séquenceur externe. Si vous
voulez économiser de l’espace disque, vous pouvez
utiliser Metro pour ajouter des pistes MIDI à vos
enregistrements multipistes audio de Deck. Deck et
Metro fournissent un environnement où MIDI complet
et audionumérique synchronisé coexistent.

Métaphore du multipiste numérique
et de la table de mixage

L’interface de Deck a l’apparence d’une simple table
avec des contrôles et des surfaces supplémentaires. Si
vous avez utilisé un multipiste portable, vous devriez
trouver l’enregistrement et le mixage avec Deck très
intuitif. Si ce n’est pas le cas, un peu d’explication peut
être utile.

Présentation du MIDI

La musique et le son sur ordinateur personnel a
radicalement changé au cours des dix dernières
années. La plupart des personnes travaillant dans
l’industrie de l'audio connaissent parfaitement ces
changements, particulièrement en raison du dévelop-
pement de la norme MIDI au début des années quatre-
vingt. Le MIDI, qui signifie Musical Instrument Digital
Interface, est devenu la norme de communication
pour les instruments de musique électronique et a
maintenant été intégré dans la quasi-totalité des
claviers électroniques, des boîtes à rythme, des outils
de contrôle, des générateurs de son et des effets.

Le MIDI a été conçu à l’origine comme une norme de
contrôle à distance qui permettrait aux musiciens de
contrôler plusieurs instruments avec un seul clavier,
mais il est rapidement devenu un environnement de
réseau audio. La création des séquenceurs MIDI est en
grande partie responsable de l’importance que la
norme MIDI occupe aujourd’hui.

En offrant un moyen bon marché d’enregistrer et de
lire des compositions multipistes sans magnétophone
à bande, les séquenceurs MIDI ont ouvert la porte à
une technologie de musique informatique accessible.
Cependant, les séquenceurs MIDI n’accomplissent pas
cette tâche en enregistrant un signal audio réel. Vous
pouvez concevoir une séquence MIDI comme un
rouleau de piano mécanique. Le séquenceur MIDI
enregistre les événements qui surviennent sur votre
clavier : sur quelle touche vous appuyez, la force avec
laquelle vous l’appuyez et vous la maintenez, et à quel
moment vous relâchez. Ces petits morceaux d’infor-
mation, appelés événements MIDI, sont attrapés et
mémorisés par le séquenceur sous forme de séquence.
Pour lire celle-ci, le séquenceur envoie les événements
enregistrés au clavier, ce qui fait jouer le clavier à
chaque fois que la séquence est relue.

La séquence offre de nouvelles possibilités. Par
exemple, vous pouvez changer le son d’une certaine
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Regardez cette illustration des fenêtres Mixer et
Transport de Deck :

Fenêtre Transport

Fenêtre Mixer

La table de mixage est constituée de plusieurs
modules d’entrée/sortie verticaux, chacun ayant des
Vu-mètres affichant le niveau du signal. Les modules
d’entrée/sortie ont tous la même apparence car ils
représentent chacun une des pistes d’enregistrement/
lecture numérique (souvenez-vous que Deck vous
permet de créer un nombre de pistes illimité, mais
que seul un certain nombre de ces pistes sont lues en
même temps, selon la puissance de votre processeur).
Chacun des modules d’entrée/sortie possède deux
modes : enregistrement et lecture. Enregistrement
vous permet de faire entrer un signal dans votre carte
audio, de régler son niveau de contrôle et de
l’enregistrer sur votre disque dur. Dès qu’une piste est
enregistrée, lecture vous permet de relire cette piste,
d’ajuster ses niveaux de lecture, d’ajouter des effets en
temps réel et d’automatiser son niveau ou son pan
(placement dans le champ stéréo).

Les boutons de la fenêtre Transport fonctionnent
comme sur un magnétophone à bande normal. Ils
vous permettent de revenir en arrière, d’avancer, de
lire, d’arrêter et d’enregistrer des pistes numériques.
Ils offrent également des contrôles pour ajuster la

hauteur de lecture et pour stocker des Temps de
position, de punch ou de boucle, et des états de
Mixer.

Commencer à enregistrer

Le cycle de production d'un projet Deck peut
progresser comme suit :

1. Vous enregistrez une première piste sur la piste 1.

2. Vous lisez la piste 1 pour vérifier qu’elle vous
convient et vous réglez son niveau de volume.

3. Vous enregistrez la piste 2 tout en écoutant la piste
1.

4. Vous lisez les deux pistes lorsque vous enregistrez
la piste 3.

5. Vous suivez la même procédure pour enregistrer
la piste 4 (vous pouvez également enregistrer
plusieurs pistes à la fois, selon votre interface
audio).

6. Vous écoutez et mixez les niveaux et les pan des
quatre pistes. Si des changements de niveau de
volume ou de réglage de pan stéréo rapides ou
plus longs sont nécessaires, vous pouvez
automatiser ces changements. Vous pouvez
également ajouter des effets intégrés à Deck ou en
utilisant des plug-ins. Lorsque vous êtes satisfaits,
vous pouvez choisir de mixer vers un fichier
master stéréo pour presser un CD ou un album ou
pour intégrer dans un film QuickTime ou un
document Macromedia Director™ ou Flash™, etc.

Le processus détaillé ci-dessus est essentiellement le
même que celui que vous suivriez si vous utilisiez un
magnétophone à bande multipiste et une table de
mixage analogiques. Deck étant cependant un
enregistreur numérique, il y a quelques points que
nous devons aborder.
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Le signal d'entrée

Le signal d'entrée est le signal audio que vous voulez
enregistrer. Il doit être branché dans l’une des entrées
audio de l'ordinateur, d’une carte ou d’une interface
audio, pour l’envoyer dans Deck. Il est souvent
conseillé d’envoyer les signaux entrants à travers une
table puis dans votre ordinateur. Ceci vous permet
davantage de contrôle sur le signal entrant.

Entrées audio du Macintosh

Sur des systèmes où vous utilisez le matériel audio
intégré du Macintosh, il est recommandé de régler un
faible volume d’entrée (Analog Input Level dans le
menu Options) et d’augmenter le volume du signal à
la source. L’amplificateur de l’entrée audio intégrée du
Macintosh peut ajouter du bruit à un signal entrant et
il faut donc mieux régler le volume d’entrée plus bas
et envoyer un signal entrant plus fort, pour minimiser
le bruit étranger.

Distorsion numérique

Lorsque vous envoyez un signal dans un enregistreur,
y compris Deck, vous devez toujours ajuster le niveau
d'entrée pour optimiser votre plage dynamique. Cela
signifie que votre signal d’entrée devrait être aussi
haut que possible sur les Vu-mètres d’entrée sans
allumer la diode de clip. Si le niveau d'entrée est trop
bas, la piste enregistrée sera bruiteuse. Si le signal est
trop haut, il clippe.

Le clip est une situation qui survient lorsque vous
envoyez un signal dans un enregistreur ou une table
qui est plus fort que ce que ne permet la machine. Sur
de nombreux magnétophones à bande analogiques,
un peu de clip semble ajouter de la chaleur au son—
souvent en utilisant davantage de circuit de réduction
de bruit (Dolby™ B ou C, par exemple). Dans
l’enregistrement numérique, le clip doit être absolu-
ment évité. Il crée de la distorsion numérique, qui
sonne presque toujours comme des parasites
numériques.

Punch in et punch out automatisés

Les punch in et punch out automatisés sont des
concepts extrêmement importants dans l’enregistre-
ment multipiste. Pour comprendre l’intérêt de ces
fonctions, imaginez cette situation : vous enregistrez la
dernière piste d'un morceau multipiste de cinq
minutes. Vous finissez la piste et vous la réécoutez.
Pendant la lecture, vous réalisez que la piste est
parfaite, à l’exception d’une petite erreur à la fin.

Punch in et punch out sont des fonctions conçues
pour remédier à ce problème. Pour arranger la
mauvaise partie, réglez un point de punch-in juste
avant et un point de punch-out juste après, puis
réenregistrez la piste. Pendant le processus d’enregis-
trement, vous entendrez la piste originale jusqu'au
point de punch-in. À ce moment, le mode enregistre-
ment est activé et vous pouvez rejouer par dessus
l’erreur. Lorsque le point de punch-out est atteint, le
mode enregistrement est automatiquement désactivé.
Ce punch-in et punch-out automatisé vous a permis de
ne réenregistrer qu’une petite partie d'une piste, sans
que vous n’ayez à déclencher les transports.

Bounce de pistes et mixage virtuel

L’un des problèmes inhérents à l’enregistrement
multipiste a toujours été le nombre limité de pistes.
Comment faites-vous avec quatre pistes pour
enregistrer cinq instruments séparés ? Il y a deux
réponses à cette question.

Une façon de réduire du matériau en trop dans un
environnement multipiste consiste à pré-mixer les
signaux entrants ensemble et à les enregistrer sur une
seule piste (un choeur de voix, par exemple). Cette
méthode est une solution haute-fidélité, mais possède
de sérieux désavantages. Spécifiquement, le niveau
relatif et le son des différents signaux ne sont plus
indépendamment modifiables après avoir été
enregistrés. Dans l’exemple du choeur, vous ne
pouvez plus monter une voix sans monter l'autre.

Bouncer, l'autre solution au problème de limite de
pistes, offre plus de flexibilité mais endommage la
fidélité globale des pistes analogiques. Dans un
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environnement de bande analogique vous pourriez
bouncer les pistes comme ceci : enregistrer trois pistes
séparées et les mixer avec le niveau relatif et l’EQ que
vous voulez, puis enregistrer les trois pistes mixées sur
la quatrième piste. Comme les trois pistes sources
existent maintenant sur une seule piste, vous pouvez
remplacer les originaux avec de nouvelles pistes. Dans
le monde analogique cette méthode augmente le
nombre de pistes enregistrables, mais chaque piste
bouncée finit par être un enregistrement d'un
enregistrement et la fidélité globale se détériore.

Deck offre les mêmes capacités de mixage et de
bounce de piste que vous trouvez dans l’enregistre-
ment analogique, mais avec de grandes améliorations.
La différence la plus importante est que Deck bounce
les pistes sans perte de fidélité. Comme toutes les
pistes de Deck sont numériques, aucun bruit n’est
ajouté pendant un bounce et aucune haute fréquence
n’est perdue. Deck vous permet également de
sauvegarder vos pistes sources originales. Ceci permet
de récupérer et de rebouncer des pistes bien après le
moment où elles auraient été effacées dans un
enregistrement multipiste analogique.

Vous pouvez utiliser la fonction de mixage virtuel au
lieu de bouncer les pistes. Le mixage virtuel est une
option qui n’est vraiment pas disponible dans le
monde analogique. Les tables analogiques sont
physiquement limitées aux nombre de pistes qui
peuvent être enregistrées. En utilisant une station de
travail numérique sur Macintosh, vous n’êtes pas
gênés par cette limite de l’enregistrement analogique.

Deck vous permet de travailler avec un maximum de
999 pistes virtuelles (ou de travail), toutes pouvant
être déplacées vers des pistes de lecture actives,
auditionées, éditées, traitées ou mixées. Donc, bien
que vous ayez un nombre limité de pistes qui peuvent
être lues à n'importe quel moment (le nombre de
pistes de votre système), vous pouvez créer des
mixages qui incluent des pistes virtuelles. Deck
n’effectue pas son mixage en temps réel, et il n’y a
donc aucune limite à la quantité d'audio qu’il peut
mixer en une seule fois, à l’exception de l’espace de

disque dur. Deck vous permet d’enregistrer autant de
pistes que vous le voulez et de les mixer ensemble
pendant le processus de mixage final. Pour plus
d'informations sur le mixage virtuel, voir “Mixage
virtuel” à la page 75.

Formats de fichier audio et fichier de
séance Deck

Une séance Deck est un document Macintosh qui
contient un relevé d'un projet d'enregistrement
spécifique. Ce diagramme devrait vous donner une
meilleure idée de la façon dont une séance Deck est
organisée :

Un fichier de séance peut contenir n'importe quel
nombre de régions audio et de pistes. Chaque piste
audio contient une liste de régions audio situées sur
votre disque dur. Une piste audio est une feuille de
direction de lecture. Elle indique à Deck quels
morceaux de quels fichiers audio lire et à quel
moment. Les pistes audio permettent de lire un fichier
de régions audio dans n'importe quel ordre et elles
surveillent cette lecture de façon non-destructive. Si
vous voulez répéter quelque chose dix fois, la même
région de disque est lue dix fois d’affilée. Si vous
voulez dix minutes de silence, aucune région de
disque n’est lue. Une séance Deck est capable de lire
plusieurs pistes simultanément. Les pistes du haut (les
pistes représentées par les fadeurs de la fenêtre Mixer)
sont vos pistes de lecture actives. Elles contiennent les
pistes qui sont lues à n'importe quel moment.
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Une séance Deck garde trace de tous les états de
Mixer (clichés), des réglages de position automatique
et de fadeur, et des configurations de fenêtres. Les
séances Deck gardent également trace et font
référence aux fichiers MIDI ou QuickTime importés
dans la séance. Lorsque vous double-cliquez sur une
séance, les fenêtres de la séance apparaissent
exactement comme elles étaient sauvegardées et les
pistes audio et les données d'automation associées
sont automatiquement chargées.

Nouveau fichiers audio

Lorsque vous créez une nouvelle séance Deck, aucun
fichier audio n’existe pour cette séance. À n'importe
quel moment, vous avez la possibilité de charger des
fichiers audio Sound Designer II, QuickTime, PC/
Windows-format (WAV), Apple Sound Resource (SND)
ou Audio Interchange File Format (AIFF) mono ou
stéréo existants dans la fenêtre Tracks et de construire
une piste audio à partir de ces fichiers audio. Vous
pouvez également créer un nouveau fichier audio en
enregistrant une nouvelle piste. Dès que vous
enregistrez une nouvelle piste dans Deck, celle-ci est
enregistrée dans un nouveau fichier audio nommé
avec le nom de la piste. Ces fichiers audio sont placés
dans le dossier Audio Files (qui se trouve dans le
même dossier que le document de séance). Vous
créez toujours un nouveau fichier audio à chaque fois
que vous enregistrez sur une nouvelle piste. Lorsque
vous faites un punch in sur une piste existante (ou
après la fin d’une piste existante), cet audio est
toujours ajouté à la fin du fichier audio de la piste dans
le dossier Audio Files de la séance.

Compatibilité des différents formats de
fichier audio

Deck est compatible avec les fichiers audio Sound
Designer I et II, AIFF, SND, WAV et QuickTime, mais le
format de lecture et d’enregistrement est Sound
Designer II mono. Lorsque vous sélectionnez et
ajouter des fichiers qui ne sont pas au format Sound
Designer II mono, Deck crée automatiquement une
copie Sound Designer II mono de ces fichiers dans le
dossier Audio Files. Si vous sélectionnez un fichier
stéréo, deux fichiers mono sont créés. Comme les

fichiers non-Sound Designer II mono doivent être
convertis de cette manière, les ajouter à votre séance
nécessite plus d’espace disque et peut prendre un peu
de temps.

Si vous déplacez un fichier audio référencé par une
séance Deck à un nouvel endroit du disque dur (ou
sur un autre disque dur), Deck vous demande
toujours de trouver les fichiers audio manquants la
prochaine fois que vous ouvrez la séance.

Qu’est-ce que l’enregistrement non-
destructif ?

Deck utilise des technologies d’enregistrement non-
destructives, qui sont bien plus puissantes que la
simple technologie d’effacement linéaire de l’enregis-
trement analogique (ou de la première version de
DECK). Il est très important de comprendre le
concept de d’enregistrement non-destructif si vous
voulez obtenir le maximum de Deck.

Dans le monde de l’audio analogique, il n’y a qu’un
seul genre d’enregistrement : destructif. Dès que vous
enregistrez sur une piste de bande analogique, le
nouveau signal remplace de façon permanente ce qui
était avant sur cette piste. Si vous enregistrez quelque
chose sur la piste 1 puis réenregistrez quelque chose
d’autre au même endroit, l’enregistrement original est
effacé et remplacé avec le nouvel audio. Telle est la
nature de la bande magnétique.

Comme Deck tourne sur un ordinateur, il vous offre
de nombreuses options nouvelles et différentes. Vous
pouvez concevoir votre document de séance Deck
comme une base de données audio. Il garde trace de
toutes les régions audio que vous avez enregistré et
ajouté et il les relit selon la façon dont vous les avez
enregistré ou placé. Du coup, Deck est capable de
garder trace de beaucoup plus de fichiers son et de
régions audio que ce que vous utilisez et cette capacité
permet l’enregistrement non-destructif.

L’enregistrement de Deck est non-destructif car le
processus d’enregistrement ne remplace ou ne
supprime jamais aucun fichier de données audio. Les
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nouvelles données sont toujours enregistrées et
“indexées” à la position des anciennes données. Si, par
exemple, vous enregistrez une piste puis que vous
faites un punch in pour une prise de remplacement
sur une mesure au milieu de cette piste, la nouvelle
prise est simplement ajoutée comme nouvelles
données sur le disque dur, et cette région de
nouvelles données apparaît au-dessus de l’ancienne
prise. Comme rien n’est effacé, vous pouvez revenir à
votre prise originale à n'importe quel moment. Vous
pouvez même enregistrer dix nouvelles prises et
choisir entre elles plus tard. Les bénéfices de ce
schéma sont évidents ; vous ne courrez jamais le
risque d’effacer une partie d'audio simplement parce
que vous essayez une autre prise ou écoutez une autre
région au même endroit. Vous pouvez également
bouncer quatre pistes sur une seule sans effacer la
piste de destination, et vous pouvez toujours revenir à
vos pistes originales pour les “rebouncer” en un
nouveau sous-mixage. Ces faits font de l’enregistre-
ment non-destructif l’une des fonctions les plus
puissantes associée aux stations de travail audionumé-
riques.

Il y a, cependant, un désavantage à l’enregistrement
non-destructif. Comme vous ne supprimez jamais
l’ancien audio lorsque vous enregistrez du nouvel
audio dessus, votre disque dur a tendance à se remplir
plus rapidement, particulièrement si vous enregistrez
plusieurs longues prises. Deck vous offre un outil pour
gérer toutes ces données : la commande Compact
Session. Cette commande examine automatiquement
la séance courante, trouve tout l'audio de vos fichiers
sources qui n’est utilisé sur aucune piste et le
supprime. Exécuter cette commande ne prend pas
beaucoup de temps et vous libère tout l’espace disque
occupé par l’audio inutile. La combinaison de
l’enregistrement non-destructif et de la commande
Compact Session vous assure une flexibilité maximum,
tout en ne consommant que le minimum d’espace de
disque dur. Pour plus d'informations, voir “Utiliser
Compact Session et Compact Audio File” à la page 46.
Vérifiez que vous comprenez comment fonctionne
Compact Session avant de l’utiliser.

Automation de fadeur
Après avoir enregistré toutes les pistes d'un projet
multipiste, vous êtes prêts à commencer le processus
de mixage. Il est appelé mixage car vous allez
combiner toutes les pistes monophoniques pour créer
un master stéréo. Vous utiliserez le master stéréo pour
rendre votre produit final—qu’il s’agisse d’un disque
compact, d’un album, d’une cassette, d’une DAT,
d’une bande 1/4 de pouce ou d’un fichier disque pour
des besoins multimédia.

Dans un environnement typique d’enregistrement à la
maison, le mixage final est accompli en lisant la source
multipiste de façon répétée. Pendant chaque passage
de lecture, vous réglez les niveaux et vous vous
entraînez à déplacer les fadeurs pour faire apparaître
ou disparaître l'audio, changer les niveaux, changer les
réglages d’envoi, etc. Lorsque vous vous êtes entraînés
au mixage, vous tentez de le “faire pour de vrai”
lorsque vous enregistrez sur le support master. Ceci
est en général un processus très délicat qui est
incohérent et peu précis.

Les studios d’enregistrement professionnels évitent ce
problème en utilisant des consoles de mixage qui
automatisent le mouvement de tous les fadeurs. Les
consoles de mixage compatibles avec l’automation de
fadeur permettent souvent à l’ingénieur de régler ses
états de console, où la position de chaque fadeur est
enregistrée et d’assigner ces états à des temps
particuliers pendant l’enregistrement. Certaines des
consoles de mixage automatisées les plus perfection-
nées enregistre même le déplacement physique de
chaque fadeur et reproduisent ce déplacement lors de
chaque passage de lecture. Les principaux désavanta-
ges de ce type d’automation sont le coût et la
complexité. En général, le coût de l’automation avec
fadeur animé place celle-ci hors de portée de
l’installation individuelle.

Deck évite ces problèmes en offrant l’automation avec
fadeur animé sous forme logicielle, plutôt que
matérielle. Après avoir enregistré des pistes numéri-
ques, vous pouvez utiliser Deck pour enregistrer un
ajustement que vous faites sur le volume et le pan.



10

155Enregistrement numérique et bases du mixage

Vous pouvez également capturer les états de fadeur de
tous les fadeurs de Deck et les assigner à des temps
spécifiques pendant l’enregistrement. Vous pouvez
voir et éditer tous les ajustements de contrôle de
façon visuelle. Ces outils vous permettent de
construire lentement un mixage et de l’enregistrer
comme partie d'une série de mixages différents.
Lorsqu’est venu le moment de créer un master stéréo,
vous pouvez être sûrs de retrouver exactement le
même réglage de niveaux et de transitions de fadeur à
chaque fois.

Synchroniser le son à l’image

Pour de nombreuses personnes, les tâches d’édition
du son consistent spécifiquement à améliorer ou à
complémenter des images. Ces tâches, en général
appelées “post-production audio”, mettent des
exigences très spécifiques sur la technologie audio. En
général, l’éditeur son commence avec l’image finie, en
vidéo ou en film et éventuellement quelques pistes de
guide brutes sur bande vidéo, bande audio ou film
magnétique. Le processus de post-production consiste
ensuite à éditer l'audio existant, à ajouter de nouveaux
dialogues, des effets, des ambiances et/ou de la
musique. Ensuite l’éditeur automatise un mixage de
tous les composants son et crée un master stéréo deux
pistes (ou plus), qui est de nouveau enregistré sur le
master vidéo ou sur un autre master avec référence
temporelle (bande audionumérique avec timecode ou
bande 1/4 de pouce de piste centrale, par exemple).

Deck offre toutes les fonctions audio de base dont
vous aurez besoin pour créer des pistes son, les
synchroniser à l’image, automatiser votre mixage et
créer un master numérique stéréo de qualité CD.

Deck diffère des systèmes analogiques conventionnels
sur un certain nombre de points. Un fait particulière-
ment important est que Deck enregistre, bounce,
traite et mixe votre audio entièrement dans le
domaine numérique. Ceci vous garantit un contrôle
maximum de l’édition sans ajout de bruit de traite-
ment ou de génération. Comme l'ordinateur est utilisé
comme plate-forme de contrôle, vous pouvez utiliser
la méthode de synchronisation de votre choix. Ceci

vous permet d’utiliser du timecode SMPTE comme
source de synchro ou de travailler entièrement à partir
de votre disque dur en utilisant une vidéo QuickTime
comme source de synchro. Pour plus d'informations
sur ces méthodes, voir le chapitre 7 “QuickTime”.

Mixage stéréo final

De façon générale, le mixage stéréo final est la
dernière étape d’une production multipiste. Pour
distribuer un projet audio, vous devrez le mettre sous
une forme disponible n’importe où. Ceci signifie
disque compact, CD-ROM, cassette numérique ou
analogique, bande vidéo ou vinyle. Malheureusement,
de tous ces supports, seules les cassette analogiques et
les bandes vidéo peuvent être enregistrées à moindre
coût à la maison et ces formats n’offrent en général
pas une fidélité optimale.

Dans le monde de l’enregistrement professionnel, le
master stéréo final est traditionnellement enregistré
sur une bande analogique deux pistes. Cette bande est
ensuite utilisée comme image pour dupliquer des
albums, des CD, des vidéos, des films ou des cassettes.
Bien qu’il s’agisse d’un status quo, les magnétophones
à bande de mastering de qualité sont très chers et un
certain nombre de nouvelles options haute-fidélité et
abordables apparaissent.

Le nouveau support de mastering le plus prometteur
est la bande audionumérique (DAT). Couplée avec
Deck et votre Macintosh, le mastering sur DAT offre
une solution relativement bon marché et d’une fidélité
extrêmement élevée qui peut être utilisée directement
pour produire des CD, des albums ou des cassettes. Si
vous possédez une carte audio qui n’offre que des
sorties analogiques, vous pouvez brancher les sorties
analogiques de la carte aux entrées analogiques d'un
enregistreur DAT pour créer un master numérique
stéréo final qui atteint la qualité de la plupart des
studios analogiques. Utiliser une machine DAT avec
timecode rend même possible la création de masters
avec référence temporelle.
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Suggestions d’archivage

L’audio est un phénomène complexe et vous avez
besoin de pas mal de données pour le décrire.
L’enregistrement audio sur votre disque dur utilise
beaucoup d’espace disque. Par exemple, une seule
piste d’audionumérique à 44,1 kHz et 16 bits utilise
environ 5 Mo d’espace disque par minute. Pour cette
raison, il est recommandé de posséder certains types
de support d’archivage pour conserver le master et
des copies de sauvegarde de votre audio. En plus de
votre fichier audio de mixage stéréo final, vous pouvez
conserver une archive de la séance entière. Vous
pouvez utiliser presque n'importe quel moyen de
sauvegarde de données pour ordinateurs Macintosh :
disques durs, support éjectable, bandes, CD-R, etc.

Lectures recommandées

La plupart des ouvrages listés ici sont disponibles chez
Music Books Plus, un revendeur spécialisé dans la
technologie de l’enregistrement et l’industrie de la
musique. Pour commander l’un des ces titres ou
commander un catalogue gratuit, contactez Music
Books Plus au 1-800-265-8481 (uniquement depuis les
U.S.A. & le Canada) ou au 1-905-641-0552, ou sur leur
site Web : www.musicbooksplus.com

All You Need to Know About the Music Business,
Donald Passman. Excellente couverture des contrats
d’enregistrement et de publication musicale, écrit par
un grand avoué spécialisé en musique. Simon &
Schuster, 1994.

The Art of Digital Audio, 2nd Ed., John Watkinson.
Ouvrage complet, détaillé et faisant autorité. L’ouvrage
indispensable sur le sujet. Focal Press, 1994.

Audio in Media, Stanley R. Alten. Un texte classique et
très large de niveau universitaire pour l’étude sérieuse
de l'audio. Wadsworth Publishing Company, 1994.

Becoming a Computer Musician, Jeff Bowen. Composé
d’un livre et d’un CD-ROM, cet ouvrage fournit une

introduction sans douleur au MIDI et à l’audionuméri-
que. Le CD-ROM contient des démos de logiciel, de la
musique et bien d’autres choses ! Howard W. Sams,
1994.

The Computer Music Turorial. Ceci est LE livre sur la
musique informatique, le traitement numérique du
signal, la synthèse, le MIDI et bien d’autres choses
encore. Curtis Roads, MIT Press, 1996. Traduit en
français sous le titre “L’audionumérique” chez Dunod :
www.audionumerique.com

Digital Audio Operations, Francis Rumsey. Guide de
niveau intermédiaire sur l’enregistrement numérique
sur bande et sur disque. Focal Press, 1991.

Digital Interface Handbook, Rumsey & Watkinson.
Traite essentiellement du maintien de la qualité à
travers toute la chaîne du signal. Facile à comprendre
& détaillé. Butterworth-Heinemann 1993.

Electronic Musician Magazine (périodique). P.O. Box
3714, Escondido, California, 92025.

Entertainment Source Library, Greg Forest, ed. Une
collection de contrats professionnels pour l’industrie
de la musique sur disquette. Ne remplace pas un réel
conseil légal, mais constitue un bon point de départ
pour protéger vos droits. Cardinal Business Media,
1992.

Getting Radio Airplay, Gary Hustwit. Apprenez
comment faire passer votre musique à la radio ; une
méthode éprouvée pour n'importe quel style de
musique. Rockpress, 1993.

Keyboard Magazine (périodique) 20085 Stevens Creek,
Cupertino, California, 95014

Making Music with Your Computer, David (Rudy)
Trubitt, ed. Un aperçu pour débutant du MIDI, de
l’enregistrement sur disque dur et du multimédia ;
compilé à partir des pages de Electronic Musician
magazine. Mix Books, 1993.

http://www.musicbooksplus.com
http://www.audionumerique.com
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Mechanics of Sound Recording, Tony Zaza. Explique la
technologie et les techniques de production d’audio
pour la vidéo et le film. Prentice-Hall, 1991.

MIDI for Musicians, Craig Anderton. Cette introduc-
tion classique au MIDI est le livre avec lequel nous
avons tous commencé. Amsco, 1986.

MIDI for the Professional, Lehrman & Tully. Un
ouvrage de référence pour les utilisateurs sérieux du
MIDI. Amsco, 1993.

Mix Reference Disc, par les éditeurs de Mix magazine.
Sons de test pour le studio sur CD. Cardinal Business
Media 1994.

Modular Digital Multitracks, George Petersen.
Apprenez comment choisir, utiliser et réparer les
enregistreurs numériques à bande dont les ADAT et
les DA-88. Le seul livre sur ce sujet. Mix Books, 1994.

The Musician's Business & Legal Guide, Mark Halloran,
ed. Un manuel facile à comprendre avec des exemples
de contrats et de documents. Prentice-Hall, 1991.

The Musician's Guide to MIDI, Christian Braut.
Monumental ouvrage de référence qui couvre des
zones que les autres titres omettent, comme Sysex,
General MIDI, Show Control et Machine Control.
Sybex, 1994.

2001 Recording Industry Sourcebook. Annuaire des
maisons de disques, des producteurs, des managers,
des distributeurs, des fournisseurs, des contacts dans
les média, et autres. Mis à jour chaque année. Mix
Books 1994.

Practical Recording Techniques, Bruce & Jenny
Bartlett. Un livre concret pour l’enregistrement
professionnel. Howard W. Sams, 1992.

Principles of Digital Audio, Ken C. Pohlman. Introduc-
tion recommandée aux concepts numériques et à la
technologie--explique les bases clairement et en
profondeur. Howard W. Sams, 1989.

The QuickTime How-To Book, Miller & Harris. Un
guide étape par étape sur les fonctions de QuickTime
et la réalisation multimédia. Sybex, 1993.

Releasing an Independent Record, Gary Hustwit.
Comment créer votre propre maison de disque et
vendre votre musique. Écrit par un ancien employé de
SST Records. Rockpress, 1993.

The Software Publishers Association Legal Guide to
Multimedia, Thomas Smedinghoff. Couvre les
problèmes légaux comme la licence, la loi de secret du
commerce, les brevets, le copyright, les noms de
marque et autres. Apprenez comment vendre et
protéger votre travail multimédia. Addison-Wesley,
1994.

The Studio Business Book, Jim Mandel. Le livre de
référence quand on possède ou gère un studio
d’enregistrement, dans une édition nouvelle et
entièrement révisée. Mix Books, 1995.

Studio Business Forms, Kevan Patten. Une collection
de documents pour l’industrie, comme les factures, les
commandes, les feuillets et les modèles, orientés vers
les besoins d’un petit studio. Patten Sound, 1993.

Synchronisation : From Reel to Reel, Jeffrey Rona.
Ouvrage pour débutant sur le SMPTE et le MTC. Hal
Leonard Publishing, 1994.

The Technique of Audio Post-Production in Video et
Film, Tim Amyes. Ouvrage intermédiaire sur la post-
production audio ; inclut une bonne couverture des
problèmes de synchronisation. Focal Press, 1990.

Tech Terms : A Practical Dictionary for Audio and
Music Production, Petersen & Oppenheimer. Explique
les termes souvent mal compris de l’enregistrement et
de la musique électronique. Mix Books, 1993.

Timecode : A User’s Guide, John Ratclif. Un ouvrage
détaillé de niveau avancé sur le timecode SMPTE/EBU
et son utilisation dans la production de film, vidéo et
audio. Focal Press, 1993.
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Appendice 1 :
Optimisation &
dépannage de votre
s y s t è m e

Deck pousse vraiment votre Macintosh à ses limites.
L’information de cet Appendice vous aidera à
optimiser votre système pour le conserver aussi rapide
et efficace que possible, et à traiter les problèmes s’ils
surviennent. Si vous avez des problèmes pour
enregistrer des pistes en raison de la vitesse de
l’ordinateur ou du disque dur, lisez ce qui suit.

La vitesse du disque est plus importante que celle du
processeur. Deck fonctionne sans problème sur la
plupart des ordinateurs Macintosh. Si vous avez des
problèmes d’enregistrement, ils sont probablement
dus à votre disque dur.

Deck nécessite un disque dur ayant un temps d’accès
moyen minimum de 27 ms et un débit soutenu de 300
Ko/seconde au moins pour de l’enregistrement et de
la lecture en quatre pistes. Pour de la lecture en 8-12
pistes, il vous faudra un temps d'accès de moins de 12
ms et un débit de 1,5 Mo/seconde. Pour de la lecture
en 12-16 pistes, il vous faudra un temps d'accès de
moins de 9 ms et un débit de 3 Mo/seconde. Évitez les
disques durs avec des routines de recalibration
thermale automatique, ce qui interrompt l’accès au
disque. Le but des constructeurs est de vendre du
matériel, et ils ne sont pas souvent la meilleure source
pour connaître le temps d'accès moyen des disques
durs. Demandez à des amis, lisez les newsgroups sur
Internet ou des articles sur les disques durs dans des
magazines d’informatique comme MacWorld pour
obtenir des informations plus précises sur les vitesses
des disques durs.

Disques durs, formatage et SCSI

Si vous avez déjà un disque dur et qu’il semble être
lent pour l’enregistrement, essayer de l’optimiser ou
de le reformater. Souvent, la raison pour laquelle votre
disque peut sursauter pendant l’enregistrement est
que les zones restées libres du disque existent sous
forme de petits segments répandus sur tout le disque
dur. Ces segments sont beaucoup plus longs à trouver
et cela ralentit le disque. Optimiser votre disque dur
est une procédure conseillée si vous comptez faire
beaucoup d’enregistrement sur disque dur. Un logiciel
d’optimisation de disque, comme Norton Speed
Disk™, cherche dans votre disque dur et le réarrange
pour que vos fichiers (et votre espace disque libre) ne
soient plus fragmentés. Ceci accélère souvent le
disque dur de façon significative.

Si optimiser votre disque dur ne suffit pas, souvenez-
vous qu’il est possible que votre disque soit trop lent.
S’il est toujours sous garantie, vous pouvez le tester
pour juger si l’information du constructeur est fausse.
Si le disque dur n’est pas aussi rapide qu’annoncé,
contactez le constructeur directement. Vous pouvez
utiliser un programme comme FWB Hard Disk Toolkit
pour tester votre disque dur.

Débit

En ce qui concerne la vitesse du disque dur, le temps
d'accès moyen ne signifie pas tout. Un disque dur de
qualité présente une bonne combinaison de temps
d'accès moyen et de vitesse de débit (en Mo par
seconde). Il n’y a pas de nombre de débit magique. La
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meilleure chose à faire lorsque vous voulez acquérir
un disque dur est de tester ce disque dur avec votre
système avant l’achat ou d’arranger une garantie de
remboursement avec le vendeur.

Formatage

Il est recommandé de formater votre disque dur en
HFS+ en utilisant Outil disque dur d'Apple. Vous
pouvez également utiliser d’autres programmes,
comme Anubis™ de Charismac Engineering ou FWB
Hard Disk Toolkit.

Terminaison SCSI

La première et la dernière machine de votre chaîne
SCSI doivent être correctement terminées pour éviter
de sérieux problèmes lorsque vous travaillez avec
Deck et d’autres applications très gourmandes en
accès de disque. Vous n’avez en général pas à vous
soucier de la terminaison interne du disque dur
interne si celui-ci a été installé par Apple. Cependant,
si votre disque dur interne n’a pas été installé par
Apple, vous devriez vérifier qu’il a été terminé selon
les spécifications du constructeur du disque dur et
d’Apple. Si vous avez des machines SCSI externes
connectées à votre Macintosh, nous recommandons
fortement l’installation d’un terminateur actif sur la
dernière machine de votre chaîne SCSI externe. Les
terminateurs gris standards fournis en général avec les
machines SCSI ne fournissent pas la terminaison
adéquate et des programmes comme Deck rendent
cela évident. Le SCSI Sentry d’APS est un terminateur
actif avec lequel nous avons eu de très bons résultats,
mais n'importe quel terminateur actif devrait convenir.

Conflits d’extensions et de tableaux
de bord

Prenez soin de votre système. Deck est un programme
qui accomplit la plupart de ses tâches importantes en
temps réel. Cela signifie que Deck ajuste de nombreu-
ses facettes de l'audio pendant la lecture. Pour cette
raison, vous devriez vérifier absolument que votre
système soit aussi simple que possible. Vous devriez

éviter les INITs et les programmes qui tournent en
arrière plan. Ces programmes peuvent consommer du
temps de processeur précieux, dont vous avez besoin
pour Deck. Spécifiquement, Norton DiskLight, certains
anti-virus, économiseurs d’écran, utilitaires de
compression de données et récepteurs FAX en arrière-
plan peuvent vous causer de nombreux problèmes de
vitesse et des blocages si vous les utilisez en même
temps que Deck. Pour obtenir les meilleurs résultats,
gardez votre Système aussi simple et propre que
possible.

Il n’existe pas de règles toutes faites, mais souvenez-
vous que les conflits d’extensions et de tableaux de
bord peuvent créer des problèmes et que vous devriez
opter pour un système aussi épuré que possible
lorsque vous utilisez Deck. De nombreux problèmes
survenants lorsque Deck fonctionne sont dus à des
conflits d’extensions système et de tableaux de bord.
BIAS recommande de ne laisser que les extensions
Apple installées et de désactiver le Partage de fichiers,
de démonter les volumes réseau, de se déconnecter
d’Internet, et de désactiver la reconnaissance vocale et
l’échange PC.

Vous devriez toujours commencer par chercher cette
possibilité lorsque vous dépannez un problème. Voici
les extensions système et les tableaux de bord qui sont
connus pour poser problème avec Deck. Les tableaux
de bord et les extensions tiers qui ne sont pas listés ici
peuvent également être suspect.

Extensions et tableaux de bord incompatibles :

Aliasmenu

AV Speed Up

Billminder

CD Remote Init

Curtis Trackball

Dal (Data Applications Language)

Directory Assistance II

Disinfectant
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Allocation de RAM et trucs de
gestion de mémoire

Allouer de la RAM à Deck

Dans la plupart des cas, vous devrez allouer plus de
RAM à Deck, car l’allocation par défaut est parfois
insuffisante pour des séances d’une certaine durée ou
d’une certaine complexité. Vous pouvez changer
l’allocation de RAM en surimpressionnant l’icône de
l’application Deck dans le Finder et en sélectionnant
Lire les informations dans le menu Fichier du Finder.
Entrez l’allocation de RAM désirée dans le champ
Souhaitée de la boîte Info sur... du Finder.

Changer l’allocation de RAM ne peut être
effectué que dans le cas où le programme n’est
pas utilisé.

Une bonne façon de garder trace de la RAM de votre
système est d’aller dans le menu Pomme du Finder et
de sélectionner À propos de ce Macintosh. Cette boîte
de dialogue vous montre combien de RAM votre
système possède et comment il est utilisé : combien
de mémoire vos applications utilisent et combien de
RAM non-utilisée est disponible.

Pour trouver quels sont les besoins en RAM de la
séance courante, allez dans le menu Session lorsque la
séance est active et sélectionnez Session Info. Cette
boîte de dialogue vous indique combien de RAM libre
Deck a à sa disposition. Si la quantité de RAM libre est
inférieure à 500K, vous manquez de RAM si vous avez
l'intention d’ajouter du matériau supplémentaire à la
séance ou d’utiliser des plug-ins d’effet. Vous devriez
quitter Deck et lui allouer plus de RAM avant de
continuer avec la séance.

Réglez la partition de mémoire pour Deck en le
sélectionnant dans le Finder et en sélectionnant Lire
les informations dans le menu Fichier. Augmentez
ensuite l’allocation Souhaitée. Vous pouvez toujours
diminuer la quantité de RAM nécessaire pour Deck en
diminuant le réglage Max. Play Tracks count. Pour faire

DiskLight (Norton)

Express Modem

Greg’s Boutons

My Speech Macros

Now Tool Box & All Now Utilities

Options Menu Pomme

Radiusware

RAM Doubler

Record Button

SAM

Serial Extension

Virex

Lorsque vous cherchez des conflits système, vous
devez réellement ouvrir le Dossier Système et les
dossiers Extensions et Tableaux de bord. Sélectionnez
Voir par Nom dans le menu Affichage du Finder. Il faut
mieux voir les extensions et les tableaux de bord
comme cela plutôt qu’avec des utilitaires comme
Gestionnaire d’extensions, dans lequel la liste peut ne
pas refléter le contenu réel du dossier Extensions.
Vous pouvez également utiliser un programme comme
Conflict Catcher.

Pour désactiver les extensions ou les tableaux de bord,
faites simplement glisser les éléments de leur dossier
vers les dossiers “Extensions (désactivées)” ou
“Tableaux de bord (désactivés)” et utilisez-les pour
stocker les éléments que vous voulez temporairement
désactiver. Vous devez redémarrez votre ordinateur
pour que les changements que vous avez fait prennent
effet.
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cela dans Deck, allez dans le menu File et sélectionnez
Preferences, puis choisissez le sous-menu Memory and
Storage et changez le réglage Max. Play Tracks count
sur un nombre inférieur. Les buffers de disque ne sont
alloués que pour les pistes de lecture, donc diminuer
le nombre de pistes de lecture diminue le nombre de
buffers qui sont placés en RAM.

MIDI

Conservez le MIDI à son strict minimum et mutez les
pistes dont vous n’avez pas besoin pendant l’enregis-
trement. Deck est un environnement d’enregistrement
et de mixage audio qui est compatible avec la lecture
et l’enregistrement MIDI simultanés (dans des
séquenceurs en arrière-plan). Comme tel, Deck place
toute son énergie sur l’audio. Si vous essayez de lire
de grandes quantités de MIDI lorsque vous enregistrez
des pistes audio, vous pouvez avoir des problèmes de
vitesse ou de dégradation du signal. Bien que ceci ne
survienne pas dans des situations d’utilisation
normales, vous pouvez avoir des problèmes si vous
utilisez le MIDI Manager pour séparer la lecture de
plus de 32 pistes (chacune envoyant des centaines de
messages par seconde). Si, pour une raison quelcon-
que, vous voulez lire un tel fichier MIDI, vous pouvez
filtrer l’information de contrôleur ou muter certaines
des pistes MIDI lorsque vous enregistrez des pistes
audio. Vous ne devriez en général pas rencontrer ces
problèmes pendant la lecture.

Astuces pour la gestion des fichiers

Une compréhension de base de la gestion de fichier
est très pratique pour les nouveaux utilisateurs de
Deck.

Fichier de séance

Un fichier de séance Deck ne contient pas de fichiers
audio, mais de l’information qui s’applique aux fichiers
audio, comme les pointeurs de région, les emplace-

ments de fichier audio, les événements d’automation
comme pan et volume, etc. Ces fichiers sont indispen-
sables à la construction de vos séances Deck. Un
fichier de séance Deck a en général une taille
d’environ 200K.

Piste

Le nombre de pistes de lecture atteint 64 pistes sur
certains ordinateurs Power Macintosh (avec des
disques durs très rapides). Une piste Deck est
analogue à une voix sur une synthétiseur polyphoni-
que. Une piste pointe toujours vers des régions et les
régions pointent vers les fichiers audio.

Pistes de travail

Les pistes de travail sont identiques aux pistes
normales, sauf qu’elles ne sont pas lues. Vous pouvez,
cependant, écouter les régions audio de pistes de
travail à n'importe quel moment en utilisant les outils
d’audition. Les pistes de travail peuvent également
être écoutées, avec automation de volume et de pan,
après avoir effectué une procédure Bounce To
Clipboard ou Mix To Disk, si Virtual Mix était activé.
Les pistes de travail peuvent être déplacées sur les
pistes de lecture. Une piste de travail pointe toujours
vers des régions et les régions pointent vers les
fichiers audio.

Fichier audio

Les fichiers audio (également appelés fichiers son)
sont toujours des fichiers Sound Designer II mono 16
bits dès qu’ils sont importés ou enregistrés dans une
séance Deck. Le taux d'échantillonnage est identique
au taux d'échantillonnage du fichier de séance. Le taux
d'échantillonnage peut varier entre 22,050 kHz, 24
kHz, 44,1 kHz et 48 kHz, selon votre processeur et
votre matériel audio. Les fichiers audio sont stockés
sous forme de fichiers individuels sur votre disque
dur, jusqu'à ce que vous effectuiez une procédure Mix
to Disk ou Bounce to Clipboard, ce qui crée un
nouveau fichier audio de votre séance entière. Pour
plus d'informations sur les commandes Mix to Disk et
Bounce to Clipboard, voir le chapitre 6 “Automation,
mixage et mastering”.
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Fichier de crossfade

Les fichiers de crossfade sont des fichiers audio réels
qui se trouvent dans le dossier Crossfades de votre
session. Ils sont créés à chaque fois que vous exécutez
un crossfade dans une séance Deck. Les crossfades
sont représentés graphiquement dans les régions
existantes de la piste.

Région

Les régions pointent vers des zones de fichiers audio
existants. Beaucoup de régions peuvent pointer vers
un seul fichier audio. Les régions peuvent également
être enregistrées/stockées dans un fichier audio.

Stratégies d’enregistrement

Il existe des stratégies que vous pouvez employer pour
vous aider à organiser vos fichiers audio, ce qui vous
évite toute confusion plus tard.

Nommez vos pistes avant d’enregistrer, sinon Deck va
par défaut nommer vos pistes Track 1, Track 2, etc.

Si vous nommez chaque piste lorsque vous travaillez,
vous pouvez éviter de finir avec plusieurs fichiers de
plusieurs séances Deck portants le même nom. En
nommant vos propres pistes, il est beaucoup plus
facile d’organiser et de se déplacer dans votre séance.

Pour nommer une piste, Commande-cliquez sur le
pop-up menu de nom de la piste situé à gauche de la
fenêtre Tracks. Ceci fait apparaître une boîte de
dialogue qui vous permet d’entrer un nouveau nom
pour votre piste (vous pouvez également cliquer sur la
piste dans la fenêtre Tracks pour la sélectionner, puis
choisir Rename dans le menu File).

Enregistrer plusieurs passages d'audio sur la même
piste ne résulte qu’en un seul fichier audio contigu
contenant tous les passages d’enregistrement
précédents. Vous pouvez éviter cela en enregistrant
toujours les nouveaux passages audio sur une nouvelle
piste. De cette façon, chaque passage d’enregistre-
ment existe en tant que fichier audio individuel.
Nommer chaque piste avant l’enregistrement rend

plus facile la gestion de vos fichiers audio, avec des
noms clairs qui signifie quelque chose pour vous (par
exemple, vous pouvez nommer plusieurs passages
d'un solo de guitare “solo prise 1”, “solo prise 2”, etc.).
Lorsque vous avez choisi quel passage utiliser, vous
pouvez supprimer les prises inutiles : ouvrez la boîte
de dialogue Session Info, sélectionnez la prise en
cliquant sur son nom et cliquez sur le bouton Delete.
Ceci libère de l’espace disque et allège votre séance—
mais souvenez-vous que cette suppression est une
édition destructive que vous ne pouvez annuler.

Une note à propos du blocage et du
redémarrage

Dès que votre ordinateur se bloque et que vous êtes
forcés de redémarrer, la première chose à faire est
d’attendre que le Bureau réapparaisse, puis d’éteindre
normalement. Laissez l'ordinateur tranquille pendant
une minute avant de le démarrer de nouveau. Ceci
s’appelle un démarrage à froid.

Si vous avez des blocages répétés, il est recommandé
de reconstruire les Desktop files de votre disque dur.
Vous pouvez faire cela en démarrant à froid votre
ordinateur tout en gardant enfoncées les touches
Commande et Option jusqu'à ce qu’une boîte de
dialogue vous demandant si vous êtes sûrs de vouloir
reconstruire le Bureau de votre disque dur apparaisse.
Sélectionnez OK pour tous vos disques durs.

Dépannage

Deck effectue une série incroyablement complexe de
tâches sur un grand nombre d’ordinateurs Macintosh.
Bien que les problèmes soient rares, vous pouvez
parfois avoir une message d'erreur ou un blocage
système, ou d’autres sortes de problèmes en utilisant
Deck. Le guide de dépannage suivant vous aide à
identifier et corriger ces problèmes.
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Problèmes avec les niveaux de sortie
pendant l’écoute

Ceci est un bogue dans le matériel son de certains
Power Macintosh. Lorsque vous activez Lecture du son
par l'unité de sortie dans votre Tableau de bord Son
pour contrôler le son lorsque vous enregistrez, le
niveau de sortie du système entier baisse d’environ 20
dB. Ceci n’est pas un bogue de Deck et ne peut être
corrigé par un logiciel—c’est un bogue du matériel du
Power Macintosh d'Apple.

Ce bogue ne modifie pas l’audio enregistré dans Deck,
mais il modifie le volume de contrôle. Lorsque vous
réglez les niveaux, ce que vous voyez sur les Vu-mètres
et ce que vous entendez est différent de ce qui passe
réellement dans le système. Veillez donc à ne pas
baser vos niveaux d’enregistrement sur les Vu-
mètres—si vous le faites, le signal de lecture sera
beaucoup plus faible que prévu.

Solution

Gardez Analog Input Level (menu Options) sur 0 pour
éviter ce bogue. Avec Analog Input Level sur 0, les
niveaux que vous voyez et entendez sont corrects.
Vous pouvez utiliser une table de mixage compacte de
bonne qualité pour monter le signal entrant.

Message d'erreur : “Problems initializing
Playback engine. No Supported hardware
installed.”

Solutions possibles

Ouvrez le tableau de bord Son et vérifiez qu’une
entrée et une sortie son sont disponibles. Dans le cas
contraire, redémarrer corrige en général ce problème.

Vérifiez combien de RAM libre vous avez sur votre
Macintosh. Quittez Deck, allez dans le Finder et
sélectionnez À propos de ce Macintosh dans le menu
Pomme. Le Plus gros bloc inutilisé indique la quantité
de RAM libre disponible. Vérifiez que vous avez au
moins 16 Mo de RAM libre sur votre Macintosh
(n’augmentez pas les réglages Disk buffer size du
menu Memory and Storage au-delà de la quantité de
RAM allouée à Deck).

Si vous le pouvez, essayer d’allouer plus de RAM à la
partition de mémoire de Deck (pour obtenir cette
information, surimpressionnez l’application et non un
alias, l’application ne tournant pas).

Jetez le fichier Deck Preferences (dans le dossier
Préférences, qui se trouve dans le Dossier Système) et
redémarrez votre machine. Les utilisateurs de matériel
Digidesign doivent également jeter les fichiers
DigiSetup et Digicomm de leur Dossier Système. Tous
les nouveaux fichiers Deck Preferences seront créés
automatiquement la prochaine fois que vous utiliserez
Deck.

Dans Deck, diminuer le réglage Max. play tracks de
Memory and Storage dans le menu Preferences.

Deck n’a peut-être pas été installé correctement. Il est
possible que le mauvais type de plate-forme ait été
sélectionné pendant l’installation, par exemple. Si vous
suspectez que cela soit le cas, réinstallez Deck. Pour
apprendre comment installer Deck, voir le chapitre 2
“Installation et configuration de Deck”.

Problème : Impossible d’enregistrer en
séparation Stéréo—non Stéréo.

Solutions possibles

Vérifiez que vous utilisez des adaptateurs stéréo, et
non mono, entrant et sortant des connecteurs audio
de votre Mac.

Vérifiez que les jacks sont fermement insérés dans les
connecteurs d’entrée et de sortie audio de votre
Macintosh.

Réglez chaque piste d’enregistrement sur une entrée
différente dans la fenêtre Mixer.

Problème : L’audio a des parasites

Solution possible

Utilisez un adaptateur stéréo 1/8 de pouce avec une
pente de 1/2 pouce et une base fixée qui est légère-
ment élevée au-dessus de l’embout de l’adaptateur. Le
connecteur d’entrée d’un Macintosh AV empêche
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certains adaptateurs 1/8 de pouce “à tête plate” d’avoir
un contact stéréo complet.

Problèmes généraux avec la lecture audio
(sauts, pops, clics, messages “Disk is Too
Slow”)

Solutions possibles

Enregistrez de l’audio sur un disque dur qui ne
contient pas le Dossier Système (voici pourquoi il faut
mieux avoir deux disques durs en utilisant Deck sur
des ordinateurs Macintosh AV).

Changez le réglage Disk buffer size : allez dans le
menu File, sélectionnez Memory and Storage dans le
sous-menu Preferences et entrez 192K dans la boîte
Disk buffer size. Il s’agit du réglage par défaut.

Problèmes avec le MIDI ou en
synchronisant sur du timecode externe
(MTC)

Solution possible

Installez OMS de Opcode version 2.3 ou ultérieure.
Nous recommandons l’installation d’OMS sur toutes
les machines si vous faites du travail qui implique de la
synchronisation. OMS fournit la compensation pour
les blancs de timecode MIDI et aide lorsque vous
mettez Deck en esclave sur du timecode externe.

Message d'erreurs

erreurs -36 I/O

Il s’agit en général de problèmes de terminaison SCSI.
Vérifiez que votre disque dur interne est correctement
terminé et que vous avez installé un terminateur actif
sur le dernier élément SCSI de votre chaîne SCSI
externe (voir la partie sur la terminaison SCSI plus
haut dans cet Appendice pour plus d'informations).

erreurs -37 “Bad File Name”

Les noms de région et de fichier audio ne doivent pas
comporter plus de 31 caractères ni de caractères
illégaux comme : et ;

erreurs -39

Il s’agit d’erreur “End of File” dans laquelle les temps
de départ et de fin d’une région ont été corrompus.
Ces erreurs surviennent lorsque vous importez des
régions à partir de fichiers enregistrés à l’origine dans
Sound Designer II. Il y a également des exemples
d’erreurs -39 pendant la lecture d’une séance Deck.
Voici des exemples d’erreurs -39 et comment les
corriger :

erreur -39 pendant la lecture

Notez les régions qui causent réellement cette erreur.
Deck arrête en général la lecture exactement au point
de départ des régions problématiques. Localisez la
position originale de la région problématique. En
Mode objet, utilisez l’outil Trim pour raccourcir la
région. Étendez maintenant la région jusqu’à sa durée
originale. Maintenant que les temps de départ et de fin
de la région ont été redéfinis par l’outil Trim, l’erreur -
39 devrait disparaître.

erreur -39 lorsque vous importez des régions
enregistrées à l’origine dans Sound Designer II

Reconstruisez les Desktop files de tous vos disques
durs (redémarrez votre Macintosh en appuyant sur les
touches Commande et Option ; cliquez sur OK lorsque
la boîte de dialogue apparaît). Ouvrez votre applica-
tion Sound Designer II, redéfinissez les temps de
départ et de fin des régions problématiques et
enregistrez-les dans Sound Designer II. Vous pouvez
maintenant importer les régions dans Deck en utilisant
Add Audio to Clipboard du menu File.

erreurs -43 “File Cannot Be Found”

Ces erreurs sont en général créées par des fichiers de
crossfade corrompus. Ceci arrive si vous avez déplacé
des fichiers de séance d’un volume à un autre. Pour
remédier aux erreurs -43, sélectionnez Rebuild Fades
dans le menu Process. Si le problème persiste,
reconstruisez les Desktop files de tous vos disques
durs. Si vous avez encore une erreur -43, vous pouvez
être obligé de supprimer tous vos crossfades (en
sélectionnant Delete Fades dans le menu Process) et
de les recréer depuis le début. Mais avant de vous
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résoudre à cela, essayer de quitter Deck et sortez le
dossier crossfades de votre séance problématique. Les
crossfades sont automatiquement recréés à la
prochaine réouverture de la séance.

-108 (ou - 2012) “Couldn’t Complete the Last
Commande due to a Mac OS error”

Allouer plus de RAM à la partition de mémoire pour
remédier à ces erreurs.

erreur -192 “Required Resources Missing”

Vérifiez vos réglages d’extensions et de tableaux de
bord et reconstruisez les Desktop files de tous vos
disques durs (ces procédures sont expliquées plus
haut dans cet Appendice). Si cela ne fonctionne pas,
réinstallez Deck. Si vous avez toujours le message
d'erreur -192, vous pouvez être obligés d’effectuer une
Installation spéciale du Système.

erreur -2720

L’entrée source incorrecte est sélectionnée. Dans le
tableau de bord Son, réglez l’entrée sur Intégré au lieu
de Digidesign.

“Problems Initializing Playback Engine”

Cette erreur est en général le résultat d’une taille Disk
buffer size trop grande par rapport à la RAM allouée à
l’application Deck dans le Finder. Des réglages Disk
buffer size plus élevés nécessitent que plus de RAM
soit allouée à Deck. Pour calculer la quantité de RAM
qu’il vous faudra allouer à Deck dans ces cas,
multipliez la quantité d’augmentation de Disk buffer
size par le nombre de pistes tournant dans Deck.
Changez maintenant l’allocation de RAM en entrant la
nouvelle quantité dans le champ Souhaitée de la boîte
Info sur... du Finder.

Deck se bloque ou se suspend pendant
l’enregistrement

Ceci peut être dû à un problème de terminaison SCSI.
Pour tester si la terminaison SCSI est la coupable,
utilisez la fonction Mix To Disk. Faites une sélection de
5 minutes dans la fenêtre Tracks et sélectionnez Mix to
Disk dans le menu Process. Effectuez ce processus

avec la même sélection trois fois, pour créer trois
fichiers mixés. Si des problèmes surviennent pendant
l’une de ces trois procédures Mix to Disk ou si vous
avez problèmes pour lire l’un des trois fichier mixés
lorsqu’ils sont importés dans une séance Deck, il est
probable que quelque chose ne fonctionne pas sur
votre chaîne SCSI. Voir la partie sur la terminaison
SCSI plus haut dans cet Appendice pour plus
d'informations.

La boîte de dialogue “Calculating File Overview”
apparaît continuellement lorsque vous tentez de
faire défiler la fenêtre Tracks

Allouer plus de RAM à Deck résout en général ce
problème, mas ne résout malheureusement pas
l’erreur -39 liée au calcul de l’affichage des boucles.

messages “Disk Too Slow” ou erreurs “out of
memory”

Avec des disques lents, utilisez la préférence Memory
and Storage (dans le sous-menu Preferences du menu
File) pour augmenter Disk buffer size. Ceci augmente
la mémoire globale nécessaire, mais diminue la
fréquence des lectures sur disque et sollicite moins
celui-ci.

Une note sur les messages “Disk Too Slow”

Si vous faites tourner Deck avec plusieurs programmes
esclaves sur un seul Macintosh ou si votre Macintosh
ou votre disque dur sont lents ou anciens, vous
pouvez voir apparaître le message “Disk Too Slow”.
Ceci ne signifie pas la mort de votre système. Il existe
un certain nombre d’ajustements simples que vous
pouvez faire pour remédier en général à ce problème.

Essayer d’augmenter Disk buffer size. Vous obtenez ce
message en général parce que votre disque est
vraiment un peu trop lent. Pour compenser un disque
lent, vous pouvez augmenter Disk buffer size : ceci
diminue le nombre de lectures sur disque, et diminue
donc le nombre total de recherches nécessaires. De
grandes parties d'audio sont chargées pendant les
lectures sur disque et la charge globale de votre disque
dur est réduite.
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Le seul désavantage peut être une légère augmenta-
tion du retard entre le moment où vous enfoncez le
bouton Play et le début effectif de la lecture. Pour
augmenter Disk buffer size, choisissez Memory &
Storage dans le sous-menu Preferences du menu File.

Utilisez cette boîte de dialogue pour entrer une plus
grande valeur de Disk buffer size. Essayer d’abord
256K, puis augmentez si cela n’améliore pas suffisam-
ment la performance du disque. Lorsque vous
augmentez votre Disk buffer size, vous devez
également augmenter la quantité de RAM allouée à
l’application Deck (plus les réglages de Disk buffer
size sont élevés, plus ils nécessitent de RAM). Voici
comment calculer l’augmentation d’allocation de RAM
nécessaire lorsque vous augmentez Disk buffer size
dans votre séance : prenez la quantité d’augmentation
de Disk buffer size et multipliez par le nombre de
pistes de votre séance Deck.

Changez l’allocation de RAM en quittant le pro-
gramme, en sélectionnant sa boîte Info sur... dans le
Finder et en changeant le champ Souhaitée.

Diminuez le réglage de vitesse de mise à jour pour les
programmes en arrière-plan. Deck offre une option
“Update speed during playback” dans General du sous-
menu Preferences du menu File. Cette préférence
vous permet de régler combien de temps est alloué
pour la mise à jour des programmes en arrière plan
derrière la lecture audio de Deck . Un réglage de 1
permet au programme en arrière-plan d’être mis à jour
aussi souvent que possible. Ce réglage permet de voir
facilement l’activité de l’écran des programmes en
arrière-plan. Un réglage de 10 empêche les program-
mes en arrière-plan d’être mis à jour pendant la
lecture, ce qui permet à Deck de monopoliser
l’affichage. Ce réglage ne modifie pas du tout la
performance du programme en arrière-plan, mais
uniquement l’affichage de l’écran. Un réglage de 5 est
suggéré. Si vous faites tourner Metro en arrière plan et
que vous avez des messages “Disk Too Slow”, réglez
sur 8 ou 10 pour diminuer la charge de travail
d’arrière-plan du processeur ou essayez de diminuer le
réglage steps per beat de Metro.

Désactivez la préférence “Stop playback if disk is too
slow”. Ceci est une préférence particulièrement
pratique disponible dans General du sous-menu
Preferences du menu File. La préférence “Stop
playback if disk is too slow” vous permet de régler
avec quelle précision Deck vérifie si votre disque dur
est trop lent. Si vous tentez de lire plusieurs pistes à
partir d’un disque dur très lent, Deck peut ne pas
pouvoir les lire sans un petit saut dans la lecture. En
général, ce saut est si subtil que vous pourriez ne pas
l’entendre. Lorsque cette préférence est activée, Deck
affiche une boîte de dialogue et arrête immédiatement
la lecture dès que la performance du disque peut
causer un saut de lecture. Lorsque cette préférence est
désactivée, Deck continue à lire, même si un léger saut
peut potentiellement survenir.

Si vous mixez en direct directement sur DAT ou sur un
support de mastering, activez “Stop playback if disk is
too slow”. Ceci garantit que la lecture audio est
vérifiée et arrêtée avant qu’un saut ne survienne. Si
vous éditez simplement du son et que vous comptez
mixer sur disque (qui est la façon suggérée d’utiliser
Deck), laissez cette préférence désactivée. La plupart
des sauts sont inaudibles, et même si vous en
entendiez un, il n’apparaîtrait pas dans le fichier
master créé avec la procédure Mix to Disk.
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Appendice 2 :
Compatibilité avec le
Tascam US-428

Deck et Deck LE offrent une compatibilité directe avec
la surface de contrôle Tascam US-428. Si Deck détecte
un port de contrôle Tascam US-428 disponible via
OMS, Deck se place lui-même en mode “US-428”.

Pour utiliser le US-428 comme interface audio de
Deck, installez le pilote ASIO 16 bits du US-428 dans le
dossier ASIO Drivers. Lancez Deck et choisissez le
pilote ASIO 16 bits du US-428 dans le pop-up menu
Audio card de la boîte de dialogue Hardware
Configuration.

Boîte de dialogue Hardware Configuration

Remarquez que vous n’avez pas besoin
d’utiliser le US-428 comme pilote ASIO pour
utiliser ce dernier comme surface de contrôle.

Lorsqu’il est en mode US-428, Deck crée un égaliseur
paramétrique 4 bandes (version 2.7.1) sur les premiers
inserts d’effet de chaque piste. Les boutons “High”,
“Hi-mid”, “Low-mid” et “Low” du Tascam US-428
sélectionnent chacune des quatre bandes
paramétriques.

Déplacer un fadeur sur le US-428 déplace le fadeur de
volume correspondant dans Deck. Les boutons Bank
du US-428 sont utilisés pour sélectionner quel groupe
de fadeurs de volume sera contrôlé par les 8 fadeurs
du US-428 (par exemple 1-8, 9-16, 17-24).

Appuyer sur les boutons “Select” du US-428 sélec-
tionne le canal. Les molettes Pan et EQ contrôlent le
Pan et les paramètres des EQ 4 bandes pour le canal
sélectionné dans Deck.

Le boutons Transport du US-428 sont directement liés
aux contrôles de Transport de Deck. Le bouton
Record agit également. Gardez appuyé le bouton
Record et appuyez sur un bouton de sélection pour
activer l’enregistrement de ce canal.

Les boutons “Mute” affichent et (dés)activent l’état de
Mute pour le canal sélectionné et la piste correspon-
dante de Deck. Si le bouton “SOLO” est allumé, cette
fonction change l’affichage et modifie l’état de Solo
pour le canal et la piste correspondante de Deck.

Les boutons “Locate <<”, “Locate >>” et “Set” du
US-428 sont utilisés pour régler et aller aux marqueurs
de position de la fenêtre Tracks dans Deck. Amenez la
fenêtre Tracks de Deck au premier-plan et utilisez le
bouton Set pour créer un marqueur de position au
temps courant.

Les boutons “Locate <<” et “Locate >>” vont au
plus proche marqueur de position avant et après le
temps courant, respectivement.

Les boutons “Select” du US-428 sélectionnent les
pistes 1–8 de la séance courante dans Deck LE. Dans
le version complète de Deck, les boutons “Select” du
US-428 sélectionnent les pistes 1–8 de la Bank
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courante. Les boutons Bank sélectionnent quelles
banques de canaux sont modifiées par les contrôles du
US-428 (par exemple 1-8, 9-16, 17-24, etc.). Le nombre
de pistes de lecture disponibles dans la table est
contrôlé par les préférences General/Storage de Deck.

Affichage du canal d’entrée/sortie lorsque le bouton “ASGN” est
appuyé

Le bouton “ASGN” utilisé avec la molette de données
sélectionne l’assignation d’entrée pour le canal
sélectionné. Gardez appuyé le bouton “ASGN” et faites
tourner la molette de données pour changer
l’assignation d’entrée du canal sélectionné. Lorsque le
bouton “ASGN” est relâché, les boutons états de Mixer
(SELECT, REC, MUTE) affichent le canal d’entrée
assigné.

Le bouton “F1” utilisé avec la molette de données
sélectionne l’assignation de sortie pour le canal
sélectionné. Gardez appuyé le bouton “F1” et faites
tourner la molette de données pour changer
l’assignation de paire de sortie pour le canal sélec-
tionné. Lorsque le bouton “F1” est relâché, les
boutons états de Mixer (SELECT, REC, MUTE)
affichent la paire de sortie assignée (par exemple 1 =
la paire de sortie 1-2, 2 = la paire de sortie 3-4, etc.).
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Glossa i r e

AIFF

Audio Interchange File Format d'Apple utilisé pour
l’enregistrement et le stockage audionumérique.

Boucle

Les boucles sont utilisées pour entretenir ou répéter
une partie d’audio ; une boucle est une région d’audio
répétée.

Carte audio (carte audio tierce, carte
d’extension audio, carte d’enregistrement
et de lecture audio)

Une carte d’extension tierce qui se place dans un port
NuBus, PCI ou PCMCIA de votre Macintosh. Ces cartes
améliorent les capacités d’enregistrement et de lecture
audio de l’ordinateur. En utilisant le logiciel Sound
Manager d'Apple, Deck fonctionne avec des cartes
audio Macintosh de Digidesign, Digigram, Echo, Korg,
Lucid, Mark of the Unicorn, MIDI Man et autres. Dans
certains cas, un pilote Sound Manager ou ASIO spécial
doit être fourni par le constructeur de la carte audio
pour que celle-ci fonctionne correctement avec Deck.

Clip

Un type de distorsion audio qui survient lorsqu’un
signal source (comme celui provenant d’un lecteur de
CD audio) est enregistré à un tel niveau que l'enregis-
treur (par exemple un Macintosh sur lequel tourne
Deck) manque de “marge”. Il peut également survenir
lorsqu’un signal est relu d’une source dans un élément
audio de destination à un niveau excessif, comme
lorsqu’une console de mixage envoie un signal à un
amplificateur à un niveau extrêmement haut. Dans les
deux cas, le clip représente une erreur de niveau entre
une source et un élément de destination. Lorsque du
clip numérique survient, par exemple pendant
l’enregistrement numérique, les résultats peuvent être
un son “craquelant” ou “râpeux”. Lorsque vous utilisez

Deck, vous pouvez éviter les clips numériques en
vérifiant que les niveaux d’enregistrement sont réglés
pour que les passages audio d'entrée les plus forts
restent en-dessous du niveau maximum d'entrée,
comme indiqué sur les Vu-mètres d’enregistrement ou
de lecture. Les indicateurs de clip situés au-dessus des
Vu-mètres dans la fenêtre Mixer montre les clips qui
surviennent. Reportez-vous également à Marge.

dB (décibel)

Unité la plus courante pour mesurer le niveau audio.
Plus le nombre de décibels est élevé, plus le signal
audio est élevé. Dans Deck, les Vu-mètres montrent
un niveau relatif du signal en dB. Il existe différents
types d’échelles de décibels, mais lors de l’utilisation
de Deck, “dB” peut être utilisé pour décrire le gain
relatif des différent passages audio ou pour décrire la
marge disponible pendant l’enregistrement. Reportez-
vous également à Gain et Marge.

Document audio

Un document audio est un fichier de données audio
Macintosh créé par Deck. Deck peut créer et ouvrir
des documents dans plusieurs formats de fichier
audio. Le format de fichier SDII est le format par
défaut. Pour plus d'informations, reportez-vous à AIFF,
WAV, Sound Designer II et QuickTime.

DSP

DSP signifie Digital Signal Processing (traitement
numérique du signal). Dans le monde de l’audio, DSP
fait référence à la manipulation d’un signal audionu-
mérique avec des procédés comme les changements
de niveau, la réverbération, le delay ou d’autres effets.
Deck utilise du DSP pour effectuer nombre de ses
tâches de traitement audio—dont celles du sous-menu
Destructive Effects et des effets intégrés.
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Échantillon

Un échantillon fait référence au matériau audio
enregistré numériquement ou “échantillonné” avec un
échantillonneur ou tout autre machine d’enregistre-
ment numérique. Échantillon fait également référence
à un seul “cliché” de cycle d’onde de son. Voir
également Échantillonner et Taux d'échantillonnage.

Échantillonner

Échantillonner fait référence au fait d’enregistrer
numériquement de l’audio avec un échantillonneur ou
tout autre machine d’enregistrement numérique. Voir
Échantillon et Taux d'échantillonnage.

Fade-in/Fade-out

Un fade-in est un processus où le gain d’un signal
audio est augmenté de zéro (silence) à son volume
maximum. Un fade-out est un processus où le gain
d’un signal audio est diminué de son volume
maximum à zéro (silence). Deck vous permet de créer
des fade-ins et des fade-outs en faisant une sélection et
en choisissant la commande Fade Selection du menu
Process (Commande-F). Les formes d’enveloppe
peuvent être éditées avec les commandes Set Default
Fade ou Custom Fade du menu Process.

Fréquence

Le son est constitué d’ondes qui apparaissent par
cycles. La fréquence fait référence au nombre de cycles
d’onde qui apparaissent pendant une période de
temps donnée (en général, une seconde). Plus la
fréquence d'un son est élevée, plus sa “hauteur”
perçue par les oreilles humaines est élevée. La
fréquence est mesurée en Hertz (Hz) ou cycles par
seconde. L’être humain est capable d’entendre des
sons dans la plage de fréquence située à peu près
entre 20 Hz et 20 000 Hz (20 kHz).

Gain

1) Le processus d’amplification d’un signal. 2) Une
façon d’exprimer des niveaux relatifs pour l’audio. Par
exemple, en ajoutant 6 décibels de niveau à un signal,
nous doublons le volume perçu du signal. Reportez-
vous également à dB et Marge.

Hz (Hertz)

Unité de mesure de la fréquence qui fait référence au
nombre de “cycles par seconde” qu’une onde sonore
génère. Dans le monde du son, plus le nombre de
Hertz est élevé, plus la fréquence d'un son est élevée
et donc plus sa “hauteur” perçue par les oreilles
humaines est élevée. Mille hertz peuvent être écrits 1
kHz (un kilohertz), et donc 20 000 Hertz est l’équiva-
lent de 20 kHz.

Marge

Décrit combien de gain il reste avant qu’un signal
n’introduise du clip ou de la distorsion. Lorsque vous
enregistrez avec Deck, les Vu-mètres de la fenêtre
Mixer indiquent combien de marge il reste avant de
clipper. Lorsque vous lisez de l’audio dans Deck, les
bandes Vu-mètres en bas de l'écran l’indiquent
également. La plupart des ingénieurs du son profes-
sionnels laissent entre 3 et 12 dB de marge lorsqu’ils
enregistrent, pour minimiser la possibilité de clip. Si
vous laissez trop de marge, cependant, votre signal
peut être enregistré à un niveau trop faible et vous
pouvez finir avec un bruit de fond excessif. Reportez-
vous également à Clip, Décibel et Gain.

Marqueur

Un marqueur est une position dans la ligne temporelle
de Deck que vous définissez comme importante ; vous
pouvez également concevoir un marqueur comme une
“mémoire de position”. En marquant une position
spécifique dans un enregistrement, vous pouvez
facilement naviguer jusqu’à elle pour des besoins de
sélection, d’édition ou de lecture.

Passage à zéro

Le passage à zéro est le point où la forme d'onde
rencontre la ligne passant par zéro ou ligne centrale au
travers de la forme d'onde. Il s’agit du point d’ampli-
tude zéro de la forme d'onde.

Plage dynamique

Dans la terminologie de l’enregistrement audio, la
plage dynamique fait référence à l’étendue de niveau
située entre les passages les moins forts et les plus
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forts d'une sélection audio. Elle est en général
exprimée en décibels. La résolution de bits détermine
la plage dynamique d’un enregistrement. Un
enregistrement 8 bits possède 256 niveaux disponi-
bles, ce qui fournit une plage dynamique de 48 dB.
Ceci peut convenir pour certaines applications, mais
peut également sonner avec du bruit, car la différence
de gain entre les passages les moins et les plus forts
(qui peut contenir du bruit de fond et d’autres bruits
potentiels) n’est pas très grande. Un enregistrement
16 bits possède 65 536 niveaux disponibles, ce qui
fournit une plage dynamique de 96 dB de bonne
qualité. De façon empirique, vous pouvez calculer la
plage dynamique en décibels en multipliant le nombre
de bits par “6”. Reportez-vous également à Résolution
de bits, Décibel et Gain.

Plug-ins

Les plug-ins sont des améliorations logicielles
optionnelles pour Deck qui sont disponibles chez
BIAS et d’autres développeurs et qui sont compatibles
avec les normes Adobe Premiere et Steinberg VST. En
installant des plug-ins dans Deck, vous pouvez
améliorer les capacités d’édition et de traitement
audio avec des outils comme des filtres, de la
réverbération, du chorus et du flanging, de la
réduction de bruit, de la spatialisation, et autres.

QuickTime

Format audio développé par Apple Computer pour le
multimédia à base de QuickTime. Il est compatible
avec toutes les applications Macintosh qui reconnais-
sent QuickTime. Le format QuickTime est recom-
mandé si vous comptez utiliser un document audio
dans des applications multimédia compatibles
QuickTime, comme Adobe Premiere ou Macromedia
Director.

Région

Une région est une partie d’un document audio.

Résolution de bits (nombre de bits)

Décrit combien de bits—de “0” et de “1” —sont
disponibles pour décrire un enregistrement numéri-

que. En pratique, la résolution de bits définit la plage
dynamique d'un son, tandis que le taux d'échantillon-
nage définit la plage de fréquence. L’audio 16 bits est
la norme professionnelle du disque compact ; l’audio
8 bits convient aux applications moins exigeantes,
comme les présentations multimédia. Plus de bits
donnent une meilleure qualité, mais nécessitent
également plus d’espace de stockage sur le disque
dur. Reportez-vous également à Plage dynamique,
Fréquence et Taux d'échantillonnage.

SCSI

Signifie Small Computer System Interface (Interface
système pour mini-ordinateur). Il s’agit d’une norme
développée pour permettre à des ordinateurs et à des
machines périphériques comme des disque durs, des
graveurs de CD, des scanneurs et autres supports de
stockage, de se connecter et de transférer des
données. La plupart des disques durs externes conçus
pour l’utilisation avec le Macintosh sont des disques
durs SCSI et doivent être connectés au port SCSI à
l’arrière du Macintosh. La spécification SCSI permet de
connecter jusqu'à sept éléments SCSI ensemble.

Sound Designer II™

Format de fichier audio développé par Digidesign
pour l’utilisation dans ses produits audionumériques.
Le format peut également être lu par plusieurs
programmes Macintosh d’édition audio et de
développement multimédia. Il s’agit du format de
fichier standard de Deck.

Taux d'échantillonnage

Le taux d'échantillonnage décrit la fréquence avec
laquelle un signal audio analogique est “échantillonné”
ou analysé lorsqu’il est enregistré et converti sur un
support numérique. Le taux d'échantillonnage modifie
directement la fidélité audio en terme de réponse de
fréquences aiguës : plus le taux d'échantillonnage est
élevé, plus la réponse de fréquence disponible est
élevée. Un principe fondamental de l’échantillonnage
précise que pour capturer précisément un son, le taux
d'échantillonnage doit être au moins le double de la
fréquence la plus haute du son. Le taux d'échantillon-
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nage des disques compacts est de 44,1 kHz. Voici les
taux d'échantillonnage courants compatibles avec de
nombreux ordinateurs Macintosh et le logiciel Deck.

 48 000 Hz L’un des deux taux d'échantillonnage
des enregistreurs DAT, souvent utilisé par les
éditeurs de son dans la post-production audio
pour la vidéo ou le film. Ce taux fournit une
réponse de fréquence de 24 kHz—bien au-dessus
de la plage d’audition humaine.

44 100 Hz Taux d'échantillonnage des disques
compacts, des enregistreurs DAT et des
applications audio haute-fidélité sur ordinateurs
Macintosh et PC permettant la lecture 16 bits. La
plupart des ingénieurs du son travaillant dans la
production  musicale utilisent cette valeur qui
fournit une réponse de fréquence de 22 050 Hz—
au-dessus de la plage d’audition humaine.

22 050 Hz & 11 025 Hz Ces taux d'échantillonnage
sont parfois utilisés pour de la lecture audio
basse-fidélité sur ordinateurs Macintosh et PC. De
nombreux jeux, sites Web et autres productions
multimédia utilisent de l’audio 22 050 Hz 8 bits,
car il n’utilise que le quart de la place occupée
par de l’audio de qualité CD. Le taux d'échan-
tillonnage de 22 050  Hz fournit une réponse de
fréquence aiguës de 12 025 Hz ; cela peut sonner
de façon “sourde”, car la plupart des gens
entendent des fréquences considérablement plus
élevées que 12 025 Hz.

Reportez-vous également à Résolution de bits,
Fréquence et Hertz.

.WAV

Format Windows Audio File de Microsoft. Il est
compatible avec de nombreuses applications Windows
et certaines applications Macintosh. Le format WAV est
recommandé si vous comptez utiliser un document
audio dans une application qui est compatible ou
nécessite des fichiers de format WAV.
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Symboles

.SND 77

.WAV 77, 178

A

Add Audio CD Track To Clipboard 122
Add Audio to Clipboard 22, 75, 122
Add SDII Playlist to Clipboard 122
Add SND to Clipboard 22, 122
Adobe Premiere 83
AES/EBU 142
Affichage de la forme d'onde 26
Affichage de l'automation 69
Affichage de l'automation de la piste 107
AIFF 77, 175
Ajuster sur la sélection 34, 104
Aligner sur la grille 105
Allocation de RAM 5
Always save regions when Session is saved 123
Amplificateur 11
Analog 142
Analog Input Level 142
Apple Sound Manager 11
Arboretum 60
ASIO 11, 12, 13, 175

configurer Deck 14
installation du pilote 14

Audio Format 87
Audio Interchange File Format 77
Audition End of Selection 135
Audition Outputs 126
Audition Pre-Post Selection 135
Audition Selection 135
Audition Volume 126
Automation 67, 112, 139

Conform To Audio Edits 139
activer/désactiver 71

créer 69
éditer 70

enregistrer 67
enveloppes 69
enveloppes visuelles 68
Erase All 139
états de Mixer 71
Mute All 139
Play All 139
point de rupture

ajuster 70
supprimer 70

Pop-up menu Affichage de la piste 68
Record All 68, 139
Record Pan 68
Record Volume 68

Automation buffer 126
Automation de la table 67
Automation d'état de Mixer 72

enregistrer 72
Automation Thin 135
Autorisation 10

Code d'Autorisation de Produit 10
Autostop at end of Session 123
Axe temporel 35, 106

B

Bit Depth 78
Bit Depth Conversion 78, 87, 127
Boîte Indicateur de valeur de contrôle 58
Boîtes Indicateur de données 37
Boucle 175
Bounce All to Mono Clipboard 131
Bounce All to Stereo Clipboard 132
Bounce to Clipboard 74
Bounce to Disk 75
Bouncer des pistes 74
Bouton Boucle 41
Bouton Enregistrement activé 113
Bouton Grille 38
Bouton MIDI Thru 118
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Bouton Mode objet 37
Bouton Mode segment 36
Bouton Mute 113
Bouton Solo 113
Bouton Zoomer 34
Boutons Mémoire d'affichage 35, 104
Boutons Taille de piste 35, 104
Boutons Zoom Vertical 34
Bypass 57

C

Capture Start 135
Carte audio 12, 15, 175
CD 79
Change region start times with BPM change 124
Chase Positioning 70
Chorus 26, 59
Clear 129
Clip 175
Clip Light Threshold 127
Clipboard Memories 129
Clock Source 15
Close Session 121
Close Window 144
Code d'Autorisation de Produit 10
Color scheme 125
Compact Audio File 29, 46, 47, 122, 127
Compact Files 127
Compact Session 29, 46, 143
Compteur Master 115
Compteurs Begin et End 116
Configuration matérielle 15
Conform To Audio Edits 139

activer/désactiver 71
Connexions audio 11
Contrôles de tempo 105
Contrôles de Transport 125
Convergent Rounding 78, 87
Copy 129
CPU 121
Crossfades 41, 134

linéaires 43
puissance constante 43

Curseur de repérage 115
Custom Fade 45, 134

Cut 129
Cycling ’74 60

D

dB (Décibel) 175
Décibel 175
Deck

allocation de RAM 10
configuration 17
effets intégrés 26
fichier de séance 21
fonctions 3
installation 9
nouveautés 4

Deck LE 5
Default Fade 133
Défilement de film 70
Defragment Audio File 122
Delay 26, 58
Delay line length 129
Delete Fade 45, 134
Destructive Effects 134
Digidesign 175
Digigram 175
Digital Format 142
Diode de clip 113, 121
Disk buffer size 125
Dithering 78, 87
Document audio 175
Dossier Audio Files 21
Dossier Crossfades 21
Dossier VstPlugIns 60
DSP 175
Duplicate 56

E

Échantillon 176
Échantillonner 176
Échantillons 37
Echo 175
Éditeur externe 50, 135
Effects Allocation 129
Effets 26, 55

ajuster les paramètres 57
assigner 56
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bypass 57
Chorus 59
curseurs 57
dans la fenêtre Mixer 56
Delay 58
destructifs 55, 134
EQ 58
externes 134
Gain 59
indicateur de valeur de contrôle 58
intégrés 56
Multitap 59
non-destructifs 55
retirer 57
temps réel 55, 56
Thru 57

Enceintes 11
Enregistrer 24
Enveloppes d'automation 69

afficher et masquer 71
copier et coller 71
créer 69
éditer 70
muter et effacer 71
point de rupture 70

EQ 26, 58
État de l'automation de la piste 70, 107
États de Mixer 26, 34, 71, 116

enregistrer dans la fenêtre Tracks 73
rappeler 72
renommer 72
stocker 72
supprimer 72

Export Movie 86
Export Session Regions 143
Extensions système 4
External Effects 134

F

Fade
custom 134
set default 134

Fade Selection 133, 134
Fade-in 176
Fade-out 176

Fades 41
par défaut 44
personnalisés 45
Silence 43
superposés 43
supprimer 45

Fadeur de contrôle de hauteur 117
Fadeur de Pan 113
Fadeur de Volume 113
Fadeur Master 121
Fast Forward 115
Fenêtre CPU Meter 24, 121, 144
Fenêtre Effect 57, 119, 144
Fenêtre Library 117, 144
Fenêtre Master Outputs 24, 61, 120, 144

plug-ins VST 61
Fenêtre MIDI 118, 144
Fenêtre Mixer 23, 61, 62, 111, 144

plug-ins VST 61
Fenêtre QuickTime 84, 119, 144
Fenêtre Tracks 23, 33, 34, 104, 144

commandes clavier 108
Fenêtre Transport 23, 26, 114, 144
Fichiers Sound Resource 77
Film QuickTime 83

exporter 86
faire défiler 84
importer 83

Final Cut Pro 83
Firewire 17
Flux du signal de canal 114
Format de fichier audio 77
Formes de fade in 42
Formes de fade out 42
Fréquence 176

G

Gain 26, 59, 176
Graphic EQ 58
Grille 37
Grille intelligente 38
Group Normalize 55
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H

Handle Length 47
Hardware Configuration 141
Hertz 176
Hi EQ 58
Hz (Hertz) 176

I

iMovie 83
Import Session 143
Indicateur de canal de piste 119
Indicateur de l'état du disque dur 106
Indicateur de Niveau 107
Indicateur de Pan 107
Indicateur de port de piste 119
Indicateur de position 104
Indicateur de sortie 120
Indicateur de valeur de contrôle 116
Indicateur d'état 116
Indicateur File 118
Indication de mesure 48
Input Type 142
Insert After 130
Insert At 130
Insert Time 130
Inserts VST

mono-to-mono 62
mono-to-stereo 62
stereo-to-stereo 62

Interface audio 12
Invert 55

K

Korg 175
1212 I/O 11, 137
SoundLink 11, 14, 15, 137

L

Launch Editor 50, 135
Library

Find File 143
Select Regions 143
Sort by size 143
Update from session 143

Library Operations 143
Ligne temporelle 27, 35
Live Video 85
Lo EQ 58
Load Audio File 122
Loop audition 124
Lucid 175

M

Magnétoscope 98
Make Contiguous 131
Make Markers From 140
Marge 176
Mark of the Unicorn 175
Marqueurs 27, 35, 106, 176

renommer 35
supprimer 35

Mastering 76
Max. play tracks 126
Menu Edit 129
Menu File 121
Menu Help 144
Menu Options 136
Menu Process 131
Menu Session 142
Menu Windows 144
Mesures et pulsations 37
Metro 49, 94, 99, 123

Always Pass Selection 128
configurer avec Deck 94

Mic Input On 142
MIDI 24

Bouton Import 118
Bouton Mute All 118
Bouton Subscribe 118
configuration 91
Default Output Port 92, 128
Dispose MIDI File 123
Edit MIDI Map 93, 139
Enregistrer et charger une MIDI Map 93
Import MIDI File 96, 123
Load MIDI Map 123
Maps 92
métronome 95
MIDI Thru 97
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Mute MIDI Map 139
préférences 91
relier des fadeurs 92, 139
Save MIDI Map 123
Split channels on incoming MIDI files 92, 128
timecode 92
Timecode Output Port 92, 128

MIDI buffer 126
MIDI Map Faders 139
MIDI Setup 119, 136
Mix Regions As Files 133
Mix to Disk 75, 77, 132, 133
Mixage final 76
Mixage virtuel 75
Mode boucle 27, 116
Mode objet 35, 104
Mode pulsation 38, 49
Mode punch 115
Mode segment 35, 104
MOTU

MIDI TimePiece 97, 99, 137
PCI-324 13

Multi-processing Support 124
Multiple Paste After 130
Multitap 59
Mute 107, 119

N

New 121
New Track 131
Nom de la piste 118
Normalize 55
Number of Channels 78

O

OMS 91
configurer Deck 91

OMS Setup 91
Opcode 91

Studio 5 97, 99, 137
Open 121
Open editor 61
Open Music System 91
Options matérielles 16

P

Partage de fichiers 5
Passage à zéro 176
Paste After 130
Paste At 130
Paste Before 129
Peak 50, 79
Peavey PC-1600 68
Performances

optimisation 4
Piste MIDI Thru 118
Pistes

coller 33
copier 33
couper 33
déplacer 33
renommer 29, 34, 76

Pistes de lecture 40
Pistes de travail 33, 40, 75, 107
Plage dynamique 176
Play 26, 115
Play audio while in background 15, 142
Plug-ins 177

Premiere 59, 134
appliquer 60
prévisualiser 60

VST 26, 60
bouncer 63
éditeur 61
insérer 61
installer 60
organiser 60
retirer 62

Point de rupture
ajuster 70
automation 70
supprimer 70

Pop-up menu États de Mixer 72
Port MIDI Thru 118
Position at Beginning 140
Position at End 140
Position automatique 26
Position to Fit 140
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Preferences
Effects 59, 128
General 123
Levels 126
Memory and Storage 125
MIDI 128
Slave Settings 127

Prévisualiser
plug-ins Premiere 60

Pulldown 138
Punch Time 140
Punch-In 26, 28
Punch-Out 28

Q

QuickTime 22, 70, 78, 177
Add audio to movie 87
Audio Format 87
bande son 83
Bit Depth Conversion 87
Chase Positioning 84
Configure Live Video 85
Copy Frame 84
défilement de la vidéo 85
Dispose Movie 84
faire défiler jusqu'à un point 85
Get Movie Info 84
Live Video 85
Make movie self-contained 86
Make playable on Non-Apple Computers 87
mode de suivi 84
raccourcis 144
Sample Rate 87
Set Offset 85
Set Poster 84
Size 85

Quit 129

R

RAM 121, 125, 142
allocation 10

RAM Doubler 10
Read DECK 1.0 Session 143
Rebuild Fades 134
Record 107, 115

Record monitoring 16, 142
Region Info 134
Régions 37, 177

changer la taille 39
éditer 39
placer sur du timecode 48

Remove 131
Rename 131
Repérage automatique 41
Repérage rapide 40
Replace 130
Résolution de bits 177
Résolution de l'axe 38, 105
Ressources minimum 4
Return-to-zero 68, 115
Reverse 55
Revert 122
Rewind 115
Rewrite region list 123
Rounding 78, 87

S

S/PDIF 142
Sample Rate 78, 87
Save 121
Save A Copy As 121
Scroll after play 124
Scroll During Playback 26, 141
SCSI 17, 177
SDII 77
Séance 21

ajouter de l'audio 22
créer 21
enregistrer 21
fermer 22
ouvrir 21

Secondes 37
Select All 131
Sélecteur de tempo 48
Sélecteur d'effet 56, 61, 112, 120
Sélecteur d'entrée 107, 112
Sélecteurs de Pan de Sortie 112
Sélection de la piste 114
Send to Slave 141
Séquence MIDI 24
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Session End Time 143
Session Info 142
Session Nominal Rate 138
Set Default Fade 44, 133
Set Grid Interval 141
Set Nudge Time 141
Set Selection 140
Slice 130
SMPTE 97, 100, 135

Preroll Time 125
Slave Driver 99

SMPTE Format 136
SMPTE Online 137
SMPTE Start Time 136
SMPTE-MIDI 99
SMPTE-MTC 137
Snap to Grid 38, 141
Soft Saturation 127
Solo 107
Sound Designer II 22, 77, 177
Sound Editor Signature 125
Sound Manager 12, 13, 175
Sound Manager Record Offset 125
Sous-menu Automation 68
State Transition Time 139
Steinberg 60
Stop 115
Stop audio playback if the drive is too slow 124
Strip Silence 136
Sync Mode 142
Syncro de déclenchement 98
Syncronisation 97

Current slave 127
déclencher 98
mettre en esclave d'une source numérique 98
Open Slave Documents 127
Quit Slave When Quitting 128
Save Slave’s Document When Saving 128

T

Table de mixage 11
Tableau de bord Son 13
Taille Minimum 5
Taille Souhaitée 5
Tascam US-428 11, 68, 93

Taux de lecture 138
Taux d'échantillonnage 177
Tempo 48
Temps de position 26, 27, 34, 35, 116
Thru 26, 57
Time Mode 141
Timecode 48
Timecode MIDI 138
Timecode Source 137
Trajet du signal 62
Trames SMPTE 37
Trigger Sync 137
Truncation 78, 87

U

Undo 129
Unités de l'axe 37, 38, 105
Update speed during playback 124
UW-SCSI 17

V

Virtual Mix 40, 133
VST 60
Vu-mètres 113, 121

W

Wave 77
Waveform Contract 34
Waveform Expand 34
Waves 60

Y

Yamaha
DSP Factory 13

Z

Zone de contrôle de piste 106
Zone de contrôle global des pistes 104
Zone Numéro 106
Zoom d'affichage 34
Zoom In 34, 104
Zoom Out 34, 104
Zoom Vertical 105
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